Using Excel for Business Analysis

Course #6850/QAS6850
Course Material
Using Excel for Business Analysis (Course #6850/QAS6850)

Table of Contents

<table>
<thead>
<tr>
<th>Chapter 1: What is Financial Modelling?</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What’s the Difference between a Spreadsheet and a Financial Model?</td>
<td>1</td>
</tr>
<tr>
<td>Types and Purposes of Financial Models</td>
<td>3</td>
</tr>
<tr>
<td>Tool Selection</td>
<td>4</td>
</tr>
<tr>
<td>What Skills Do you Need to Be a Good Financial Modeller?</td>
<td>5</td>
</tr>
<tr>
<td>The Ideal Financial Modeller</td>
<td>10</td>
</tr>
<tr>
<td>Summary</td>
<td>15</td>
</tr>
</tbody>
</table>

| Review Questions & Solutions | 19 |

| Chapter 2: Building a Model | 20 |
| Model Design | 23 |
| The Golden Rules for Model Design | 25 |
| Design Issues | 26 |
| The Workbook Anatomy of a Model | 27 |
| Project Planning Your Model | 29 |
| Model Layout Flow Charting | 30 |
| Steps to Building a Model | 31 |
| Information Requests | 38 |
| Version-Control Documentation | 39 |
| Summary | 40 |

| Review Questions & Solutions | 41 |

| Chapter 3: Best Practice Principles of Modelling | 42 |
| Document Your Assumptions | 44 |
| Linking, Not Hard Coding | 44 |
| Only Enter Data Once | 45 |
| Avoid Bad Habits | 45 |
| Use Consistent Formulas | 46 |
| Format and Label Clearly | 46 |
| Methods and Tools of Assumptions Documentation | 47 |
| Linked Dynamic Text Assumptions Documentation | 53 |
| What Makes a Good Model? | 56 |
| Summary | 57 |

| Review Questions & Solutions | 58 |

| Chapter 4: Financial Modelling Techniques | 59 |
| The Problem with Excel | 61 |
| Error Avoidance Strategies | 62 |
| How Long Should a Formula Be? | 67 |
| Linking to External Files | 69 |
| Building Error Checks | 72 |
| Avoid Error Displays in Formulas | 75 |
| Circular References | 75 |
| Summary | 79 |

<p>| Review Questions &amp; Solutions | 80 |</p>
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Formulas and Functions in Excel</td>
<td>83</td>
</tr>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Excel Versions</td>
<td>83</td>
</tr>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Handy Excel Shortcuts</td>
<td>86</td>
</tr>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Basic Excel Functions</td>
<td>91</td>
</tr>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Logical Functions</td>
<td>95</td>
</tr>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Nesting: Combining Simple Functions to Create Complex Formulas</td>
<td>97</td>
</tr>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Cell Referencing Best Practices</td>
<td>100</td>
</tr>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Named Ranges</td>
<td>102</td>
</tr>
<tr>
<td>Chapter 5: Using Excel in Financial Modelling</td>
<td>Summary</td>
<td>105</td>
</tr>
<tr>
<td>Review Questions &amp; Solutions</td>
<td></td>
<td>106</td>
</tr>
<tr>
<td>Chapter 6: Functions for Financial Modelling</td>
<td>Aggregation Functions</td>
<td>109</td>
</tr>
<tr>
<td>Chapter 6: Functions for Financial Modelling</td>
<td>LOOKUP Formulas</td>
<td>109</td>
</tr>
<tr>
<td>Chapter 6: Functions for Financial Modelling</td>
<td>Other Useful Functions</td>
<td>116</td>
</tr>
<tr>
<td>Chapter 6: Functions for Financial Modelling</td>
<td>Working with Dates</td>
<td>124</td>
</tr>
<tr>
<td>Chapter 6: Functions for Financial Modelling</td>
<td>Financial Project Evaluation Functions</td>
<td>133</td>
</tr>
<tr>
<td>Chapter 6: Functions for Financial Modelling</td>
<td>Loan Calculations</td>
<td>138</td>
</tr>
<tr>
<td>Chapter 6: Functions for Financial Modelling</td>
<td>Summary</td>
<td>143</td>
</tr>
<tr>
<td>Review Questions &amp; Solutions</td>
<td></td>
<td>148</td>
</tr>
<tr>
<td>Chapter 7: Tools for Model Display</td>
<td>Basic Formatting</td>
<td>151</td>
</tr>
<tr>
<td>Chapter 7: Tools for Model Display</td>
<td>Custom Formatting</td>
<td>151</td>
</tr>
<tr>
<td>Chapter 7: Tools for Model Display</td>
<td>Conditional Formatting</td>
<td>157</td>
</tr>
<tr>
<td>Chapter 7: Tools for Model Display</td>
<td>Sparklines</td>
<td>162</td>
</tr>
<tr>
<td>Chapter 7: Tools for Model Display</td>
<td>Bulletproofing Your Model</td>
<td>165</td>
</tr>
<tr>
<td>Chapter 7: Tools for Model Display</td>
<td>Customising the Display Settings</td>
<td>168</td>
</tr>
<tr>
<td>Chapter 7: Tools for Model Display</td>
<td>Form Controls</td>
<td>175</td>
</tr>
<tr>
<td>Chapter 7: Tools for Model Display</td>
<td>Summary</td>
<td>188</td>
</tr>
<tr>
<td>Review Questions &amp; Solutions</td>
<td></td>
<td>189</td>
</tr>
<tr>
<td>Chapter 8: Tools for Financial Modelling</td>
<td>Hiding Sections of a Model</td>
<td>191</td>
</tr>
<tr>
<td>Chapter 8: Tools for Financial Modelling</td>
<td>Grouping</td>
<td>191</td>
</tr>
<tr>
<td>Chapter 8: Tools for Financial Modelling</td>
<td>Array Formulas</td>
<td>196</td>
</tr>
<tr>
<td>Chapter 8: Tools for Financial Modelling</td>
<td>Goal Seeking</td>
<td>197</td>
</tr>
<tr>
<td>Chapter 8: Tools for Financial Modelling</td>
<td>Pivot Tables</td>
<td>202</td>
</tr>
<tr>
<td>Chapter 8: Tools for Financial Modelling</td>
<td>Macros</td>
<td>204</td>
</tr>
<tr>
<td>Chapter 8: Tools for Financial Modelling</td>
<td>User-Defined Functions (UDFs)</td>
<td>208</td>
</tr>
<tr>
<td>Chapter 8: Tools for Financial Modelling</td>
<td>Summary</td>
<td>216</td>
</tr>
<tr>
<td>Review Questions &amp; Solutions</td>
<td></td>
<td>218</td>
</tr>
</tbody>
</table>
# Table of Contents (cont’d)

<table>
<thead>
<tr>
<th>Chapter 9: Common Uses of Tools in Financial Modelling</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Escalation Methods for Modelling</td>
<td>221</td>
</tr>
<tr>
<td>Understanding Nominal and Effective (Real) Rates</td>
<td>226</td>
</tr>
<tr>
<td>Calculating Cumulative Totals</td>
<td>230</td>
</tr>
<tr>
<td>How to Calculate a Payback Period</td>
<td>230</td>
</tr>
<tr>
<td>Weighted Average Cost of Capital (WACC)</td>
<td>234</td>
</tr>
<tr>
<td>Building a Tiering Table</td>
<td>237</td>
</tr>
<tr>
<td>Modelling Depreciation Methods</td>
<td>240</td>
</tr>
<tr>
<td>Break-Even Analysis</td>
<td>249</td>
</tr>
<tr>
<td>Summary</td>
<td>255</td>
</tr>
</tbody>
</table>

**Review Questions & Solutions**

256

<table>
<thead>
<tr>
<th>Chapter 10: Model Review</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebuilding an Inherited Model</td>
<td>259</td>
</tr>
<tr>
<td>Auditing a Financial Model</td>
<td>268</td>
</tr>
<tr>
<td>Appendix 10.1: QA Log</td>
<td>273</td>
</tr>
<tr>
<td>Summary</td>
<td>274</td>
</tr>
</tbody>
</table>

**Review Questions & Solutions**

275

<table>
<thead>
<tr>
<th>Chapter 11: Stress-Testing, Scenarios, and Sensitivity Analysis in Financial Modelling</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What's the Difference between Scenario, Sensitivity, and What-If Analysis?</td>
<td>277</td>
</tr>
<tr>
<td>Overview of Scenario Analysis Tools and Methods</td>
<td>279</td>
</tr>
<tr>
<td>Advanced Conditional Formatting</td>
<td>287</td>
</tr>
<tr>
<td>Comparing Scenario Methods</td>
<td>290</td>
</tr>
<tr>
<td>Summary</td>
<td>300</td>
</tr>
</tbody>
</table>

**Review Questions & Solutions**

301

<table>
<thead>
<tr>
<th>Chapter 12: Presenting Model Output</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preparing an Oral Presentation for Model Results</td>
<td>303</td>
</tr>
<tr>
<td>Preparing a Graphic or Written Presentation for Model Results</td>
<td>304</td>
</tr>
<tr>
<td>Chart Types</td>
<td>306</td>
</tr>
<tr>
<td>Working with Charts</td>
<td>319</td>
</tr>
<tr>
<td>Handy Charting Hints</td>
<td>324</td>
</tr>
<tr>
<td>Dynamic Range Names</td>
<td>326</td>
</tr>
<tr>
<td>Charting with Two Different Axes and Chart Types</td>
<td>328</td>
</tr>
<tr>
<td>Bubble Charts</td>
<td>331</td>
</tr>
<tr>
<td>Waterfall Charts</td>
<td>336</td>
</tr>
<tr>
<td>Summary</td>
<td>345</td>
</tr>
</tbody>
</table>

**Review Questions & Solutions**

346
<table>
<thead>
<tr>
<th>Table of Contents (cont’d)</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notes</td>
<td>348</td>
</tr>
<tr>
<td>Glossary</td>
<td>349</td>
</tr>
<tr>
<td>About the Website</td>
<td>351</td>
</tr>
<tr>
<td>Index</td>
<td>352</td>
</tr>
</tbody>
</table>

**NOTICE**

This course and test have been adapted from supplemental materials and uses the materials entitled *Using Excel for Business Analysis, A Guide to Financial Modelling Fundamentals* © 2012 by Danielle Stein Fairhurst. Displayed by permission of the publisher, John Wiley & Sons, Inc., Hoboken, New Jersey. All rights reserved. This course is sold with the understanding that the publisher is not engaged in rendering legal, accounting, or other professional advice and assumes no liability whatsoever in connection with its use. Since laws are constantly changing, and are subject to differing interpretations, we urge you to do additional research and consult appropriate experts before relying on the information contained in this course to render professional advice.

© Professional Education Services, LP 2013

Program publication date 6/24/13

---

**About the Author**

Danielle Stein Fairhurst is the principal of Plum Solutions, a Sydney-based financial modelling consultancy. With her talent for analytical modelling and professional approach, Danielle helps her clients create meaningful financial models for business analysis. Over past decades she has worked in a number of industry sectors, including telecoms, information systems, manufacturing, and financial services, with solutions such as business cases, pricing models, and management reports. She is regularly engaged as a speaker, facilitator, and consultant around Australia and globally.

She holds a master of business administration (MBA) from Macquarie Graduate School of Management, and has taught management accounting subjects at Sydney University. Danielle lives in Sydney with her husband and two children, but travels widely and enjoys the challenge of balancing a healthy family lifestyle with her passion for financial modelling pedagogy.
Chapter 1: What Is Financial Modelling?

There are all sorts of complicated definitions of financial modelling, and in my experience there is quite a bit of confusion around what a financial model is exactly. A few years ago, we put together a Plum Solutions survey about the attitudes, trends, and uses of financial modelling, asked respondents “What do you think a financial model is?” Participants were asked to put down the first thing that came to mind, without any research or too much thinking about it. I found the responses interesting, amusing, and sometimes rather disturbing.

Some answers were overly complicated and highly technical:

- “Representation of behaviour/real-world observations through mathematical approach designed to anticipate range of outcomes.”
- “A set of structured calculations, written in a spreadsheet, used to analyse the operational and financial characteristics of a business and/or its activities.”
- “Tool(s) used to set and manage a suite of variable assumptions in order to predict the financial outcomes of an opportunity.”
- “A construct that encodes business rules, assumptions, and calculations enabling information, analysis, and insight to be drawn out and supported by quantitative facts.”
- “A system of spreadsheets and formulas to achieve the level of record keeping and reporting required to be informed, up-to-date, and able to track finances accurately and plan for the future.”

Some philosophical:

- “A numerical story.”

Some incorrect:

- “Forecasting wealth by putting money away now/investing.”
- “It is all about putting data into a nice format.”
- “It is just a mega huge spreadsheet with fancy formulas that are streamlined to make your life easier.”

Some ridiculous:

- “Something to do with money and fashion?”

Some honest:

- “I really have no idea.”
- And some downright profound:
  - “A complex spreadsheet.”

Whilst there are many other (often very complicated and long-winded) definitions available from different sources, but I actually prefer the last, very broad, but accurate description: “a complex spreadsheet.” Whilst it does need some definition, a financial model can pretty much be whatever you need it to be.

As long as a spreadsheet has inputs and outputs, and is dynamic and flexible – I’m happy to call it a financial model! Pretty much the whole point of financial modelling is that you change the inputs and the outputs. This is the major premise behind scenario and sensitivity analysis – this is what Excel, with its algebraic logic, was made for! Most of the time, a model will contain financial information and serve the purpose of making a financial decision, but not always. Quite often it will contain a full set of financial statements: profit and loss, cash flow, and balance sheet; but not always.
According to the more staid or traditional definitions of financial modelling, the following items would all most certainly be classified as financial models:

- A business case that determines whether or not to go ahead with a project.
- A five-year forecast showing profit and loss, cash flow, and balance sheet.
- Pricing calculations to determine how much to bid for a new tender.
- Investment calculations for a joint venture.

But what about other pieces of analysis that we perform as part of our roles? Can these also be called financial models? What if something does not contain financial information at all? Consider if you were to produce a spreadsheet for the following purposes:

- **An actual-versus-budget monthly variance analysis** that does not contain scenarios and for which there are no real assumptions listed.
- **A risk assessment**, where you enter the risk, assign a likelihood to that risk, and calculate the overall risk of the project using probability calculations. This does not contain any financial outputs at all.
- **A dashboard report** showing a balance scorecard type of metrics reporting like headcount, quality, customer numbers, call volume, and so on. Again, there are few or no financial outputs.

See the section on the “Types and Purposes of Financial Models” later in this chapter for some more detail on financial models that don’t actually contain financial information.

Don’t get hung up on whether you’re actually building something that meets the definition of a financial model or not. As long as you’ve got inputs and outputs that change flexibly and dynamically you can call it a financial model! If you’re using Excel to any extent whereby you are linking cells together, chances are you’re already building a financial model – whether you realise it or not. The most important thing is that you are building the model (or whatever it’s called!) in a robust way, following the principles of best practice, which this course will teach you.

Generally, a model consists of one or more input variables along with data and formulas that are used to perform calculations, make predictions, or perform any number of solutions to business (or non-business) requirements. By changing the values of the input variables, you can do sensitivity testing and build scenarios to see what happens when the inputs change.

Sometimes managers treat models as though they are able to produce the answer to all business decisions and solve all business problems. Whilst a good model can aid significantly, it’s important to remember that models are only as good as the data they contain, and the answers they produce should not necessarily be taken at face value. “The reliability of a spreadsheet is essentially the accuracy of the data that it produces, and is compromised by the errors found in approximately 94% of spreadsheets.” When presented with a model, the savvy manager will query all the assumptions, and the way it’s built. Someone who has had some experience in building models will realise that they must be treated with caution. Models should be used as one tool in the decision-making process, rather than the definitive solution.
WHAT'S THE DIFFERENCE BETWEEN A SPREADSHEET AND A FINANCIAL MODEL?

Let me make one thing very clear: I am not partial to the use of the word spreadsheet; in fact you’ll hardly find it used at all in this course.

I’ve often been asked the difference between the two, and there is a fine line of definition between them. In a nutshell, an Excel spreadsheet is simply the medium that we can use to create a financial model.

At the most basic level, a financial model that has been built in Excel is simply a complex spreadsheet. By definition, a financial model is a structure that contains input data and supplies outputs. By changing the input data, we can test the results of these changes on the output results, and this sort of sensitivity analysis is most easily done in an Excel spreadsheet.

One could argue then, that they are in fact the same thing; there is really no difference between a spreadsheet and a financial model. Others question if it really matters what we call them as long as they do the job? After all, both involve putting data into Excel, organising it, formatting, adding some formulas, and creating some usable output. There are, however, some subtle differences to note.

1. “Spreadsheet” is a catchall term for any type of information stored in Excel, including a financial model. Therefore, a spreadsheet could really be anything – a checklist, a raw data output from an accounting system, a beautifully laid out management report, or a financial model used to evaluate a new investment.

2. A financial model is more structured. A model contains a set of variable assumptions, inputs, outputs, calculations, scenarios, and often includes a set of standard financial forecasts such as a profit and loss, balance sheet, and cash flow, which are based on those assumptions.

3. A financial model is dynamic. A model contains variable inputs, which, when changed, impact the output results. A spreadsheet might be simply a report that aggregates information from other sources and assembles it into a useful presentation. It may contain a few formulas, such as a total at the bottom of a list of expenses or average cash spent over 12 months, but the results will depend on direct inputs into those columns and rows. A financial model will always have built-in flexibility to explore different outcomes in all financial reports based on changing a few key inputs.

4. A spreadsheet is usually static. Once a spreadsheet is complete, it often becomes a stand-alone report, and no further changes are made. A financial model, on the other hand, will always allow a user to change input variables and see the impact of these assumptions on the output.

5. A financial model will use relationships between several variables to create the financial report, and changing any or all of them will affect the output. For example, Revenue in Month 4 could be a result of Sales Price × Quantity Sold Prior Month × Monthly Growth in Quantities Sold. In this example, three factors come into play, and the end user can explore different mixes of all three to see the results and decide which reflects their business model best.
6. **A spreadsheet shows actual historical data, whereas a financial model contains hypothetical outcomes.** A by-product of a well-built financial model is that we can easily use it to perform scenario and sensitivity analysis. This is an important outcome of a financial model. What would happen if interest rates increase by half a basis point? How much can we discount before we start making a loss?

In conclusion, a financial model is a complex type of spreadsheet, whilst a spreadsheet is a tool that can fulfill a variety of purposes – financial models being one. The list of attributes above can identify the spreadsheet as a financial model, but in some cases, we really are talking about the same thing. Take a look at the Excel files you are using. Are they dynamic, structured, and flexible, or have you simply created a static, direct-input spreadsheet?

**TYPES AND PURPOSES OF FINANCIAL MODELS**

Models in Excel can be built for virtually any purpose – financial and non-financial, business- or non-business related – although the majority of models will be financial and business-related. The following are some examples of models that do not capture financial information:

- **Risk Management:** A model that captures, tracks, and reports on project risks, status, likelihood, impact, and mitigation. Conditional formatting is often integrated to make a colourful, interactive report.
- **Project Planning:** Models may be built to monitor progress on projects, including critical path schedules and even Gantt charts. (See the next section in this chapter, “Tool Selection,” for an analysis of whether Microsoft Project or Excel should be used for building this type of project plan.)
- **KPIs and Benchmarking:** Excel is the best tool for pulling together KPI and metrics reporting. These sorts of statistics are often pulled from many different systems and sources, and Excel is often the common denominator between different systems.
- **Dashboards:** Popularity in dashboards has increased in recent years. The dashboard is a conglomeration of different measures (sometimes financial but often not), which are also often conveniently collated and displayed as charts and tables using Excel.
- **Balanced Scorecards:** These help provide a more comprehensive view of a business by focusing on the operational, marketing, and developmental performance of the organisation as well as financial measures. A scorecard will display measures such as process performance, market share or penetration, and learning and skills development, all of which are easily collated and displayed in Excel.

As with many Excel models, most of these could be more accurately created and maintained in a purpose-built piece of software, but quite often the data for these kinds of reports is stored in different systems, and the most practical tool for pulling the data together and displaying it in a dynamic monthly report is Excel.
Although purists would not classify these as financial models, the way that they have been built should still follow the fundamentals of financial modelling best practices, such as linking and assumptions documentation. How we classify these models is therefore simply a matter of semantics, and quite frankly I don’t think what we call them is particularly important! Going back to our original definition of financial modelling, it is a structure (usually in Excel) that contains inputs and outputs, and is flexible and dynamic.

TOOL SELECTION

In this course we will use Excel exclusively, as that is most appropriate for the kind of financial analysis we are performing when creating financial models. I recommend using plain Excel, without relying on any other third-party software for several reasons:

- No extra licenses, training, or software download is required.
- The software can be installed on almost any computer.
- Little training is required, as most users have some familiarity with the product – which means other people will be able to drive and understand your model.
- It is a very flexible tool. If you can imagine it, you can probably do it in Excel (within reason, of course).
- Excel can report, model, and contrast virtually any data, from any source, all in one report.
- But most importantly, Excel is commonly used across all industries, countries, and organisations. What this means to you is that if you have good financial modelling skills in Excel, these skills are going to make you more in demand – especially if you are considering changing industries or roles or getting a job in another country.

Excel has its limitations, of course, and Excel’s main downfall is the ease with which users can make errors in their models. Therefore, a large part of financial modelling best practice relates to reducing the possibility for errors. See Chapter 3, “Best Practice Principles of Modelling,” and “Error Avoidance Strategies” in Chapter 4 for details on errors and how to avoid them.

Is Excel Really the Best Option?

Before jumping straight in and creating your solution in Excel, it is worth considering that some solutions may be better built in other software, so take a moment to contemplate your choice of software before designing a solution. There are many other forms of modelling software on the market, and it might be worth considering other options besides Excel. There are also a number of Excel add-ins provided by third parties that can be used to create financial models and perform financial analysis. The best choice depends on the solution you require.

The overall objective of a financial model determines the output as well as the calculations or processing of input required by the model. Financial models are built for the purpose of providing timely, accurate, and meaningful information to assist in the financial decision making process. As a result, the overall objective of the model depends on the specific decisions that are to be made based on the model’s output.
As different modelling tools lend themselves to different solutions or output, before selecting a modelling tool it is important to determine precisely what solution is required based on the identified model objective.

**Evaluating Modelling Tools**

Once the overall objective of the model has been established, a financial modelling tool that will best suit the business requirements can be chosen.

To determine which financial modelling tool would best meet the identified objective, the following must be considered:

- The output required from the model, based on who will use it and the particular decisions to be made.
- The volume, complexity, type, and source of input data – particularly relating to the number of interdependent variables and the relationships between them.
- The complexity of calculations or processing of input to be performed by the model.
- The level of computer literacy of the users, as they should ideally be able to manipulate the model without the assistance of a specialist.
- The cost versus benefit set off for each modelling tool.

As with all software, financial modelling programs can either be purchased as a package or developed in-house. Whilst purchasing software as a package is a cheaper option, in a very complex industry, in-house development of specific modelling software may be necessary in order to provide adequate solutions. In this instance, one would need to engage a reputable specialist to plan and develop appropriate modelling software.

Which package you choose depends on the solution you require. A database or customer relationship management (CRM) data lends itself very well to a database such as Microsoft Access, whereas something that requires complex calculations, such as those in many financial models, is more appropriately dealt with in Excel.

Excel is often described as a Band-Aid solution, because it is such a flexible tool that we can use to perform almost any process – albeit not as fast or as well as fully customised software, but it will get the job done until a long-term solution is found: “... spreadsheets will always fill the void between what a business needs today and the formal installed systems...”

**Budgeting and Forecasting**

Many budgets and forecasts are built using Excel, but most major general ledger systems have additional modules available that are built specifically for budgeting and forecasting. These tools provide a much easier, quicker method of creating budgets and forecasts that is less error-prone than using templates. However, there are surprisingly few companies that have a properly integrated, fully functioning budgeting and forecasting system, and the fallback solution is almost always Excel.

There are several reasons why many companies use Excel templates over a full budgeting and forecasting solution, whether they are integrated with their general ledger system or not.
- A full solution can be expensive and time-consuming to implement properly.
- Integration with the general ledger system means a large investment in a particular modelling system, which is difficult to change later.
- Even if a system is not in place, invariably some analysis will need to be undertaken in Excel, necessitating at least part of the process to be built using Excel templates.

**Microsoft Office Tools: Excel, Access, and Project**

Plain-vanilla Excel (and by this I mean no add-ins) is the most commonly used tool. See the next section for a review of some extra add-ins you might like to consider. However, there are other Microsoft tools that could also serve to create the solution. Microsoft (MS) Access is probably the closest alternative to Excel, and quite often solutions are built in Excel when, in fact, Access is the most sensible solution.

There is often some resistance to using Access, and it is becoming less popular than it was a decade or so ago. Prior to the release of Excel 2007, Excel users were restricted to only 65,000 rows, and many analysts and finance staff used Access as a way to get around this limit. With now over 1.1 million rows, Excel is able to handle a lot more data, so there is less need for the additional row capacity of Access. However, Access is still worth some consideration.

**Advantages of Excel**

- Excel is included in most basic Microsoft packages (unlike Access, which often needs to be purchased separately) and therefore comes as standard on most PCs. Excel is much more flexible than Access and calculations are much easier to perform.
- It is generally faster to build a solution in Excel than in Access.
- Excel has a wider knowledge base among users, and many people find it to be more intuitive. This means it is quicker and easier to train staff in Excel.
- It is very easy to create flexible reports and charts in Excel.
- Excel can report, model, and contrast virtually any data, from any source, all in one file.
- Excel easily performs calculations on more than one row of data at a time, which Access has difficulty with.

**Advantages of Access**

- Access can handle much larger amounts of data: Excel 2003 is limited to 65,000 rows and 256 columns, and Excel 2007 and 2010 are limited to around 1.1 million rows and 16,000 columns. Access’s capability is much larger, and it also has a greater memory storage capacity.
- Data is stored only once in Access, making it work more efficiently.
- Data can be entered into Access by more than one user at a time.
- Access is a good at crunching and manipulating large volumes of data.
- Due to Access’s lack of flexibility, it is a harder for users to make errors.
- Access has user forms, which provide guidance to users and are an easy way for users to enter data.
MS Project is specifically for creating project plans and associated component tasks, assigning resources to those tasks, tracking progress, managing budgets, and monitoring workloads. The user can also create critical path schedules and Gantt charts.

Because the program handles costs, budgets, and baselines quite well, Project could be considered a viable alternative to a financial model, if the purpose of the model were simply to create an actual-versus-budget tracking report. In fact, as with most purpose-built software, if your aim is to track and monitor a project, Project is a far superior option to Excel. Of course creating a project plan and even a Gantt chart is certainly possible in Excel, although it will take longer, and be far more prone to error than Project. There are many reasons, however, why users will opt to use Excel for a project plan over Project:

- Project is not included in any of the Office suites and therefore needs to be purchased separately.
- The plan may need to be accessed, updated, and monitored by different users, who may not be able to use Project due to lack of skills.
- For a reasonably small project it’s probably not worth the trouble; it’s simpler to just work it up in Excel.

In summary, the choice between Excel and Project really depends on the size, scope, and complexity of the project plan model you are building. Bear in mind of course that there are many other pieces of project planning software besides Project on the market!

Excel Add-ins: Add-ins are programs that add optional commands and features to Excel. There are many add-ins on the market that have been developed specifically for the purpose of financial modelling. For more complex calculations or processing of input, it may be useful to activate or install one or more add-ins, especially tools such as Solver, which are included in your MS Excel licence. Bear in mind that other users will probably not have add-ins enabled, so they will not be able to see how your model has been created or calculated.

Excel add-ins can be categorised according to source:

- Add-ins such as Solver and the Analysis ToolPak that only need to be activated once Excel has been installed.
- Add-ins that must be downloaded from Office.com and installed before they can be used.
- Custom add-ins created by third parties that must be installed before they can be used: Component Object Model (COM) add-ins, Visual Basic for Applications (VBA) add-ins, Automation add-ins, or DLL add-ins.

Excel add-ins from all sources can be used to perform a variety of tasks that assist in the financial modelling process. These add-ins can be broadly defined as:

- Standard Excel add-ins such as the Analysis ToolPak and Solver.
- Audit tools.
- Integration links between Excel and the general ledger system.

The most commonly used add-ins are the Analysis ToolPak and Solver, which are standard add-in programs that are available when you install Microsoft Office or Excel. They are included in the program but are disabled by default, so if you want to use them, you need to enable them.
Prior to the release of Excel 2007 the only way to access certain functions (e.g., =EOMONTH and =SUMIFS) in Excel 2003 was to download the Analysis ToolPak. However, these functions are now standard in Excel 2007 and later, so the Analysis ToolPak is now less commonly used.

Other features in the Analysis ToolPak are tools like Data Analysis ToolPak, which has some powerful statistical and engineering functions not commonly used in financial modelling. Solver, however, is an extremely useful but rather advanced tool for calculating optimal values in financial modelling.

**Audit Add-Ins:** Audit add-ins for Excel are used to ensure the accuracy of data and calculations within a spreadsheet or workbook. They can very quickly identify formula errors by looking at inconsistent formulas, comparing versions, and getting to the bottom of complex named ranges. There are several custom add-ins available both from Microsoft and other parties that will facilitate accuracy by performing formula investigations, precedent/dependent analysis, worksheet analysis, and sensitivity reporting.

Whilst they can assist with checking for formula errors, there are many other types of errors that can be easily overlooked, and using these add-ins can provide a false sense of security. See the section on “Error Avoidance Strategies” in Chapter 4 for more detail.

**Integration Add-Ins:** Integration add-ins allow information from the financial reporting system to be transferred into Excel for further analysis, or data stored in Excel to be transferred into the financial reporting system. These are often used for the purpose of:

- Transferring information from the general ledger system into Excel for the purposes of reporting and analysis. Many management reports are built in Excel, and extract up-to-date data directly from the general ledger system into the reports.
- Loading information in the form of journal entries back into the general ledger system. Data is often manipulated in Excel, and then loaded into the general ledger as a journal. For example, if an invoice needs to be split between different departments based on headcount allocation, this calculation might be done in Excel, split to departments in the journal, and loaded into the general ledger system.

**The Final Decision**

The more sophisticated a financial model is, the more expensive it is to maintain. It is therefore best to use a model with the lowest possible level of sophistication needed to provide a specific solution. For this reason, purchasing a software package, provided it can provide the desired solution, would usually be advisable.

Once the decision has been made to purchase a software package, it must be determined which package will provide the best solution as certain solutions may be better provided by particular software packages.

There are many forms of software and Excel add-ins on the market that can be used to create financial models. However, provided that it can provide an adequate solution, we recommend using plain Excel, as it is easy to use and no extra licenses, training, or software downloads are required. If additional functionality is needed, Excel add-ins may be considered.
WHAT SKILLS DO YOU NEED TO BE A GOOD FINANCIAL MODELLER?

When you decide your financial models are not as good as they should be, should you immediately take an advanced Excel course? Whilst this is helpful, there’s a great deal more to financial modelling than being good at Excel!

When considering the skills that make up a good financial modeller, we need to differentiate between conceptual modelling, which is to have an understanding of the transaction, business, or product being modelled, and spreadsheet engineering, which is the representation of that conceptual model in a spreadsheet. Spreadsheet skills are reasonably easy to find, but a modeller who can understand the concept of the purpose of the model and translate it into a clear, concise, and well-structured model is much rarer.

People who need to build a financial model sometimes think they need to become either an Excel super-user or an accounting pro who knows every in and out of accounting rules. I’d argue you need a blend of both, as well as a number of other skills, including some business common sense!

Spreadsheet and Technical Excel Skills

It’s very easy for financial modellers to get bogged down in the technical Excel aspects of their model, get carried away with complex formulas, and not focus on key high-level, best-practice procedures, such as error-checking strategies and model stress-testing.

Excel is an incredibly powerful tool, and almost no single Excel user will have the need or desire to utilise most of the functionality this program offers. As with most software, the 80/20 rule applies: 80 percent of users use only 20 percent of the features – although some would argue that 95 percent of Excel users use only 5 percent of the features! Still, there are those select few who understand every in and out of Excel, every single function, and work out how to do practically anything in Excel. Do you need to have this level of Excel skill to become a good financial modeller? Unfortunately, having great software skills doesn’t always help when it comes to applying them to a specific area of business. Realise that Excel is used in several capacities, so being an Excel super-user doesn’t automatically mean you’ll be a super financial modeller. The best financial models are clear, well structured, flexible, and dynamic; they are not always the biggest and most complicated models that use the most advanced tools and functions! Many of the best financial models use only Excel’s core functionality.

Having said that, to be a good financial modeller, you do need to know Excel exceptionally well. Those people who maintain that you don’t need good Excel skills to be a financial modeller are usually those with weak Excel skills. You should be building a superb model using simple and straightforward tools because you’ve chosen to make your model clear and easy to follow, not because that’s all you know how to do! You don’t have to be a super-user – the 99th percentile in Excel knowledge – but you must certainly be above average. A complex financial model might use features in Excel that the everyday user doesn’t know. The best financial model will always use the solution that is the simplest tool to complete the task (as simple as possible and as complex as necessary, right?), so the more familiar you are with the tools available in Excel, the easier it will be. An array formula or a macro might be the only way to achieve what you need to achieve, but a simpler solution may well be – and often is – superior. You might
also need to take apart someone else’s model, which uses complex tools, and it’s very
difficult to manipulate an array formula or a macro if you’ve never seen one before! So, if
you are considering a career as a financial modeller (as I assume you are) improving
your Excel knowledge is an excellent place to start.

EXAMPLES OF TECHNICAL EXCEL SKILLS QUESTIONS

- How do I use the appropriate formula? For example, should I use a VLOOKUP or
  a SUMIF?
- How do I insert or hide a sheet and then protect it so that the user can’t access
  it?
- How do I construct a complex but concise formula?

Industry Knowledge

One of the fantastic things about financial modelling is that it is applicable across so
many different industries. Good financial modelling skills will always stand you in good
stead, no matter which industry or country you are working in! Financial modelling
consultants or generalists will probably work in many different industries during their
careers and be able to build models for different products and services. They will
probably not be experts in the intricacies of each industry, however, and that’s why it’s
important for a financial modelling generalist to consult carefully with the subject matter
expert for the inputs, assumptions, and logic of the financial model. Don’t be afraid to
ask lots and lots of questions if the details are not absolutely clear. It’s quite likely that
the person who has commissioned the model hasn’t actually thought through the steps,
inputs, assumptions, and even what the outputs should look like, until you ask the right
question.

Financial modellers working within an organisation, however, usually become experts in
their own industry or domain, and will become very familiar with the minutiae of how
financial models for that industry should be designed, and which assumptions should be
used.

Financial modelling consultants are very careful to transfer responsibility for the
assumptions to the end user, which is a very sensible course of action. The person
building the model is often not the one who has commissioned it or the person who is
actually using it. Model builders are often not overly familiar with the product or even the
organisation, and they cannot (and should not) take responsibility for the inputs. (See the
section “Document Your Assumptions” in Chapter 3 for greater detail on the importance
of documentation of assumptions.)

For example, when building a pricing model, the modeller needs to understand the
product and how the costs and revenue work. Experience with regulatory constraints will
help the modeller to understand the basis of regulation and its components (e.g., cost
building blocks, cost index, revenue cap, weighted average price cap, maximum prices,
etc.). Understanding of economic concepts, such as efficient cost calculation, return on
and of a regulatory asset base, operating costs and working capital, long-run versus
short-run marginal costs, and average costs, are other examples of industry knowledge
that is useful for the financial modeller.
EXAMPLES OF INDUSTRY KNOWLEDGE

- Regulatory constraints.
- Industry standards.
- Maximum price that can be charged for a certain item.

Accounting Knowledge

Elements such as financial statements, cash flow, and tax calculations can be an important aspect of many financial models. Professional accountants know every single accounting rule and law there are, so are they good financial modellers? If a highly skilled accountant built a financial model, you would guess that the layout and structure of the financial statements will be 100 percent correct, but will they be linked properly? If you change some of the inputs, does the balance sheet still balance? Sometimes not! A good accountant, or even someone qualified with a master of applied finance, might not be familiar with all of the modelling technical tools, even if they are a competent Excel user. As with the other modelling skills, you don’t need a top level of accounting knowledge to build a financial model. In fact, financial models are often relatively straightforward from an accounting standpoint. You certainly do not need to be a qualified accountant to become a financial modeller, although a good understanding of accounting and knowledge of finance certainly help.

There are some situations where industry knowledge and accounting are required for financial modelling. For example, in manufacturing or, particularly, in the oil and gas industry, the modeller needs to know whether FIFO (first in, first out) or LIFO (last in, first out) accounting is being used, as this has a big impact on the way that inventory is being modelled. A financial modeller who has never worked in these industries may not have ever heard of FIFO and LIFO, and would probably have no idea how to model it.

EXAMPLES OF ACCOUNTING KNOWLEDGE

- How is a profit-and-loss statement structured?
- How do I construct a cash-flow forecast from my model?
- How do I turn capital expenditure into a depreciation expense?

Business Knowledge

A modeller with wide-ranging business experience is well equipped to probe for the facts and assumptions that are critical for building a financial model. This is probably the most difficult skill to teach, as it’s most easily picked up by working in a management role.

Business acumen is particularly important when commissioning, designing, and interpreting a financial model. When creating the model, the modeller needs to consider the purpose of the model. What does the model need to tell us? Knowing the desired outcome will assist with the model’s build, design, and inputs. If, for example, we are building a pricing model, we need to consider the desired outcome; normally, the price...
we need to charge in order to achieve a certain profit margin. What is an acceptable margin? What costs should we include? What cost will the market bear? Modellers should also have an understanding of economic concepts, such as efficient costs and how these are calculated, an expected return on an asset base, operating costs and working capital, or long-run versus short-run marginal costs.

Of course the answers to these questions can be obtained from other people, but a modeller with good business sense will have an innate sense of how a model should be built, and what is the most logical design and layout to achieve the necessary results.

### EXAMPLES OF BUSINESS KNOWLEDGE

- What is cost of capital and how does that affect a business case?
- Which numbers are important?
- What does the internal rate of return (IRR) mean and what is an acceptable rate?

### Aesthetic Design Skills

This is an area that many modellers and analysts struggle with, as aesthetics simply do not come naturally to left-brain thinkers like us. We are mostly so concerned with accuracy and functionality that we fail to realise that the model looks – and I’m not going to mince words here – ugly! Although it’s just a simple matter of taking our time when formatting, most of us could not be bothered with such trivial details as making models pretty, and consequently most models I see use the standard gridlines, font, and black-and-white colouring that are Excel defaults. I’m certainly not suggesting that you embellish your models with garish colours, but you should take some pride in your model. See the section on “Bulletproofing Your Model” in Chapter 7 for some ideas on how to remove gridlines and change some of the standard settings so that your model looks less like a clunky spreadsheet and more like a reliable, well-crafted model you’ve taken your time over. Research shows that users place greater faith on models with aesthetic formatting than those without, so one of the fastest and easiest ways to give your model credibility is to simply spend a few minutes on the colours, font, layout, and design.

Some aesthetic formatting is critical for the functionality and to avoid error (see section on “Error Avoidance Strategies” in Chapter 4), but mostly it adds credibility and makes your model easier to work with.

Models can become complex very quickly and without a well-planned design they can be unintelligible. Some basic components of a model should be a cover sheet, instructions, and clearly labelled inputs, outputs, workings, and results. For extremely long and complex models with many sheets, a hyperlinked table of contents is also a valuable addition to help the user navigate the model.
Communication and Language Skills

This is also an area that we left-brain thinkers are not always good at. Some analysts like to lock themselves away, working on spreadsheets without communicating with other people. If this is your tendency, then you might need to consider whether financial modelling is a good career choice for you, because there is a surprising amount of human interaction required for most financial modellers.

- **Assumptions Validation:** In order to gain buy-in from stakeholders, the key assumptions and inputs often need to be communicated verbally or in writing. People in various parts of the business should be involved in order to check the accuracy and appropriateness of inputs for inclusion in a model. Stakeholders will often query the assumptions or the way they have been used and provide extremely valuable insight for modellers (particularly for a consultant or modeller with little industry or product knowledge). Performing this task well is a critical step in the modelling process.

- **Data Gathering:** There are some modelling projects where more time is spent gathering and collating data than actually building the model. Holders of information can be guarded about giving access to data, sometimes irrationally, but often it’s because they’ve had bad experiences in the past. This can occur when someone provides estimates off the record, and later discovers that those numbers have been used in budgets or other documents to which they are held accountable. So, people can be understandably reticent about providing data when requested for an ad hoc project such as a financial model. A modeller with good communication skills will be able to dig, delve, and coax the information out of them!

- **Presentation Skills:** Senior management, when approving a project, often wants to hear about the financial implications of the project from the person who actually built the model, and so modellers are sometimes required to present the key outcomes to a board or executive committee. Being able to distill a 30-megabyte, extremely complex financial model that contains 20 tabs and took you six weeks to build, into three PowerPoint slides and a six-minute summary presentation can be quite a challenge!

- **Client Skills:** Whether you are a consultant or an in-house employee, working well with clients is a useful skill. Even in-house modellers have clients; every person you work with or for should be considered a client and treated with the same respect and consideration as though they were paying your bill.

In all of these interactions with other people, financial modellers must show confidence in their model. Build the model to the best of your ability. Use best practices, check for errors, and follow a good and logical thought process, so that when you present or discuss your model, you can do so in a way that exudes absolute confidence. Doing so reduces questions about the accuracy, usefulness, and validity of your model. Be honest about the fallibility of your model and its known shortcomings (let’s face it, no model is perfect), but be confident that you have built it to best-practice standards within the limitations of time, data, or scope. This will serve to increase your model’s credibility, building your reputation within your company, and, of course, enhancing your career!
Numeracy Skills

Financial models, of course, have a significant mathematical component, and people with good numeracy skills are best suited to it. Solid math skills can be particularly useful in error-checking and sense-checking. The ability to make rough estimates quickly means they will be able to spot errors more easily. If we sell 450 units at $800 each, will our sales revenue be $3.6 m, or $360,000? If we’ve made a calculation error, the numerate modeller will pick up the mistake much more quickly.

The numerate modeller will also have a gut feel for differentiating between critical assumptions that need further verification, and input that is insignificant or immaterial to the model. The less-numerate modeller will have to test it manually, and will probably end up with the same result, but it will take longer!

General numeracy is a skill that is difficult to teach, and one that can be easily tested for in the recruitment process. Experience working with models over time can drastically improve these skills as the modeller who is less numerate will learn ways to compensate through error-testing, and these techniques will become acquired, innate habits.

Ability to Think Logically

Modelling is often like programming, and complex logic needs to be interpreted into the language of Excel so that the program can understand and create the modeller’s expected results. For example, if we want to show a value, but only if the cell being tested is in the future, we would vocalise it by saying: “Show me the value, but only if the test cell is greater than or equal to today’s date.” The way that we need to translate this into Excel’s language is to use the formula:

\[ \text{IF(test\_cell}\geq\text{today},\text{value},0) \]

Logic is also critical for model layout, design, and the use of assumptions in calculations. The issue of timing in annual models is one that I use often when demonstrating logic in my training workshops. If we are estimating the revenue for a new insurance product, and the assumption is that we acquire 30,000 customers every year, we can’t assume revenue for the full 30,000 customers, as not all of them will begin on the very first day of Year 1. Customers will be acquired gradually throughout the year, so we need to take an average in order to calculate revenue. This is an example of how it is very easy to get logic wrong, and overestimate revenue by a substantial amount.

Logic is one of those analytical skills that is very difficult to teach, but modellers who have made a logic error (like the one illustrated above) learn quickly from their mistakes and are quite careful to use clear, well-documented logic for others to follow and check.

THE IDEAL FINANCIAL MODELLER

In general, most modellers have at least some of the aforementioned skills, and at times it is necessary to consult specialists in order to create a successful financial model. Having read the section on the skills that you need to be a good financial modeller, you should have a fairly good idea about which areas you are lacking in. Once you have identified these areas, you can work to improve them and liaise with other specialists to ensure that your model is not lacking as a result of your weaknesses.
What financial modellers bring to the table is a combination of skills. First, they know Excel well enough to be able to choose the simplest and most functional tool to build a model. They can create a pivot table, array formula, or macro (but only when necessary, of course!); use a simple or complex nested formula; and choose the best technical tool to perform a scenario analysis. They also understand all the relevant business and accounting principles. At the end of the day, the balance sheet has to balance, and the ending cash on your cash flow statement needs to tie to the balance sheet, for example.

The ideal financial modeller brings a unique combination of skills that neither an Excel guru nor an accounting whiz possesses. He or she understands sensitivity and relationships between variables, how fluctuations in inputs will impact the outcomes, and how this needs to be modelled in Excel. A financial modeller can also take a step back and realise what the ultimate goal of the model should be. Are we building a model for in-house use, or to present to investors? Do we need a valuation, a variance analysis, a nice summary, or a detailed, month-by-month profit-and-loss report? The financial modeller can take information, build an Excel model that is technically correct from an accounting standpoint, set up the model, and ultimately reflect what the business is looking to achieve.

What’s the Typical Background for a Financial Modeller?

A key problem in the financial modelling industry is that modelling is often incorrectly considered a junior task, and is often given to inexperienced graduate analysts who undoubtedly have good Excel skills, but simply do not have the depth of business experience to create good financial models. If a modeller is able to tick all of the above boxes (i.e., good financial skills, good communicator, able to resolve ambiguity), he or she is likely to quickly move into a more senior position to execute more management responsibilities and spend less time building financial models.

Most financial modellers come from a finance background and have gradually been exposed to industry knowledge. They often become specialists in a field, picking up business acumen, communication skills, and logic along the way. Quite often engineers, project managers, construction specialists, or even scientists who are required to build their own financial models end up pursuing a career in financial modelling. They have the industry and product knowledge and are able to learn the Excel skills, but may struggle with the finance side of things. Some would argue that it is easier to teach an engineer or scientist financial skills than it is to teach a financial accountant about the industry, but I think both have a tough job. Every modeller will have strengths and weaknesses, but a good financial modeller will span different skill sets and will have a little bit of everything.

Training Courses

As a specialist financial modelling consultant and trainer, I spend a lot of my time running training courses and, consequently, many people expect me to be a firm advocate of the face-to-face training workshop, right? Not necessarily. I’ve come under fire from my training partners in the past for publicising this opinion, but I’m not entirely convinced that going on a training course is always the best option for someone keen to improve their financial modelling skills.
Excel is the backbone to any custom-built financial model, and as discussed in the previous section, one of the core attributes of a financial modeller is to have good technical Excel skills. When struggling with financial models, some managers’ first reaction is to send their staff on an advanced Excel course to improve their modelling skills. However, with training budgets under constant scrutiny, you really need to make sure that you get the best value out of your training options. Is a training course really what you need?

When considering an advanced Excel course, there are a few points you should consider.

- As financial modellers, our use of Excel is quite narrow. I know it’s hard for us to conceive, but there is a whole world of Excel outside the finance industry! Statisticians, database programmers, and engineers, to name a few, are able to use Excel’s advanced functions to create non-financial spreadsheets. Most advanced Excel courses are very broad, and will cover functions and capabilities that do not apply to your needs as a financial modeller. You may learn a few tricks, but the time and money spent could be invested elsewhere.
- Research shows that a large percentage of the skills learned in training courses are not retained. Will you really remember everything that you learn? A programme of continuous, applied learning is often more effective than an intensive training course.
- Are your Excel skills really the problem? Following best practices and mastering the logic behind a financial model are more important than building in complex formulas and, for the most part, you will want to keep formulas as simple as possible.

Alternatives to Attending a Training Course: Other options to improve your financial modelling skills without going on an advanced Excel course include:

- Read a book! Buying this course is a great start. You’ll still have it to refer to when the excitement and enthusiasm you felt after completing a training course are long gone, and you’re back to struggling with building your financial models.
- Take an interest in what work your colleagues have done and how they did it – you can always learn from the techniques of others.
- Read, use, and dissect other people’s models. Sometimes the best way to learn is to see what someone else has done. Try taking someone else’s model apart and see how he or she built it. It’s probably best to use your company’s models, but if you don’t have access to those, take a look at some of the sample models provided on this course’s companion website, which can be found at www.wiley.com/go/steinfairhurst.
- Read specialist financial modelling publications or subscribe to e-mail newsletters about using Excel. They often contain useful articles about specific techniques and tips that can enhance your skills. Getting a short e-mail tip every day is much more effective than reading many all at once. You’ll retain the information better in bite-size pieces.
- Search online. If you’re struggling with a formula or layout problem and are convinced that there must be an easier way to do something, there usually is! Chances are that others have had the same problem in the past and, if you’re lucky, they’ve documented it as a blog post. There are some fantastic, publicly
available online resources including tutorials, articles, blogs, forums, and videos specialising in Excel and financial modelling that can be used at your convenience rather than taking an entire day or two to attend a course. You will find links to some of my favorite websites and online resources listed on the companion website at www.wiley.com/go/steinfairhurst.

Select the Right Training Option for You: The strategies outlined here are great for continually improving your Excel and financial modelling skill set, and they certainly won’t break the budget, but what if you really need to give your skills a quick boost to get you ready for an upcoming project? There are a number of options available:

- Try to find a course specifically aimed at Excel for financial modellers, and – even better – find one dedicated to your industry. Although good financial modelling skills are relevant across many different industries, there is nothing like specialised training dedicated to the modelling issues inherent in your own industry. In recent years, many more specialist financial modelling courses have become available, especially in major cities.
- If your company is able to arrange a group in-house training course, this will be even better, as you may be able to learn with the templates and models actually used within your organisation. You also have the added advantage of choosing a time and location that suit you.
- If you can afford a private session, this is the most convenient and time-efficient method, as you can ask questions and cover only topics that are useful to you. Many specialist training companies provide Excel one-on-one mentoring sessions.

Do You Really Need an Advanced Excel Course?

It’s true that “you don’t know what you don’t know,” and so some people go on training courses because they want to make sure there isn’t something about the subject that they are missing. Having heard or seen something in a training course gives you exposure to something that you might never have heard about, but if it’s simply inspiration you’re after, a good newsletter might well suffice (and be a lot cheaper)!

You might learn a few tricks on a course, but most people have got to think really hard before spending the money and taking a day or two out of their schedules to commit to training workshops. There is no question that face-to-face workshops are very effective; for many people, they are the best way to learn. However, I would recommend that potential attendees exhaust the available blogs, forums, and newsletters first.

In summary, an advanced Excel course would certainly benefit those who plan on extensively using Excel in their role for multiple purposes. However, if your main objective is to become an expert financial modeller, focus instead on mastering the few tools you need – such as logic and methodology – either in a course or via another medium, rather than expending time and money to learn things you may not use.
SUMMARY

In this chapter, we have discussed the definition of a financial model, and determined that, at a basic level, a financial model is really just a complex spreadsheet that contains inputs and outputs in a dynamic way. However, not every spreadsheet could be called a financial model. Models in Excel can be built for virtually any purpose, both financial and non-financial, business or non-business, although the majority of models will be financial- and business-related – and these are the kinds of examples we will mainly focus on.

Although this course is about how to use Excel in the context of business analysis and financial modelling, consider that there are many other available modelling tools besides Excel, including Microsoft products, add-ins, and third-party software. Excel is the most commonly used software for this type of analysis, and in terms of building your skill set, improving your Excel skills will always stand you in good stead for a career in finance.

Having good technical Excel skills is not the only attribute of a good financial modeller; industry knowledge, accounting, business acumen, design skills, communication, logic, and numeracy are also important. Modellers will have all of these skills in varying degrees, so think about which skills you need to work on the most. Going to a training course; using and taking apart others’ models; reading specialist publications and blogs; and using other online resources are all great ways to improve your financial modelling skills.
Chapter 1 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Which of the following is an advantage of using Excel for creating financial models over any other third-party software:
   a) Excel can report, model, and contrast virtually any data
   b) Excel can be installed on almost any computer
   c) Excel is a very flexible tool
   d) all of the above

2. Which of the following is a standard Excel add-in:
   a) Analysis Toolpak
   b) Component Object Model (COM) add-ins
   c) Visual Basic for Applications (VBA) add-ins
   d) DDL add-ins

3. Which types of add-ins would you typically need if you want to transfer information from a financial reporting system into Excel:
   a) Visual Basic for Applications (VBA) add-ins
   b) audit add-ins
   c) integration add-ins
   d) automation add-ins

4. 80 percent of Excel users will use only ______ percent of the features Excel offers.
   a) 20 percent
   b) 50 percent
   c) 70 percent
   d) 100 percent
Chapter 1 – Solutions and Suggested Responses

1. A: Incorrect. One advantage of Excel is that it is quite versatile. It allows you to report, model, and contrast just about any data, but the other answer choices are also correct.

B: Incorrect. There are several advantages of using Excel for financial modeling over other third-party software. The fact that Excel can be installed on almost any computer is just one advantage, so all of the above is the correct answer.

C: Incorrect. One advantage of Excel is that it is very flexible and you can probably accomplish most tasks using Excel, but the other choices are also correct.

D: Correct. There are many reasons to use Excel for financial modeling over other third-party software. Excel can report, model, and contrast virtually any data, Excel can be installed on almost any computer, and Excel is very flexible.

(See page 5 of the course material.)

2. A: Correct. Analysis ToolPak comes standard with Excel and just needs to be activated before it can be used.

B: Incorrect. COM add-ins are created by third parties and must be installed before they can be used.

C: Incorrect. VBA add-ins are not standard and must be installed on your computer before they can be used.

D: Incorrect. DDL add-ins do not come standard in Excel as they are created by third parties and must be installed before they can be used.

(See page 8 of the course material.)

3. A: Incorrect. VBA add-ins are a category of Excel add-ins. Excel add-ins add optional commands and features to Excel, but they are not used to integrate information from a financial reporting system into Excel.

B: Incorrect. Audit add-ins are used to confirm the accuracy of data and calculations present in your spreadsheet or workbook, but they are not used for integration purposes.

C: Correct. Integration add-ins allow information from the financial reporting to be transferred into Excel for further analysis.

D: Incorrect. Automation add-ins are custom Excel add-ins created by third-parties. Excel add-ins are used for many reasons, but they are not used to transfer information from the financial reporting system into Excel for further analysis.

(See page 9 of the course material.)
4. A: Correct. Most of the features that Excel offers are not even used by users, with about 80 percent of users only using 20 percent of the features.

B: Incorrect. 50 percent is too high of a percentage.

C: Incorrect. 80 percent of users use 20 percent, not 70 percent, of the features Excel offers.

D: Incorrect. 100 percent is too high of a percentage.

(See page 10 of the course material.)
Chapter 2: Building a Model

Before launching in to build a model, it’s important to think about model design, structure, layout, and planning. A thought-out design and clear project plan can make a huge difference to the quality and success of the modelling project.

MODEL DESIGN

Design can sometimes be the most difficult part of building a financial model and, in my experience, one of the most difficult to teach and learn. The best way to develop design skills is to critically assess other people’s models, taking note of what works and doesn’t, and then applying it to your own models.

Even the simplest models can become complex if poorly designed, and a well-designed model will be so straightforwardly logical that it will simply speak for itself. It’s pretty easy to just dive in and start building a model without thinking about the implications of the design. It’s not a bad idea to spend some time thinking about the layout before you get started. The layout and structure of the model relate to the look and feel of the model, and how users navigate through the model.

The following examples outline a couple of different challenges you might come across when designing the layout of a model.

Practical Example 1 – Assumptions Layout

Let’s say you are creating a high-level five-year forecast. We’ve got 15,065 customers in 2013, and we are expecting that number to increase by 5 percent every year. If you set up your model as shown in Layout Option 1 in Figure 2.1, with only one growth assumption, you’re very much restricted to a single input for the growth number.

FIGURE 2.1 Model Layout Option 1
If we change the design of the calculations by adding multiple input assumption cells, and change the formula just a little, we are making our model a lot more flexible and useful in the long term. This way if we decide to change the growth number for each year, as shown in Figure 2.2 below, we won’t need to change any of our formulas in the future, and our model is much more robust and less prone to error.

**FIGURE 2.2 Model Layout Option 2**

![Figure 2.2 Model Layout Option 2](image)

Of course Layout Option 2 is slightly more complex, but is more functional for the user. This example demonstrates the constant balance that a modeller needs to maintain between functionality and simplicity when building a financial model.

**Practical Example 2 – Summary Categorisation**

Arranging products to display into categories in a model is another potentially difficult model layout problem. Let's say you're creating a pricing model for some advertising products. You've got print ads and digital ads, and these are both split into Display and Text Only. The question is, should you display the output of the model as shown in Figure 2.3 or Figure 2.4?

**FIGURE 2.3 Model Categorisation Option 1**

![Figure 2.3 Model Categorisation Option 1](image)
The example in Figure 2.4 is more concise, but shows less detail, so it really depends on how much detail you want to show your user. This comparison demonstrates the constant balance that a modeller needs to maintain between detail and conciseness when building a financial model.

**THE GOLDEN RULES FOR MODEL DESIGN**

There are a few rules for model design that should be followed when designing the layout of a model. Most experienced modellers will follow these instinctively, as they are generally common sense.

**Separate Inputs, Calculations, and Results, Where Possible**

Clearly label which sections of the model contain inputs, calculations, and results. They can be on separate worksheets or separate places on a given worksheet, but make sure that the user knows exactly what each section is for. Colour coding can help with ensuring that each section is clearly defined.

See the forthcoming section titled “The Workbook Anatomy of a Model” for more discussion on whether it is always practical to separate these sections.

**Use Each Column for the Same Purpose**

This is particularly important when doing models involving time series. For example, in a time-series model, knowing that labels are in Column B, unit data in Column C, constant values in Column D, and calculations in Column E, makes it much easier when editing a formula manually.

**Use One Formula per Row or Column**

This forms the basis of the best-practice principle whereby formulas are kept consistent using absolute, relative, and mixed referencing, as described in more detail in Chapter 3, “Best Practice Principles of Modelling.” Keep formulas consistent when in a block of data, and never change a formula halfway through.
Refer to the Left and Above

The model should read logically, like a book, meaning that it should be read from left to right and top to bottom. Calculations, inputs, and outputs should flow logically to avoid circular referencing. Be aware that there are times when left-to-right or top-to-bottom data flow can conflict somewhat with ease of use and presentation, so use common sense when designing the layout. By following this practice, we can avoid having calculations link all over the sheet, which makes it harder to check and update.

Use Multiple Worksheets

Avoid the temptation to put everything onto one sheet. Especially where blocks of calculations are the same, use separate sheets for those that must be repeated to avoid the need to scroll across the screen.

Include Documentation Sheets

A documentation sheet where assumptions and source data are clearly laid out is a critical part of any financial model. A cover sheet should not be confused with an assumptions sheet. Document, document, document!

DESIGN ISSUES

Here are four key issues you need to think about before you start a model.

1. **Time Series**: Most financial models include a time-series element, and the majority of these will be either monthly, quarterly, or annual. It’s important to get this right from the start, as it’s much easier to summarise a monthly model up to an annual basis than it is to split an annual model down to a monthly basis!

2. **Data Collection**: Often the majority of time is not spent building a model, but rather collecting, interpreting, analysing, and manipulating data to put into the model. For example, you could be building an annual model for your company’s fiscal year, which goes from July 1 to June 30, but the survey data you’ve collected and want to include is for the period January 1 to December 31. If you’ve got access to the raw data on a monthly basis, you’ll be able to manipulate the data so that it’s accurate – or else you’ll need to extrapolate.

3. **Model Purpose**: Think about what it is that you want the model to do. What outputs do you expect the model to show? See “Types and Purposes of Financial Models” in Chapter 1 for more detail on different types of financial models. The outcome that you want the model to show will greatly influence the design of the model. For example, in a business case or project evaluation model, the outcome that we are working toward is the net present value (NPV), and in order to get that, we need cash flow, for which we need a profit-and-loss statement, and this then determines how we build the model.

4. **Model Audience**: Who will be using your model in the future? If it’s for only your use, no need to make it very fancy, but most models are built for others to use. If so, you will need to make your model as user-friendly as possible, and clearly define which cells are input variables and which cannot be changed. If you expect users to have limited knowledge of Excel, the model needs to be as simple to use as possible.
THE WORKBOOK ANATOMY OF A MODEL

Typically, modellers will work from back to front when building their model. The output, or the part they want the viewer or user to see, will be at the front, calculations will go in the middle, and source data and assumptions should go at the back. Figure 2.5 shows an example of what your model structure might look like.

**FIGURE 2.5 Model Structure**

![Model Structure Diagram]

Like the executive summary, a board paper, or other report, the first few pages should contain what casual viewers need to see at a glance. If they need further information, they can dig deeper into the model.

Unless a model is very small, there should be a dedicated tab worksheet for each major component of the model. Whilst by no means a prescriptive list, below is an example of what might be included on each tab:

- **Cover Sheet:** The cover sheet contains many details about the model. Whether or not a cover sheet is necessary is an issue for debate, but one can include (but is not limited to) details such as:
  - A log of changes and updates to the model with date, author, change details, and their impact to the output of the model. This is important for version control.
  - Flow chart of the model structure.
  - Table of contents.
  - Instructions on how to use the model.
  - The purpose of the model for which it should be used.
  - Disclaimers as to the limitations of the model, legal liability, and caveats.
  - Global or key assumptions integral to the use of the model.

- **Input Sheet:** This is the only place where hard-coded data is permissible. There may be one or more input sheets if there are copious amount of data, but the input data should be laid out in logical blocks, for example: consumption data, WACC data, assets and depreciation data, inflation and indices, pricing and tariffs, assumptions and constants (such as tax rate, discount rates, concession rates).

- **Output, Summary, and Scenario Sheets:** These present the final outcomes. They may also contain scenario drop-down boxes, spin buttons, or tick boxes that allow the users of the model to generate their own outputs. Tables and charts summarising the outputs should be set up in such a way that they can be easily printed or used to generate reports. Ensure that these can be easily printed directly from the model, or copied or linked to other programs such as Word or PowerPoint.

- **Calculation or Workings Sheets:** Split the calculation sheets logically and then, within each sheet, set them up consistently. If calculation sheets are split, ensure that the layout and formatting are as consistent as possible across all sheets.
• **Error Check Sheet:** This sheet contains links to all error checks in the model. Error checks should be performed in the calculation section, but a summary of all error checks in one location means that once the model is in use, the modellers can quickly check to see if any of the error checks have been triggered.

**Workbook Anatomy Issues**

Matters to consider when designing the layout and structure of the model include:

• **A Cover Sheet:** Is a cover sheet necessary? It’s not absolutely critical, but it is good practice to put one in. In my experience, cover sheets and instruction pages are rarely used. If you decide not to include a cover sheet, make sure that the model contains explicit instructions regarding operation, purpose, assumptions, source data, and disclaimers.

• **Input and Output Locations:** Should there be a dedicated input sheet, or should the inputs and outputs be contained in one sheet? Many modelling specialists maintain that inputs, outputs, and calculations must be clearly separated, but this is not always practical. Generally, larger models should have a dedicated input sheet, whilst smaller models may show inputs and outputs on the same sheet. However, if you’ve created a large model with inputs and outputs on different sheets, and then want to perform a scenario analysis using a data table, you’ll need to move the inputs and outputs to the same sheet. For example, in a small model that takes inputs and generates simple tables of output data and charts in reports, the modeller may set up the sheet to have a block of input at the top of the worksheet with the calculations and charts directly underneath. You may consider splitting the charts and ratio calculations into separate worksheets to avoid the worksheet becoming too long and unwieldy.

• **Calculation Organisation:** Should calculations be on one or multiple sheets? Depending on the size of the model, all calculations could be contained within one worksheet, spread over several worksheets, or even spread over several workbook files. If the calculations become long and confusing, it makes sense to split them into logical sections. For example, they can be split by type of service, customers, financial tables, geographical location, or business segments.

• **Colour Coding:** If you decide to use colour (and I’d recommend that you do, or else your model will look pretty boring), make sure that the colours you use are consistent. For example, if African regions are yellow, Europe is blue, and Asia is pink, make sure that you use those same colours every time numbers for Africa, Europe, and Asia are displayed. These colours should be consistent in calculations in your model, display tables, and charts. Some companies have standard colour coding, but if your company does not, you might consider developing a standard. You could consider including a colour code key in the cover page. The use of predefined styles (found on the home tab) can make colour coding very quick and easy. Below are some commonly used colour codes that you may consider adopting in your company:

  - Blue font and beige background for input cells.
  - Pink or grey for error checks.
  - Green or orange for external links.
Use a double border to indicate that the calculations change. In Figure 2.6, the double line shows that the formula is not consistent across the row.

Many companies have their pre-defined colour coding loaded as style templates, which ensures consistency in colour coding in financial models.

**FIGURE 2.6 Commonly Used Formatting for Inconsistent Formulas**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>2013</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Existing HoneyCorp Customers</td>
<td>2,200,000</td>
<td>2,219,864</td>
<td>2,239,429</td>
<td>2,258</td>
<td></td>
</tr>
<tr>
<td>HoneyCorp Pet Owners</td>
<td>1,189,000</td>
<td>1,198,726</td>
<td>1,209,319</td>
<td>1,219</td>
<td></td>
</tr>
<tr>
<td>Expected Customer Acquisition</td>
<td>29,700</td>
<td>29,968</td>
<td>30,233</td>
<td>30</td>
<td></td>
</tr>
<tr>
<td>Gross Cumulative Customers at YE</td>
<td>29,700</td>
<td>59,668</td>
<td>89,901</td>
<td>120</td>
<td></td>
</tr>
<tr>
<td>Average no cumulative customers</td>
<td>14,850</td>
<td>44,684</td>
<td>74,785</td>
<td>105</td>
<td></td>
</tr>
<tr>
<td>Churn</td>
<td>2,234</td>
<td>3,739</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>2015</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Average Cumulative Customers</strong></td>
<td>14,850</td>
<td>42,450</td>
<td>71,045</td>
<td>95</td>
<td></td>
</tr>
<tr>
<td>Gross Premiums</td>
<td>$5,940,000</td>
<td>$17,489,340</td>
<td>$30,148,830</td>
<td>$43,66</td>
<td></td>
</tr>
<tr>
<td>Premium Revenue</td>
<td>$594,000</td>
<td>$1,748,935</td>
<td>$3,014,883</td>
<td>$4,36</td>
<td></td>
</tr>
</tbody>
</table>

**PROJECT PLANNING YOUR MODEL**

Whilst planning ahead is very important for successful modelling, it is unrealistic to expect that a detailed project plan can be created prior to starting to build it. Quite often the modellers do not have much idea of the size and scope of a model until they get in and start working on it.

**How Long Does It Take to Build a Financial Model?**

Whether you are a consultant building a model for a client, or an internal modeller, you or the person who has commissioned the model build will, understandably, want to know how long it will take. The answer is never straightforward. As with many other tasks, it really depends on how much time you have (and there’s never enough time) and how much detail the users need. The more time you have, the better the model will be! Some models could take months and months of dedicated work, but it is also possible to throw together a very high-level model in a day or two.

In a high-level model, the assumptions would probably be only estimates, as you won’t have had time to validate them with stakeholders, and the calculations will be pretty rough. You also might not have much in the way of fancy colours, formatting, drop-down boxes, or tick boxes, but the numbers should still be reasonably accurate.

**Building a Model under Pressure**

It’s a critical point to remember that even when under immense time pressure, the modeller should never compromise on good work practices. Even in a high-level model, best practices should be adhered to, and correct labeling and documentation of assumptions should be maintained. For this reason, there should be surprisingly little difference in the base numerical outcome between a high-level model that takes a few days, and a detailed model that could take months. If pressed for time, cosmetic features such as those shown below should be omitted.
Time permitting, the detailed model may show:

- Detailed assumptions documentation, validated by key project stakeholders.
- Scenarios and sensitivity analysis, using drop-down boxes, tick boxes, or data tables.
- Table of contents or navigation tools.
- Colours and formatting, conditional formatting, and insertion of company logos.
- Output summary and detailed analysis of output.

Time should be spent on quick wins. Use your judgement to spend your time on calculations that are material to the model. Don’t waste time on validating minor assumptions that are not material to the outcome of the model.

**MODEL LAYOUT FLOW CHARTING**

Based on an initial concept discussion of the problem, modellers can map out the structure of the model and how it will arrive at the required outputs. For models that will be viewed by external parties, and large or more complex models, a flow chart diagram that maps the model’s structure and how it solves the problem is essential. Not only does this help in building the model, it also helps users of the model to better understand the model’s logic, design, and purpose, and can be used as a presentation tool when explaining the model. Taking time to design the layout and structure of the model is particularly helpful if there is uncertainty about what the model needs to cover, both in terms of breadth and depth.

Such flow charts, if created, should become part of the model’s final documentation. There are some pieces of software that will automatically create model flow charts, but most modellers will create them manually using PowerPoint, Visio, or Excel. Of course, it is highly likely that your model will be amended during the build or as the result of a review. Therefore, if you create the flow chart manually, remember to update it as the design of your model changes!

In Figure 2.7, the output that is required is to determine what price needs to be charged per customer. This is a high-level flow chart of what the model might look like.
FIGURE 2.7 Sample Flow Chart of Model Calculations

![Flow Chart of Model Calculations]

**FIGURE 2.7 Sample Flow Chart of Model Calculations**

**STEPS TO BUILDING A MODEL**

Once the aforementioned factors have been determined, you can begin to create your model. Most modellers will just dive in and start building, and whilst it’s good to encourage innovation and creativity in creating financial models, it’s still important to follow some ordered steps to achieve the best outcome.

If you’re working as the sole financial modeller in a company or as a consultant, you might be able to follow a less formal process, and so I’ve provided a more streamlined version of the steps to follow (“The Streamlined Version,” below). If you are working as part of a team of financial modellers, the steps are more detailed, as it’s more important to follow a documented and structured process, particularly if there are many modellers and stakeholders providing input. (See “The Team Version” that follows.)

**The Streamlined Version**

This version of the model-building process is for less formal projects, especially those models designed to be used exclusively by their creator. The seven steps to the streamlined version are as follows:

1. **Design the high-level structure.** Okay, you’re not going to know exactly what the layout of the model will be until you dig into it, but you should have some idea of the tabs. Start by assembling the data you have so far into the tabs as shown in Figure 2.5.
2. **Design outputs**: summaries, charts, and reports. Begin with the end in mind. By thinking about the output of your model early on in the process, you’ll be more focused and will ensure that all of your calculations work toward the desired end result.

3. **Design inputs.** Thinking about the input design issues, get your input data into the right format or layout so that you can link your calculations to it.

4. **Plan calculations by breaking larger problem into smaller ones.** Now begin your calculations. You might begin by thinking that all expenses can go on one tab, but if staff costs, for example, begin getting rather complicated, you might decide that staff costs needs a tab of its own.

5. **Finalise outputs.** Link through your calculations to the outputs page. Test at every stage to make sure that the model makes sense and adjust as necessary.

6. **Design sensitivities and scenario analysis.** Once the model is working correctly, you can add sensitivities and scenario analysis. See “Overview of Scenarios Analysis Tools and Methods” in Chapter 11 for more detail to help you choose which methods of scenario analysis to use.

7. **Document as you go.** Assumptions documentation should not be left to the end. Do it as you go!

**The Team Version**

If you are working in a large organisation and the modelling project is large, involving several financial modellers and stakeholders, you’ll need to follow a more formal process. The larger the size of the model and the scale of the project, the more up-front project planning will be required. This detailed process is simply to provide a framework in the absence of one; it should by no means make the process more complex or constrict it, and how closely you stick to the process will depend on the size and scale of the project.

The 12 steps have been split into two stages: 1) planning, and 2) build.

**Planning Stage**

1. **Scope out the project.** Assess what needs to be done in order to complete the model.
   - What is the purpose of the model? Clarify the scope and parameters of the model. Be clear about what the model will be designed to do and its limitations.
   - What is the problem we are trying to solve? Is a model really required and is Excel necessarily the best solution? See “Tool Selection” in Chapter 1 for more detail on alternative tools. (The rest of this course assumes that the model will continue to be built in Excel.)
   - What’s the time frame? Create a project plan by separating the work that needs to be done into sections and assign the tasks and milestones.

2. **Assign project tasks.** Once the project has been defined and scoped, you’ll be able to determine the skills and resources required to complete the project.
   - What kind of skills will be needed for this project? Make sure you have a balance of industry, finance, and business skills in the team. (See “What Skills Do You Need to Be a Good Financial Modeller?” in Chapter 1 for more detail.) Consider hiring external consultants if the skills are not available in-house.
• Who will be involved? Identify the stakeholders who need to provide input and validations on the model. Communicate with them about their project requirements and time-frame expectations.

3. **Determine the users of the model.** The modeller must know who will be using the model, as this will affect the technical development. Creating a model for others to use will require designing an interface that is suitable for their needs and, in particular, their level of familiarity with Excel. This requires consideration of several issues that impact the model build:

• Excel Version. The modeller needs to consider whether the user may be opening the model in Excel 2003 or an earlier version. This is becoming less of an issue, but there are still many considerations the modellers need to make if the model must be compatible with the older versions of Excel. For example, the file must be saved as an .xls version, not .xlsx, and they must avoid some of the newer functions. See “Excel Versions” in Chapter 5 for more information on this issue.

• User-Friendliness. The weaker users’ skills with respect to spreadsheets and modelling, the more user-friendly the model will need to be, for example, by incorporating more instructions, control tools (such as drop-down boxes, option boxes), and simple macros. In some cases, a model may be supplied to a third party or made publicly available, through a website, for example. In such cases, the modeller should assume the user has an extremely low level of Excel skill, and the model should be highly protected to make sure that users do not damage the model. See “Bulletproofing Your Model” in Chapter 7 for more information on how to protect models.

• Data Validation. The model can be constructed so as to minimise the risk of users entering incorrect data. For example, when entering staff names, they may enter “William Jones” as “Will Jones,” “W. Jones,” “Jones, W,” or any other number of variations, which can cause errors in a model. The modeller must consider how much validation of inputs should be included, and if error messages should be provided, as this functionality can be quite time-consuming to build and test.

• Frequency of Use. The modeller needs to consider how outputs can be located and generated and how often the model will be used. If the model is to be used often, the design of the outputs and the time it takes to run should take this into account. Most models will calculate automatically, but more complex models may include a procedure that needs to be manually updated, or macros that may take time. If the model is only to be used occasionally, it may be of less importance if it takes longer to create the outputs each time the model is used.

• Testing and Adapting. Creating a model for your own use may not require as much work as creating a model for others. However, it is important to keep in mind that someone else will need to test and validate the model, and others may need to use or adapt the model in future. Modellers should always ensure that the model is generally logical and user-friendly.
4. **Design the high-level structure.** Create a flow chart as discussed in “Model Layout Flow Charting,” earlier in this chapter.

- The flow chart will include a place for the input, outputs, summaries, and charts. Create a list of all the outputs needed and how they may be presented (e.g., in a table, chart, diagram, or other method). The outputs and their presentation format should be taken into account when designing the layout of the model.
- Translate the flow chart into the model. You should have an idea of the number of tabs and how they will be arranged within the model. Try to ensure that the data will flow logically in one direction (right to left) throughout the model, so that links do not jump around, making it confusing to the user.
- Remember to update the flow chart if the design of the model changes during the building process.

5. **Create a data collection plan.** Data collection can be the most time-consuming part of a financial modelling project, so this needs to be carefully incorporated into the project plan to ensure that the data used in the model are as accurate as possible and received on time.

- Create a list of inputs that will be required and where they will be sourced. These will feed into the project plan as tasks.
- At this stage you may be able to identify data-related issues that need attention and consider solutions to anticipated problems. If you are creating a risk register as part of the project planning process, this is a key risk. For example, some inputs may be critical to the model but rely on the data being available. You will need to consider risk-mitigation strategies to ensure the availability and reliability of data to be provided by your sources.
- The model should be designed to accommodate the format in which the necessary data are available, and the output is required. For example, if the data are provided in a weekly format, but the output is required as monthly, you need to consider whether you want to preserve the original data as weekly, and consolidate it as part of the model, or consolidate it prior to entering the data into the model.
- You may even consider designing an information request form for sources to fill in so that the data can be easily extracted and entered into the model.
- With the plan in place and layout, structure, and logic determined, you can now begin to build the model.

**Build Stage**

6. **Build inputs.** Enter the data into the input pages. Make sure that you follow best practices by documenting all assumptions and source referencing. It is critical that this is done as you enter the data, or where you got the data from. If there is any possible misinterpretation or lack of clarity about how a calculation works, make sure that it is explicitly documented, either in the calculations page or as part of the assumptions. See “Methods and Tools of Assumptions Documentation” in Chapter 3 for more detail on tools and techniques that can be used for documenting assumptions.
As inputs become available and the model is populated with actual data, it is critical that the source of that data is kept up-to-date. Source referencing of inputs should be sufficiently detailed to allow a third party to track it back to the source easily. Information should include title, date, author, page number, web page, and so on to allow for easy tracing and validation of the model’s input data.

Documentation should include:

- A description of the model’s functionality so users will be able to see the general purpose of the model and its limitations, often graphically displayed by a flow diagram of the model’s structure.
- Instructions on how to use the model, including a colour-code key explaining the colours and styles used in the model.
- If a calculation or data point in one section is treated differently from the rest of the model, an explanation of the reason for the difference.
- Changes to the structure of a model in the version log on the cover page, detailing what structural or major changes were done, when, and by whom.

7. **Build calculations and workings.** Building accurate and clearly auditable calculations is a critical step in building a financial model. A logical calculation should allow users to follow and trace the calculation easily – from the inputs to the outputs, and back again.

- Follow best practices by linking to input cells, only enter data once, and always refer to the original source’s cell where possible, rather than linking to another link.
- Don’t mix hard-coded data with formulas. If you need to hard-code a number into a cell, it should be included in the assumptions or source data sheet, and linked from there.
- Try to work from left to right and top to bottom where possible.
- Use name ranges in Excel to name single-cell constants, or tables of inputs. This can make it easier to build and validate formulas in a financial model. (See “Named Ranges” in Chapter 5 for detail on that topic.)
- Use the superior method and the most efficient functions. This method will be the simplest, most efficient, and easiest to follow.
- Link logically throughout the model. Try to make sure links go in one direction (from left to right) instead of jumping backward and forward between different tabs.
- Build error checks wherever possible, and sense-check and test for errors as you go.
- Double-check calculations using alternative calculation methods or by manually calculating from first principles.
- Document the calculations and their logic as you go; don’t leave it all to the end. Your process may seem obvious to you at the time, but it is probably not clear to someone else reviewing your model. There is a fairly high likelihood that later on you won’t remember why you’ve calculated something a certain way.
- Long calculations should be broken up into logical components of simpler calculations. This will avoid one long formula in Excel, making it easier to understand, test, and update, and greatly reduce the possibility of error.
(See “How Long Should a Formula Be?” in Chapter 4 for an example of how trying to do too much in one cell can make a calculation extremely difficult to follow.)

- A more detailed flow chart expanding out the calculations into sub-components may be the clearest way to present the model's logic if a calculation is particularly complex. This can be done in Excel by taking an example piece of input data and documenting its flow throughout the calculations.

8. **Build outputs**: summaries, charts, and reports. Begin to summarise the calculation on the output page.

- Continue to test and check for formula and logic errors at every stage of building.
- Follow best practices as outlined above for outputs as well as calculations.

9. **Peer and client review of draft model**. Now that the model's design, logic, and calculations have been determined, it is important to go through it with the rest of the team to ensure that the model meets its purpose. Get the team together, take a key input, and follow it through from beginning to end. The timing of this review is important, as it needs to occur after some of the model has been built, to allow the reviewers to check the expected outputs and how the model operates in practice; however, the model should not be finalised yet in case there are significant structural changes required as a result of the review.

Not only must a model solve the problem for which it is designed, user acceptance of the model is also important. Clients (end users) must accept and understand the model. A walkthrough at this stage may assist to identify areas where corrections or modifications are needed, and will also allow the user to become familiar with how the model is intended to work.

Factors to be considered in the peer draft review are:

- Walk through the calculations; are they accurate at a high level?
- Are the assumptions and source data clearly driving the output?
- Does the model solve the problem it is being designed to solve?
- Are the flow and structure easy to follow?

Note that this peer review is your last chance to ensure that there are no formula or logic errors in the model prior to the formal quality assurance (QA) of the model. Modellers should be confident that their models submitted for formal QA are free from mistakes.

10. **Design sensitivities and scenario analysis**. Once the base model is completed and working correctly, you can add sensitivities and scenario analysis. The inputs for scenario analysis may not have been determined as part of the planning process, and now that the base model is complete, you will be able to test the inputs to see their impact. This may influence your decision as to what to show in the scenario analysis.
11. **Formal model QA (quality assurance) check.** This final QA check of the model is a formal process and should not be confused with continual testing and debugging that should have taken place during the model build. (See “Error Avoidance Strategies” in Chapter 4 for more detail on the tests and checks that should be done by the modeller during the build process.) It is the modeller’s responsibility to ensure that the model is accurate, robust, and operational. The QA process should not uncover formula or logic errors at this late stage, and discovery of such will raise questions about the competency of the modeller. The model’s final QA testing process includes:

- Stress-testing the inputs with a wide range of values to check the inner workings of the model. This includes testing values at the extremes to ensure that the model processes the input as expected, especially where validation and protection are used. Also test a wide range and combination of input variables, as some hidden bugs may exist in the calculations. Using 0 or 1 can help to highlight obvious errors, as the outputs should be simple. For example, a unit price of zero should generate a revenue of zero and if it does not, you’ll need to investigate why not!
- Check that Excel errors such as “#DIV/0!” have not been triggered by entering zeros or other invalid data as inputs.
- Make sure that all inputs can still be entered properly. By applying protection to a model, a modeller can inadvertently cause switches and drop-downs to stop working. If protection is applied, additional testing and checking will need to be carried out.
- Check the sensitivity of outputs (dependent variables) to changes in the inputs (independent variables). Part of the QA process should be to check that the direction and magnitude of the change are in accordance with how you logically expect the outputs to behave.
- Check all documentation for spelling, grammar, colour coding consistency, and presentation.
- As the model goes through several iterations, it’s common to find that redundant calculations are included even though they are no longer useful or applicable to the model. Tracing dependents is useful for identifying input data that is not being used.

12. **Maintain the model.** Once a model is completed and provided to the users, it is fairly likely that at some point – either weeks, months, or years after the model has been completed – maintenance or updating of the model will need to be undertaken. If it’s simply to change inputs, this can be done by the user, but if the change is major or structural, a model developer should be the one to make the changes.

Depending on the availability of resources, it is preferable that a member of the original model-building team undertake the update, but if best practices have been followed throughout the build process; if it has been well documented and built in a robust fashion; and if the modeller doing the update is well versed in financial modelling procedure, updating the model should not pose any problem.

When the model is updated or amended, especially if the change is structural, version control processes need to be followed to ensure that the correct version of the model is used. Below is some more information on how to document versions correctly.
INFORMATION REQUESTS

The collection of data is a critical part of financial modelling, as a model is only as good as its inputs and, in many cases, the inputs of the model rely solely on information from other parties, whether internal or external to the organisation. Therefore, the receipt of timely and accurate information from these parties is important. Sometimes as much time can be spent collecting data as actually building the model and if this is an issue, you may consider creating a formalised information-request procedure.

Larger organisations, particularly government agencies, often already have information templates in place for purposes such as compliance and monitoring, and will not encounter much resistance internally to their introduction. However, advice on how to go about implementing information requests is outlined in the following:

- Incorporate tables for key data and make provisions for executive sign-off.
- Liaise at an early stage with the other parties about the information requested and its purpose. Different departments and other companies have different information systems, and so the form in which data is available may differ. Work closely with the other parties to communicate the purpose of the information, and to devise templates that facilitate easy collection of input data.
- Design the information request so that the data is provided in the correct format by using import and export sheets. This is useful for large data sets and, if used frequently, macros speed up the insertion of data into the model.
- Design the data-collection sheets such that once completed, they can be fed directly into the model by copying and pasting or using links. No manual data entry should be required to save time and reduce the possibility of error.
- Make clear what is expected in terms of data quality. It is possible that the information provided by other parties is not entirely accurate, so you may consider subjecting that information to internal QA processes. Normally model input data is simply taken at face value, and the source documented in the assumptions, but a QA of the data will provide a greater degree of assurance that the data being input to the model is complete, accurate, and consistent. Make sure that the party providing the information is aware of this procedure in advance.
- Provide a timeline that is sufficient for the parties to respond to information requests. This will feed into the project plan as outlined above. The modellers will also need to allow time to check the quality and reliability of the information that has been submitted.
- Ensure consistency of information-request templates with previous templates that have been issued, and try to ensure consistency with previous requests that may have been distributed in the past.
- Pre-fill information request documents with existing information where available, as this will expedite the process.
- Even if the modeller sets up an information request in the correct format that is required to input directly into the model, there is always the risk that the person entering the data will insert or delete rows, columns, or formulas. It is advisable to protect the worksheets to prevent this happening, as an extra row when copying, pasting, or linking data can be disastrous!
VERSION-CONTROL DOCUMENTATION

A new version of the model means structural changes to the design or new calculations. It should not be confused with changes to input variables such as those in blue font on the source data page. Changes to input variables are simply changes to scenarios or sensitivity, not a new version.

A version-control log is usually located on the cover sheet of a model, although in particularly long or complex models it may warrant having its own worksheet tab.

It’s important to remember that any new versions of a model subsequent to its being completed still need to go through the QA process. There is no point in creating a model that has been through the sign-off process only to make changes that do not meet the same standards!

Below are a few generally accepted guidelines to follow when creating a new model version:

- File names should end with version number. For example:
  - HoneyCorp RePricing Model – 16 July 2012 – V1.xlsx
- If this is a sizable project and it’s going through multiple versions, which need to be tracked, each model should contain a log (usually located on the cover sheet) that lists the original version of the model and details the calculation changes made to that version since inception. Information that needs to be included on the version-control log is:
  - Version number and date.
  - Description of changes clearly detailing each change that was made for that version.
  - Where in the model the changes were made.
  - Who made the changes.
  - A mark to show that the changes have been through QA.
  - Any necessary comments explaining the changes (e.g., a change in cost structure or a new scenario needed to be built).

File Structure

Over the course of a complex modelling project with multiple versions, you need to put some thought into the file structure to ensure ease of finding the correct version. A modeller who picks up and works on the incorrect file can have disastrous results and also waste a lot of time!

Your file directory might look something like Figure 2.8.
Keep a separate folder for each project. In this case, the HoneyCorp Repricing project has its own folder. Underneath you find:

- **Models**: A list of the model with version-control nomenclature applied. If there are several models pertaining to the project, create sub-folders in this section. You might delete older versions of the model (if you are sure that they are completely redundant) once the project is complete to save on file space.
- **Project Planning**: Documents relating to the project plan, resource allocation, and timelines.
- **Source Data**: All the details about where the data for the model came from. The models should be linked to this folder for auditability. Be extremely careful with linking if there are several versions of the source data files. Use the “edit links” function to manage the links between the files.

This sample folder directory is only a guideline, and assumes a medium-sized financial modelling project in terms of size and complexity. Add as many folders as you need, but make sure they’re well organised and easy to navigate so you can find the required information.

**SUMMARY**

In conclusion, considering the layout and design of a financial model is an important part of the model build. It takes a unique mixture of logic, clarity of thought, and graphic layout skills by the financial modeller to build a well-designed model, and this often proves to be difficult to implement in practice. Model design can sometimes be the most difficult part of building a financial model and it is, in my experience, one of the most difficult aspects to teach and learn. When building your model, pay close attention to the design layout, and ensure that it is clear, coherent, and logically structured.
Chapter 2 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Every model (unless that model is very small) should have which of the following features:
   a) a cover sheet with a flow chart of the model structure
   b) a dedicated tab worksheet for every major component of the model
   c) hard-coded data
   d) pivot tables, array formulas, and nested formulas

2. Hard-coded data is only permissible on which of the following:
   a) the calculation sheets
   b) the error check sheet
   c) the output sheet
   d) the input sheet

3. Which of the following colors are commonly used to indicate error checks on a financial model in Excel:
   a) blue and beige
   b) pink or grey
   c) green or orange
   d) purple or yellow

4. Which of the following is the first step in the team version model building process:
   a) scope out the project
   b) assign project tasks
   c) determine the user of the model
   d) create a data collection plan
Chapter 2 – Solutions and Suggested Responses

1. A: Incorrect. A cover sheet does not have to be included in a financial model. If one chooses to, he or she may decide to include a flow chart of the model structure on the cover sheet, but this is also not a required feature.

   **B: Correct.** Unless a model is very small, there should be a dedicated tab worksheet for every major component within the model.

   C: Incorrect. The course recommends staying away from hard-coded data if external linking can be used instead, so hard-coded data is not a requirement.

   D: Incorrect. Pivot tables, array formulas, and nested formulas are all examples of features that may be added to a financial model, but they are by no means necessary.

   (See page 27 of the course material.)

2. A: Incorrect. Data should not be hard-coded on calculation sheets. The only place where hard-coded data is permissible is on the input sheet.

   B: Incorrect. The error check sheet should only contain links and no hard-coded data.

   C: Incorrect. The output sheet should only contain links and no hard-coded data. The only place where hard-coded data is permissible is on the input sheet.

   **D: Correct.** It is recommended that you link instead of hard-code where possible, and the input sheet is the only place where hard-coded data is permissible.

   (See page 27 of the course material.)

3. A: Incorrect. Blue font and beige background is typically used for input cells.

   **B: Correct.** Pink or grey are typically the colors used for error checks.

   C: Incorrect. Green or orange are typically used for external links.

   D: Incorrect. Pink and grey, not purple or yellow, are typically used to color code error checks.

   (See page 28 of the course material.)
4. **A: Correct.** The first step of the team version entails scoping out the project to determine what needs to be done in order to complete the model.

   B: Incorrect. Assign project tasks is the second step of the team version.

   C: Incorrect. The third step of the team version is to determine the users of the model.

   D: Incorrect. Create a data collection plan is the fifth step of the team version.

   (See pages 32 to 34 of the course material.)
Chapter 3: Best Practice Principles of Modelling

The principles of best practice outlined here are for the purpose of reducing errors and making a model easier to read, audit, update, and use for its intended purpose. This chapter is by no means exhaustive, but outlines the most important principles in using Excel for business analysis and financial modelling. By following these key principles, your model is easier to navigate and check, and much more likely to be robust, accurate, reliable, and error-free.

**DOCUMENT YOUR ASSUMPTIONS**

Good assumptions documentation is one of the most important principles of best practice. It is impossible to check, validate, or use a model if you are unable to verify the integrity of the data sources or methods of calculation in the model. Your model design, layout, and structure can be perfect, but its validity is really reliant on the assumptions that go into it (i.e., garbage in, garbage out). The most beautifully structured model in the world is pretty useless if the assumptions that go into it are garbage!

Documentation of assumptions helps with validation and avoids misinterpretation. If there is any possible misunderstanding about why, how, or what the assumptions are in the model, make sure it's recorded in black and white on the assumptions page.

List assumptions on a separate page, clearly labelled. For a smaller model, you might decide to mix source data and assumptions together, or they could be separated in a large model.

The more detail, the better! If your assumptions are extremely detailed, you could have a section for key assumptions, where you summarise the important assumptions but leave all the detail in case it is needed.

Document source data and unique calculations as you go. Don’t leave it all to the end and don’t rely on your memory. Months later you or another modeller will have no idea why you calculated something a certain way. Make sure it's well documented.

**LINKING, NOT HARD CODING**

Financial models are, by definition, dynamic and changing, depending on the input variables, and they need to include links in order to facilitate this. This becomes particularly important when performing scenario and sensitivity analysis. Always link as much as possible in your model so that when the inputs change, the outputs also change (which is pretty much the whole point of financial modelling). By linking, you can trace source data back through the links, which makes your model auditable, traceable, and easy to validate.

- When you link to external files, make sure that you use named ranges. (See “Linking to External Files” in Chapter 4 for more detail on this.)
- There should be no hard coding except for input variables, unless referenced or source data is listed or it is otherwise blindingly obvious where you got the number from.
• Never use a value within a formula. The only exceptions are those things that are considered standard or commonly accepted and will not change, such as:
  - 24 hours in a day.
  - 7 days in a week.
  - 60 minutes in an hour.

You may notice that many modellers put input variables in blue font. Whilst this is a bit old-fashioned, it’s still quite standard practice and it acts as a signal to your user or another modeller that this is a hard-coded input variable that can change (i.e., you are allowed to change this value). The problem with blue font, though, is that you can’t see it when there is no value in the cell, so many modellers use a beige or yellow background with blue font. See “The Workbook Anatomy of a Model” in Chapter 2 for more detail on colour coding.

**ONLY ENTER DATA ONCE**

Source data should always be entered only once. For example, list inflation assumptions on the source data or assumption documentation page and, every time you use inflation in the model, refer back to that cell or row of cells. This will make the model easier and faster to update, and less prone to error.

Never use a value within a formula. For example, =IF(G$6>=$E7,136800,0) should have a link, not 136800 typed in. This means that you don’t have to edit each cell when the value changes, and makes the model much easier to audit.

However, make sure that you do not link source data to a cell that itself has been linked to the original source. Always go directly to the source data. The result of this malpractice has been aptly termed “daisy-chaining” in financial modelling best practice circles. It is an inefficient and error prone (yet tempting!) practice, and should be avoided when building financial models. It causes the link flow throughout the model to be a lot longer and complex than it needs to be, and will cause errors if a section of the model is deleted.

**AVOID BAD HABITS**

Here are a few bad habits financial modellers can get into:

• **Hitting the Enter key or the green tick after editing a formula.** Don’t just click elsewhere. It’s a bad habit many people have, and one that can cause unintentional errors. See “Avoiding Simple Formula Errors” in Chapter 4 for more explanation on how this common habit can cause errors.

• **Highlighting a range only, instead of the entire row or column.** Using the entire row or column is tempting, but uses too much memory and can really slow down the calculation speed.

• **Daisy-chaining links throughout the entire model instead of linking to the source,** as described above.
USE CONSISTENT FORMULAS

In a table or block of data, the same formula should exist all the way across and down the entire block. Use absolute/mixed referencing to achieve this. (See the section “Cell Referencing Best Practice” in Chapter 5 for a practical exercise on how to do this.) It saves time, and avoids errors – and this practice is a keystone to good financial modelling technique. If you only pick up one modelling technique from this course, let this be it!

If you really need to change formulas so that they differ across adjacent cells, you can indicate this with a double border to show that the formula has been broken. This will help with auditing. See the section “Model Design” in Chapter 2 on colour coding for an example of how this looks.

• Avoid blank rows or columns in data blocks where possible, as this can cause problems with sorting, filters, and pivot tables.
• If sheets are similar, use a template where possible and copy the same sheet. Then when you need to update it, group the sheets to make global changes.
• Try not to use macros to perform lengthy calculations or manipulations because this reduces transparency. Only in limited areas, such as goal seek on the scenario generation page, should macros be used, and these instances should be clearly documented.

FORMAT AND LABEL CLEARLY

Formatting and labelling in a model will reduce error and make your model easier to understand. It sounds simple, but, like mixing apples and oranges, mixing units is a common source of error in financial modelling. Clear formatting and labelling will avoid this.

• Format cells appropriately. Use symbols for currency (e.g., $, €, £, ¥), the percent symbol (%) for percentages, and commas for thousands. This makes your model easier to read and avoids mistakes and misinterpretations.
• Include a dedicated units column (e.g., column C) and make sure the units are entered into that column, (e.g., $, ’000, MWh, litres, head count, etc.).
• If you decide to round figures into thousands, show this clearly at the top of the row with a descriptive heading such as “Revenue $’000” to avoid confusion and misinterpretation.
• Column and row headings should have unit or currency headings and only contain one type of unit or currency.
• When building multi-sheet models, columns should be used consistently. For example, if building a model for the period 2013–2020, use column F on each worksheet for 2013, column G for 2014, and so on.
• It is often a good idea to reserve a column (for example, column D) for constants that apply to all years, months, or days. For example, if growth rate is 5 percent, have that in column D and then link all calculations to column D.
In general, these best-practice guidelines are really just common sense. Whilst some of them may seem tedious and overly prescriptive to the beginner, most of these points are for the purpose of reducing error and bringing increased robustness and clarity to the model. These practices are probably second nature to the experienced financial modeller, who will most likely already follow these guidelines by instinct.

**METHODS AND TOOLS OF ASSUMPTIONS DOCUMENTATION**

Many senior managers put a lot of faith in a business case, new venture, or decision supported by a financial model. I've seen many cases where managers will blindly decide to go ahead with a project because the financial model seems to indicate that we should. Unless the assumptions are clearly understood and listed beside the outputs of the model, the financial model should not be considered a definitive decision-making tool. Important decisions are made based on the outputs of the model, and it is critical to list the assumptions that have gone into the model. A model is only as good as the accuracy of the assumptions. It is important to mitigate your liability by documenting your assumptions thoroughly, and adding caveats where necessary.

As documentation of assumptions is one of the key points of best practice in financial modelling, let's take a look at some commonly used methods and Excel tools for including this documentation in a model. All assumptions should be listed somewhere in the model, but key assumptions should be visible and easily accessible (e.g., via footnotes or statements). The definition of what is classified as a key assumption is somewhat subjective. As the modeller, you need to assess and identify the assumptions that are critical to the model. This could be something to which the model is very sensitive, and in this case, sensitivities should be performed. You may also choose to include the assumptions on which, in your opinion, there has been little research available and you are perhaps not entirely comfortable with the data. In such cases, this should be stated, and a recommendation to perform more research proposed.

General notes and instructions about the model should be entered in the cover page of the model, but notes relating to a certain worksheet should be placed in the top area of that particular worksheet. Most assumptions will simply be documented on the assumptions page using straightforward pasted text, but there are a few other sections of the model that may contain assumptions documentation as well, and there are several different methods and techniques for doing this. More detail on each tool is outlined in the following list:

- In-cell comments
- Red triangle comment
- Input message
- Footnotes
- Hyperlinks
- Hard-coded text
- Linked, dynamic text
In-Cell Comments

There are two different methods of creating in-cell comments: the ordinary comment with the red triangle in the corner (which I will call red triangle comments), and the less commonly used data validation input message.

Documentation of assumptions using in-cell comments is most appropriate for specific matters relating to only one cell or set of calculations, as they can only be viewed in a single cell. These are useful for communicating details to another modeller about specific calculation details, as they will only be viewed on the soft copy of the model. More wide-ranging, generic assumptions should be documented using other methods.

Useful comment entries would be sources or assumptions relating to the data in the commented cell. For example, the casual observer of a model may wonder why volume is so low at that time of the year. This can be documented with a comment as shown in Figure 3.1.

**FIGURE 3.1 Assumptions Documentation Using In-Cell Comment**

![Assumptions Documentation Using In-Cell Comment](image)

**Red Triangle Comments:** The most commonly used method is to simply insert a comment within the cell as shown in Figure 3.1.

You see the red triangle, but the comment doesn’t appear until you hover your mouse over the cell.

**HOW TO INSERT A COMMENT**

Go to the Review tab and select the New Comment icon from the Comments section. (See the Excel 2003 instructions at www.wiley.com/go/steinfairhurst.)

Alternatively, you can right-click on the cell with the comment and select Edit Comment to edit. Similarly, right-click and select Delete Comment to delete.

In-cell comments are a good way of documenting models, but they are not usually printed, so they are only helpful on a soft copy of the model. It is possible to print comments, but this isn’t a great option, as they look messy and can cover other numbers or text in the model.
HOW TO VIEW ALL COMMENTS IN THE WORKSHEET

In Excel 2007/10 and Excel for Mac 2011, go to the Review tab and select the Show all Comments button on the Comments section. Unselect it to hide the comments. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

Data Validation Input Messages: The less commonly used type of in-cell comment is to use data validations. These types of comments are more discreet, as they do not have the red triangle in the corner, and you don’t see the comment until you actually click on the cell. See Figure 3.2.

FIGURE 3.2 Assumptions Documentation Using Data Validation Input Messages

This sort of in-cell comment is especially useful for creating little instructions and warnings regarding input data to users, as they won’t see it until they actually click on the cell to enter the data.

HOW TO INSERT AN INPUT MESSAGE

In Excel for Mac 2011, go to the Data tab and select the Data Validation icon from the Data Tools section. Select the second tab entitled Input Message and type the message you wish to see. This message will appear only when the cell is selected. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

The box will look like Figure 3.3.
Data validations are incredibly useful in financial modelling. For other uses, see the section on “Bulletproofing your Model” in Chapter 7. Table 3.1 is an overview comparison of the different types of in-cell comment methods.

**TABLE 3.1 Comparison of In-Cell Comment Methods**

<table>
<thead>
<tr>
<th>Red Triangle Comments</th>
<th>Input Message Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Can detract from the model making it look messy.</td>
<td>• More discreet; don’t distract the eye of the user.</td>
</tr>
<tr>
<td>• Can be viewed all at once.</td>
<td>• Can only be view one at a time.</td>
</tr>
<tr>
<td>• More obvious to the user.</td>
<td>• Easily overlooked.</td>
</tr>
<tr>
<td>• Most appropriate for details about a cellspecific calculation for another modeller’s information.</td>
<td>• Most appropriate for instructions relating to inputs for the user, as opposed to the modeller.</td>
</tr>
</tbody>
</table>

My personal preference is to use input message comments wherever possible, as they are neater and cleaner-looking. Remember, though, that if the cell isn’t selected, the comment won’t be viewed, so make sure that the comment is only cell-specific. More important, general assumptions and comments should use plain text or another method of documentation.

**Footnoting**

Unfortunately, the footnote tool in Excel is almost completely useless for assumptions documentation in financial modelling because:

- It cannot be linked to sections of the model, which greatly limits its usefulness.
- The modeller cannot see the footnote in the ordinary soft copy working view whilst building the model.

For these reasons, the footnote tool in Excel is really only useful for information such as file names, page numbers, print dates, and times. However, linked footnotes can be done manually by formatting the cell font to superscript.
HOW TO FORMAT TO SUPERSCRIPT

If you select the cell, the entire cell’s format will change. Alternatively, you can highlight part of the cell’s text, which will change only the highlighted section.

Right-click, go to the Format Cells option, and tick the Superscript box on the Font tab.

Footnotes are highly recommended for noting sources of data, assumptions, and other important information. For an example, see Figure 3.4.

FIGURE 3.4 Example of Manual Footnoting in Excel

![Figure 3.4 Example of Manual Footnoting in Excel](image)

We can go further with this by making the assumptions documentation linked so that the numbers update automatically. How to do this is detailed later in this chapter in the section “Linked Dynamic Text Assumptions Documentation.”

Hyperlinks

There are two different types of hyperlinks that are useful in financial modelling: URL web links and links to other files or locations within the model.

Cell and File Hyperlinks: You can also create hyperlinks to source or other reference files and other sections of a model. They can aid in navigation of a long and complex model, and are especially helpful for new users to find their way around the model.

HOW TO INSERT A HYPERLINK

1. On the Insert tab, select the Hyperlink icon from the Links section. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

   In Excel for Mac 2011, select Insert on the Menu bar, and select Hyperlink from the drop-down menu.

2. On the left-hand side, select Place in This Document. Note that in Excel for Mac 2011, you must first select the Document menu, then click the Select ... button and choose the document you are working in. Then type the name of the range you wish to link to in the Anchor text box.

3. Select the sheet and cell reference or named range of the hyperlink source.

4. You can change the Text to Display at the top to display something like Go to Staff Salaries instead of Salaries!A45, for example.

Similarly, you can insert a hyperlink to another file in your source referencing as shown below.
HOW TO INSERT A HYPERLINK TO ANOTHER FILE

1. On the Insert tab, select the Hyperlink icon from the Links section. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

   In Excel for Mac 2011, select Insert on the Menu bar, and select Hyperlink from the drop-down menu.

2. Click on the Browse for File icon, which is located at the top right-hand corner. Select the file that you want to insert.

   Note that for Excel for Mac 2011, you will select the Document menu, then click the Select ... button before selecting the file you want to insert. It can be any file type.

3. Hit OK, and this will create your hyperlink.

4. You can also create a hyperlink to another file or web page that does not show the full web or file address of the file. Follow the instructions above, but change the Text to Display field at the top of the Edit Hyperlink dialog box such that it shows your desired text rather than the full file path or web address.

Test this out on one of your models. This is useful if you obtained data from another file and want to document it as a source reference without retaining links in the model.

Warning: Bear in mind that unlike formula links, hyperlinks do not move if the source cell moves. If you create a hyperlink to a cell on another tab (e.g., A1), and then insert a row above row 1, the hyperlink will not automatically update to A2 as a linked formula would.

For this reason it is a good idea to hyperlink to a named range rather than a cell reference, as hyperlinks do not follow insertion or deletion of rows and columns, and this will make your model more robust.

Web URL Hyperlinks: Hyperlinks can also be used to refer to relevant Internet or intranet sites directly from your spreadsheet. For example, if the tax rate we have assumed in our model was obtained from the World Health Organization (WHO), we should put a reference to the WHO next to the assumption as shown below in the “How to Insert a Website Hyperlink” box.

HOW TO INSERT A WEBSITE HYPERLINK

1. In the cell next to or beneath your assumption, type www.who.int/research.
2. Make sure you hit Enter after you finish typing, and it will turn into a hyperlink.
3. Test it out by clicking on the link.
4. If you would rather show text such as Health Research than the web address, open the hyperlink dialog box as shown in the box above, and change the text to display to Health Research. This will display the text, but retain the website link.
**Hard-Coded Text:** This method of assumptions documentation is not very sophisticated, but like with many things in financial modelling, a simple solution is often best.

It’s fairly obvious in the calculations in row 5 of Figure 3.5 that the growth rate does not change over time, but the modeller is making it absolutely, explicitly clear by typing the hard-coded text below the table. There is no danger here that a modeller or user can overlook this assumption, whether it is being viewed in soft copy or has been printed out.

**FIGURE 3.5 Hard-Coded Assumptions Documentation**

![Customer Forecast - Layout 1](image)

**LINKED DYNAMIC TEXT ASSUMPTIONS DOCUMENTATION**

Documenting assumptions liberally within your model is very important—however it is very difficult to keep the documentation up-to-date when your model is dynamic and inputs are continually changing.

For example, in a business case it would be useful to put the cost of capital next to the net present value (NPV), as this is a very important assumption. If we type Cost of capital is 12 percent, however, it will be out-of-date as soon as we change the assumption, and there is a very high risk that we could distribute the model with incorrect assumption documentation.

The answer to this is to use an ampersand (the & symbol). The CONCATENATE function will do a similar thing, but using the ampersand is quicker to build (and easier to spell)! You can join any cells together by using this symbol.

**Practical Exercise 1**

Let’s try a basic exercise to get the hang of how the ampersand works.

1. Practice this in a blank worksheet: Type **Hello** in cell A1 and **Robert** in cell B1.
2. In another cell, type the formula =A1&B1, which will give you the result **HelloRobert**.
3. Now try adding some text. For example, =A1&B1&“how are you?” will give you the result: **HelloRobert how are you?**
4. Next add a space between **Hello** and **Robert** like this: =A1&” ”&B1&” how are you?”
5. Now add a comma after **Robert** like this: =A1&” ”&B1&”, how are you?”.  
6. Your sheet should look like the sample in Figure 3.6.
7. Now change the word Robert to Mary and see how your text changes.

**Practical Exercise 2**

1. Go to a model and practice creating a sentence using linked text to document an assumption.
2. For example, number of customers starts at 15,065 in 2013, as shown in Figure 3.7.

**FIGURE 3.7 Linked Dynamic Assumptions Documentation**

3. Practice changing either the date or the beginning number of customers and watch the text change.
4. If you want to format the number so that it shows as 15,065 instead of 15065 you can use the TEXT function like this: =TEXT(B5,“###,###”) Remember that this function turns the data to text, so it is no longer a number. You can find out the format that the TEXT function required by going into Custom Formatting, as shown in Figure 3.8, by right-clicking on a cell, selecting Format Cells and Custom.
5. The total formula would be: =“Number of customers starts at “&TEXT(B5,“###,###”)&” in “&B4.”
FIGURE 3.8 Format Cells Dialog Box

Practical Exercise 3

This method of documentation can also be used in reporting to create commentary on outputs. This commentary can then be easily copied to Word or PowerPoint.

1. Create a simple calculation on a new worksheet as shown in Figure 3.9.

FIGURE 3.9 Practical Commentary Exercise

2. The formula in cell B4 should be =B2-B3 and the formula in cell B5 should be =B4/B2.
3. Now in cell A7 create a comment that says **Profit margin is 20%**. Remember to use the TEXT function to format it as a percentage.
4. Your formula should be =“Profit Margin is “&TEXT(B5,“#%”).
5. Now try changing the revenue amount to $3 million. Your profit margin changes to 33 percent, and your text commentary still remains accurate. Change the revenue back to $2.5 million.
6. If you would like the text to say **Profit margin is 33.33%** instead of 33%, add some decimal places to your formula after the # symbol: \(=\text{"Profit Margin is \\
&TXT(B5,"#.##\%")}.\)

7. Your sheet should look like Figure 3.10.

**FIGURE 3.10 Practical Commentary Exercise (Completed)**

![Excel Sheet with Year End Results](image)

**WHAT MAKES A GOOD MODEL?**

A well-built model will have the following user-friendly features and structural attributes:

**User-Friendly Features:**

- Well-documented assumptions so there is no possibility of misunderstanding or misinterpretation of the model.
- Explanation of the functionality. Many models lack this. What is the model for? How do I use it and where do I input data?
- Logical flow (left to right and top to bottom).
- Inputs and outputs, workings, and results are clear and easy to find.
- Built-in error checks and input validation such that the user is aware as soon as there is an invalid entry or calculations are not correct.
- Easy navigation to help users find desired information. Use a hyperlinked table of contents to help users find their way around if there are a large number of tabs.
- Instructions on how to use it if the functionality is not self-explanatory or obvious. These instructions could be dispersed throughout the document in the form of comments (my preference) or as a separate instructions page.
- Printability so outputs are summarised and fit onto printable pages, which are easy to read. Reports are legible and colours are not too dark.
- Formatting that is easy on the eye and consistent. The whole model should have the same look and feel even if different modellers have built different parts of it.
- The user should be able to access summarised information as well as the detail. Each page should form the backup data and source information. Users should be able to print or distribute this page if further information is required.
Structural Features:

- The only hard coding should be the inputs and source data. The sources or assumptions for these must be documented. All other information is linked.
- Duplication is minimised.
- Names, formulas, and formats should follow a consistent convention.
- The model should be built in a modular form so that pieces can be removed and reused if required.
- The build is logical such that each topic is handled on a different section, and similar inputs or calculations are grouped together.
- The most efficient function is used.
- The model should be scalable so that greater detail or a large number of units, for example, can be added with minimal rework.

At www.wiley.com/go/steinfairhurst you will be able to download a model assessment checklist, which will help you to assess how a model stacks up against financial modelling best practices.

Standards in Financial Modelling

There have been some good attempts in recent years to standardise financial modelling practice, with good reason. Excel is such a flexible tool that literally anyone can jump in and start creating the most frighteningly poorly designed and error-prone models – and they do! The FAST Modelling Standard is a philosophy that promotes FAST (Flexible, Accurate, Structured, and Transparent) design, and a recently developed methodology called SMART focuses on transparency, flexibility, and presentation. To download these standards, refer to the list of online resources that can be found at www.wiley.com/go/steinfairhurst.

Whichever methodology you follow, using the key principles outlined in this chapter or in the above methodologies, your model will be easier to navigate and check, and much more likely to be robust, accurate, reliable, and error-free.

SUMMARY

By following the points of modelling best practice such as assumptions documentation, linking, only entering data once, ensuring formulas are consistent, and avoiding bad modelling habits, financial modellers can be sure that their models are more robust, have fewer errors, and are easier to audit. One of the most important principles of best practice is to document assumptions, and this chapter lists different technical methods of assumptions documentation, such as comments, footnoting, hyperlinks, and linked text. We also looked at the features and structural attributes of a well-built financial model.
Chapter 3 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. In order to make your model more auditable, traceable, and easy to validate, you should:
   a) hard-code data
   b) hide sheets
   c) link data
   d) all of the above

2. Source data should only be entered:
   a) once
   b) twice
   c) thrice
   d) there is no limit

3. Which of the following is true regarding data validation input messages:
   a) they can be viewed all at once
   b) they are more discreet than red triangle comments
   c) they are most appropriate for instructions relating to the modeler
   d) they are more obvious to the user than red triangle comments

4. Which of the following is the ampersand symbol:
   a) &
   b) *
   c) ^
   d) ()
Chapter 3 – Solutions and Suggested Responses

1. **A:** Incorrect. Hard-coding data actually makes your model less auditable, traceable, and easy to validate. This is because hard-coded data cannot be modified. Linking is preferred so that when your inputs change, the outputs also change.

   **B:** Incorrect. Hiding sheets does not necessarily make your model more auditable, traceable, and easy to validate. It can prevent users from making errors or changes, but it can also make it harder for users to read and understand your overall model.

   **C:** Correct. Linking data makes your model easier to audit, trace, and validate because the information is included in your model. If you do not link data, auditors and users will not know where the information originated.

   **D:** Incorrect. Only linking data will make your model more auditable, traceable, and easy to validate.

   (See page 44 of the course material.)

2. **A:** Correct. Source data should only be entered once. Whenever you need to, refer back to the cell or rows containing the source data. This makes the model easier and faster to update, making it less prone to errors.

   **B:** Incorrect. Source data should only be entered once. Any more than that and your model will be prone to errors.

   **C:** Incorrect. Entering source data three times is redundant and unnecessary.

   **D:** Incorrect. There is a limit to how many times source data should be entered, and it is once.

   (See page 45 of the course material.)

3. **A:** Incorrect. Data validation input messages can only be viewed one at a time.

   **B:** Correct. Input message comments are more discreet as users won’t see them until they actually click on the cell to enter data. On the other hand, red triangle comments can distract from the model making it look messy as the red triangle is always visible.

   **C:** Incorrect. Data validation input messages are used more for instructions relating to inputs for the user rather than the modeler.

   **D:** Incorrect. Input message comments are easily overlooked whereas red triangle comments are more obvious to the user, because the red triangle always shows and an input message only shows when the user clicks on the cell to enter data.

   (See page 50 of the course material.)
4. **A: Correct.** & is the ampersand symbol.

   B: Incorrect. * is the asterisk symbol.

   C: Incorrect. ^ is the caret symbol.

   D: Incorrect. () are called round brackets.

   (See page 53 of the course material.)
Chapter 4: Financial Modelling Techniques

In this chapter, we’ll take a look at some of the more frequently used techniques, as well as some of the common errors (and avoidance strategies), issues, and decisions a financial modeller encounters when building models in Excel.

As discussed in Chapter 1 in “Tool Selection,” Excel is by far the most commonly used tool for financial modelling due to its wide acceptance and ubiquity in the market. However, it most certainly has its flaws, mostly to do with the prevalence of undetected mistakes in Excel-built models. Astute financial modellers need to understand the dangers of a poorly built financial model and the ease with which mistakes can be made.

THE PROBLEM WITH EXCEL

A well-built financial model or piece of analysis is an invaluable tool in decision making and financial management, but all too often a wrong calculation can have disastrous consequences. Many executives and decision makers rely far too heavily on Excel models – probably because they don’t fully understand the risks involved.

There are many well-documented cases of high-profile Excel model blunders. Some of those documented by EuSpRiG, the European Spreadsheets Risks Interest Group, include:

- The auditor’s office that divided the growth from one year to the next by the second year, rather than the first year, specifically, calculated it using (Year 2 – Year 1)/Year 2 instead of (Year 2 – Year 1)/Year 1.
- Aspiring police officers were told they passed an exam only to discover that the administrators had incorrectly sorted the results to the names and scores were mismatched.
- A gas company submitted the wrong week’s gas storage figures, leading to artificial inflation of natural-gas prices and a lawsuit.
- Shares of a self-storage company dropped when it was disclosed that it had overpaid its chief executive and another investor $700,000 each and took more than six months to find and correct the error, which was due to using the wrong spreadsheet.

The list of Excel horror stories continues to grow, reminding us that simple mistakes in spreadsheet and financial models can cause companies to lose significant amounts of money – not to mention the resulting embarrassment.

Figure 4.1 is an example of one of many very simple and yet common formula mistakes often found in Excel models. In the figure, row 13 has been entered, but it’s not been picked up in the summary total below it.
To avoid this error, when creating summary totals, leave an extra gap row between the last row of values and the sum formula. Therefore, when new rows are inserted, the summation formula will automatically include the newly inserted rows. This will minimise the chance of error when the model needs to be expanded. The use of error checks can also help to alert the user or modeller when this happens.

Excel is just such an amazingly flexible program that you can do anything with; however, it is for this very reason that it is so prone to user error. So, what’s the solution to Excel’s error problem? It is extremely difficult to ensure an error-free model, but by employing certain strategies, you can most definitely reduce their number and impact. When building a model in Excel, it’s recommended to proceed carefully and build and use it with caution.

**ERROR AVOIDANCE STRATEGIES**

There are certain strategies the modeller can employ during the build process that will help identify errors as they occur. Even extremely skilled modellers make mistakes all the time. A good, experienced modeller, however, will pick up these errors as they are made and avoid situations where mistakes are likely to happen.

**Avoiding Simple Formula Errors**

Silly formula mistakes are the easiest to avoid, and the most embarrassing when they are not picked up. Commonly, it’s the wrong cell being picked up or a dollar sign in the wrong place.

**Use the Enter Key:** Many Excel users get into the bad habit of clicking elsewhere in the page when they have finished typing a formula. This is a dangerous practice. Instead, always hit the Enter key when you’ve finished with a formula. Most of the time you’ll get away with it, but every now and then it can cause problems, so you must get out of the habit. See Figure 4.2.
Firstly, it’s easy to accidentally pick up the wrong formula as shown above if your cursor happens to be in the wrong place, but more importantly, you need to be deliberate about entering the formula. When modelling quickly, it’s easy to mentally move onto the next task before completely finishing the last one.

Once you’ve finished the formula, hit the Enter key and look at the formula. Does it look right? Does it look sensible? Is that what you intended to show?

**Check Your Work and Use the F2 Shortcut Key:** The worst kind of error is one that you are not aware of. Constantly performing rough checks on the results of the formulas as you build will minimise the chance of an error. Every time you hit the Enter key (and you must use the Enter key) check the result. Is the number what you expected? Before you add anything else to the formula, make sure the first part is right.

A lot of modelling is trial and error, and it’s okay to make mistakes – just make sure you pick up mistakes before someone else does! The only thing worse than finding a mistake in your model is not finding the mistake in your model, and your model being wrong. Worse than that is having your boss find the error! There’s no faster way to lose credibility as a modeller or analyst than having your mistakes pointed out in public.

Clicking in the cell or hitting the F2 key (as demonstrated in Figure 4.3) will also show the source cells, or precedents of a formula. This is most useful if the source cells are nearby and on the same sheet. When you’ve copied down all the cells in a block of data, do a spot-check with the F2 key to make sure it’s picking up the correct cells. Note that this shortcut is Control + U in Excel for Mac 2011.
Have Someone Else Check Your Work: Once you’ve checked and checked again, it’s good to have your model reviewed or audited by someone else, as that person will bring a fresh perspective. Sometimes you’ve looked at your model for so long you just can’t see the glaring error in front of you. Working in pairs can be very effective.

If the model is high profile or very important, it might be worth getting it audited by a model audit firm. There are many organisations that specialise in conducting professional model audits. This is really the best way to be confident that there are no errors and your model is working correctly!

Now that the reality of spreadsheet error has been established, the next step is to ask what we can do to reduce spreadsheet errors. Unfortunately, only one approach to error reduction has been demonstrated to be effective. This is code inspection, in which a group of spreadsheet developers checks a spreadsheet cell-by-cell to discover errors. Even this exhausting and expensive process will catch only about 80% of all errors.²

Stress-Testing: Test the technical workings of the model by stress-testing it (i.e., varying the inputs to see how much the outputs change). Insert some ridiculous numbers into the inputs, and see if the results are what you expect. The following are some stress tests you can perform:

- Set inputs to zero and check that the outputs respond as you would expect. For example, by setting price to zero, you would expect revenue to also be zero.
- If you add one unit, is the output increased by the value of one unit?
- Double your headcount. Do your staff costs roughly double?
- If you are indexing costs, try setting the indexation percentage to zero and see if the costs remain flat.
- If you double the pricing, does gross revenue double as well? If not, why not? The answer could be due to the effect of discounting or complex pricing structure. Make sure that you get to the bottom of any anomalies and discrepancies.
- Chart metrics on a line graph such as cost per head, price per unit, cost to serve a customer, or other metrics relevant to your business. Look at the curve and make sure that you can explain each and every trend, spike, and downturn.

Thorough stress-testing, along with scenario and sensitivity analysis, will provide your business case the rigour and robustness to cope with various fluctuations in economic inputs. More detail on how to perform scenarios and sensitivity analysis is detailed in Chapter 11.

Avoiding Logic Errors

Compared to formula mistakes, logic errors can be more difficult to spot. They include things like incorrect timing, inserting the wrong inputs and source data assumptions, and using pre-tax instead of post-tax inputs, to name a few. Sometimes the mistakes can be a combination of both formula and logic errors, and we need to diligently guard against both types of errors.
**Validate Your Assumptions:** A model is only as good as the accuracy of the assumptions. The phrase garbage in, garbage out has never been more relevant than in the context of financial modelling. Even the most beautifully built, best-designed model will be completely worthless if the assumptions that go into it are not validated. This is one of the most important points of financial modelling best practice, and different technical assumption documentation methods are detailed in Chapter 3 under “Methods and Tools of Assumptions Documentation.”

Important decisions are made based on the outputs of the model, and it is absolutely critical to list clearly (and often painstakingly!) the assumptions that have gone into the model. While a good model can aid your business or decision-making process significantly, it’s important to remember that models are only as good as the data they contain, and the answer they produce should most certainly not be taken at face value. When presented with a model, a smart manager or decision maker will query all the assumptions, and the way it’s built.

As a financial modeller, ensure that all the assumptions have been validated to the best of your ability. Document clearly where the numbers came from so that there can be no possible misinterpretation of the assumptions you have used, so that the assumptions can be revisited and possibly revised at a later date.

**Document Your Methodology:** Using a flow-chart format, document the inflows and outflows of your data within the model. This helps to check your logic, but is also useful in explaining the methodology of your model to other people.

For example, you can calculate the customer acquisition of a business case using the following methodology. If you start with the total population, apply the number of pet owners and then a take-up rate, you get the number of acquired customers. This methodology can be documented as follows in Figure 4.4.

**FIGURE 4.4 Methodology Documentation**
Use Models in the Right Context: Some managers treat models as though they are able to produce the answer to all their business decisions and solve all their business problems. It’s absolutely terrifying to see the blind faith that many managers have in their financial models. Anyone with any real experience in model building will appreciate how incredibly easy it is to get a dollar sign in the wrong place and end up with the wrong result. Models should be used as one tool in the decision-making process, rather than the definitive solution.

All too often back-of-the-envelope models turn into something more permanent. They’ll then perhaps be used to determine pricing. Then used as a cash-flow forecast. Then later, when it’s budget time, the same model gets used for that, too, and you end up with an important model based on hastily gathered assumptions and a flaky design structure. Models should always be built for a specific purpose. If you do pick up a model to use for another purpose, make sure you understand the model fully before making any changes. See “Rebuilding an Inherited Model” in Chapter 10 for more information on how to take someone else’s model apart.

Sensitivities and Scenario Analysis: Do lots and lots of sensitivities and scenario analysis. If the absolute worst happens, what happens to my bottom line? How sensitive is my model to changes in key assumptions? This will help to test the logic and robustness of your model, as well as the soundness of the business, product, or project the model is representing. At the minimum, you should do at least a best case, a base case, and a worst case.

This can often flush out anomalies in the model. Look carefully at the results of your scenario analysis. Is it what you would expect to see? Compare the sensitivity results side by side. If you increase the escalation factor from 2 percent to 3 percent, do costs increase by the same margin as if you increase escalation from 3 percent to 4 percent?

Sense-Checking Methodology: Let’s look at an example of using sense-checking methodology.

Figure 4.5 shows a pretty common one. Let’s say you are adding up these totals and accidentally double-count by including the subtotals in your grand total. If you look at the subtotals you can see that the grand total should be around $170,000. Instead of doing this in your head, you could highlight the two subtotals using the Control key, and the total will appear at the bottom right-hand side of the screen, as shown by the outlined box at the bottom of Figure 4.5.
FIGURE 4.5 Sense-Checking Methodology Using the Sum Total

Highlighting cells and checking totals using this method is a good way of sense-checking for errors, and by employing a sense-checking methodology, you are less likely to let errors slip through the cracks.

**Note:** Note that in Excel 2003 and Excel for Mac 2011 you only see the sum at the bottom in the status bar. You can easily change this by right-clicking in the status bar to show average, count, min, max, and so on – but you can only see one at a time. In later versions of Excel, as shown above, average, count, and sum are all shown automatically by default.

**HOW LONG SHOULD A FORMULA BE?**

If you’ve been modelling for a while you’ll know that it’s pretty easy to end up with a really long formula. Excel will handle them – as long as they are constructed correctly – but they can be pretty tricky to follow, especially for other people. Even if you’ve written a lengthy formula yourself, you’ll struggle to follow it at a later date.

As with most concepts in financial modelling, a formula should be as simple as possible and as complex as necessary.

The way to make a formula shorter, of course, is to break it down into several steps, by adding additional working cells. Too much of this can make your model cumbersome; therefore the good modeller needs to strike a balance between:

- Making the formula too long and complex; and
- Having a model with additional working rows and columns.
If you do have a very long formula, one way to make it a bit easier to understand is to use Alt + Enter in the middle of the formula to force the next section of the formula onto another line. Note that this shortcut is Control + Option + Enter in Excel for Mac 2011.

For an example, see Figure 4.6:

**FIGURE 4.6 Very Long Formula Broken in Several Lines**

Of course, a formula of this length is not recommended. One of the new features of Excel 2007/10 is the expandable formula bar, but it is generally accepted best practice that a formula should not exceed about half of the width of the formula bar. This does not include file paths if the formula is linking to an external file that is currently closed, and therefore the full file path is included in the formula (as shown in Figure 4.7). Keep formulas particularly short when linked to external files for this reason.

**FIGURE 4.7 Very Long Formula Broken in Several Lines**

Figure 4.8 reveals two different ways of achieving the same result. The first example shows that revenue has been calculated by:

```
=IF($A2=0,0,IF($B2>Assumptions!$B59,0,IF($AND($B2>Assumptions!$B62=4855),
```
Row 3: Forecasting the number of customers.
Row 4: Forecasting how many calls per day each will make.
Row 5: Applying seasonality to these calls.
Row 6: Multiply row 3 by row 5 to get the total number of calls per day.
Row 7: Multiply row 6 by the number of days in the month to get the number of calls per month.
Row 8: Multiply row 7 by the price to get the total revenue.

Alternatively, the whole calculation could be done in row 9 using the complex formula:

\[ =\text{Assumptions!B9}\times(1+\text{cust\_growth})\times(\text{B2-\$B\$2})\times\text{B4}\times\text{Assumptions!B6}\times\text{Assumptions!B8}\times\text{price} \]

You could argue that this is a more succinct, sparse way of modelling. However, it makes it very difficult to take apart this formula for checking or debugging. Calculating the revenue step by step, as shown in the first example, is a much better way of modelling.

**LINKING TO EXTERNAL FILES**

One of the important principles in Excel modelling best practice is to link to the source data. Whenever possible, hard coding should be avoided, and you should always try to link your cells so that as variables change, the results remain accurate.

However, if your source data exists in an external file, this can cause many problems, such as broken links, incorrect data, and error messages. In fact, some analysts avoid linking to external files at all costs! However, if done properly, external links add value to your models.

The following is a list of reasons why you should link to external files:

- It’s best practice to never hard code when you could link.
- Your numbers are auditable. There’s nothing more frustrating than trying to audit a model and finding hard-coded numbers with no annotation.
- The numbers will automatically update, so the model is less prone to error.
- It saves time because you’ll spend less time entering and checking your data and more time analysing.
Table 4.1 shows the problems and solutions as to why many analysts don’t link to external files.

### TABLE 4.1

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The links break.</td>
<td>Avoid moving files. Use Edit Links to fix.</td>
</tr>
<tr>
<td></td>
<td>Use named ranges to minimise number of formulas to fix when this does happen (and it will!).</td>
</tr>
<tr>
<td>People move the data and my formulas are wrong.</td>
<td>Use named ranges to refer to external files, which will minimise this. Use more robust formulas such as INDEX &amp; MATCH.</td>
</tr>
<tr>
<td>The numbers keep changing.</td>
<td>Yes, they should. Consider saving in one location to maximise version control.</td>
</tr>
</tbody>
</table>

### Why You Should Use Named Ranges in External Links

One of the main issues with linking to external files is that if users insert or delete rows or columns in the source file, this can easily mess up the files that are linking to it.

Imagine you want to use a pricing threshold in your financial model, which is being generated in another model. Using best practices, you decide to create a link, rather than hard coding the number. This will make your model more auditable so that we can see exactly how that threshold amount was calculated. You create a link from your financial model to another source file, using the link:

```
=C:\Plum Solutions\Clients\Transactions\Files\[Financial Statements.xls\]July'!$C$46
```

If you are using Excel for Mac 2011, your file name might look more like this:

```
```

If both files are open at the same time, and you insert a row in the Financial Statements file, the link will automatically update from $C$46 to $C$47. However, if your file is closed, your model will not update. This means that next time you open it, your model will be picking up the wrong cell!

The way around this issue is to create a named range in the source file (for example, threshold) and then if that cell moves in the source file, the cell will still retain its name, and the formula in your model will still be correct. See “Named Ranges” in Chapter 5 for how to do this.

```
=C:\Plum Solutions\Clients\Transactions\Files\[Financial Statements.xls\]July'!threshold
```

The next time your model tries to update the link, it will look for the name threshold, rather than $C$46, and the integrity of the link will be maintained. This is why using named ranges when dealing with external links is considered best practice; it a much more robust way of linking files together.
Dealing with Links and the Potential Errors They Can Cause

If you have linked two files together, you should not start moving either of the files around into other drives or directories. If you do, Excel will not be able to find the file that has been moved, and the link will be broken. If a file has been moved or had a name change, you can try to amend this by using Edit Links as described in the following text.

Before you start linking workbooks together you need to think about what will happen to the workbooks in the long term. Will other people be using them? Will they be making copies? Will they be mailing copies to other people? If so, then perhaps in that case, you should avoid creating a link to an external spreadsheet.

HOW TO EDIT LINKS

Click on Edit Links on the Data tab, in the Connections group. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

In Excel for Mac 2011, go to Edit, then select Links.

Use the Change Source button to tell your model the new location of the file it has been linked to.

Tip: Another handy use for Edit Links is to break all links in a file. If you are emailing a file, it is not recommended that you leave links in it. You could paste the cell values one by one, but breaking links will convert every single formula in the entire file to their hard-coded values. Click on Edit Links, and then you will be able to select the external files and click on the Break Links button. See Figure 4.9.

FIGURE 4.9 Break Link Dialog Box
Linking Do’s and Don’ts

Here are some common do’s and don’ts to keep in mind when linking:

- Do use named ranges when linking to external files.
- Don’t e-mail files that contain links. Save another version, and use Break Links in such cases.
- Don’t change file names and sheet names unless you really need to.

BUILDING ERROR CHECKS

Basic reconciliations can be built within a model, and a well-built financial model should have error checks included where possible so that the user or modeller can see at a glance if the formulas are calculating correctly. For example, when creating management reports, check that the sum of each individual department’s report adds to the company-wide total. This can be done by inserting a simple IF function, or several other methods, as shown in the next section.

Note that error checks are not a substitute for good practice such as checking and auditing your formulas. Error checks are most appropriate for capturing errors a subsequent user has made; they are less likely to highlight a model building error. See “Error Avoidance Strategies” in Chapter 4 for more details on how to reduce errors when building models.

Error Check Exercise

Let’s say, for example, that you have the following cars in stock in a showroom. You want to know how many of each type of transmission you have in stock, so you have created a SUMIF formula to summarise how many of each type are in stock. (See Figure 4.10.) “Aggregation Functions” in Chapter 6 discusses how to create a SUMIF formula.

FIGURE 4.10 Summary Report
If someone is updating this model and accidentally types *Automatic* in cell B3 instead of *Automatic*, your totals at the bottom will be wrong.

In cell C18, we can create an error-checking formula that will alert us if something like this happens. There are several different formulas we could put in cell C18 that will alert us if the model is not balancing properly:

- **=C17-C13** is the easiest formula to build that would serve as an error check, as it would return a value in the case of an error, but this would not necessarily alert the user immediately that an error had been made.
- **=C17=C13** will return the value TRUE if they are the same, or FALSE if not. However, this is also subject to a false error, as shown in the following section.

**Allowing Tolerance for Error**

`=IF(C17<>C13, "error", 0)` is a superior error check, but on a small number of occasions, there can be an issue with this.

This formula usually works, but it can occasionally return a false error result, even though the values are the same. This is a bug caused by the fact that Excel carries calculations to 14 decimal places. After that, it truncates the value, and can cause a minute discrepancy, which will report an error when it’s only 0.00000000000001 off.

Therefore, to avoid this potential issue, you could use an absolute value formula, which would allow a tolerance for error. `=IF(ABS(C17-C13)>0.1,"error",0)` will allow the values to be off by 0.1 before it reports an error. If you use the ABS function in Excel, this will take the absolute value of the result, such that it does not matter if it is a positive or negative number.

In Figure 4.11, if the sum of each individual item does not equal the grand total, the cell will return the word error; otherwise it will show a zero. There are many variations of this formula, and I’m sure you can come up with many of them. Many modellers prefer to show the word **OK** if the numbers are right, and **Check** if they are not.

**FIGURE 4.11 Error-Check Example**

To make the error check even more prominent to the user, use conditional formatting to add a rule that makes the entire cell turn red if the error check has been triggered. See “Conditional Formatting” in Chapter 7 for how to do this.
Error-Check Alerts

Consider adding in an error-checking page at the very back of your model that links through to all the error checks in the entire model. This page can be hidden, as the user does not need to see it, and the modeller can unhide it if necessary.

Create a summary cell that will identify, in a single cell, whether or not there are any errors in the entire model. This can be achieved with a COUNTIF formula like this:

\[
=\text{COUNTIF(S1:S1111,}"\text{error}"\text{)}
\]

See “Aggregation Functions” in Chapter 6 for more detail on how to use a COUNTIF function.

The COUNTIF function returns a 1 if there are errors. Now nest this with an IF statement, which will show the text *Errors exist within this model* if any of the error checks have been triggered.

\[
=\text{IF(}\text{COUNTIF(S1:S1111,}"\text{error}"\text{)}>0,"\text{Errors exist within this model"},0)\]

Now copy this formula (see Figure 4.12) to somewhere prominent at the top of each page (such as within the header) to create a global error check indicator, which will alert users to any error as soon as it is triggered.

**FIGURE 4.12 Error Check Alert Formula**

![Error Check Alert Formula](image)

Global error check alerts are particularly useful for a modeller who has users working with the model regularly. The error check will alert the user that something has gone wrong in the model – usually the user has simply entered some incorrect data – and hopefully the user will be able to correct the input, ensuring the continuing integrity of the model.
AVOID ERROR DISPLAYS IN FORMULAS

Sometimes a formula may return an error message. Usually, you will want to know when a formula error occurs. But now and then you may prefer to avoid the messages. For example, if you are calculating a percentage in a column and one of the entry fields contains a zero, you will get a #DIV/0! error. Or if using a VLOOKUP function, the criteria you have entered does not exist in the data, a #N/A error will appear. You can stop these errors from appearing by using an IF function to check for an error.

\[ =\text{IF(ISERROR(VLOOKUP("payback",Payback!B1:C109,2,0)),0,VLOOKUP("payback",Payback!B1:C109,2,0))} \]

You can adapt this technique to any operation. The original formula serves as the argument for the ISERROR( ) function, and it repeats as the last argument of the IF( ) function. Like this:

\[ =\text{IF(ISERROR(OriginalFormula),"",OriginalFormula)} \]

**Tip:** To make this quicker, you'll find using the copy and paste shortcuts Control-C and Control-V (Command-C and Command-V in Excel for Mac 2011) will make building this formula much more efficient.

Note that many modellers do not agree with avoiding error displays and recommend that you always show errors. The reason for this is that using error suppression can mask other, genuine errors, so use this function with caution.

If you are using the new version of Excel, you will be able to use the new =IFERROR formula. This is much more concise, as it does not require the entire formula to be repeated.

The formula just shown would instead look like this:

\[ =\text{IFERROR(VLOOKUP("payback",Payback!B1:C109,2,0),0)} \]

Only use the IFERROR formula if you are sure that your model will not be opened using Excel 2003.

CIRCULAR REFERENCES

If you have been using Excel for any length of time, you’ve probably come across a circular reference. If your formula is trying to refer to itself, you’ll end up with a circular reference. A common (and easily fixed) cause of this is when a sum range includes the sum itself. For example, in the formula in Figure 4.13, cell B11 refers to cell B11, and this means that the formula cannot calculate properly.
FIGURE 4.13 Formula Creating a Circular Reference

You cannot rely on a model that contains circular references. The calculations may not work, and you can’t be sure the other formulas are calculating properly.

How to Fix Circular References

You can have intentional circular formulas, (in which case you’ll have to enable iterative calculations, as shown in the box below) but if your circular reference is unintentional, you’ll have to get rid of it as soon as possible. The older it is, the harder it is to track down and fix.

You’ll get a warning message as soon as the circular reference happens, so the simplest way to fix this is to stop and simply undo the last thing you did. You really just need to find the offending cell and remove the link. Sounds simple, but sometimes it’s not that easy. The notification in the status bar in the bottom left-hand corner of Figure 4.14 may help find the cell causing the problem.

FIGURE 4.14 Circular Reference Notification in the Status Bar

However, you need to be on the correct tab in order for this message to show. If you aren’t sure which tab the circular reference is on, you need to hunt it down by going to each tab to see if it shows on the status bar. Alternatively, you can use the auditing tool to locate the circular reference.
LOCATING A CIRCULAR REFERENCE WITH THE AUDITING TOOL

On the Formulas tab, in the Formula Auditing group, click the arrow on the Error Checking button. Select Circular References, and this will show the circular reference in the model. Click on the reference to go to the circular reference. See Figure 4.15 (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

FIGURE 4.15 Finding the Circular Reference Auditing Tool in the Ribbon in Excel 2010

In Excel for Mac 2011, using the Circular: reference on the status bar, select the cell containing the circular reference. On the Formulas tab, in the Formula Auditing group, click the Trace Precedents button. See Figure 4.16.

FIGURE 4.16 The Circular Reference Auditing Tool in the Ribbon in Excel for Mac 2011

You can move between cells in a circular reference by double-clicking the tracer arrows. Keep reviewing and correcting the circular reference until the status bar no longer shows the words Circular References.

Circular References in Interest Calculations

There are a few instances where you might wish to keep a circular reference within the model. A common reason for this is when you are calculating interest payments on a profit-and-loss statement. See Figure 4.17.
When modelling financial statements, this circular reference can be avoided in a few different ways:

- Hard-code one of the inputs, such as the interest amount. This is not recommended, as this will impede the flow of numbers throughout the model!
- Use a macro to update the numbers, keep the links flowing, but paste the number to avoid the circular reference. This will work, but needs some good testing to make sure it works properly. See “Macros” in Chapter 8 for points to consider before including macros in a financial model.
- Calculate the interest based on the closing balance of the debt amount in the previous period. This is most appropriate for statements modelled on a monthly basis, as the variance between debt balances from year to year can mean that the interest amount calculated using this method is less accurate. Although not perfect, this is still my preferred method for getting around the problem of circular references in interest calculations.
- Lastly, another commonly used method in financial statements is to allow the circular reference by enabling iterative calculations. The problem with this method is that it might allow other circular references to be enabled, which means that other parts of the model might not calculate properly.

**Enabling Iterative Calculations**

If you decide to enable iterative calculations, you must determine how many times the formula should recalculate. When you turn on iterative calculations without changing any of the defaults, Excel stops calculating after 100 iterations or after all values in the circular reference change by less than 0.001 between iterations, whichever comes first. However, you can control the maximum number of iterations and the amount of acceptable change.
HOW TO ENABLE ITERATIVE CALCULATIONS

Go to Excel Options by either clicking the Microsoft Office Button in 2007, or the File tab in 2010, and then select Options (or Excel Options), and then click the Formulas category.

In the Calculation Options section, select the Enable Iterative Calculation tick box. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

FIGURE 4.18 Enabling Iterative Calculations in Excel 2007/10

(Excel for Mac 2011): Go to Preferences (or hit Command+,). In the Calculation Options section, select the Limit Iteration tick box. See Figure 4.19.

FIGURE 4.19 Enabling Iterative Calculations in Excel for Mac 2011

SUMMARY

This chapter has been a collection of techniques and strategies commonly used in financial modelling. Anyone who has been using Excel for any length of time will know how easy it is to make a mistake, and what a huge impact this can have on their business models. Therefore, knowing and using strategies for reducing errors is an important skill for the Excel modeller to have. We also looked at how to avoid overly long and complex formulas, and how to dissect them if we are unfortunate enough to have inherited a model that includes overly complicated formulas! Linking to external files, building error checks, and dealing with circular references are also issues that are commonly encountered in financial models.
Chapter 4 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Listing the assumptions of a model is:
   a) useless
   b) optional
   c) fast
   d) critical

2. Which of the following solutions helps solve the common problem of links breaking:
   a) avoid moving files
   b) use Edit Links to fix
   c) use named ranges
   d) all of the above

3. The #DIV/0! error occurs while calculating a percentage in a column if:
   a) one of the entry fields contains a zero
   b) the criteria you have entered does not exist in the data
   c) the calculation produces a negative number
   d) all of the above

4. Each of the following is true regarding circular references except:
   a) you will get a warning sign as soon as the circular reference occurs
   b) they commonly occur when the sum range includes the sum itself
   c) they may be used in a model that calculates interest payments on a profit-loss statement
   d) you can rely on a model that contains circular references
Chapter 4 – Solutions and Suggested Responses

1. A: Incorrect. Listing the assumptions of a model is far from useless; in fact, it is imperative.

B: Incorrect. Listing the assumptions of a model is not optional. It is absolutely critical that you list the assumptions that have gone into the model.

C: Incorrect. Taking the time to list the assumptions of a model can often be painstaking and time consuming, but it is very important that you take the time do to this for all models.

D: Correct. It is critical that you take the time to validate as well as list the assumptions that have gone into a model.

(See page 65 of the course material.)

2. A: Incorrect. If you avoid moving files, you may prevent links from breaking, but the other answer choices are also correct.

B: Incorrect. If a link does break, one solution would be to use the Edit Links feature to fix the problem. There are other possible solutions, so all of the above is the correct answer.

C: Incorrect. There are numerous solutions to fixing a broken link, and using named ranges to minimize the number of formulas to fix when a link does break is just one solution; therefore, all of the above is the correct answer.

D: Correct. Avoiding moving files, using the Edit Links feature, and using named ranges are all solutions that can be employed in order to solve the problem of broken links.

(See page 70 of the course material.)

3. A: Correct. If you are attempting to calculate a percentage in a column and one of the entry fields contain a 0, you will get the #DIV/0! error.

B: Incorrect. If the criteria you have entered does not exist in the data, a #N/A error will appear, not a #DIV/0! error.

C: Incorrect. The #DIV/0! will not occur if a calculation produces a negative number. The #DIV/0! error occurs when you are calculating a percentage and one of the fields contains a 0.

D: Incorrect. The #DIV/0! error occurs when you are calculating a percentage and one of the fields contains a 0.

(See page 75 of the course material.)
4. A: Incorrect. As soon as a circular reference occurs, a warning sign will appear. In order to fix the circular reference, you need to stop and delete the last thing you did.

B: Incorrect. Circular references often occur when the sum range includes the sum itself.

C: Incorrect. You may want to keep a circular reference within a model when you are calculating interest payments on a profit-loss statement. This is because interest payments are an input to profit, the profit impacts the cash needed for funding, and funding impacts interest rate, therefore creating a circular reference.

D: Correct. If your formula tries to refer to itself, calculations may not work or the formulas will not calculate properly. You cannot rely on models containing circular references.

(See pages 75 to 77 of the course material.)
Chapter 5: Using Excel in Financial Modelling

In this chapter, we take a look at some of the practical tools, functions, and formulas commonly used in financial modelling in Excel.

FORMULAS AND FUNCTIONS IN EXCEL

Excel contains over 300 different formula codes, called functions. The most commonly known function is the SUM, used to total a range of cells. Most Excel users only use a very small percentage of the available functions, and many of them are irrelevant for use in finance and financial modelling. It is impossible to go over all of them, but here we will cover the ones that are going to be the most useful in using Excel for business analysis.

In most cases, you will find it easiest to use the Function Wizard, accessible via the Insert Function button on the Formula tab. See Figures 5.1 and 5.2.

FIGURE 5.1 Function Wizard
Note that the Function Wizard is called the Formula Builder in Excel for Mac 2011; however we will refer to it as the Function Wizard in future for simplicity.

It’s fair to say that some Excel users are guilty of using Excel as a fancy calculator! If so, you’d be just using a formula in Excel, such as =A1+A2 or =452*12.

There are, however, pre-defined formulas in Excel such as IF, SUM, VLOOKUP, INDEX (and several hundred more). These are referred to as functions.

So, you could write a formula containing a function, like =MAX(A1:B20), or you could just write a simple formula that does not contain a function, like =A1/A2. Many of us use the words formula and function interchangeably, but it’s nice to know the difference!

Because there are hundreds of functions in Excel, you should familiarise yourself with as many as possible, so that you know what is available.
For use in business analysis, the most useful functions fall into the categories of logical, aggregation, lookup, and financial. The most commonly used functions in financial modelling are listed here:

- **Logical** functions (IF, AND, etc.) are used when you need to evaluate a condition. For example: “Shall we include tax in our calculation?” If the user enters yes, the calculation will include the tax; if no, it is excluded.

- **Aggregation** functions (SUMIF, COUNTIF, etc.) are helpful when there is a lot of data arranged either vertically or horizontally that must be added together.

- **Lookup** functions (HLOOKUP, VLOOKUP, etc.) are used when you need to look up a value to return a single amount.

- **Financial** functions (NPV, IRR, PMT, etc.) can usually be created manually using a long and complicated formula, but the pre-defined function in Excel saves time and makes it much easier to calculate commonly used financial calculations such as net present value, interest payments, or depreciation amounts.

There is a bit more to choosing the right function, however, than simply knowing lots and lots of functions in Excel. Choose the simplest formula to perform the task you need it to do. Choose one that is not overly complicated and don’t try to do too much in one cell. If it starts getting difficult to decipher, consider breaking the formula into several parts. See “How Long Should a Formula Be?” in Chapter 4 for an example of this.

As with most tools in financial modelling, you should choose the simplest option – not because you don’t know how to do a more sophisticated function, but because you want to make the model as clear, simple, and transparent as possible. However, you still need to arm yourself with as many different functions as possible. The more you know, the more options you have available to you, and the more likely you are to find the best solution.

For example, Figure 5.3 shows the calculation of a compound growth rate when escalating the starting sales number by 5 percent to the power of the year. In order to do this, we’ve had to insert a helper row to link to. This makes the formula easier to follow, but a helper row is distracting and makes the model look messy, so it needs to be hidden. The entire row cannot be hidden in this instance, so we’d probably change the font to a pale grey to make it less distracting.

**FIGURE 5.3 Compounding Growth Calculation Using a Helper Row**

Alternatively, we can achieve the same result without the helper row by calculating it all in one cell. Instead of inserting 1, 2, 3, and so on across the top, we can do the entire calculation in one cell by looking at the difference between the years; in this case, 2010 minus 2010 equals zero, and 2011 minus 2010 equals one, and so on. See Figure 5.4.
FIGURE 5.4 Compounding Growth Calculation without a Helper Row

Using the second method, the value 1 in the helper row has been replaced by the formula \((C9-B89)\). This makes the second formula more difficult to follow, but the model is less cluttered.

This is an example of how a modeller needs to strike the balance between having a streamlined model, yet formulas that are easy to follow. Either of these methods would be perfectly acceptable, but as this is not a terribly long or complicated formula, the second option is probably preferable because it avoids the addition of a potentially confusing helper row.

EXCEL VERSIONS

There are currently several different versions of Excel available in Microsoft Windows that modellers are likely to be using. Although Excel 2003 has not been sold by Microsoft for many years, it is still used by a surprising number of business users. This is because of the huge change between Office 2003 and later versions. If you, your entire company, and all your clients are using Excel 2007 or later, this will probably not affect you as a financial modeller, but if you are working with other people using different versions, then you need to consider the version capabilities when building your models.

For detailed explanations of the changes between versions and how they impact model building, please see [www.wiley.com/go/steinfairhurst](http://www.wiley.com/go/steinfairhurst) to download supplementary material in PDF format. This section also discusses the difference between using Windows and Mac for financial modelling.

This course assumes you are using one of the later versions of Excel in either Windows or Mac, but for those using Excel 2003, detailed instructions are also available on the companion website.

HANDY EXCEL SHORTCUTS

Working in Excel – particularly for the purpose of financial modelling – can be very time-consuming, and increasing your speed and accuracy will increase productivity significantly. Excel users just starting out with using Excel would be very comfortable with using the mouse for navigation and editing purposes. However, with growing familiarity, the mouse is not the fastest or most efficient way of modelling. Excel offers a lot of shortcuts to tackle this problem, and as you become faster, you will find them very handy.
There are many advantages of using Excel shortcuts:

- **Ease of use:** Whilst intuitively it may seem like a mouse is the more comfortable option, it is a lot more comfortable for your wrist, arm, and shoulders to punch the keys on the keyboard than trying to align the cursor on the screen.
- **Easier on the body:** Given the natural placement of keyboard and mouse on any desktop, using the keyboard more often is less stressful on the body. Using the mouse constantly can cause stress on the wrists and shoulders. With the mouse most users typically end up using just the wrists and index finger, which can cause fatigue and long-term problems.
- **Speed of execution:** Keystrokes are much faster than the mouse. To put this to test, try creating a new worksheet in Excel using the mouse by clicking on File (or the Microsoft Button in Excel 2007), then New – Blank Workbook. Alternatively try the shortcut CTRL-N. There is a distinct improvement in speed with keystrokes over the mouse click.
- **Standard shortcuts:** Within the Windows environment, you will find that similar functions have the same shortcuts, so the expertise you develop can be applied to programs other than Excel. The shortcuts in Excel are generally common across all other office suites and even other applications like browsers, Notepad, Paintbrush, and others.
- **No other choice:** There are some functions for which shortcuts are necessary to get the desired results, unless you want to insert manual edits. For example, when creating an array formula, the Control-Shift-Enter shortcut is the only way to get your array formula to insert correctly.

**Windows Shortcuts**

Table 5.1 is a small selection of some of the most common and particularly useful shortcuts that are invaluable when using Excel for financial modelling. Note that a printable list of these shortcuts is also available at www.wiley.com/go/steinfairhurst.

TABLE 5.1 Useful Windows Keyboard Shortcuts for Financial Modellers

<table>
<thead>
<tr>
<th>Editing</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+S</td>
<td>Save workbook</td>
</tr>
<tr>
<td>CTRL+C</td>
<td>Copy</td>
</tr>
<tr>
<td>CTRL+V</td>
<td>Paste</td>
</tr>
<tr>
<td>CTRL+X</td>
<td>Cut</td>
</tr>
<tr>
<td>CTRL+Z</td>
<td>Undo</td>
</tr>
<tr>
<td>CTRL+Y</td>
<td>Redo</td>
</tr>
<tr>
<td>CTRL+A</td>
<td>Select all</td>
</tr>
<tr>
<td>CTRL+R</td>
<td>Copies the far left cell across the range*</td>
</tr>
<tr>
<td>CTRL+D</td>
<td>Copies the top cell down the range*</td>
</tr>
<tr>
<td>CTRL+B</td>
<td>Bold</td>
</tr>
<tr>
<td>ALT+TAB</td>
<td>Switch program</td>
</tr>
<tr>
<td>ALT+F4</td>
<td>Close program</td>
</tr>
<tr>
<td>CTRL+N</td>
<td>New workbook</td>
</tr>
<tr>
<td>SHIFT+F11</td>
<td>New worksheet</td>
</tr>
<tr>
<td>Command</td>
<td>Action</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td>CTRL+W</td>
<td>Close worksheet*</td>
</tr>
<tr>
<td>ALT+E+L</td>
<td>Delete a sheet*</td>
</tr>
<tr>
<td>CTRL+TAB</td>
<td>Switch workbooks</td>
</tr>
</tbody>
</table>

**Navigating**

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+9</td>
<td>Hide row</td>
</tr>
<tr>
<td>SHIFT+CTRL+9</td>
<td>Unhide row</td>
</tr>
<tr>
<td>SHIFT+Spacebar</td>
<td>Highlight row</td>
</tr>
<tr>
<td>CTRL+Spacebar</td>
<td>Highlight column</td>
</tr>
<tr>
<td>CTRL+Minus sign</td>
<td>Delete selected cells</td>
</tr>
<tr>
<td>Arrow keys</td>
<td>Move to new cells</td>
</tr>
<tr>
<td>CTRL+Pg Up/Down</td>
<td>Switch worksheets</td>
</tr>
<tr>
<td>CTRL+Arrow keys</td>
<td>Go to end of continuous range and select a cell</td>
</tr>
<tr>
<td>SHIFT+Arrow keys</td>
<td>Select range</td>
</tr>
<tr>
<td>SHIFT+CTRL+Arrow</td>
<td>Select continuous range</td>
</tr>
<tr>
<td>Home</td>
<td>Move to beginning of line</td>
</tr>
<tr>
<td>CTRL+Home</td>
<td>Move to cell &quot;A1&quot;</td>
</tr>
<tr>
<td>SHIFT+ENTER</td>
<td>Move to cell above</td>
</tr>
<tr>
<td>TAB</td>
<td>Move to cell to the right</td>
</tr>
<tr>
<td>SHIFT+TAB</td>
<td>Move to cell to the left</td>
</tr>
<tr>
<td>ALT+Down arrow</td>
<td>Display a drop-down list</td>
</tr>
</tbody>
</table>

**Formatting**

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>CTRL+1</td>
<td>Format box</td>
</tr>
<tr>
<td>ALT+H+0</td>
<td>Increase decimal*</td>
</tr>
<tr>
<td>ALT+H+9</td>
<td>Decrease decimal*</td>
</tr>
<tr>
<td>SHIFT+CTRL+B</td>
<td>General format</td>
</tr>
<tr>
<td>SHIFT+CTRL+!</td>
<td>Number format</td>
</tr>
<tr>
<td>SHIFT+CTRL+#</td>
<td>Date format</td>
</tr>
<tr>
<td>SHIFT+CTRL+$</td>
<td>Currency format</td>
</tr>
<tr>
<td>SHIFT+CTRL+%</td>
<td>Percentage format</td>
</tr>
</tbody>
</table>

**In Formulas**

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>F2</td>
<td>Edit formula, showing precedent cells</td>
</tr>
<tr>
<td>CTRL+’</td>
<td>Edit formula, showing precedent cells (same as F2)</td>
</tr>
<tr>
<td>ALT+ENTER</td>
<td>Start new line in same cell</td>
</tr>
<tr>
<td>SHIFT+Arrow</td>
<td>Highlight within cells</td>
</tr>
<tr>
<td>F4</td>
<td>Change absolute referencing (&quot;$&quot;)</td>
</tr>
<tr>
<td>ESC</td>
<td>Cancel a cell entry</td>
</tr>
<tr>
<td>= (equals sign)</td>
<td>Start a formula</td>
</tr>
<tr>
<td>ALT+“=”</td>
<td>Sum selected cells</td>
</tr>
<tr>
<td>CTRL+’</td>
<td>Copy formula from above cell</td>
</tr>
<tr>
<td>CTRL+B</td>
<td>Show formulas or values</td>
</tr>
<tr>
<td>F9</td>
<td>Recalculate all workbooks</td>
</tr>
</tbody>
</table>
Mac Shortcuts

Almost all of the keyboard shortcuts that are available for Windows are available on the Mac as well. If you are new to the Mac, remember that in most cases, Command replaces Control, and Option replaces Alt. See Table 5.2.

**TABLE 5.2 Useful Mac Keyboard Shortcuts for Financial Modellers**

<table>
<thead>
<tr>
<th>Editing</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>COMMAND+S</td>
<td>Save workbook</td>
</tr>
<tr>
<td>COMMAND+C</td>
<td>Copy</td>
</tr>
<tr>
<td>COMMAND+V</td>
<td>Paste</td>
</tr>
<tr>
<td>COMMAND+X</td>
<td>Cut</td>
</tr>
<tr>
<td>COMMAND+Z</td>
<td>Undo</td>
</tr>
<tr>
<td>COMMAND+Y</td>
<td>Redo</td>
</tr>
<tr>
<td>COMMAND+A</td>
<td>Select all in an area</td>
</tr>
<tr>
<td>COMMAND+A twice</td>
<td>Select all data on the sheet</td>
</tr>
<tr>
<td>COMMAND+B</td>
<td>Bold</td>
</tr>
<tr>
<td>COMMAND+TAB</td>
<td>Switch program</td>
</tr>
<tr>
<td>COMMAND+Q</td>
<td>Close program</td>
</tr>
<tr>
<td>COMMAND+N</td>
<td>New workbook</td>
</tr>
<tr>
<td>SHIFT+F11</td>
<td>New worksheet</td>
</tr>
<tr>
<td>COMMAND+TAB</td>
<td>Switch workbooks</td>
</tr>
<tr>
<td>COMMAND+page up</td>
<td>Select next worksheet to the right</td>
</tr>
<tr>
<td>COMMAND+page down</td>
<td>Select next worksheet to the left</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Navigating</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTROL+9</td>
<td>Hide row</td>
</tr>
<tr>
<td>SHIFT+CONTROL+9</td>
<td>Unhide row</td>
</tr>
<tr>
<td>SHIFT+Spacebar</td>
<td>Highlight row</td>
</tr>
<tr>
<td>CONTROL+Spacebar</td>
<td>Highlight column</td>
</tr>
<tr>
<td>CONTROL+Minus sign</td>
<td>Delete selected cells</td>
</tr>
</tbody>
</table>
A few of the keyboard shortcuts found in Excel for Windows are unavailable for Mac (as noted in Table 5.1). These, however, may be created manually by selecting Tools > Customize Keyboard.
BASIC EXCEL FUNCTIONS

Now that we understand the basics of formulas and functions in Excel, it is time to start looking at some of the basic Excel functions. With financial modelling – or any other use for Excel for that matter – it is highly unlikely that the entire range of Excel functions will get used. However, the more functions we know, the better equipped we are to translate our business logic into a highly functional, dynamic, and robust financial model.

There are some common basic functions that are used frequently, and understanding them is important for any modeller. Some of the basic mathematical functions included in the Excel suite are: SUM( ), MAX( ), MIN( ), COUNT( ), and AVERAGE( ). The function names are indicative of the functions they perform.

SUM( )

This function is used to sum up a series of numbers. You can add individual cells, by separating them with commas, and you can also specify a range of cells. In Figure 5.5 we have the sum of total sales at a fashion store.

FIGURE 5.5 Using the SUM Function

Note: You can use ranges as well as numbers in the SUM( ) function; just separate each entry by a comma.

TIP: Place the cursor at the end of the series of numbers you want to sum and click on the AutoSum button under the Editing section of Home tab. The AutoSum button is found in the Function section of the Formula tab in Excel for Mac 2011. See Figure 5.6.
Also, try using the ALT + = shortcut instead of clicking the mouse. Note that this shortcut is Command + Shift + T in Excel for Mac 2011.

**MAX( )**

This function helps identify the maximum value. The syntax for this function is very similar to `SUM( )`; you can enter a range of cells, individual cells separated by commas, or a combination of both. This function will return an error if the arguments have some text that cannot be converted appropriately. Similarly, if the arguments do not have any numbers, the function returns 0. See Figure 5.7.

**FIGURE 5.7 Using the MAX Function**
MIN( )

This function is the inverse of the MAX( ) function. It gives the least value in the list. Even this function can use any combination of ranged series and individual cells. The limitations on inputs and the results are similar to the MAX( ) function. See Figure 5.8.

FIGURE 5.8 Using the MIN Function

COUNT( )

The COUNT( ) function counts the total number of entries in a series. Like with all other basic functions, you can count items in a series as well as individual cells. This function only counts the numerical values and not the logical and text expressions. Logical expressions entered directly into the formula do get counted, though. See Figure 5.9.

FIGURE 5.9 Using the COUNT Function
AVERAGE( )

As the name suggests, this function calculates the average of the numbers in the list. AVERAGE is a very useful function in certain financial models and this function can be invaluable in such models.

**TIP:** It is important to note that AVERAGE function only counts the cells with values. Make sure that your model recognises the difference between no value and zero. The AVERAGE function will count the cells with value 0 but it will ignore the empty cells. If your model does not identify this difference, the AVERAGE function will return incorrect values. See Figure 5.10.

**FIGURE 5.10 Using the AVERAGE Function**

Combining Basic Functions

These basic functions can be used individually to calculate the respective results, but they can also be used in combination for various calculations. For example, if you want to find the maximum deviation (or range of values) in the values you could subtract the maximum and minimum value. So you would have a formula like =MAX(B2:B8)-MIN(B2:B8). See Figure 5.11.
LOGICAL FUNCTIONS

Logical functions, particularly IF statements, are very commonly used in financial models because they allow the user to turn on and off certain calculations, and create scenarios and certain conditions or thresholds for calculations to maintain.

IF Statement

The IF statement takes three fields (called arguments):

Where:
Field 1 = the logical expression that is evaluated.
Field 2 = the result if argument 1 is true.
Field 3 = the result if argument 1 is false.

The syntax therefore looks like this:

\[ \text{=IF(}\text{statement being tested, value if true, value if false}\text{)} \]

The first field consists of a logical expression (i.e., something that, when evaluated, is either TRUE or FALSE). The expression in the first argument is evaluated. If it is TRUE, then the IF statement returns the value of the second argument. If it is FALSE, the IF statement returns the value of the third argument.

Consider the following example:

\[ \text{=IF(}6>5, "greater", "less than"\text{)} \]
The statement being tested is true so the “greater” value is returned. Consider another example:

\[ =\text{IF}(4>5, "greater","less\ than") \]

The first expression is false so the “less than” value is returned.

IF statements can also be nested, meaning that it is possible to have an IF statement inside another IF statement. See the “Nesting” section in this chapter for further information.

For example:

\[ =\text{IF}(6>5,\text{IF}(11>10, "both","second"), "first") \]

The first argument is TRUE so the second argument is then evaluated. Because the second argument is also true, it returns its second argument. Hence the result for this formula is both.

Test this formula in Excel and enter criteria in the first argument such that it returns second and first.

**Tip:** Highlight a section of the formula that makes sense in its own right and hit F9. This will show you the result of the logic test. Be sure to hit ESCAPE, not ENTER afterward; otherwise the result will be pasted as text. Note that this option is not available in Excel for Mac 2011.

**AND Statement**

The AND statement can take up to 30 logical arguments. It returns TRUE only if all the logical expressions are TRUE.

For example:

\[ =\text{AND}(2\leq3,4<5) \]

Both of these arguments are true, so the result of the formula will be TRUE.

For example:

\[ =\text{AND}(2\leq3,4<3) \]

Only one of these arguments is true, so the result of the formula will be FALSE. The AND statement is most commonly used in conjunction with IF.

For example:

\[ =\text{IF}(\text{AND}(2<3,4<5), "A", "B") \]

Only if both of the arguments are true will the second argument be returned. If one or both are false, then the third will be returned.

The result of this formula is A, because both AND arguments are TRUE.
OR Statement

The OR statement is very similar to the AND statement except that either argument can be true, rather than both.

For example:

\[ \text{AND}(2<3, 4<3) \text{ is FALSE because only one of these arguments is true.} \]

However,

\[ \text{OR}(2<3, 4<3) \text{ is TRUE because any one of these arguments is true.} \]

NESTING: COMBINING SIMPLE FUNCTIONS TO CREATE COMPLEX FORMULAS

Excel allows you to include more than one function in a formula. For example, you can add two totals using the formula:

\[ =\text{SUM}(A1:A2)+\text{SUM}(B1:B2) \]

But this does not make it a nested formula.

A nested formula is one in which a function is included in the argument of another function. This technique allows you to build more complex formulas. Arguments appear in brackets after the function. Some functions require several arguments; some require only one. An argument can be a number, a reference, or text (usually in inverted commas). If a formula has more than one argument they will be separated by commas.

Some examples follow. This formula has one argument, a reference:

\[ =\text{SUM}(A3:A23) \]

This formula has three arguments: a reference, text, and another reference:

\[ =\text{SUMIF}(A1:A10, "Product A", B1:B10) \]

Finally, we have an example of a nested function, containing another function in an argument. This one calculates the average of two totals:

\[ =\text{AVERAGE}(\text{SUM}(A3:A23), \text{SUM}(D3:D23)) \]

Nested IF Functions

A nested function is basically a function within a function, and the IF statement is probably most commonly used as a nested function.

The IF function can normally be used to test a cell and perform two different actions depending on the outcome of the test. But by nesting another IF function inside an IF function, you can test a cell and perform three different actions depending on the outcome of the tests. You can actually nest up to seven functions within a formula, so you could actually perform up to seven different actions, depending on the result of the test. (This is not very good modelling practice, however!)

The basic IF formula takes the form: \[ =\text{IF}(\text{condition to test, action if true, action if false}) \]
When using most functions, we recommend the use of the Function Wizard, however, the Function Wizard does not work with nested formulas, and therefore you need to know the syntax of the formula before attempting to nest. Because an IF statement is one that is very commonly nested, it is important that you know the IF function syntax.

Let’s take a look at a practical example of a useful nested IF formula. See the volume pricing table in Figure 5.12.

**FIGURE 5.12 Volume Pricing Table**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Items</td>
<td>Price per Item</td>
<td>Total Price</td>
</tr>
<tr>
<td>63</td>
<td>$10.50</td>
<td>$662</td>
</tr>
</tbody>
</table>

If you have 63 items, you can see that they would be $10.50 each. If you want to create an automatic calculation for this, you’d need to create a nested formula.

1. Start with a basic IF statement. If your volume is less than or equal to five, the price is $15; otherwise it’s $12 (for now). So your formula in cell B8 would be =IF(A8<=B3,C3,C4).
2. Once we’ve got this working, we can make it more complicated. In another cell, say B10, let’s do another formula, which will deal with the value if it is greater than five. Create the formula =IF(A8<=B4,C4,C5) in cell B10.
3. Once we’ve got both of these working, you can add them together. Go into the formula in cell B10, and copy the whole formula except for the equal sign using a Control + C shortcut. (Note that this shortcut is Command + C in Excel for Mac.) See Figure 5.13.

**FIGURE 5.13 IF Function in the Formula Bar**
1. Now go back to your formula in cell B8, and replace the C3 with the formula you have copied onto the clipboard. Your entire formula in cell B8 should now be = IF (A8>=B3,IF(A8<=B4,C4,C5),C3).

2. Multiply your price by the volume in cell C8 so we know the total.

3. Your sheet should look something like the sheet shown in Figure 5.14.

FIGURE 5.14 Completed Nested IF Function

So the following rules will apply in this formula in cell B8:

- If cell A8 is less than or equal to 5, the price is $15 each.
- If cell A8 is less than or equal to 50, the price is $12 each.
- If cell A8 is less than or equal to 150, the price is $10.50 each.

Thus, the formula tests cell A1 to see if it is greater than or equal to five. If it is less than five, the formula will stop there and return the first value if true. If it is greater than five, however, it is then tested again to see if it is greater than or equal to 50. If it is, it will stop there and return the second value if true. If it is greater than five and greater than 50, only then will it return the value if false.

Note that a nested IF statement is an appropriate formula to use in this situation. However, if there were more than three pricing steps in the table, it is recommended that you use a close match VLOOKUP or LOOKUP function instead as this is a much simpler function than nesting multiple IF statements. (See the section “Building a Tiering Table” in Chapter 9 for how to do this.) Basically, if you find yourself including more than two or three IF statements in a formula, consider whether the formula should be broken into several steps, or whether an alternative, simpler function should be used instead.
CELL REFERENCING BEST PRACTICES

Formula consistency is critical for fundamental best practice both in financial modelling and any other sort of analysis using Excel, for that matter. In order to have consistent formulas across and down the block of data, you need to understand how cell referencing works. Whilst this is a very basic feature of Excel that is taught in introductory Excel courses, it is surprising how many modellers don’t understand its importance.

The $ sign in a cell referencing tells Excel how to treat your references when you copy the cell. If there is a dollar sign in front of a row number or column letter, the row or column does not change when you copy it. Otherwise, it does change.

Relative and Absolute Referencing

Cell references are relative, by default. This means that when you copy the cell, it will change. In Figure 5.15, if cell B3 is copied down, the reference =B2 will change to =B3 and so on, down the row.

FIGURE 5.15 Relative Cell Referencing

However if you want the formula to anchor itself to cell B2, you’d need to use absolute referencing. For example, if you wanted to calculate the price below of $450 at various numbers of units, you’d need to anchor the cell reference to the price as shown. This means that when you copy the formula down, the reference to cell A3 is relative, and changes to A4, A5, or wherever you paste it, but $B$2 remains anchored to cell B2 because it is an absolute reference.
Mixed Referencing

To illustrate further, suppose the following formulas are in cell B3 and you copy them to cell B4.

Here are the results in each case:

- \( =B2 \) copies as: \( =B3 \)
- \( =$B$2 \) copies as: \( =$B$2 \)
- \( =B$2 \) copies as: \( =B$2 \)
- \( =$B2 \) copies as: \( =$B3 \)

The $ sign anchors a row number or column letter when you copy it. You can anchor both the column and row (this is absolute referencing), or you can anchor one or the other (called mixed referencing).

In summary:

- \( =B2 \) is relative referencing.
- \( =$B2 \) or \( =B$2 \) is mixed referencing.
- \( =$B$2 \) is absolute referencing.

**Tip:** A quick way to fix a reference is to enter a reference like \( =B3 \) and then tap the F4 key. Note that this shortcut is Command + T in Excel for Mac. Each time you hit F4, Excel cycles to another option. To illustrate:

- \( =B2 \)  
  tap F4 to get:  
  \( =$B$2 \)
- \( =$B$2 \)  
  tap F4 to get:  
  \( =B$2 \)
- \( =B$2 \)  
  tap F4 to get:  
  \( =$B2 \)
- \( =$B2 \)  
  tap F4 to get:  
  \( =B2 \)
  and so on...

Mixed Referencing Exercise

1. Type the following table into a blank Excel worksheet. See Figure 5.17.

**FIGURE 5.17 Mixed Cell Referencing Exercise**

2. In cell B2, create a formula, using absolute referencing, that can be dragged across and down the entire block to cell D4 in one action (without editing). Spend a few minutes on this before turning the page. Note that understanding mixed cell referencing is critical for good financial modelling practice and so it’s important to understand this. The fewer unique formulas in your model the better!

3. Your formula should look like the formula in Figure 5.18.
NAMED RANGES

Excel allows you to select a single cell, or a range of cells, and give it a name. You can then use the name to move to the cells and select them, or include them in a formula.

In Figure 5.19, we have used an absolute reference to anchor our formula to the consistent price of $450.

FIGURE 5.19 Absolute Reference in a Formula

This cell is called B2, and this won’t change; however, we can also change the name of it to something else.

Why Use a Named Range?

Those new to named ranges sometimes struggle to see the benefits of including them in models. It’s true that most of the time named ranges are not entirely necessary, but there are some good reasons to use named ranges when building a model:

- **It makes your formulas easier to follow.** A formula containing lots of cell references can be confusing to look at and difficult to edit. But if the cell references are replaced by a range name it becomes much easier to understand.

  For example, the formula \( \text{SUM(B3:B24)} - \text{SUM(F3:F13)} \) could be expressed as \( \text{=TotalIncome-TotalExpenditure} \).
HOW TO CREATE A NAMED RANGE

1. Select the cell, in this example B2.
2. Go to the Name box in the top left-hand corner. See Figure 5.20.

FIGURE 5.20 The Name Box

3. Type over the name and call it something else, like **Price**, and press Enter.

Note that the name must not contain any spaces or special characters. For instance, if you want to call it **Year 1 Price**, you’d need to call it **Year1Price** or **Year1_Price**.

Named ranges don’t necessarily need to be confined to only a single cell; you can also create named ranges for an entire range of cells, and these can be used in formulas. Simply highlight the range instead of a single cell, and type over the name as shown above.

- **They don’t need absolute referencing.** By default, a named range is an absolute reference, so you don’t need to add any in.
- **Macros.** You can also use ranges in writing visual basic code.
- **Drop-down lists with off-sheet sources.** You won’t be able to create drop-down boxes with dynamic sources unless you use a named range. (See the section on “Using Validations to Create a Drop-Down List” in Chapter 7 for a practical example of this.)
- **Linking to external files.** It’s best practice to use named ranges when linking to external files. This means that when the source file changes, the data linking to it will automatically update.
Finding, Using, Editing, and Deleting Named Ranges

Clicking on the drop-down arrow next to the name will show all the defined names in the workbook (as shown in Figure 5.21). Clicking on the name will take you directly to the cell(s).

**FIGURE 5.21 Finding a Named Range Using the Name Box**

Excel will then move to and select the range. It does not matter what sheet you are in when you select the name. This can make finding your way around the named ranges in a model much faster.

Having created a range name, you can now use that name in a formula instead of cell references. For example, if you have created the range name called `TotalIncome` for the cell containing the total income result, and a range name `TotalExpenditure` for cell containing the total expenditure result, you can create a formula `=TotalIncome-TotalExpenditure` (just by typing this text into a cell).

Another example: If you have created the range name `Costs` for all the cells in a column containing your costs data, you can calculate the total costs using the formula `=Sum(Costs)`.

A cell does not need to be an input field in order to assign a name to it, although it often is in financial models. The cell can also contain a formula as well as a hard-coded input value.
Named ranges can be useful, but it’s not good practice to have too many. They can be confusing, especially if you have not used a consistent naming methodology. It’s also quite easy to accidentally name the same cell twice. So in order to keep names neat and tidy, you might need to edit or delete them.

Also, if you have added more data to a spreadsheet, and a range name no longer expresses the correct range of cells, you can redefine the named range.

**HOW TO EDIT OR DELETE A NAMED RANGE**

On the Formula tab, in the Defined Names group, click on the Name Manager. Here you can add, edit, or delete existing named ranges. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

In Excel 2011 for Mac, go to Insert – Name – Define.

The only difference between Excel 07/10 and 2003 in this instance is that you can add comments to named ranges in 07/10. Also, it is called a Name Manager in 07/10, but otherwise works in exactly the same way as it did in 2003 and still does in Excel 2011 for Mac.

**SUMMARY**

This chapter introduced the more basic tools and functions that are commonly used in financial modelling, such as basic functions, cell referencing, and named ranges. We also covered functions, such as IF, SUM, AVERAGE, and nesting these, as well as useful shortcuts that will make your model-building faster and more accurate. The fundamental techniques of using cell referencing for best practice as well as the use of named ranges are the critical basic knowledge required for financial modellers before moving on to more advanced tools. The Windows and Mac shortcuts named here will also prove invaluable to increasing your speed, productivity, and accuracy as a financial modeller.
Chapter 5 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Which of the following is a logical function in Excel:
   a) IF
   b) SUMIF
   c) COUNTIF
   d) HLOOKUP

2. Which of the following is the Windows keyboard shortcut for tracing immediate precedents:
   a) ALT+M+P
   b) ALT+M+D
   c) ALT+M+A+A
   d) CTRL+[ ]

3. Which of the following is the Mac keyboard shortcut for starting a new line in the same cell:
   a) CONTROL+U
   b) CONTROL+OPTION+RETURN
   c) SHIFT+Arrow
   d) COMMAND+SHIFT+T

4. By default, cell references are:
   a) relative
   b) absolute
   c) circular
   d) either a or b
Chapter 5 – Solutions and Suggested Responses

1. **A: Correct.** The IF function is a logical function that is typically used to test a cell and perform two different actions. It produces a value that tests if the condition is true or the condition is false.

   B: Incorrect. SUMIF is an aggregation function that can be used when there is a lot of data arranged either vertically or horizontally that needs to be added together.

   C: Incorrect. COUNTIF is an aggregation function that can be used when there is a lot of data arranged either vertically or horizontally that needs to be added together.

   D: Incorrect. HLOOKUP is a lookup function that is used to look up a value to return a single amount.

   (See page 85 of the course material.)

2. **A: Correct.** ALT+M+P is the Windows keyboard shortcut for tracing immediate precedents.

   B: Incorrect. ALT+M+D is the Windows keyboard shortcut for tracing immediate dependents.

   C: Incorrect. ALT+M+A+A is the Windows keyboard shortcut for removing tracing rows.

   D: Incorrect. CTRL+[ is the Windows keyboard shortcut for highlighting precedent cells.

   (See page 89 of the course material.)

3. A: Incorrect. CONTROL+U is the MAC keyboard shortcut that allows you to edit a formula.

   **B: Correct.** CONTROL+OPTION+RETURN is the MAC keyboard shortcut for starting a new line in the same cell.

   C: Incorrect. SHIFT+Arrow is the MAC keyboard shortcut used to highlight within a cell.

   D: Incorrect. COMMAND+SHIFT+T is the MAC keyboard shortcut used to sum the selected cells.

   (See page 90 of the course material.)
4. **A: Correct.** Cell references are only relative by default. When you copy a cell, it will change.

   B: Incorrect. Cell references are only relative by default. If you want a formula to anchor itself to a cell and you do not want a cell to change when copied, you would need to use absolute referencing.

   C: Incorrect. A circular reference occurs when a formula is trying to refer to itself. Cell references are not circular by default.

   D: Incorrect. Cell references are only relative, not absolute, by default.

   (See page 100 of the course material.)
Chapter 6: Functions for Financial Modelling

In this chapter, we will introduce the most useful functions commonly used in financial modelling. Whilst there are hundreds of functions that can be used in a model, I have attempted to only list the ones you are most likely to come across, and that you will find most useful when building models. Please don’t stop here, though! There are many more wonderful Excel functions that you will find useful in your financial modelling and business analysis.

AGGREGATION FUNCTIONS

COUNTIF, SUMIF, COUNTIFS, and SUMIFS are very handy functions to know for modelling. They add or count ranges of data.

COUNTIF

COUNTIF is used to count the cells that match specified criteria.

For example, let’s say you have sold $497 worth of different products on a particular day, as shown in Figure 6.1.

FIGURE 6.1 Sales List

![Figure 6.1 Sales List](image)

You’d like to know how many (in terms of number of products) you’ve sold of each product: books, CDs, and DVDs.

1. In range A15:A17, type the words Book, CD, and DVD.
2. In cell B15, use the Formula Wizard and find the COUNTIF function or, if you prefer, simply begin typing `=COUNTIF(`.
3. If you are using the Formula Wizard, it should look like Figure 6.2.
4. Press OK. The answer is 4. Your formula should be $=\text{COUNTIF}(B2:B10,A15)$.
5. Change your formula to use absolute referencing as follows: $=\text{COUNTIF}(SB2:SB10,A15)$ and copy the formula down the range. You don’t want absolute referencing on the criteria, because it needs to change its row references to CD and DVD as you copy down the formula.

(As a shortcut, highlighting B2:B10 in the formula bar and pressing F4 (Command + T in Excel for Mac 2011) will set absolute references $SB2:SB10$. Each time you press F4 (Command + T in Excel for Mac 2011) Excel will modify the referencing until you are back to square one.

6. Add a total, and some titles. Your sheet should now look something like Figure 6.3.

**FIGURE 6.3 Completed COUNTIF Function**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Customer</td>
<td>Product</td>
</tr>
<tr>
<td>2</td>
<td>Lim</td>
<td>DVD</td>
</tr>
<tr>
<td>3</td>
<td>Jenny</td>
<td>CD</td>
</tr>
<tr>
<td>4</td>
<td>Faisal</td>
<td>Book</td>
</tr>
<tr>
<td>5</td>
<td>Lim</td>
<td>Book</td>
</tr>
<tr>
<td>6</td>
<td>Jenny</td>
<td>Book</td>
</tr>
<tr>
<td>7</td>
<td>Faisal</td>
<td>DVD</td>
</tr>
<tr>
<td>8</td>
<td>Lim</td>
<td>Book</td>
</tr>
<tr>
<td>9</td>
<td>Jenny</td>
<td>CD</td>
</tr>
<tr>
<td>10</td>
<td>Faisal</td>
<td>DVD</td>
</tr>
<tr>
<td></td>
<td>Total</td>
<td></td>
</tr>
</tbody>
</table>

Summary

<table>
<thead>
<tr>
<th></th>
<th>Number</th>
<th>Sales $</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Book</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>CD</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>DVD</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>Total</td>
<td></td>
</tr>
</tbody>
</table>
SUMIF

SUMIF is similar to COUNTIF but it sums rather than counts the values of cells in a range that meet a given criteria. SUMIF can be used in place of a pivot table, and doing so is preferable as it uses less memory, and (most importantly) because SUMIF formulas are live links. Pivot tables do not update automatically, which can cause errors in models if not refreshed correctly. Therefore pivot tables are only used where necessary in financial modelling.

1. Let’s say that you’d like to know how much (in terms of dollar value) you’ve sold of each product: books, CDs, and DVDs.
2. Select cell C15. Find the SUMIF wizard or start typing =SUMIF. Because there are several fields required for this function, I’d recommend you use the wizard, as it’s easier to find your way through the function.
3. The items you are adding together go in the Range field, the criteria you are looking for in that range goes in the Criteria field, and the numbers you want to sum together go in the Sum_range field.
4. Your wizard should look like Figure 6.4.

**FIGURE 6.4 SUMIF Function Wizard Dialog Box**

6. Use absolute referencing, and copy the formula down the range. Your formula should be =SUMIF($B$2:$B$10,A15,$C$2:$C$10). You don’t need absolute referencing on the criteria, because it needs to change its reference as you copy down the formula.
7. Add a total. Your sheet should now look like Figure 6.5.
We’ve now got a summary report at the bottom, showing us how much we have sold in terms of number and dollar value.

Be careful: If your Range and your Sum_range don’t match up, your result will be wrong. For example \( \text{SUMIF}($B$1:$B$10,A15,$C$2:$C$9) \) will give you an incorrect result without warning! This is a very easy mistake to make, and quite common in financial modelling. You can see in Figure 6.6 that the totals are not the same because the SUMIF function is picking up the incorrect range. This is the same for COUNTIF functions, but it is not a problem with the SUMIFS, as the formula will return an error and therefore you will notice the error straightaway, unlike the SUMIF function.

**FIGURE 6.5 Completed SUMIF Function**

Tip: Note that you might like to add an error check below the summary in cell C19 to pick up errors such as this. This can be done using a simple minus or equals formula, or see the section on “Building Error Checks” in Chapter 4 for more detail on how to do this.
Additional Exercise – Pivot Table versus SUMIF

1. Create a pivot table in cell G3 that will give you exactly the same result as the SUMIF function. Your pivot table should look like this:

<table>
<thead>
<tr>
<th>Product</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Book</td>
<td>187</td>
</tr>
<tr>
<td>CD</td>
<td>176</td>
</tr>
<tr>
<td>DVD</td>
<td>134</td>
</tr>
<tr>
<td>Grand Total</td>
<td>497</td>
</tr>
</tbody>
</table>

See the section on “How to Create a Pivot Table” in Chapter 8 for instructions if you don’t know how to build a pivot table.

2. Change one of your values in column C. What happens to the pivot table? What happens to the SUMIF function?

This is why the use of pivot tables is not recommended in pure financial models: because pivot tables do not update automatically. See the section on “Using Pivot Tables in Financial Modelling” in Chapter 8 for more detail.

COUNTIFS

This function is not available in standard Excel 2003.

Excel 2007/10 and Excel for Mac 2011 have introduced a function that applies criteria to cells across multiple ranges and counts the number of times all criteria are met. For instance, COUNTIFS could answer how many of each product had been sold for a particular customer.

1. In row 13, create a filter cell to show which customer we want to show in our summary. So in cell B13, enter the value Jenny. By linking the COUNTIFS function to this cell, we can change it in the future if we want to.

In cell B15, use the formula wizard and find the COUNTIFS function, or simply begin typing =COUNTIFS( if you prefer. If you are using the Formula Wizard, it should look like Figure 6.7.
As you can see, we are invited to keep adding more ranges and criteria to the function COUNTIFS, which was not possible in COUNTIF. Use absolute references for ranges in your formula.

The formula should be \(\text{COUNTIFS}(\$B\$2:\$B\$10,\$A\$15,\$A\$2:\$A\$10,\$B\$13)\).

The result should look like Figure 6.8.

**FIGURE 6.7 COUNTIFS Dialog Box**

![COUNTIFS Dialog Box](image)

Counts the number of cells specified by a given set of conditions or criteria.

Criteria_range1: is the range of cells you want evaluated for the particular condition.

Formula result = 1

Help on this function

OK  Cancel

**FIGURE 6.8 Completed COUNTIFS Function**

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Lim</td>
<td>DVD</td>
<td>$41</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Jenny</td>
<td>CD</td>
<td>$81</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Faisal</td>
<td>Book</td>
<td>$22</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Lim</td>
<td>Book</td>
<td>$53</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Jenny</td>
<td>Book</td>
<td>$66</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Faisal</td>
<td>DVD</td>
<td>$62</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Lim</td>
<td>Book</td>
<td>$46</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Jenny</td>
<td>CD</td>
<td>$95</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Faisal</td>
<td>DVD</td>
<td>$31</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Total</td>
<td></td>
<td></td>
<td>$497</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Filter by: jenny</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Summary Number</td>
<td>Sales $</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Book</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>CD</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>DVD</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Total</td>
<td>3</td>
<td></td>
<td>0</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
SUMIFS

This function is not available in standard Excel 2003.

Like the COUNTIFS function, the SUMIFS function applies criteria to cells across multiple ranges and sums specified columns for which criteria are met. For instance, SUMIF tallied up the value of all products, whereas SUMIFS could add up only those purchased by Jenny.

In cell C15, use the formula wizard and find the SUMIFS function, or simply begin typing =SUMIFS(). Complete the instructions given to achieve the result in Figure 6.9.

FIGURE 6.9 Completed SUMIFS Function

As you can see, we are able to append one or more ranges and criteria to the function SUMIFS in the form Criteria_range, Criteria, which was not possible in SUMIF =SUMIFS($C$2:$C$10,$B$2:$B$10,A15,$A$2:$A$10,$B$13).

AVERAGEIF

This function is not available in standard Excel 2003.

The AVERAGEIF function will average values in the specified range that match specified criteria. This is similar to SUMIF.

1. Let’s say that you’d like to know the average in dollar terms of each product sold. Select cell D15. Find the AVERAGEIF wizard or start typing =AVERAGEIF().
2. The items you are interrogating go in the Range field, the criteria you are looking for in that range goes in the Criteria field, and the numbers you want to average go in the Average-range field.

Your wizard should look like Figure 6.10.
3. Press OK. The answer is 46.75. Your formula should be =AVERAGEIF(B2:B10,A15,C2:C10).

4. Use absolute referencing, and copy the formula down the range. Your formula should be =AVERAGEIF ($B$2:$B$10,A15,$C$2:$C$10). You don't need absolute referencing on the criteria, because it needs to change its reference as you copy down the column.

AVERAGEIFS

This function is not available in standard Excel 2003.

AVERAGEIF averaged the value of all products, whereas AVERAGEIFS could average only those products that exceed $50. Use the appropriate wizard to achieve the results described next.

As with COUNTIFS and SUMIFS, the AVERAGEIFS function also allows you to append one or more additional criteria to it in the form Criteria_range, Criteria.

The formula should look like this= AVERAGEIFS($C$2:$C$10,$B$2:$B$10,A15,$C$2:$C$10,$B$13).

LOOKUP FORMULAS

LOOKUP functions are very often used in financial modelling and analysis – sometimes a little too often in my opinion. They are useful to know, but sometimes another function would create a more robust solution.

VLOOKUP (Vertical Lookup)

VLOOKUP stands for Vertical Lookup. It can be used anytime you have a list of data with the key field in the leftmost column, and it is by far the most commonly used form of LOOKUP formula.
Let's say you have a shopping price list like in Figure 6.11.

**FIGURE 6.11 Example Shopping Price List**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fruit Price List</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Fruit</td>
<td>Price</td>
</tr>
<tr>
<td>3</td>
<td>Apples</td>
<td>$0.80</td>
</tr>
<tr>
<td>4</td>
<td>Oranges</td>
<td>$0.60</td>
</tr>
<tr>
<td>5</td>
<td>Pears</td>
<td>$1.00</td>
</tr>
<tr>
<td>6</td>
<td>Bananas</td>
<td>$1.20</td>
</tr>
<tr>
<td>8</td>
<td>4 Oranges</td>
<td></td>
</tr>
</tbody>
</table>

In cell C8, we'd like to find out how much it will cost to buy four oranges, using a VLOOKUP.

**How to Create a VLOOKUP:** The following is a step-by-step process for creating a VLOOKUP.

1. Find and select the VLOOKUP function. Using the wizard is probably going to be the easiest for VLOOKUPS, as there are four parameters it needs.
2. The first parameter is the criteria we are testing, in this case the word Oranges, so enter B8 in the first field.
3. The next parameter is the table, which contains the data you want to reference. This is where it gets tricky. The criteria you are looking for must always be in the far left-hand column of the data table you are referencing in the table array. So, in this case, the data we are referencing will be the range B3:C6. Figure 6.12 is what your wizard should look like so far.

**FIGURE 6.12 VLOOKUP Dialog Box**
4. Now, if you were going to copy this formula down the page, you would have to use absolute referencing for the table array, or use a named range. Let's create a named range here.

5. Cancel out of the wizard and create a named range for the whole table. Highlight the range B3:C6 and type over the name box in the top left-hand corner of your screen with the word `FruitList`, and press Enter. We can now use this in the VLOOKUP. Now that we have used a named range, we won't have to worry about absolute referencing in our VLOOKUP formula. See Figure 6.13.

**FIGURE 6.13 Creating a Named Range**

6. Go back into the VLOOKUP wizard again, re-reference the lookup value to B8, and either select the table array in the second field box, or simply type in `FruitList`. Make sure you have spelt it the same way as your named range! Your wizard so far should look like Figure 6.14.

**FIGURE 6.14 VLOOKUP Dialog Box Using a Named Range**
7. The third field called Col_index_num tells Excel in which column the value is found. We need to tell the function which column in the table array we want it to return. In this case, we want it to tell us the price. So, counting from the far left-hand side of the table array, we want it to return the second column. So we enter a number 2 in the Col_index_num field.

8. The optional fourth parameter tells Excel if a close match is okay. If you want an exact match, enter zero; otherwise leave it blank. You may also enter TRUE or FALSE, but typing a zero or leaving it blank is quicker. Click OK to complete the formula.

9. Your formula should now be =VLOOKUP(B8,FruitList,2,0).

10. Now, try changing the word oranges to apples. The price should change.

11. Lastly, we need to multiply the price by the number of items we are purchasing. Change your formula to =VLOOKUP(B8,FruitList,2,0)*A8.

Note: There are very few instances where you want a close match. (See the section on "Building a Tiering Table" in Chapter 9 for an example of using a close match in VLOOKUPS.) In most VLOOKUPs, you want an exact match, so enter a zero in the last field.

#N/A Errors in VLOOKUPs: While this example worked out perfectly, when viewers use VLOOKUP, it usually means that they are matching up lists that came from different sources. When lists come from different sources, there can always be subtle differences that make the lists hard to match. This means you will get a #N/A error if the VLOOKUP function cannot find a match. Here are two examples of what can go wrong and how to correct the error.

Example 1: One list has dashes, for example, and the other list does not. The first time that you try the VLOOKUP, you will get #N/A errors. To remove the dashes with a formula, use a find and replace. Replace with nothing (i.e., leave the field blank). Your data will now match and the formula works. You can wrap that function in the VLOOKUP to get the description.

Example 2: One list has a trailing blank space after the entry. This one is subtle, but very common. Use =TRIM( ) to remove excess spaces. When you initially enter the formula, you find all of the answers are N/A errors. You know for sure that the values are in the list and everything looks okay with the formula.

One standard thing to check is to move to the cell with the lookup value. Press F2 to put the cell in edit mode. Once in edit mode, you can see that the cursor is located one space away from the final letter. This indicates that there is a trailing space in the entry.

To solve the problem, use the TRIM function. Entering =TRIM(D4) as part of your VLOOKUP formula will remove leading spaces and trailing spaces, and will replace any internal double spaces with a single space. In this case, TRIM works perfectly to remove the trailing space. =VLOOKUP(TRIM(D4),$I$3:$J$351,2,FALSE) is the formula.

Breaking a VLOOKUP: If you have created a VLOOKUP in a model such as the one above, this should work well until someone enters or deletes a column in your source data. With a formula such as =VLOOKUP(B8,FruitList,2,0)*A8, it specifically asks for the second column, so it will not work if someone inserts a column within the FruitList range. This is because your required column becomes the third column, but the VLOOKUP is asking for the second.
VLOOKUPs and HLOOKUPs are not very robust formulas – you can see how easy they are to break! For this reason, try some of the alternatives below to make your LOOKUP formulas more robust; otherwise, use another formula or protect your model so that users cannot insert or delete rows or columns.

**Improving VLOOKUPs with MATCH:** The best way around this is to make the 2 in your VLOOKUP a formula instead of a hard-coded number. One way of doing this is to nest the VLOOKUP with a MATCH function. We will create the MATCH formula in a separate cell, and then replace the 2 with the MATCH formula.

1. Using the VLOOKUP example above, test the problem by inserting or deleting a column in our sheet. You will see that the value in your VLOOKUP is now incorrect.
2. Now go to another spare cell, say cell B17, and create a MATCH formula that will find the word Price in the range B2:C2 above and tell us its position in the range.
3. Your Formula Wizard should look like Figure 6.15.

![MATCH Function Dialog Box](image)

4. By putting a 0 in the Match_type range, you are asking it to return you an exact match instead of a close match.
5. When you hit OK, your formula should be `=MATCH(C2,$B$2:$C$2,0)` and the result should be 2.
6. Go into the MATCH formula bar, highlight the entire formula (except for the = sign), and press Control + C (Command + C in Excel for Mac 2011) to copy it. Hit Enter. Now, go back to your original VLOOKUP, and replace the 2 in your VLOOKUP formula with this entire MATCH formula by highlighting the 2 within the formula and pasting the MATCH formula over it by pressing Control + V (Command + V in Excel for Mac 2011). Hit Enter.
7. Your formula should look like this: `=VLOOKUP(B8,FruitList,MATCH(C2,$B$2:$C$2,0),0)*A8`.
8. Test that this works, by inserting or deleting a column.
9. Another way of doing this is to use the =COLUMN or =ROW function instead of MATCH. This will automatically return the range’s column or row reference. Using this, the formula instead would be: `=VLOOKUP(B8,FruitList,COLUMN(C3)-1,0)*A8`. (The -1 is required because the range is starting from column B.)
HLOOKUP (Horizontal Lookup)

HLOOKUP works in exactly the same way as the VLOOKUP, except that the data is arranged horizontally instead of vertically. See Figures 6.16 and 6.17 for example.

FIGURE 6.16 Use of a HLOOKUP Function

![HLOOKUP Function Example](image1)

FIGURE 6.17 HLOOKUP Function Dialog Box

![HLOOKUP Function Dialog Box](image2)

The HLOOKUP is subject to exactly the same issues as the VLOOKUP and works in exactly the same way, except for the orientation.

LOOKUP Function

The LOOKUP function is much simpler than either the VLOOKUP or the HLOOKUP, and it has the added advantage of being able to have the results column or row either to the left or the right of the criteria column or row – a huge advantage. However, the data must be sorted in alphabetical order or it won’t work. This does limit its usage significantly, and it is for this reason that it is far less popular than the VLOOKUP or HLOOKUP formulas.

It’s worth knowing how it works, though, so here’s a brief overview:

1. Select LOOKUP from the Function Wizard.
2. Choose the first option. See Figure 6.18.
3. Similar to an HLOOKUP or VLOOKUP, the criteria being tested goes in the first field.
4. The column (or row) containing the criteria goes in the second field, and then the column (or row) containing the result goes in the last field. See Figure 6.19.

5. Copy the LOOKUP function down, and multiply the price by the total amount to complete the pricing table as shown in Figure 6.20.
FIGURE 6.20 Completed Pricing Calculation

Note that this works exactly the same whether the data is shown vertically or horizontally. Importantly, unlike a VLOOKUP or HLOOKUP, it does not matter whether the result data is to the left or right, above or below the lookup data.

However, you would only use a LOOKUP for numerical values where the numbers are sorted and you want a close match, not an exact match. You would not use a LOOKUP function for text, as shown in the last fruit shopping list VLOOKUP example, because it will only return a close match, and this is dangerous. This makes the LOOKUP function almost useless in most cases where a lookup is required. The only time a modeller would use a LOOKUP is when they specifically want a close match. See Table 6.1 for the advantages of the different LOOKUP functions just described.

TABLE 6.1 Advantages and Disadvantages of LOOKUP Functions

<table>
<thead>
<tr>
<th>FUNCTION</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>VLOOKUP</td>
<td>• Data does not need to be sorted alphabetically as long as you use 0 or FALSE in the last field.</td>
<td>• The column number is hard-coded, so if a column is inserted, it can mess up the formula. (You can use a MATCH formula to fix this.) • The column containing the results must be to the right-hand side of the column containing the lookup criteria.</td>
</tr>
<tr>
<td>HLOOKUP</td>
<td>• Data does not need to be sorted alphabetically as long as you use 0 or FALSE in the last field.</td>
<td>• The row number is hard-coded, so if a row is inserted, it can mess up the formula. (You can use a MATCH formula to fix this.) • The row containing the results must be to the right-hand side of the row containing the lookup criteria.</td>
</tr>
</tbody>
</table>
LOOKUP

• The column/row number is not hard-coded.
• It does not matter where the columns or rows are in relation to each other.
• Data must be sorted or it will give the wrong result.

OTHER USEFUL FUNCTIONS

Using INDEX and MATCH to Create a More Robust Formula

As described in “Linking to External Files” in Chapter 4, robust formulas, such as a nested formula using a combination of an INDEX and a MATCH, used with named ranges will make the link a lot less likely to break and cause problems in models.

Let’s say that you are referencing a table in another file. Your co worker keeps inserting and deleting rows and columns. The VLOOKUP solution as previously described may work, but with large tables an INDEX and MATCH formula combination will be more efficient.

Figure 6.21 contains the source data showing we need to pick up the staff amenities costs for Geelong.

**FIGURE 6.21 Sample Data**

You could simply reference the cell F5, using the formula =F5, but this will not help you if your file is closed, and someone else changes the referenced table. Let’s say your coworker inserts a column while your model is closed. When you open your file again, it will still reference F5, but Geelong has moved to column G, so the formula in your model will be wrong!

By using a combination of an INDEX and MATCH formula, we will be able to specify the exact coordinates of the required value, even if it’s position in the table changes.

1. In cell B12, insert the word **Geelong**, and in cell A13, insert the phrase **Staff Amenities**. These cells will become input variables that we will link our formula to.
2. Now let’s find the coordinates of the required data. Start by creating a MATCH formula in a spare cell that will find the word Geelong and tell us its position in the range of city names.
3. Your formula should be =MATCH(B12,A1:I1,0), and the result should be 6. Note that you could type the word Geelong directly into the formula, but linking it is considered best practice in financial modelling.
4. Now do the same thing for the expense types. In another spare cell, create a MATCH formula that will find the phrase Staff Amenities and tell us its position in the range of expense types.

5. Your formula should be `=MATCH(A13,A1:A9,0))`, and the result should be 5.

6. Now create the INDEX formula that will return the value that you specify. Note that when you use the wizard, it will ask you which argument list you wish to use. Select the first one. See Figure 6.22.

FIGURE 6.22 INDEX Function Options

7. Once you are in the Formula Wizard, ask it to return the first row and the first column, just to test it. See Figure 6.23.

FIGURE 6.23 INDEX Function Wizard

8. Your formula should look be `=INDEX($A$1:$I$8,5,6)`, and the result should be $23,021.

9. This formula will work fine, but it cannot handle someone inserting or deleting rows. In order to make it completely robust, we need to replace the 5 and 6 with the results of the MATCH formulas. We are going to turn this into a nested formula, just like we did in the “Nested IF Functions” section in Chapter 5.

10. Go back into the first MATCH formula bar, highlight the whole thing (except the = sign), and press Control + C (Command + V in Excel for Mac 2011).

11. Go into the INDEX formula and replace the column reference with this formula. Highlight the 6 and press Control + V (Command + V in Excel for Mac 2011).
12. Now do the same for the row reference. Go into the second MATCH formula bar, highlight the whole thing (except the = sign), and press Control + C (Command + C in Excel for Mac 2011).
13. Go into the INDEX formula and replace the row reference with this formula. Highlight the 5 and press Control + V.
14. Don’t forget to add in some absolute referencing. Your formula should look like this: =INDEX($A$1:$I$8,MATCH(A13,$A$1:$A$9,0),MATCH(B12,$A$1:$I$1,0))
15. Test the robustness of your formula by inserting or deleting rows or columns. You can now cut this formula to another file, and it will work in the same way.
16. Remember that if you want to move this formula around, use the cut and paste functions, not copy and paste. Cutting (Control + X or Command + X) will move all formulas with it. If you cut this formula to another file, you should follow best practice by using named ranges in the formula, particularly where the INDEX function is referencing the data. This way if the data is added to, the named range will expand accordingly.

OFFSET Function

The OFFSET function, in my opinion, is less useful than the other functions we have covered so far, as it can be tricky to build and is complex to audit. However, many financial modellers are fond of including it in their models, and therefore you will be likely to come across it and need to know how to decipher it!

OFFSET is used to return the address of a cell or a range of cells through the use of a reference cell, and is generally used in order to stagger series of values by a variable amount. For example, if you want to delay a project by a certain number of months, but want those months to be variable, the OFFSET function will move the value by the number of months that is specified in the model.

To give a very simple example, let’s say you wanted to pick up the value in cell B3, which is located one column across and two rows down from cell A1. In Figure 6.24, cell B3 is 54.

FIGURE 6.24 Example Data

Using the OFFSET wizard, the reference point given is cell A1, and the offset rows are 2 and offset columns are 1. See Figure 6.25.
Don’t worry about the height and width for now (this is for when you want the result to be a range, rather than a single cell). Your formula will be =OFFSET(A1,2,1).

This is picking up the cell one column to the right, and two rows below the reference cell. If you wanted to pick up a cell above or to the left of the cell, you’d used a negative offset number for the rows and columns (e.g., −2 instead of 2).

Using an OFFSET to Model Cash Flow: So now that you know how to do an OFFSET function, let’s see how it’s used in a more practical context.

Let’s say that you have monthly sales data, but the terms of payment are one month, as shown in Figure 6.26. This means the cash is received one month after the sale is made.

Let’s create a Cash Receipts line in row 5 using the OFFSET formula, which will delay the cash receipts by the number in cell B1.

1. Start in cell C5, and create an OFFSET function that uses cell C4 as a reference point and offsets the number of columns by the number of months in cell B1.
2. Leave rows blank, as you do not wish to move rows.
3. Make the offset number of columns a negative number, because you wish to return the cell to the left, not the right.
4. Your wizard should look like Figure 6.27, and the formula in cell C5 should be 
   =OFFSET(C4,-$B$1).
5. Copy this formula across the row.

**FIGURE 6.27 Calculating a Dynamic Cash Flow Using the OFFSET Function**

Nesting OFFSET and COLUMN Formulas: This works when the terms are one month, 
but if you change the number of months in cell B1 to 2, it will pick up the word Sales in 
cell A4. Similarly, if you change the cell B1 to 3, it returns a #REF! error value. We need 
to create a nested formula with a COLUMN function to make this model more robust.

A COLUMN function will return the column reference of the formula. For example, 
COLUMN(B3) returns the value 2.

Similarly, a ROW function will return the row reference of the formula. For example, 
ROW(B3) returns the value 3.

We need to add a formula in front of our OFFSET function to say that if the number of 
months in cell B1 is greater than the column position, it should return a zero.

1. In cell C5, replace the formula with 
   =IF($B$1>=COLUMN(C4)-1,0,OFFSET(C4,, -$B$1)).
2. Don’t forget the absolute referencing, and copy it all the way across, including 
cell B5.
3. Test to see if the formula is working correctly by changing cell B1 to different 
   values.
4. If you are expecting no delay in cash receipts, you can enter a zero in cell B1, 
   and the formula will still work.

Your model should look like Figure 6.28.
Alternatively, you may also choose to suppress the errors and text using an IF and ISNUMBER nested formula. In this case, it will return a zero if the result of the OFFSET is either an error or text. Only a numerical value will be displayed in the output. The completed formula in cell B5 should look like this:  

\[
\text{=IF(ISNUMBER(OFFSET(B4,, -\$B$1)),OFFSET(B4,, -$B$1),0)}
\]

**Tip:** Note that cell C1 contains the word month instead of months. If you insert the formula  
\[
\text{=IF(B1=1,\"month\",\"months\")}
\]
into cell C1, the syntax will always be correct no matter what value you insert in cell B1.

Note that it is not normally a good idea to use entire column or row references in formulas because they use a lot more memory. However, by using them in this case, there is no limitation on how large the range can grow. If memory is an issue, you may prefer to limit the range to, say, 1,000 rows and columns or as many as you think your users may need. In this case you could add some colour markings so that users know when they have exceeded the range limits.

**CHOOSE Function**

The CHOOSE function returns a value from a list of values based on a given position.

For example, let’s say you want to pick up the second value in the following list of data in Figure 6.29.

**FIGURE 6.29 List of Days of the Week**
1. Type out the list of days, starting with Sunday.
2. Select cell A9. Go into the Function Wizard and select CHOOSE.
3. Index_num is the value that you want the formula to return. Enter 2 in this field.
4. Enter the values from which you want the formula to choose. Note that you can hard-code these, or use a reference the way that we have done here. See Figure 6.30.
5. Hit OK, and your formula should be =CHOOSE(2,A1,A2,A3,A4,A5,A6,A7).

**FIGURE 6.30 CHOOSE Function Wizard**

![CHOOSE Function Wizard](image)

**Using a Nested CHOOSE Formula with Dates:** Let’s say you’d like to be able to enter in any date and have a formula that tells you, in words, the day of the week it is.

1. Go to cell B9, and enter your date. This could be your birth date, or you could create a formula with today’s date by typing =TODAY( ). Every time you open the model, it will show the current date. Note that =NOW( ) will show the date and the time.
2. The formula =WEEKDAY(B9) will return the day of the week as a number, with Sunday being the first day of the week. Therefore, Sunday = 1, Monday = 2, and so on.
3. Go back to your previous formula in cell A9, and turn it into a nested formula by replacing the hard-coded 2 with the WEEKDAY formula.
4. Your formula should be =CHOOSE(WEEKDAY(B9),A1,A2,A3,A4,A5,A6,A7).

**Regression Analysis with a FORECAST or TREND Function**

The FORECAST function in Excel predicts or forecasts data based on historical data, using the linear trend. These functions are a simple way of performing regression analysis in Excel, and are useful to include in forecasting models. The TREND function almost always gives the exact same result (but uses the least-squares method instead of the linear trend), so for our purposes, the two can be used interchangeably.
Select the FORECAST function from the Formula Wizard. Basically:

- **X** is the date or number for which you want the numbers to be forecast.
- **Known y’s** is the known historical data.
- **Known x’s** is the known historical dates or numbers.

Let’s say, for example, that you have the following historical data available, and you need to provide a forecast for Jul-13.

<table>
<thead>
<tr>
<th>Date</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan-13</td>
<td>650</td>
</tr>
<tr>
<td>Feb-13</td>
<td>660</td>
</tr>
<tr>
<td>Mar-13</td>
<td>680</td>
</tr>
<tr>
<td>Apr-13</td>
<td>670</td>
</tr>
<tr>
<td>May-13</td>
<td>700</td>
</tr>
<tr>
<td>Jun-13</td>
<td>690</td>
</tr>
<tr>
<td>Jul-13</td>
<td></td>
</tr>
</tbody>
</table>

If we were to quickly chart these numbers, we can add a linear trend line by right-clicking on the series. See Figure 6.31.

**FIGURE 6.31 Inserting a Linear Trend Line**

![Inserting a Linear Trend Line](image)

We can see from the trajectory of the trend line that, based on historical data, the sales in July 2013 should be somewhere between 700 and 710. The formula tells us the slope, which is what the FORECAST function uses to calculate the projections. See Figure 6.32.
This is exactly how the FORECAST formula calculates forecasts: It looks at the historical relationship between the X-axis and the Y-axis, and projects based on these numbers.

1. Type the dates and numbers into a blank sheet.
2. Bring up the =FORECAST Formula Wizard. The inputs for our formula fields will be:
   - X: A8 (Jul-13) as the date for which we want to forecast.
   - Known_y’s: B2:B7 (650–690) as the historical data we know already.
   - Known_x’s: A2:A7 (Jan-13–Jun-13) as the corresponding years for the numbers we know already.
3. Your Formula Wizard should look something like Figure 6.33.
4. The forecast sales for Jul-13 is 706.

FIGURE 6.33 FORECAST Function Wizard
WORKING WITH DATES

Excel treats dates and times as numbers, which means they can be computed mathematically. For example, you can subtract two dates to find the number of days in between. This feature is invaluable in financial modelling, as a very large proportion of financial models are times-series based.

You can add some number of days to a date by using simple formulas. Since Excel stores dates as a number of days, you can change the date by including the date in a formula. For example, to add seven days to 1-Jul-13 in B3, use =B3+7, which gives 8-Jul-13, and hence a weekly cash flow report. See Figure 6.34.

FIGURE 6.34 Using a Formula to Calculate Dates

Handy Functions

Many financial models require specific dates or sections of the dates for the analysis. Excel has a fantastic collection of functions to isolate various parts of the dates and calculate special dates like the last day of the month. Given below are some of the handy date functions in Excel.

=TODAY( ): This function gives today’s date, whenever you open the model.
=NOW( ): This function gives the exact date and time, whenever you open the model.
=EOMONTH: This function gives you the last date of the month, with reference to any date. The snapshot in Figure 6.35 shows how this formula works. Note that the EOMONTH function is only available in the later versions of Excel.

FIGURE 6.35 Using the EOMONTH Function
The EOMONTH is an extremely useful function because it will always take you to the last day of the month, regardless of how many days it contains. In Figure 6.35, we have a project start date of 6th July 2013 in A2. The last date of the next month is 31st August 2013, which is represented in B2 and can be copied across the row.

The alternative way of doing a variable start date would be to use formula =A2+30, and copy it across. But this is not very accurate, and if you have interest calculations running from the dates, for example, the calculations will not be exactly correct.

The other benefit of using the EOMONTH function is that it handles leap years very well. In Figure 6.36, if we have a February start day, and want to show six monthly milestones, you can see that by using the EOMONTH function, it will always give us the last day of the month. 2012 is a leap year, so cell C3 gives us 29th February 2012, whereas cell D3 gives us 28th February 2013, as 2013 is not a leap year.

**FIGURE 6.36 The EOMONTH Function Calculates a Leap Year Correctly**

![Figure 6.36](image)

While finding the last date of the month is the standard output of the EOMONTH function, with some improvisation you can also get the first day of the month. Since Excel treats dates as numbers EOMONTH( )+1 will give you the first day of the next month if this is required in your model.

=WEEKDAY: This function gives you the day number in the week corresponding to the date specified. In Figure 6.37 you have the dates corresponding to 6th July 2013 through to 9th July 2013.

**FIGURE 6.37 The WEEKDAY Function Will Return the Day of the Week**

![Figure 6.37](image)

In your financial model, you may have to make some decisions based on the day of the week, and in such cases, the WEEKDAY function can be a useful filter criterion. For example, trading or stock prices are not shown on the weekends, so you would skip those days for certain calculations.
Note: The complete syntax of the WEEKDAY function is =WEEKDAY(date,return type). The return type lets you decide the week cycle for your model. Here are the various options Excel offers you for the return type.

<table>
<thead>
<tr>
<th>Value</th>
<th>Series of Weekdays</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sunday (1) to Saturday (7)</td>
</tr>
<tr>
<td>2</td>
<td>Monday (1) to Sunday (7)</td>
</tr>
<tr>
<td>3</td>
<td>Monday (0) to Sunday (6)</td>
</tr>
</tbody>
</table>

Note: The input to this function must be a valid date in Excel. If the text is not in proper date format, you will get garbled output.

=YEAR: This function is used to identify the year in a specified date. If your model needs to use the year in the date for a particular calculation or analysis, this function can help you build the necessary logic. Figure 6.38 is a simple example showing the function.

FIGURE 6.38 The YEAR Function Will Return the Calendar Year

Note that the =YEAR function does not help if your fiscal year does not match the calendar year. If you need to return a fiscal year (e.g., 2012/13), you need to create a table showing which dates fall in each financial year, and then use a formula such as a VLOOKUP function to return the value.

=MONTH: This is another function very similar to the MONTH( ) function. It returns the month in the date. See Figure 6.39.

FIGURE 6.39 The MONTH Function Will Return the Number of the Month

These functions are particularly useful for summarising and collating raw data. For example, column C as shown in Figure 6.40 can identify the month, and then be used as the criteria in a pivot table or a SUMIF formula to summarise the raw data into months.
=DAY: This returns the day in the date. As evident, this is very similar to the MONTH and YEAR function. Note that this is different to the =WEEKDAY function, which will return the day of the week. =DAY will return the day of the month. For example, as shown in Figure 6.41, on 6th July 2013 the =DAY function will return a 6.

FIGURE 6.41 Using a DAY Function to Return the Calendar Day of the Month

Note that for all the three functions, MONTH, YEAR, and DAY, the input must be in a valid date format. Without proper input the desired results cannot be returned!

Date Format Dilemma

Two of the most popular standards used in the world today are the dd/mm/yy (U.K.) and the mm/dd/yy (U.S.) formats. Depending on the regional relevance of the information, the first two numbers could mean the month or the date. Your financial model must eliminate any such ambiguity, particularly if the model is working across several different regions. It is therefore best practice to format date as 5-June-2014 instead of 5/6/14. This way there is no chance of it being interpreted erroneously as 6th May 2014!

Long and Short Date Formatting: A shortcut exists on the Home tab that allows you to very quickly change the date format on any cell from the Number ribbon, as shown in Figure 6.42.
In the drop-down menu you should see both the options Short Date and Long Date. The samples for both are shown in the drop-down itself for easy understanding. While you could use any format in your calculations, you can eliminate confusion by sticking to long date format for any information that requires user interaction. See Figure 6.43.

The short and long dates are not the only formats that Excel provides; you can choose from a much wider range of formats by clicking on the dialog box launcher in the Number ribbon as shown in Figure 6.44.
This brings up the Format Cells dialog box, which you can use to change the way the date appears. In Excel for Mac 2011, the Format Cells dialog box can be found by selecting Format – Cells from the toolbar.

In all versions of Excel, the Format Cells dialog box can be found by right-clicking on the cell and selecting Format Cells.

See the section on "Custom Formatting" in Chapter 7 for more detail on how to create different formats.

**Tip:** When you drag a series of dates in Excel, it will auto fill it for you. If you want to exclude the weekends in your financial model, Excel can do it automatically for you with the Auto Fill options. Select Fill Weekdays to exclude weekends. See Figure 6.45.

**FIGURE 6.45 Auto Fill Option**

![Auto Fill Option](image)

**FINANCIAL PROJECT EVALUATION FUNCTIONS**

Financial functions are designed to save Excel users time when calculating long and complicated formulas such as interest repayments, depreciation, or net present values (NPVs). They can be created manually, and if you have studied business or finance at the university level, you will have had to create these calculations the long way or using a financial calculator. The pre-defined function in Excel saves time and makes it much easier to calculate commonly used financial calculations.

There are three financial functions that are commonly used to assess a business case or any series of cash flows: NPV, internal rate of return (IRR), and payback period. There are pre-defined functions in Excel for calculating NPV and IRR, but there is not one for payback period. For methods on how to calculate it, see the section on "How to Calculate a Payback Period" in Chapter 9.
NPV (Net Present Value)

NPV is the value of the expected future cash flows from an investment, expressed in today’s dollars. The investor specifies a target rate of return (the cost of capital) for investing capital; it is an opportunity cost concept. Investors have the choice of investing in a project, or putting their funds elsewhere, so they determine the hurdle rate, or the amount they want to get back from the project.

The general rule (and the one you would have studied in your university finance textbooks) for considering the investment is: If the NPV is greater than zero, the investment should be accepted; if the NPV is negative, it should be rejected. A positive NPV means the investor can expect to earn a rate of return greater than the required return rate for such an investment. However, from a financial modelling perspective, the decision-making process is much more complicated than a deal-or-no-deal situation. It really depends on the scenario and sensitivity analysis from the financial model to test whether or not the project should go ahead. Large companies often have policies regarding the standard cost of capital or how long the payback period can be before it is rejected.

What Cost of Capital Should We Use?: How much time is spent calculating the cost of capital really depends on how detailed your modelling is. Many models will simply use a nominated amount and document this as an assumption. This nominated cost of capital could be anything between, say, 6 and 15 percent (although sometimes higher), and it can fluctuate depending on the perceived risk of the project. We may decide to use very high required rate of return for a risky project to compensate for the risk taken.

However, instead of simply nominating a cost of capital amount as we will do in the example in Figure 6.46, you may decide to calculate the weighted average cost of capital (WACC). This calculation takes into account the mixture and rates of debt and equity in the company, and is therefore a much more accurate way of evaluating the expected rate of return for a project. For more detail on how to calculate the WACC, see the section on “Weighted Average Cost of Capital (WACC)” in Chapter 9.

What Is Wrong with the NPV Function?: Note that a key assumption of the NPV function is that the cash flows occur at the end of the period, whereas in reality they will probably occur unevenly throughout the year, with a large portion of costs spent closer to the beginning of the period. In this example we have included the initial investment in the first year. If, however, we know that a large initial investment will be made prior to the start of the project, then this should be included in Year 0, and added to the NPV calculation like this: \(\text{NPV}(B4:B2:F2) + Y0\_investment\).

IRR (Internal Rate of Return)

IRR equates the present value of the cash inflows and the present value of the cash outflows. The decision rule in this case is: If the IRR is greater than or equal to the investor’s required rate of return, the investment should be accepted; otherwise it should be rejected.
Comparing IRR with the Risk Factor: Knowing about the IRR is of little use unless you can make decisions using it. To do that, you must compare the IRR with the risk factor. There are two possible outcomes when you compare IRR with the risk:

1. The projected returns from the investment are greater than the risk. In other words, the returns from the investment are high enough to justify the risk of the investment. This is a positive recommendation to invest.
2. The projected returns from the investment are less than the risk. In other words, the returns from the investment are not high enough to justify the risk of the investment. This is a negative recommendation, cautioning against investment.

Like NPV, IRR uses all three criteria – returns, risk, and time – in its evaluation, and for this reason, many managers find it an easy, accurate, and dependable tool to use.

HOW TO CALCULATE THE NPV

With a series of cash flows as shown in Figure 6.46, the NPV is calculated as follows.

**FIGURE 6.46 Using the NPV Function**

1. Select NPV function. At the Rate prompt, enter the cost of capital, which we will assume is 12 percent.
2. At the Value1 prompt, link the formula to the cells that contain the expected return (i.e., as we are calculating the five-year NPV, it will be the profit or loss for 2013 to 2017). The formula should be =NPV(B4:B2:F2).
3. The result of your formula should be $127,568.

In this case, the NPV is greater than zero, meaning that the return is greater than the required rate of return of 12 percent stated by the company. This means that, theoretically, the project should be accepted. However, scenario and sensitivity analysis will help determine how sensitive the model is to changes in inputs and gain a better perspective on whether or not this project should be accepted.

Using NPV and IRR to Make Decisions: Just because the NPV is positive, and our IRR is greater than our required rate of return, does not necessarily mean that we should go ahead with the project! Blindly accepting the output of a model is a dangerous business. As we know, a model is only as good as the assumptions that go into it, and if we have included aggressively optimistic assumptions in our model, of course the NPV will look good – but this does not mean the project will do well!
All financial models should be subjected to, at minimum, a base case, best case, and worst case scenario, which are used to evaluate the sensitivity of outputs to changes in inputs. The NPV, IRR, and payback period, which are calculated by the model, should be used as decision-making factors and not the ultimate deciding factors of the fate of the project.

**HOW TO CALCULATE THE IRR**

Using the same investment assumptions as in the previous example, the rate of return on the initial investment can be calculated as follows:

1. Select the IRR function.
2. At the Values prompt, select or specify the cells that contain the requested information.
3. Leave the Guess prompt blank at this stage. (See the forthcoming section on “The Problem with IRR” for more detail on when and why you need to include a guess.) In this instance all the cash flows are positive, so we don’t need to enter a guess.
4. Click on the OK button and the yield (IRR) is displayed. The formula should be: 
   \[=\text{IRR}(B2:F2)\].

The result of your formula should be 13.3 percent and look something like Figure 6.47.

**FIGURE 6.47 Using the IRR Function**

In this case, the IRR is higher than the required rate of return of 12 percent, as stated by the company. This means that, theoretically, the project should be accepted.

**The Problem with IRR:** There are a few problems with the IRR function that the modeller needs to be aware of.

Sometimes the IRR function in Excel can produce multiple results. Every time the cash flows change sign (i.e., from negative to positive or from positive to negative), the formula will create another solution. This is why it a good idea to insert a guess amount – especially if the sign of the cash flows is not consistent.

Take the following set of cash flows in Figure 6.48 as an example.
If we use the ordinary IRR function without using the guess [entered as =IRR(B2:H2)], we get a result of 13 percent. However, because there are several negative returns in this series of cash flows, there are multiple results. If you enter the following guesses, different IRRs will be returned:

- =IRR(B2:H2) gives a result of 13 percent.
- =IRR(B2:H2,0) gives a result of 6 percent.
- =IRR(B2:H2,30%) gives a result of 25 percent.
- =IRR(B2:H2,400%) gives a result of 481 percent.

Which one is correct? They all are! There are as many valid IRRs as there are changes in sign. Excel goes through an iterative process and comes up with the first solution it finds, which does not necessarily give you the result you want. This is why it’s important to use the guess. If the guess is omitted, IRR is assumed to be 10 percent because this is close to a usual rate of return.

Another issue with the IRR is that the way the IRR function calculates in Excel, it assumes that cash generated during the investment period will be reinvested at the rate that has been calculated by the IRR. If the project is generating a lot of cash, the IRR calculation can overstate the financial benefits substantially, which is something that needs to be considered, and possibly manually manipulated in the calculations.

We don’t normally make any changes to the calculations to account for these problems, but it’s important to consider these issues when calculating the IRR.

**What Difference Does an X Make? XNPV and XIRR**

The NPV formula assumes that the values entered into the formula are annual, are in chronological order, and occur at the end of the period.

The XNPV formula offers more flexibility, as you can specify exactly when the payments occur. However, XNPV and XIRR are only available in Excel 2007 and later.

XNPV allows you to enter payments that occur at varying intervals, not necessarily in chronological order (although the first payment must still be shown first), and occur at any time. Therefore, it is a much more flexible and useful function. Also, because it does not assume that the payments occur at the end of the period, the XNPV formula will be more accurate.
Be careful when comparing the NPV and XNPV functions, as the NPV assumes the current period (the date we are in right now) is a full year prior to the first cash amount and therefore discounts the first amount back by a full 12 percent (or whatever the nominated discount rate is). If this is not the case, you need to exclude the first period from the function, and add it in separately, like this: \( =\text{NPV}(B4,B2:F2) + Y0\text{\_investment} \).

The XNPV function, however, assumes that the current date is the date of the first cash flow, so in the example above, the current date is assumed to be 1st June 2013. Therefore, the first cash amount is not discounted at all. IRR and XIRR have the same issue. This is quite misleading, as most people naturally assume that the functions, being slight variations on the same formula, work in a similar way, but the way they treat the first cash amount is quite different!

### HOW TO CALCULATE THE NPV USING THE XNPV FUNCTION

If you were to be more precise about the actual timings of the expected cash flow, you would get a more accurate NPV calculation using XNPV.

Instead of saying that you expect a net outflow of $3.2 million in 2013, let’s be a little more specific about when the outflows actually occur. Let’s say you split that into $2 million in June 2013, and the rest at the end of the year. We will also put a date in the middle of the year for subsequent years, which is more likely to accurately reflect what will happen, instead of assuming that payments are made or received at the end of the period, as it does with the NPV calculation.

Figure 6.49 shows the cash flows.

**FIGURE 6.49 XNPV Function**

Using the XNPV formula, and assuming that the cost of capital is, say, 12 percent, the formula should be \( =\text{XNPV}(B4,B2:G2,B1:G1) \), giving us a result of $190,828.

Similarly, the XIRR can be calculated using the formula \( =\text{XIRR}(B2:G2,B1:G1) \) giving us a result of 13.8 percent.

### LOAN CALCULATIONS

Calculating debt is an important part of many financial models, and understanding the theory behind how loan repayments are calculated will help in financial modelling. The way that interest, principal, and periodic payments are calculated can be complicated, and fortunately for us, Excel has many useful functions that make calculating loans a lot easier. However, you should still have a basic understanding of how loan calculations work!
Loan-Interest Calculation Method

Interest on loans can be calculated using either the simple interest method, or the
compound interest method. The simple interest method charges the same amount of
interest each year, but under the compound interest method, the interest is added to the
loan, so increasing the loan amount each year. From the moment at which the interest is
added to the loan, it charges interest on itself, increasing the interest on a compounding
basis. The compound interest method is by far the most commonly used method, and in
the examples in this chapter we assume that the interest is compounding.

When evaluating a loan, you may also need to consider the compounding frequency. If
the interest is added to the loan on a daily basis, this would actually make the loan
interest payments much higher than if it were added monthly or annually. Most loans are
normally calculated on a daily basis, and this means the interest rate actually charged is
higher.

Note that the PMT function shown below, if calculated on an annual basis, does not
compound the interest. You will need to convert the interest rate from a nominal or
effective rate before using in the calculation.

Nominal and Effective Interest Rates

We are used to seeing interest rates expressed as an annual rate (e.g., an interest rate
of 12 percent means that we are charged 12 percent per year). However, this is only the
nominal rate, and this does not mean that we are charged 1 percent per month. In fact, if
the interest is calculated daily, we are charged 12 percent divided by 365, or 0.33
percent on the first day of the loan. This amount is added to the principal, so on day two,
we are actually paying interest on the interest from the previous day. I know this sounds
trivial but it can make a big difference to your calculations on a large debt.

Tip: An easy way to work out the effective interest rate is to use the EFFECT
function (only available in Excel 2007/10) to calculate the effective rate of 12
percent, compounded daily. Use the formula =EFFECT(12%,365). The
answer is 12.75 percent. See the section on “Understanding Nominal and
Effective (Real) Rates” in Chapter 9 for more detail on how to use this
function as well as the NOMINAL function. Note that the EFFECT function is
not available in standard Excel 2003.

Loan Repayment According to an Amortisation Schedule

The most common form of calculating loan repayments is to apply an amortisation
schedule. Regular repayments of equal value made over the term of the loan are used to
pay both the interest charged as well as a portion of the principal amount. With each
repayment, an amount equal to the value of the interest charged for the period is applied
first to the interest portion, and the remainder of the repayment is then set off against the
principal. In this way, the principal decreases after each repayment and the interest
calculated for the next period will therefore be less, as it is calculated on a smaller
principal amount.
To calculate the amount of the equal repayments to be made, the interest rate, the principal amount, and the term of the loan must be known. As interest rates are usually subject to change, the monthly repayment will often have to be revised during the course of the loan.

If you need to calculate the repayments long-hand using the amortisation method, the following formula is used:

\[
\text{repayment} = \left( \frac{\text{loan amount} \times i(1 + i)^n}{(1 + i)^n - 1} \right)
\]

Where \( i = \) the interest rate per annum, which must be divided by the number of repayment periods per annum (e.g., 12 periods if payments are made monthly).

\( n = \) the number of repayment periods (e.g., 24 if the loan is for a period of 2 years and repayments are made monthly).

**Excel Amortisation Functions:** Whilst it’s good to know the theory of how the repayments are calculated, fortunately Excel offers several loan calculation functions that can be easily included in financial models. The following are some of the most common functions available in Excel for loan-related calculation.

**PMT:** This is the very basic function that calculates the fixed amount you need to pay at regular intervals to repay the loan along with fixed interest. This is the syntax for using the PMT function: \( \text{PMT} \text{ (rate, number of payments, principal amount, final amount, type). In this syntax, the following applies:} \)

- **Rate:** This is the fixed interest rate for the loan period.
- **Number of Repayments:** This is the number of instalments within which you want to repay the loan.
- **Principal Amount:** Amount of original loan (no interest included).
- **Final Amount:** The total amount at the end of all the instalments. This is not a mandatory field and the default value is set to zero.
- **Type:** This determines when the payment needs to be made. The default value is zero, which means at the end of the period; one means at the start of the period.

In Figure 6.50, we have a loan of one million dollars repaid over a 10-year period (annually) at an 8 percent interest rate. The PMT function calculates the fixed payment amount, which in this case is $149,029.
FIGURE 6.50 PMT Function

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Interest on loan calculations</td>
</tr>
<tr>
<td>2</td>
<td>You borrow $10m over ten years to refurbish your premises at an interest rate of 8%:</td>
</tr>
<tr>
<td>3</td>
<td>Loan amount</td>
</tr>
<tr>
<td>4</td>
<td>Interest Rate</td>
</tr>
<tr>
<td>5</td>
<td>Term</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Year</td>
</tr>
<tr>
<td>11</td>
<td>Annual Repayment</td>
</tr>
<tr>
<td>12</td>
<td>Interest Only</td>
</tr>
</tbody>
</table>

IPMT: The IPMT function is complementary to the PMT function. While PMT calculates the entire repayment instalment amount, IPMT gives the interest component of the instalment. Like the PMT, this is calculated for fixed principal and interest rate for a given duration of time. The syntax for IPMT is IPMT (rate, period, number of payments, principal amount, final amount, type), where the following applies:

- **Rate**: This is the fixed interest rate for the loan period.
- **Period**: This is the period for which the interest amount needs to be calculated. For the first period (week, month, year, etc.) this would be 1, and for subsequent periods it will increase as 2, 3, 4, and so on.
- **Number of Repayments**: This is the number of instalments within which you want to repay the loan.
- **Principal Amount**: Amount of original loan (no interest included).
- **Final Amount**: The total amount at the end of all the instalments. This is not a mandatory field and the default value is set to zero.
- **Type**: This determines when the payment needs to be made. The default value is zero, which means at the end of the period; one means at the start of the period.

In Figure 6.51, C10 represents the period that changes in the formula, while all other parameters are fixed references to the loan amount.

FIGURE 6.51 IPMT Function

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Interest on loan calculations</td>
</tr>
<tr>
<td>2</td>
<td>You borrow $10m over ten years to refurbish your premises at an interest rate of 8%:</td>
</tr>
<tr>
<td>3</td>
<td>Loan amount</td>
</tr>
<tr>
<td>4</td>
<td>Interest Rate</td>
</tr>
<tr>
<td>5</td>
<td>Term</td>
</tr>
<tr>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Year</td>
</tr>
<tr>
<td>11</td>
<td>Annual Repayment</td>
</tr>
<tr>
<td>12</td>
<td>Interest Only</td>
</tr>
</tbody>
</table>

Chapter 6: Functions for Financial Modeling 146
**PPMT:** This is another complementary function to the PMT function. Like the IPMT, PPMT returns the other component of the instalment: principal amount.

The syntax for PPMT is `PPMT(rate, period, number of payments, principal amount, final amount, type)`. In this syntax, the following applies:

- **Rate:** This is the fixed interest rate for the loan period.
- **Period:** This is the period for which the interest amount needs to be calculated. For the first period (week, month, year, etc.) this would be 1, and for subsequent periods it will increase as 2, 3, 4, and so on.
- **Number of Repayments:** This is the number of instalments within which you want to repay the loan.
- **Principal Amount:** Amount of original loan (no interest included).
- **Final Amount:** The total amount at the end of all the instalments. This is not a mandatory field and the default value is set to zero.
- **Type:** This determines when the payment needs to be made. The default value is zero, which means at the end of the period; one means at the start of the period.

In Figure 6.52, C10 represents the period that changes in the formula, while all other parameters are fixed references to the loan amount.

**FIGURE 6.52 PPMT Function**

![PPMT Function](image)

**Tip:** If you want to verify your calculations, always remember that the sum of IPMT and PPMT must equal PMT. This is a great opportunity to enter an error check!

**Why Does the Interest Amount Decrease on a Fixed Interest Rate?**

When using an amortisation schedule for loan-repayment calculations, the initial interest amounts are high, but with each period the interest amount goes down and the principal amount increases. This is reflected in Figure 6.53, which is based on Figure 6.52.
Looking at the graph, the calculations may initially seem incorrect since the interest rate is constant but the interest amount is decreasing. This can be better understood by delving into the actual amounts. The original principal amount was one million dollars and the interest was calculated on this principal amount as $80,000. The rest of the instalment ($69,029) went toward repaying the principal.

In the second year, the principal amount was reduced by the first instalment ($69,029 went toward the principal). This means the new principal is one million dollars less the first instalment, which is $930,971. Due to reduced principal amount, the net interest amount is reduced. However, to maintain the constant instalment amount, the principal amount is increased. Extrapolating this calculation, it is evident that as the period number increases that the unpaid principal amount decreases and so does the interest amount. However, the principal amount being repaid increases to maintain constant repayment instalments.

SUMMARY

In this chapter we have covered a couple of the important aggregation, lookup, referencing, date, and finance functions that, at minimum, are important for a financial modeller to know. As we know, however, there is a lot more to being a good financial modeller than knowing hundreds of different Excel functions! The most challenging part is to know when to use these functions in your modelling. When faced with a problem, creating a modelling solution that contains the most appropriate tools and functions is the task faced by the financial modeller. Usually, there are several different possible tools that can be used, and the one that is the most concise, yet easiest to follow will be the best solution.
Chapter 6 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Each of the following is true regarding the LOOKUP function except:
   a) the data must be sorted in alphabetical order  
   b) the data must be stored from smallest value to largest value  
   c) the column/row number is not hard-coded  
   d) it is less popular than the VLOOKUP and HLOOKUP functions

2. The NOW( ) function gives which of the following information:
   a) today’s date whenever you open the model  
   b) the last date of the month with reference to any date  
   c) the day number in the week corresponding to the date specified  
   d) the exact date and time whenever you open the model

3. Which of the following is not a criterion used to evaluate NPV and IRR:
   a) returns  
   b) risk  
   c) time  
   d) interest
Chapter 6 – Solutions and Suggested Responses

1. A: Incorrect. The primary disadvantage of the LOOKUP function is that data must be sorted in alphabetical order or else it will not work.

   **B: Correct.** The data must be sorted in alphabetical order, not numerical order.

   C: Incorrect. Unlike the VLOOKUP or the HLOOKUP, neither the column nor the row is hard-coded.

   D: Incorrect. Due to the requirement that the data must be sorted in alphabetical order, it limits the usage of this function significantly making it less popular than both the VLOOKUP and HLOOKUP functions.

   (See pages 122 to 124 of the course material.)

2. A: Incorrect. The =TODAY( ) function only gives today’s date whenever you open the model and not the time.

   B: Incorrect. The EOMONTH function gives the last date of the month with reference to any date.

   C: Incorrect. The =WEEKDAY function gives the day number in the week corresponding to the date specified.

   **D: Correct.** The NOW( ) function gives the exact date and time whenever you open the model.

   (See pages 133 to 134 of the course material.)

3. A: Incorrect. Returns are one of the criteria that NPV and IRR use in their evaluation.

   B: Incorrect. NPV and IRR both use risk in their evaluation.

   C: Incorrect. Time is one of the criteria that NPV and IRR use in their evaluation.

   **D: Correct.** Interest is not one of the three criteria that both NPV and IRR use in their evaluation.

   (See page 140 of the course material.)
Chapter 7: Tools for Model Display

Leaving aside the formulas and calculations of a model, in this chapter we will focus on the look and feel of a model. There are many Excel tools that can be used to make the model more attractive and friendly to the user. We’ll look at the basic formatting, and then more complex custom formatting, conditional formatting, and then form controls, which can be built to help the user interact with the model more easily.

BASIC FORMATTING

Believe it or not, as simple as it may sound, good formatting is an important part of building a financial model. While it’s critical of course to get the numbers right, making your model look good is the next step! A model that is well formatted will be more readable, user-friendly, and easy to navigate. Additionally you, the modeller, will find it easier to work with the model if it is clearly formatted.

In the latest version of Excel, all the formatting options for colour, font, and alignment are clearly displayed on the Home tab. A shortcut exists on the Home tab where you can very quickly change the number format on any cell from the Number ribbon, as shown in Figure 7.1.

FIGURE 7.1 Formatting from the Ribbon in Excel 2010

For detailed instructions on the more basic formatting tools, including changing number formats, percentage and currency formatting, number alignment, cell attributes, and styles, please see the supplementary material at www.wiley.com/go/steinfairhurst, available for download in PDF format. The instructions for Excel 2003 can be found in the Excel 2003 supplementary document.

CUSTOM FORMATTING

We can go one step further with our formatting to customise the way data is displayed in cells without changing the underlying data. For instance, the function =NOW( ) gets the current date and time from your computer and, by default, displays it in the format “dd/mm/yyyy hh:mm” (or according to the date conventions in your computer’s Regional and Language Options within Control Panel).

We can change the look of this date without disturbing its intrinsic value by formatting it differently. Let’s have a look at how we’d do this:

1. Open a blank spreadsheet and type into cell A1 Report as at, and into cell B1 type the function =NOW( ) or =TODAY( ).
2. Size the column widths to match the data, then select cell B1 for formatting. See Figure 7.2.
3. Choose Format on the Cells section of the Home tab. Select Format Cells at the bottom of the drop-down list that appears.

   In Excel for Mac 2011, from the Format menu, select Cells.

   The dialog box in Figure 7.3 appears, showing how Excel has already customised the cell.

FIGURE 7.3 Format Cells Dialog Box

As can be seen from the dialog box, there are many pre-set formatting options for numbers, from General to Accounting to Custom. As suggested within the dialog box, we can type our own codes over pre-set ones if the format we want isn’t available.
4. To create a customised format, select Custom from the Category list. Overwrite Excel’s choice of “dd/mm/yyyy hh:mm” with just the three characters “mmm” and observe what Excel does with your date. Add a further “m” to make our custom formatting “mmmm” and the result will be, after reflection, obvious.

5. Custom format your current date to the following format: 24 Feb 2014 (your date will be different in content).

In all Windows Excel versions, the shortcut key Control + 1 will invoke the formatting dialog box as seen in step 3, above. For Excel for Mac 2011, press Command + 1.

Excel 2010 has an additional shortcut to pre-set formats in the Number section of the Home tab, as seen in Figure 7.4.

**FIGURE 7.4 Changing the Date Format**

Excel for Mac 2011 has the most commonly used formats pre-set on the Formatting toolbar; namely currency, percent, thousands separator, and decimal places, but dates are not there. You’ll need to use the Format Cells dialog box to format cells to dates.
Custom Currency Symbols

As mentioned earlier, changing the look of a cell doesn’t affect the underlying data. So far we’ve played with dates (which are numbers to Excel even though they’re generally displayed as text), but there are plenty of other pre-set number formats that we can, if necessary, customise.

1. Go to a blank sheet, and type in 582504 into a cell. If you have not defined any formatting on that cell yet, Excel will assign a General format to it.
2. Change the number to currency (to two decimal places) preceded by your country’s monetary symbol, by using the Currency category in the Format Cells dialog box.
3. Change the currency symbol to that of the Chinese Yuan, or some other foreign currency.
4. Change the currency symbol to that of a currency we’ve made up – Elbonian Spree (EL).

As you might have suspected, the Elbonian Spree isn’t available in the list of symbols. We’ll have to build a custom format for it.

Select the Custom category and overwrite Excel’s ¥ symbol with EL, as follows:

\[\text{[$¥-804]##0.00;[$¥-804]-##0.00} \text{ is changed to “EL” ##0.00;“EL” #,##0.00}\]

Note that EL, as invented by us, is unknown to Excel and must be presented as a string (i.e., in quotes). This custom currency symbol will be saved with the workbook and will be available for future use.

Understanding Excel’s Number Formats

Number formats have four elements:

1. Positive number
2. Negative number
3. Zero
4. Text

Each is separated by a semicolon. None of them are mandatory, but there should be a positive element, at least.

Consider the elements in the format $ * #,##0; [Red]$ * -# #,##0; $ * “,”;

<table>
<thead>
<tr>
<th>Format</th>
<th>Positive</th>
<th>Negative</th>
<th>Zero</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>$ 1,000</td>
<td>$ -100</td>
<td>$ 0.00</td>
<td>Jack</td>
</tr>
<tr>
<td>Represetation</td>
<td>$ 1,000</td>
<td>$ -100</td>
<td>$ -</td>
<td></td>
</tr>
</tbody>
</table>
Leading zeros of both positive and negative numbers will be suppressed wherever # is specified. Negatives will show the minus symbol after $ and zeros will display −. The text Jack will be represented as a single asterisk. The monetary symbol asterisks ($ *) indicate that the symbol must be fixed to the left and not follow the number as it shrinks or expands.

You’ll note that Excel sometimes uses codes, particularly in currency formats. These are used, for instance, in differentiating between Australian and U.S. dollars, and needn’t concern us.

The important thing to remember is that the underlying number doesn’t change no matter how we format it. It retains its decimal places even if we can’t see them. Arithmetic can continue to be done on a cell’s contents, even if it’s invisible.

**Useful Formatting Options**

If you intentionally leave an element blank, it will be rendered invisible.;$-.#,#0.00;; will show negatives only, all the other elements being deliberately suppressed. The entry ;; will make everything in the cell invisible (so will changing the font colour to match the background).

To display a number as 000s, while still retaining its full value, custom format it as $#,##0, (the format followed by a comma). Millions are represented by $#,##0,, “m”. $458,243,555.42 will display as $458m, which, if multiplied by one, will return $458,243,555.42. If this does not work, your digit grouping symbols within Regional and Language Options in the Control Panel are not set as commas.

To physically change a number to rounded thousands use the ROUND, ROUNDUP, or ROUNDDOWN functions, employing minus digits. ROUND(458243,-3) will change the number to $458,000. The format $#,##0, will display $458, which, if multiplied by one will return $458,000.

To make currency negatives by default show in parentheses, change your negative Currency Format options within Regional and Language Options in the Control Panel to default to parentheses.

**Custom Formatting in Reporting**

Create some numbers that look like Figure 7.5:

**FIGURE 7.5 Sample Report**
We are going to format the numbers so that they look similar to Figure 7.6 (without changing the underlying data):

**FIGURE 7.6 Completed Report**

1. Highlight the data and, as described above, go to the Custom Formatting dialog box.
2. Add a comma to the end of the format type as shown in Figure 7.7.

This will change the look of the numbers without changing the value of the numbers at all.

Next, add up cells B4:B8 manually. You'll notice that the total should be $1,612, not $1,611! Use the =ROUND formula, as shown above, to round the numbers to the nearest thousand, such that your report or PowerPoint slide is correct.

**FIGURE 7.7 Custom Formatting Using the Format Cells Dialog Box**
CONDITIONAL FORMATTING

Conditional Formatting is a tool that allows you to apply formats to a cell or range of cells, and have that formatting change, depending on the value of the cell or the value of a formula. For example, you can have a cell appear bold only when the value of the cell is greater than 100. When the value of the cell meets the format condition, the format you select is applied to the cell. If the value of the cell does not meet the format condition, the cell’s default formatting is used.

This is handy for variance analysis on a profit and loss (P&L), for example. If you want to highlight any instance where a variance is greater than 10 percent higher than budget, the cell will turn red.

Remember that Conditional Formatting is the same as adding one or more formulas to each cell in which you use it, so applying Conditional Formatting to a large number of cells may cause performance degradations. Use caution when applying to large ranges!

Conditional Formatting is greatly improved in Excel 2007/10. There are many more options (including the handy Data Bars), and the limitation of three conditions has been lifted. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

To Apply Conditional Formatting

1. Select the desired cell or cells in the spreadsheet. Let’s say, for example, you wanted to highlight with a red font any cell value that is between 1 and 10.
2. On the Home tab, in the Styles group, select Conditional Formatting. Select Highlight Cells Rule and then Between. Type in 1 and 10, and define the desired font colour. See Figure 7.8.

Add a new rule for each new condition; you can have as many as you like (unlike in Excel 2003, where you are limited to three rules).

FIGURE 7.8 Conditional Formatting in Excel 2007/10
To Remove Conditional Formatting

On the Home tab, in the Styles group, select Conditional Formatting. Select Manage Rules, and you can delete your chosen rules one by one. Alternatively, you can clear rules from selected cells or from the entire sheet by clicking on Clear Rules.

Data Bars

Data bars are a new feature in Excel 2007 and, therefore, it is possible to create them in versions 2007, 2010, and Excel for Mac 2011, but not in Excel 2003. Data bars are a dynamic bar chart that you can apply to any numerical data in Excel. They graphically show the relative size of each value. See Figure 7.9.

FIGURE 7.9 Data Bars in Excel 2010

Go to a table of numeric data, and highlight the numbers.

1. On the Home tab, in the Styles group, select Conditional Formatting, and then Data Bars.
2. Choose your desired bar.
3. Practice changing the underlying numbers, and see the bars change.

Icon Sets and Colour Scales

Icon Sets are a feature that was new to Excel 2007. They allow you to conditionally display a small icon that represents changes in data. For example, if revenues are down this month compared to last, you may choose to represent this with a red arrow pointing down, or if your cash balance is above a certain threshold, you could use a green checkmark to give the user a quick way to see that everything is okay.

Your options for icons currently available in Excel 2007/10 are shown in Figure 7.10. Note that there is no way to import any additional icons, but this might be possible in future releases.
Another feature new to Excel 2007 was Colour Scales. Looking at Figure 7.11, how would you be able to quickly assess what is good, bad, and in-between?

By using Colour Scales, you can assign rules for what is good, bad, and in-between, and display the data with colour to represent these rules. You can see in Figure 7.12 how data is more useful when the user can quickly spot areas of concern.
Enhancements to Conditional Formatting in Excel 2010

You have access to more icon sets, including triangles, stars, and boxes. You can also more easily hide icons from view, as is evident in Figure 7.13.

Being able to hide the icons is a new feature applicable to Excel 2010 and Excel for Mac 2011 only.

Editing the rule gives you a variety of options. See Figure 7.14.
You can also easily mix and match data bars, colour scales, and icons from different sets. In Figure 7.15 the same range has both data bars and icons.

The automatic negative bars as shown in Figure 7.15 are a new feature, available in Excel 2010 and Excel for Mac 2011 only.

In Excel 2010 and Excel for Mac 2011, you can also create conditional formatting with references to a different sheet in the workbook. This means that you no longer need to copy or link your data to the same sheet when using conditional formatting.
SPARKLINES

Just like Conditional Formatting and the Icon Sets, Excel also has another interesting micro-charting feature termed the sparkline. These lines are not as descriptive as regular graphs and charts, but they are very effective in displaying a quick view about the trends in the data or metrics. This is a new feature introduced in Excel 2010, so it is an enhancement over the older versions. At the same time, since this is the first release, the design is not necessarily as polished as a modeller would hope. Note that sparklines can only be created and viewed in Excel 2010, so if your model is viewed in Excel 2007 or earlier, the sparklines will disappear. This is one of the few instances where Excel 2007 and 2010 differ in functionality.

HOW TO CREATE A SPARKLINE

1. Select the data series for which the sparkline needs to be created. See Figure 7.16.

FIGURE 7.16 Data to Contain Sparklines

<table>
<thead>
<tr>
<th>Year</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
</tr>
<tr>
<td>12</td>
<td>$30,000</td>
<td>$75,476</td>
<td>$86,516</td>
<td>$92,072</td>
<td>$96,936</td>
<td>$99,403</td>
<td>$99,403</td>
<td>$98,722</td>
<td>$91,201</td>
<td>$113,029</td>
</tr>
<tr>
<td>13</td>
<td>$89,029</td>
<td>$59,150</td>
<td>$80,516</td>
<td>$96,936</td>
<td>$99,403</td>
<td>$103,477</td>
<td>$109,541</td>
<td>$118,394</td>
<td>$127,799</td>
<td>$137,999</td>
</tr>
<tr>
<td>14</td>
<td>$140,029</td>
<td>$140,029</td>
<td>$140,029</td>
<td>$140,029</td>
<td>$140,029</td>
<td>$140,029</td>
<td>$140,029</td>
<td>$140,029</td>
<td>$140,029</td>
<td>$140,029</td>
</tr>
</tbody>
</table>

2. Under the Insert tab in the Sparklines ribbon, select Line. Note that sparklines are found in the Charts ribbon under Insert Sparklines in Excel for Mac 2011. See Figure 7.17.

FIGURE 7.17 Choosing Sparklines from the Ribbon

3. In the Create Sparklines dialog box, the data range is automatically selected, so enter the cell or cell range in which you want the sparklines to be placed. Click OK. See Figure 7.18.

FIGURE 7.18 Sparklines Dialog Box
4. The sparklines are drawn in the selected cells. See Figure 7.19.

**FIGURE 7.19 Completed Report with Sparklines**

<table>
<thead>
<tr>
<th>Year</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
</tr>
<tr>
<td>12</td>
<td>$80,000</td>
<td>$74,478</td>
<td>$68,613</td>
<td>$62,072</td>
<td>$55,116</td>
<td>$47,600</td>
<td>$39,486</td>
<td>$30,725</td>
<td>$21,261</td>
<td>$11,019</td>
</tr>
<tr>
<td>13</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
<td>$149,029</td>
</tr>
<tr>
<td>14</td>
<td>$214,029</td>
<td>$214,029</td>
<td>$214,029</td>
<td>$214,029</td>
<td>$214,029</td>
<td>$214,029</td>
<td>$214,029</td>
<td>$214,029</td>
<td>$214,029</td>
<td>$214,029</td>
</tr>
</tbody>
</table>

**Tip:** Use a combination of sparklines and icons to create more meaningful representations of data points.

**Editing Sparklines**

The attributes of the sparklines can be modified from options under the Design tab. To edit data, select the sparklines and click on the Edit Data in Sparkline ribbon under the Design tab. See Figure 7.20.

**FIGURE 7.20 Editing Sparklines**

This will open the Edit Sparklines dialog box, where you can change the data range as well as the sparkline location. See Figure 7.21.

**FIGURE 7.21 Edit Sparklines Dialog Box**
To edit chart type, select the sparklines and click on one of the three options in the Type ribbon under the Design tab. See Figure 7.22. The three options are:

- Line: Simple line graph.
- Column: Column graph, similar to area plots.
- Win/Loss: Map the data in win/loss format.

**FIGURE 7.22 Changing Sparkline Type on the Ribbon**

To highlight important points in the sparklines, choose from:

- High Point
- Low Point
- Negative Points
- First Point
- Last Point

To highlight important data points, select from a series of checkboxes in the Show ribbon, under the Design tab. See Figure 7.23.

**FIGURE 7.23 Highlighting Sparkline Data Points on the Ribbon**

You can also edit the style of the sparklines by changing the line colours and marker colours. See Figure 7.24.

**FIGURE 7.24 Editing Sparkline Formatting on the Ribbon**
Changing Properties for a Group of Sparklines

While each sparkline represents a unique series of data, you can edit the properties of a group of sparklines using the group and ungroup features. When the sparklines are grouped, you can edit the properties for the entire group, even if you select just a single line from the group. See Figure 7.25.

FIGURE 7.25 Grouping Sparklines Together

To separate out the sparklines in the group, select Ungroup in the Group ribbon under the Design tab.

Tip: If you want to create a series of sparklines for a series of data points, you can create it for the first list and just copy paste the sparkline to auto-create it for the rest of the lists.

BULLETPROOFING YOUR MODEL

If your model is publicly available, or if you have a lot of users entering data into it (especially if their Excel skills are questionable), it’s a good idea to spend some time protecting it and making sure that all your hard work is not inadvertently corrupted!

Protection

Once you have completed building your model, there are three basic layers of protection you can include:

1. **Protect the file** so that no one can open it without the password.
2. **Protect the structure** of the workbook so that no structural changes can be made (normally used for hiding sheets and restricting access to them).
3. Unlock individual cells on the worksheet and then **protect the sheet** so that only those cells that are unlocked can be changed.

Protecting the structure or worksheets can be done with or without a password.

**Warning:** Do not use a password unless you are certain that you will not forget what it is! There is no way to retrieve a forgotten password in Excel. Passwords are case-sensitive.

However, if it is a matter of life and death, do not trust your model to a password! Passwords can be hacked reasonably easily. Note that there are programs out there that can decode a password. If your file contains highly sensitive information, do not rely on passwords in Excel.
Protect the File

This is done by changing the options, and saving over the existing copy of the file. There are two options with this: protecting the file with a password, or recommending read-only access.

Password-Protect a File: If you don't want anyone to be able to open your file without a password, or make changes without a password, this is done under General Options. You can select Password to Open or Password to Modify.

HOW TO PASSWORD-PROTECT A FILE

1. Click on the Microsoft Office button or File menu in the top left-hand corner of your screen and select Save As.
   In Excel for Mac 2011, go to File – Save As.

2. Click on the Tools button and select General Options.

3. Enter the password, and save over the file.

This is recommended if you are e-mailing a confidential file and are concerned that it might be intercepted or viewed by the wrong person!

Read-Only Recommended: Instead of using a password to prevent access, you could use the read-only option to deter users from changing your workbooks. This way you prevent inadvertent changes to models.

HOW TO ENABLE READ-ONLY

1. Follow the instructions as above (“How to Password-Protect a File”).
2. Instead of typing a password, tick the Read-Only Recommended tick box.

Protect the Structure

The most common use of protecting the structure is to protect hidden sheets, but it also stops users from adding or deleting sheets, or changing other structural aspects of your model, but not from editing cell contents. If you want to stop users from entering data or changing values in cells, you need to protect the worksheet. See the next section for how to do this.

Protecting Hidden Sheets: If you have a sheet containing sensitive data, you can hide the entire sheet, and then protect the workbook so that the sheet cannot be viewed. This is particularly handy if, for example, you have salary data on sheet in a budget model and don’t want all users to have access to the information.
Protect the Worksheet

This is the most commonly used form of protection. If you have created a spreadsheet that you do not want to be altered by the others who might view it, you can protect the sheet. You can either protect the whole sheet, or just certain key cells in the sheet (probably those containing the formulas) so that new data can still be entered onto the sheet.

**HOW TO PROTECT HIDDEN SHEETS**

1. Put all sensitive information on one sheet.
2. Hide the sheet. Right-click on the sheet tab name and select Hide. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)
3. Now protect the structure of the workbook so that users cannot unhide sheets.
   - On the Review tab, in the Changes group, select Protect Workbook and then Protect Structure and Windows from the drop-down box.
   - In Excel for Mac 2011, on the Review tab, in the Protection group, select Workbook and then Protect Structure and Protect Windows from the dropdown box.
4. If you enter a password, users will need a password in order to view the sheet(s) you have hidden.

**HOW TO PROTECT A WORKSHEET**

1. Go to the sheet you wish to protect.
2. On the Review tab, in the Changes group, select Protect Sheet. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)
   - In Excel for Mac 2011, on the Review tab, in the Protection group, select Sheet.
3. This will bring up the Protect Sheet dialog box, in which you can enter a password to prevent users from unprotecting the sheet. You do not have to use a password; you can just leave the Password box empty, and this may be enough of a deterrent to prevent users from modifying your model.
4. Enter a password (if necessary) and click OK.
5. If you have entered a password, you will be asked to confirm the password.
6. Type the password again.
7. The whole sheet is now protected. Users will not be able to change the contents of any cell. If you need to change cell contents you will need to unprotect the sheet.

*Note: If the sheet has been protected it sometimes is not possible to adjust column width. This can be very frustrating for the user, so make sure your columns are the correct width!*
HOW TO UNPROTECT A WORKSHEET

1. Select the tab name of sheet you wish to unprotect.
2. On the Review tab, in the Changes group, select Unprotect Sheet. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)
   In Excel for Mac 2011, on the Review tab, in the Protection group, select Sheet.
3. If no password was originally used to protect the sheet, then the sheet will automatically be unprotected at this point.
4. If a password has been used, the Unprotect Sheet dialog box will appear. Enter the password and click OK.

Protect Data by Locking Cells: By following the process outlined above to protect the worksheet, you will find that you won't be able to make any changes at all to any cell! If you want to allow entry into certain cells, but leave part of the sheet protected (perhaps the cells containing formulas), you'll need to unlock those cells to be edited first, before protecting the sheet. Make sure you turn off your protection before unlocking cells!

By default, every cell in a sheet has a lock applied to it. It is the lock that is activated when the sheet is protected and stops people from editing cells. You need to unlock those cells that should be changed.

CUSTOMISING THE DISPLAY SETTINGS

The following is an example of a model that's been very highly protected, and the display settings have been changed so that it almost does not even look like an Excel file. You can download a copy of this file called “Salary Sacrifice Calculator” from www.wiley.com/go/steinfairhurst and if you would like to unprotected it, use the password plumsolutions. You will need to unprotect the sheet as well as the file structure, and how to do this is outlined in this section.

To make your model highly protected, like the model in Figure 7.26, you may choose to change a few settings to make your model look less like an Excel sheet, and more difficult for the user to change.
Removing Row and Column Headers

This is one of the few instances where the instructions differ slightly between Excel 2010 and 2007. Click on the Microsoft Office button or the File tab in the top left-hand corner, go to Options or General Options. Under Advanced in Display Options for this Worksheet, untick the Show Row and Column Headers box. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

In Excel for Mac 2011, go to Excel, then Excel Preferences and under View, in the Window Options section, untick the Show Row and Column Headers box.

Removing Sheet Tabs

Click on the Microsoft Office button or the File tab in the top left-hand corner. Go to Options or General Options, and under Advanced, in Display Options for this Worksheet, untick the Show Sheet Tabs box.

In Excel for Mac 2011, go to Excel, then Excel Preferences and under View, in the Window Options section, untick the Show Sheet Tabs box. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

Note that vertical and horizontal scroll bars can also be removed via the same method.
Removing the Formula Bar

Click on the Microsoft Office button or the File tab in the top left-hand corner; go to Options or General Options and under Advanced, in Display, untick the Show Formula Bar box.

In Excel for Mac 2011, go to Excel, then Excel Preferences. Under View in the Window Options section, untick the Show Formula Bar by Default box.

Minimising the Excel 2007/10 Ribbon

Again, the instructions differ between Excel 2007 and 2010. Note that this only changes the view in your Excel on your computer; it does not change the model. Hence if colleagues open up the same model and their Excel settings have the ribbon maximised, they will see the whole ribbon.

In Excel 2010, go to the top right-hand corner of your screen and click on the little icon. See Figure 7.27.

**FIGURE 7.27 Minimising the Ribbon in Excel 2010**

![Minimising the Ribbon in Excel 2010](image)

In Excel 2007, go to the Customise Quick Access Toolbar button in the top left-hand corner of your screen, and select Minimise the Ribbon from the menu. See Figure 7.28.

**FIGURE 7.28 Minimising the Ribbon in Excel 2007**

![Minimising the Ribbon in Excel 2007](image)

*Tip:* You can also minimise the ribbon by simply pressing Control + F1! (Option + Command + R in Excel for Mac 2011).
Restrict the Work Area

You can make the work area of the sheet much smaller so that users cannot enter data in cells you don’t intend them to. See Figure 7.29.

FIGURE 7.29 A Worksheet with Restricted Work Area

To restrict the work area, it is exactly the same in all versions of Excel:

1. Highlight the first column you don’t want to see (for example, column F) and press Control + Shift + Right Arrow (Command + Shift + Right Arrow in Excel for Mac 2011). Now right-click and select Hide.
2. Highlight the first row you don’t want to see (for example, row 6) and press Control + Shift + Down Arrow (Command + Shift + Down Arrow in Excel for Mac 2011). Now right-click and select Hide.

Restricting Incorrect Data Entry with Data Validations

Usually we are building models for others to use, and they might not have the same level of Excel skill as we do. Users often have a knack for finding strange and wonderful methods of entering data in the wrong format, which can mess up your formulas. They might enter text where the model requires numbers, or spell names in a different way to what the criteria in a VLOOKUP is expecting, for example. If unsure of a number they sometimes write TBA (for to be advised), or if the value is a range, they might enter 5–10%. They don’t realise that the model must have a numeric value to calculate properly, and so they need to choose between 5 percent and 10 percent or enter the average of 7.5 percent! Using data validation will allow you to control the data that is typed into your model, and avoid errors.

HOW TO APPLY DATA VALIDATIONS

1. We’d like to restrict a cell’s entries so that is will only allow values between 1 and 10.
2. Select your input cell(s) (either select a single cell or highlight a whole range).
3. On the Data tab, from the Data Tools group, click on the Data Validation button. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)
4. Choose Whole Number under the Allow drop-down.
5. Leave the Between option as it is, and enter the values 1 and 10 under the Minimum and Maximum value fields and click OK.
Every cell will allow any value at all. Therefore, you can enter any type of data, of nearly any length (up to several thousand characters) into any cell. You can use the data validation feature to restrict the values users enter into cells in the model.

Data validations take protection one step further: Instead of restricting where data can be entered, they can also restrict what can be entered into the cell.

Once users enter a wrong value, they have to either enter the right value, or hit the Esc (escape) key to get out of the error message. Hitting Esc will clear the entry in the cell they are trying to enter data into.

There are a couple of handy little tools you can add into the data validation while you are here. You can enter in-cell comments on the Input Messages, as shown in Figure 7.30. Some text will pop up to help users or give them important information whenever the cell is selected.

**FIGURE 7.30 Data Validation Comment**

![Data Validation Comment](image)

See the section on “Methods and Tools of Assumptions Documentation” in Chapter 3 for more information on how to create the data-validation comment.

In the data-validation dialog box, you can also enter your own, customised error message on the Error Alert tab. This message will be shown if users enter invalid data. Resist the temptation to write something silly. See Figure 7.31.

**FIGURE 7.31 Customised Error Message**

![Customised Error Message](image)

Note that you can control how vigilant the data-validation restrictions on your model will be. One day your department may have grown and it suddenly really is valid to have more than 500 staff. If you change the options on the Error Alert tab to Warning instead of Stop, then the message will alert users and discourage them from entering staff number 501, but it will allow it, if necessary. The error message will then prompt users that the restriction should be changed. The users can choose Yes to allow the entry of 501.
If you change the options on the Error Alert tab to Information instead, users are alerted that they entered an unexpected value, but the message defaults to OK and allows them to keep the value that they entered.

**Using Validations to Create a Drop-Down List**

Instead of specifying a range, you can be more specific and only allow certain pre-defined entries. This is how we can create drop-down lists with data validations. See Figure 7.32.

**FIGURE 7.32 Creating a Drop-Down List**

1. First, create a list of valid regions, such as the list below:
   - United Kingdom
   - Germany
   - India
   - Australasia
   - France
   - United States
2. Select the cell that should contain the drop-down list.
3. Bring up the Data Validation box:
   - In Excel 2007/10, on the Data tab from the Data Tools group, click on the Data Validation button.
   - In Excel for Mac 2011, on the Data tab from the Tools group, click on the Validate button.
4. In the Allow section, change Any Value to List, as shown.
5. In the Source field, enter the range that contains the data you want to appear in the drop-down list. Leave In-cell Dropdown selected. See Figure 7.33.
6. Any time that the cell is selected, a drop-down arrow will appear and users will be able to select from the list. See Figure 7.34.

FIGURE 7.34 Completed Drop-Down List

If users try to enter data that is not on the list, an error alert will appear. Also, if you change the source data, the drop-down options will also change. Practice this; try changing United Kingdom to Britain. You’ll see that Britain now appears on the list instead of United Kingdom.

Be aware, however, that it is possible to paste values over a restricted cell! You may have spent a long time protecting and setting up your worksheet so that users cannot enter incorrect data; however, it is very easy for users to inadvertently (or perhaps deliberately) paste over a data validation without receiving the error message or restrictions that would have appeared had they tried to enter the data directly into the cell.

Referencing Source Data on Another Sheet

A restriction with data validation drop-downs is that the source data and the drop-down must be on the same page. There is a workaround, however.

1. Assign a named range to the source data (for example, =countries). See the section on “Named Ranges” in Chapter 5 for instructions on how to do this. See Figure 7.35.
FIGURE 7.35 Creating a Drop-Down List Using a Named Range

2. When creating the data-validation drop-down, in the List box, enter an equal sign followed by the name of the range on the other worksheet. You must type = and then spell the named range correctly for it to work.

Note that in Excel 2010, it is possible to link directly to source data on other sheets when creating a data-validation drop-down box without having to use a named range. However, if this is done in 2010 without using the named range, then the file will not be compatible with Excel 2007 or 2003. It is therefore recommended to always use named ranges when linking drop-down boxes to source data on another page to ensure compatibility with earlier versions of Excel.

FORM CONTROLS

Form controls are objects such as drop-down boxes and option buttons that sit over the top of Excel sheets, like charts do. They can interact with formulas so that when the option is selected, it changes the formula and can drive the model. They can be especially useful for scenario selection and assumptions in a financial model.

Building form controls into a financial model can be time-consuming for the modeller, but they do make the model look very professional and the interface becomes extremely easy to use.

Accessing Form Controls

If you are using Excel 2007 or 2010, you will need to have the Developer tab showing in the ribbon. If you cannot see it in the ribbon, you’ll need to change your options.

Showing the Developer Tab in the Ribbon

This section is only relevant for Excel 2007/2010 and Excel for Mac 2011 users. The Developer tab contains several functions that are useful when developing macros and form controls. The default installation version of Excel 2007 or 2010 will not have the Developer tab showing in the ribbon. You will need to change this setting only once, unless you re-install Excel, or move to another machine.
This is one of the few instances where the instructions for 2010 differ from 2007. To display the Developer tab in the ribbon in Excel 2010:

1. Click on the File menu in the top left-hand corner of your screen.
2. Scroll down to Options at the very bottom and select it.
3. Select Customize Ribbon.
4. In the box to your right, tick the Developer box.

In Excel 2007:

1. You need to click on the Microsoft Office button in the top left-hand corner of your screen.
2. Under Excel Options, go to the Popular section.
3. Check the Show Developer Tab in the Ribbon.

And in Excel for Mac 2011:

1. Click on the gear box in the top left-hand corner of your screen.
2. Select Ribbon Preferences.
3. In the dialog, tick the Developer box.

You don’t need to do any of this if you are using Excel 2003, as it doesn’t have a Developer tab; macros and form controls are directly accessible via the toolbar in Excel 2003. See Figure 7.36.

FIGURE 7.36 The Developer Tab

Check Boxes

Tick boxes (or check boxes, as Microsoft calls them) are very handy tools that can help users choose their desired options from a list. By building check boxes into a financial model, the developer allows users to customise the model by adjusting the combinations of inputs for the financial model’s assumptions.

HOW TO CREATE CHECK BOXES

1. Go to the Developer tab on the Excel toolbar and click on Insert. See Figure 7.37. If you cannot see the Developer tab, follow the instructions above on how to show the Developer tab in the ribbon.
In Excel for Mac 2011: Below is how the Developer tab in the ribbon looks if you are using Excel for Mac 2011. See Figure 7.38.

**FIGURE 7.38 Form Controls in Excel for Mac**

2. From the Forms Controls menu select the check box as shown in Figure 7.39.

**FIGURE 7.39 Inserting the Check Box**

3. Draw the check box, and you should see the box with a name Check Box 1. Subsequent check box names will be Check Box 2, Check Box 3, and so on. For ease of use and understanding, you must place the check box next to the item in the list you want to check.

   Note that you can change the check box name to anything you prefer. In this example, the item name itself has been used to keep things simple. See Figure 7.40.
4. You can now link the tick mark in this box to any function in your financial model. To do that you need to open the Format Control associated with the check box. This can be done in two ways.

a. Right-click on the check box and select Format Control as shown in Figure 7.41.

FIGURE 7.41 Assigning Check Box Options
b. Alternatively, select the check box and click Properties on the ribbon under the Developer tab, as shown in Figure 7.42.

**FIGURE 7.42 Check Box Properties**

5. In the Format Control dialog you can select the default value of the check box (unchecked, checked, or mixed) and the cell to which you want to link the check box status. In Figure 7.43, it is linked to C5. To enhance the look of the check box, you can select 3-D shading.

**FIGURE 7.43 Format Control Dialog Box**

6. The cell to which the status is linked will have a Boolean value of TRUE or FALSE. See more detail in “Boolean Logic (Binary Codes)” later in this chapter.
7. You can add multiple check boxes corresponding to the items in the list. Based on the Boolean status, you can design your financial model to pick the respective items. See Figure 7.44.

FIGURE 7.44 Worksheet Showing Check Boxes

8. Practice adding multiple items to the list and associating check boxes to each item.

Option Button

Sometimes users may need to choose one item from a list, which drives the rest of the calculations and analyses. The Option button (sometimes called a Radio button) offers you the ability to create this logic to restrict the number of options users can choose in the financial model.

HOW TO CREATE OPTION BUTTONS

1. Go to the Developer tab on the Excel toolbar and click Insert.
2. From the Forms Controls select the Option Button, as shown in Figure 7.45.

FIGURE 7.45 Inserting the Option Button

In Excel for Mac 2011, go to the Developer tab on the Excel toolbar. Select Radio Button, as shown in Figure 7.46.
3. Draw the Options button in front of the item in the list. Like the check boxes, the Option button default name starts with Option Button 1 and increases with each new button. The name can be later customised. See Figure 7.47.

FIGURE 7.47 Worksheet with Option Button

4. You can edit the properties of the button using Format Control. You can access the format control dialog in the same manner as for check boxes.
   a. Right-click – Format Control.
   b. Click Properties in the ribbon under the Developer tab.
5. In the Format Control dialog box you can select the default value of the option button (unchecked or checked) and the cell to which you want to link the option button status. (Here it is linked to D5.) To enhance the look of the option button you can select 3D shading. See Figure 7.48.
6. The cell to which the status is linked will have a numerical value of the item in the list. In the Figure 7.49, the fourth item was selected, hence $D5 = 4$.

7. You can add multiple option buttons corresponding to the items in the list. Based on the item number selected, you can design your financial model to carry out the necessary analysis.

8. Practice adding multiple items to the list and associating option buttons to each item. As you switch between each item in the list you can observe the number change in the linked cell.
Spin Buttons

Spin buttons are useful for controlling what users can enter into the input fields in your financial models. By including a spin button, users can increase or decrease the number in the increments that you specify. For example, if you set it to increments of 5, and the current value is 400, when user hit the up arrow, it will change to 405, then 410, 415, and so on, and the same with the down arrow.

HOW TO CREATE A SPIN BUTTON

1. Go to the Developer tab on the Excel toolbar and click on Insert.
2. From the Forms Controls select the Spin Button, as shown in Figure 7.50.

FIGURE 7.50 Inserting the Spinner

In Excel for Mac 2011, go to the Developer tab on the Excel toolbar. Select the Spin Button.
3. Draw the spin button next to the input box for the value you want to control. Figure 7.51 shows an example of the spin button.

FIGURE 7.51 Completed Spin Button

4. You can edit the properties of the button using Format Control. You can access the format-control dialog in the same manner as for a check box.
   a. Right-click – Format Control.
   b. Click Properties in the ribbon under the Developer tab.
5. In the Format Control dialog, you can specify the current or default value in the cell, the minimum value (here it is set to 0), maximum value (here it is 1,000), and the incremental change (here it is 10). You must also specify the cell in which you want to change the values in the cell link. See Figure 7.52.
6. Practice pressing the arrows up and down.

**Combo Boxes**

Creating a drop-down box is an important tool in many user-friendly models where the modeller wants the user to select from a pre-defined number of options, making the model easier to use, and also avoiding mistyping and potential errors. The advantage of the combo boxes is that you eliminate any ambiguity in user inputs and still keep things simple for users to provide the inputs. See Figure 7.53.

**FIGURE 7.53 Completed Combo Box Drop-Down**

The combo box is an alternative to using the data-validation drop-down tool. See the section on “Bulletproofing Your Model” earlier in this chapter for instructions on how to create a data-validation, in-cell drop-down box. The only advantage of the combo box is that the drop-down arrow is visible whether the cell is selected or not. This is a significant advantage if users are not very Excel savvy.
HOW TO CREATE A COMBO BOX

1. Go to the Developer tab on the Excel toolbar and click on Insert.
2. From the Forms Controls select the Combo Box as shown in Figure 7.54.

FIGURE 7.54 Inserting the Combo Box

In Excel for Mac 2011, note that combo boxes can only be used in conjunction with VBA in Excel for Mac 2011, and therefore the instructions in this section do not apply to Mac users. Please see the “Macros” section in Chapter 8 for more details on how to use VBA to build form controls in Excel for Mac 2011.

3. Draw the combo box next to the input box for which you want to control input. Figure 7.55 shows an example of the combo box.

FIGURE 7.55 Inserting the Combo Box

4. To fix the inputs, create an input box with inputs such as shown in Figure 7.56. Here we are using the range B8:C11.
5. You can now associate these inputs with your combo box using Format Control. You can access the Format Control dialog box in the same manner as for check box.
   a. Right-click – Format Control.
   b. Click Properties in the ribbon under the Developer tab.
6. In the Format Control dialog, give the Input Range (here it is B9:B11), and the Cell Link (here it is $D$8). Select 3-D shading to enhance the combo box. See Figure 7.57.

FIGURE 7.56 Scenario Source Data

![Image of Scenario Source Data]

This relation will only indicate the item number selected; so D8 would reflect 1 for optimistic, 2 for likely, and 3 for pessimistic. To translate these numbers into meaningful percentages from the chart, you need to link column C to D8; this can be done using IF or INDEX functions in Excel.

7. INDEX is a more elegant way of representing this link. Use the formula =INDEX(B9:C11,D8,2) to create the necessary linkage. See Figure 7.58.

FIGURE 7.57 Format Control Dialog Box

![Image of Format Control Dialog Box]
8. To keep the form clean, typically modellers would change the font colour of cell D8 to white so that the text is invisible to the user but available for calculation.

9. Practice changing the combo box, and see the values change.

From the modeller’s perspective, however, a combo box takes much longer to build, requiring more cells for the process, and is therefore less efficient. For these reasons, most modellers prefer the data-validation drop-down tool.

**Boolean Logic (Binary Code)**

Most form controls use Boolean logic, which converts everything one of to two values: a one or a zero. For example, if a check box is ticked, it will return a value in the output cell of TRUE, which equals 1; and if it is un-ticked, it will be FALSE, which equals zero. We can use the output cell to drive a formula.

In Figure 7.59, the output cell is B5. When the check box is ticked, it shows the value TRUE, which is equal to one, so this has been done by using the formula:

**FIGURE 7.59 Ticked Check Boxes Drive Calculation**
If the check box is left un-ticked, the output cell would display FALSE, which gives the value zero, and according to the formula, the GST would then not be included in the total. See Figure 7.60.

**FIGURE 7.60 Un-Ticked Check Boxes Drive Calculation**

![Figure 7.60](image)

Similar formulas can be created to link to other form controls such as option buttons and combo boxes.

**Form Controls versus ActiveX Controls**

If you are using Excel 2007 or 2010, you may have observed that the Insert button under the Developer tab has two set of options: form control and activeX controls. While both have the same set of functions, they have a slight difference. The ActiveX controls are tailor-made for a Microsoft Office environment and use Microsoft ActiveX to enhance their functionality. If you are absolutely certain that your financial model would be used in the MS Office environment only, then you could possibly add a few additional enhancements to your controls. However if your users might also be using other environments like Mac OS, the ActiveX controls can cause problems – as Apple’s operating system does not support Microsoft ActiveX.

If you want to keep your financial modelling product platform independent, stick to form controls. As far as core functionality is concerned, Form controls will offer you all the necessary flexibility required for a smooth user experience.

**SUMMARY**

Formatting and displaying the data and inputs are important parts of building a financial model. Of course the accuracy of the model and its calculation are most important, but having a model that looks good and is easy to use certainly adds to the integrity and usability of the model. A model with which the model builder has obviously taken care to use clear colour coding, borders, and correct formatting will be trusted more, and given more credibility by the user. Therefore, most good modellers will spend a little time (not too much) during the model build to format colours, borders, and styles to make it look better.
Chapter 7 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. You can hide icons in which of the following programs:
   a) Excel 2003
   b) Excel 2007
   c) Excel 2010
   d) all of the above

2. Each of the following is true regarding data validations except:
   a) they restrict where data can be entered into the cell
   b) they restrict what data can be entered into the cell
   c) if users enter the wrong value, they must exit the model to get rid of the error message
   d) you can enter in-cell comments to give users important information

3. Which of the following allow users to increase or decrease a number only in the increments that you specify:
   a) combo box drop-down
   b) check boxes
   c) option button
   d) spin button
Chapter 7 – Solutions and Suggested Responses


   C: Correct. Being able to hide icons is a new feature only applicable beginning with Excel 2010.

   D: Incorrect. You can only hide icons in Excel 2010.

   (See page 160 of the course material.)

2. A: Incorrect. Data validations restrict incorrect data entry by restricting where data can be entered.

   B: Incorrect. Data validations restrict incorrect data entry by restricting what data can be entered.

   C: Correct. If users enter the incorrect value, they have to either enter the correct value or hit the escape key to get out of the error message. They do not have to exit out of the model.

   D: Incorrect. In-cell comments can be entered in order to provide users with pop-up messages that give further and important information whenever a cell is selected.

   (See page 172 of the course material.)

3. A: Incorrect. Combo boxes allow a modeler to create a drop-down list with a predefined number of options, but they do not deal specifically with incremental adjustments.

   B: Incorrect. Check boxes allow users to choose their desired options from a list, allowing the developer to adjust the combinations of inputs for the financial model’s assumptions.

   C: Incorrect. The option button only allows users to choose one item from a predefined list which drives the rest of the calculations and analyses. Spin buttons control the increments of which a number can be increased or decreased.

   D: Correct. Spin buttons control what a user can enter into the input fields by allowing the users to increase or decrease the number only in the increments that you specify.

   (See page 183 of the course material.)
In this chapter, we’ll look at the basic, commonly used tools of hiding and grouping. We’ll then cover some more advanced tools such as array formulas, goal seeking, pivot tables, and macros. Whilst the best financial models are the simplest and easiest to understand (and therefore often don’t contain these complex tools) it’s important that the financial modeller has a grasp on how to use these tools if functionality requires.

HIDING SECTIONS OF A MODEL

Being able to hide sections of a model is a very handy tool, especially when tidying up a model to conceal cells that are necessary for the model to work, but not necessary for the user to see. You can hide rows or columns in the model, or you can hide an entire sheet. If you have information in a model you don’t want users to see (for example, unnecessary detail or a calculation that will only serve to distract from the model), you can hide the section of the model that contains the data.

Columns and Rows

It is possible to hide a column or row of data to stop it printing out, or to stop other people from viewing it.

**HOW TO HIDE A COLUMN OR ROW**

1. Select the column or row by clicking on the heading.
2. Right-click and select Hide.

The column or row will be hidden from view. But if you look at the column or row headings you can see which column is missing.

**Tip:** If you have hidden column A, or row 1, it can be tricky to unhide it. You’ll need to hold down the mouse and select across the row or column headings left or upward in order to unhide the column or row. Now the knack is that you have to right-click with the mouse in the highlighted row or column, as shown in Figure 8.1. If you click elsewhere, it won’t work.
You can hide multiple columns or rows at the same time. Just select all the columns or rows at the same time and follow the steps outlined above.

**Sheets**

Hiding sheets is also very useful. If you have information on a model you do not want users to see at all, (e.g., salary information on budget models) you can hide the sheet with sensitive information, and then protect the workbook. The hidden sheets disappear from view, but links are retained as the sheet has not been deleted from the workbook.

**HOW TO VIEW (UNHIDE) A COLUMN OR ROW**

The difficulty of bringing back a hidden column or row is that you need to select it first. As it is hidden, you cannot see the row or column to click on it. The trick is to select the headings either side of the hidden column or row. This will select the columns or row before and after, as well as the hidden column or row itself.

1. Click and drag across the headings to select those before and after the hidden column or row.
2. Right-click and select Unhide, as shown in Figure 8.2.
TO HIDE OR UNHIDE A SHEET

1. Select the sheet(s) you want to hide or unhide.
2. Right-click on the sheet tab and select Hide/Unhide. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

**Note:** Although we can easily hide multiple worksheets at a time by selecting several sheets using the Control key, only one sheet can be unhidden at a time!

**Tip:** A way to hide a sheet even more securely is to change the properties of the sheet in the Visual Basic code to Very Hidden. This method is not commonly known and will ensure that only a user experienced with programming will be able to work out how to unhide your sheets.

1. To try this out, right-click on the tab name of your worksheet, and select View Code, as shown in Figure 8.3.

    In Excel for Mac 2011, select Tools, then Macro, then Visual Basic Editor.

**FIGURE 8.2 Unhiding Rows**

**FIGURE 8.3 Viewing the Source Code**
2. This will bring up your Visual Basic Editor. This should look fairly similar in all versions of Excel.
3. Click on the sheet that you want to hide in the top left, and change properties of that sheet in the bottom left from Visible to Very Hidden, as shown in Figure 8.4.

**FIGURE 8.4 Changing the Visibility Options in the Visual Basic Editor**

By default, all sheets are set to Visible. If you change the properties to Hidden, this will change the sheet so that it is hidden using the ordinary Hide Sheets tool, and it can be unhidden as easily as normal. If it is “Very Hidden” it cannot be seen even when you try to unhide the sheets. The only way to unhide a Very Hidden sheet is to change the properties in the VBA code!

For more information on the Visual Basic Editor using macros, see the section on “Macros in Financial Modelling Case Studies” later in this chapter.
Using Protection: As just outlined, there are two methods of hiding: either hide rows and columns, or hide the worksheet itself. Depending on what is hidden, you might want to use another layer of protection to ensure that the data cannot be viewed. Password protection is a good option in such a case.

See the section on “Bulletproofing Your Model” in Chapter 7 for more detail on how to apply protection to models.

Errors Caused by Hiding

Hidden sheets, rows, and columns may hide complexity from the user and make the model less confusing, but many users don’t like using what they perceive to be a black box. It’s up to you, the model developer, to decide how much power you will give to model users. If you hide everything and then protect the model so that they can’t see how it has been calculated, this makes the model easy to use, but it does not inspire confidence in users. It often depends on who is using the model. If a model is for other modellers to use, they probably won’t appreciate being locked out of certain sections of the model, as they’d like to check it for themselves to ensure that it is working properly. If users have limited Excel use, then hiding with protection is probably appropriate to make sure they don’t mess up the formulas or make unauthorised changes.

HOW TO PROTECT HIDDEN SECTIONS OF A MODEL

If you have hidden rows or columns, apply the protection to the worksheet itself by selecting Protect Sheet from the Review tab.

In Excel for Mac 2011, select Sheet from the Review tab in the Protection group.

If you have hidden a sheet, apply protection to the structure of the workbook by selecting Protect Workbook from the Review tab.

In Excel for Mac 2011, select Workbook from the Review tab in the Protection group. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

There are many well-documented cases where hidden rows and columns have been overlooked in financial models and caused significant errors. In 2008, Barclays Capital was forced to file a legal relief motion relating to its acquisition of Lehman Brothers’ U.S. assets after a reformatting error in an Excel spreadsheet resulted in 179 contracts being mistakenly included in the purchase agreement.

The spreadsheet contained nearly 1,000 rows with more than 24,000 individual cells and had to be reformatted and converted into a PDF document before being posted on the bankruptcy court’s website by the end of the day.

But a junior associate reformatting the work was unaware that the original Excel document included hidden rows containing contracts that were marked with an n to signify they should not be part of the deal.
The document was posted on the website, but the hidden cells had become visible when the employee globally re-sized the rows in the spreadsheet – without the original n designations. The error was not spotted until Barclays posted a revised list of contracts, with notice to the affected parties.

For more Excel horror stories see the section on “Error Avoidance Strategies” in Chapter 4. This story illustrates why it is highly recommended to use the Grouping Tool when hiding rows and columns in financial models.

**GROUPING**

Determining whether there are hidden rows or columns on your worksheet can be difficult. Using the grouping tool can make hidden data more obvious and avoid its being overlooked.

Go to the Data tab and select Group/Ungroup from the Outline section. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.) When grouping is applied to a model, it will look like Figure 8.5 when collapsed.

It will look like Figure 8.6 when expanded.

**FIGURE 8.5 Collapsed Grouping**

![Collapsed Grouping](image-url)
FIGURE 8.6 Expanded Grouping

Notice the little 1 and 2 numbers in the top left-hand corner for the rows and the columns. Clicking on these numbers is a very quick and easy way to expand and contract hidden rows and columns. Clicking 1 will contract the data, and 2 will expand it.

ARRAY FORMULAS

Array formulas are an advanced type of Excel calculation. Before we launch into what an array formula is, let me begin by saying that I don’t recommend you include array formulas in your models unless there is not possibly any other way. Array formulas can be difficult to understand and hard to edit if you don’t know what they are, because you cannot change part of an array. In general, array formulas are very difficult to edit and audit because they add a new layer of complexity that is often unnecessary. Most array formulas I have seen are usually built by consultants who want to ensure that the client is unable to edit the model themselves, so guaranteeing themselves work in the future.

An array is basically just a collection of data of the same type that can be treated as a single entity. An array formula treats the entire array as a single input to the formula. The reason that array formulas are difficult to understand is because they don’t follow the usual rules of ordinary formulas. Trace Precedents and Trace Dependents will work on arrays, but don’t help very much! Many people don’t know how to use them, and if you have never seen an array formula before, they can be pretty hard to work out. Therefore, if you are building a model for others to use, using array formulas is not a great idea because they need to make changes to the formula they may have trouble.

However, in order to seriously consider yourself an Excel super-user, you should know how to build an array formula – or at least be able to recognise and edit one if you come across it – if only to remove it from the model, and replace it with a far more auditable and user-friendly formula.
Array formulas are very powerful tools, and there are many reasons why analysts use them. One of the main advantages is security – nobody can accidentally delete part of the array block when using an array formula. Also, because the data can be manipulated as a whole block and used in the formula as a single unit, it’s a lot harder to make a mistake when building the formula.

You can identify an array formula because it includes curly brackets (like these: {}). Data tables are a type of array formula – probably one of the most useful ones – especially for the financial modeller. (See “Using Data Tables for Sensitivity Analysis” in Chapter 11 for how to build a data table.)

**Advantages and Disadvantages of Using Array Formulas**

The advantages of using array formulas are as follows:

- They ensure consistency because all formulas in the table are exactly the same.
- A model containing arrays will use less memory and be more efficient.
- Because it’s not possible to change a single cell on its own within an array formula, it is unlikely that you or someone else will change your formula accidentally.
- Because array formulas are difficult to understand, it means those with only basic Excel knowledge are less likely to change (and mess up!) your formulas.
- Array formulas do make it possible to perform some calculations that would otherwise be impossible. This is really the only reason you should use an array formula!

The disadvantages of using array formulas are as follows:

- Although array formulas use less memory, if you use too many large arrays in one model it can slow down your calculation.
- You cannot use column references (such as A:A or D:D) in your array formulas. This is not best practice in financial modelling anyway, so no great loss!
- They are difficult to audit for many Excel users and require specialist skills, though this can be considered both an advantage and a disadvantage.

**Simple Array Formula Example**

1. Create two simple blocks of data (arrays) as shown in Figure 8.7.

**FIGURE 8.7 Sample Data**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>5</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>6</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
2. Highlight the block of cells C1:C5 and type/highlight \( =A1:A5*B1:B5 \) in the formula bar. See Figure 8.8.

**FIGURE 8.8 Sample Data**

![Figure 8.8 Sample Data](image)

3. Now, hold down the Control and Shift keys while hitting Enter at the same time (Control + Shift + Enter). Use the Command key first (Command + Shift + Enter) in Excel for Mac 2011. See Figure 8.9.

**FIGURE 8.9 Completed Array Formula**

![Figure 8.9 Completed Array Formula](image)

4. The formula will appear in the whole array block. Note that curly brackets have appeared around the formula.

5. Note that you now cannot make any changes to the array block.

Please also note that array formulas are sometimes referred to as CSE formulas, because you press Control + Shift + Enter to enter them.
Array Formula Uses

Financial modellers generally advocate the use of array formulas only when it is not possible to do something any other way. Some examples of these situations are as follows:

- Data tables are a form of array formula that is extremely useful for scenarios and sensitivity analysis in financial modelling. Instead of changing inputs one at a time, an array shows hypothetically what an outcome would be simultaneously in a single table.
- TRANSPOSE allows you to transpose a range of data either vertically or horizontally, and retain links.
- Using a SUM and a VLOOKUP together as an array formula makes a very concise formula. For example, =SUM(VLOOKUP(value, list, {2,3,4},0)) will give you sum of values in rows 2, 3, and 4 instead of having to do =VLOOKUP(value, list,2,0) + VLOOKUP(value, list,3,0) + VLOOKUP(value, list,4,0). Note: You need to hold down Control, Shift, and Enter for this to work.

Transposing Data Using an Array

One of my favourite uses of an array formula is to create an =TRANSPOSE function, which will transpose data, allowing a link to be maintained within the model.

Let's say you have the following data in a table. See Figure 8.10.

**FIGURE 8.10 Temperature Data**

<table>
<thead>
<tr>
<th>J</th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Average Temperature Degrees Celsius</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>London</td>
<td>New York</td>
<td>Sydney</td>
<td>Moscow</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>5.9</td>
<td>-1.8</td>
<td>22.1</td>
<td>-10.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3.5</td>
<td>-1.2</td>
<td>22.1</td>
<td>-8.9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>8</td>
<td>3.5</td>
<td>22</td>
<td>-4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>9.8</td>
<td>9</td>
<td>18.4</td>
<td>4.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>13.1</td>
<td>14.6</td>
<td>15.3</td>
<td>12.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>18.2</td>
<td>19.5</td>
<td>12.9</td>
<td>16.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>18.9</td>
<td>22.8</td>
<td>12</td>
<td>18.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>18.5</td>
<td>22.7</td>
<td>13.2</td>
<td>16.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>16</td>
<td>19.1</td>
<td>15.3</td>
<td>10.9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>12.8</td>
<td>12.5</td>
<td>17.7</td>
<td>4.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>8.9</td>
<td>6.6</td>
<td>15.5</td>
<td>-2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>7.1</td>
<td>1.2</td>
<td>21.2</td>
<td>-7.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

And you’d like to transpose the data so that months and cities are switched around, as shown in Figure 8.11.

**FIGURE 8.11 Transposed Temperature Data**
Before you start cutting and pasting, you could try the transpose values tool.

1. Highlight the original table, and copy it to the clipboard using Control + C (Command + C in Excel for Mac 2011).
2. Right-click in the cell that you want the data to appear, and select Paste Special.
3. Tick the Transpose box as shown in Figure 8.12, and click OK.

This will paste all of the transposed values as hard-coded data in a new table. Using this method creates two separate, independent tables of data.

**FIGURE 8.12 Paste Special Dialog Box**

![Paste Special Dialog Box](image)

Using a TRANSPOSE Array Function: However, you may wish to maintain the original table as the source data, and have the second table linked to the first. Instead of linking each cell individually (time-consuming and prone to error) you could use a TRANSPOSE Array Function.

1. Highlight a range with exactly the correct rows and columns for the destination data. (It's probably easiest to use the Paste – Transpose procedures above to determine exactly how big the range needs to be).
2. In the formula bar, type the formula `=TRANSPOSE` (referencing the original data (i.e., `=TRANSPOSE(A2:M6)`).
3. Now, hold down the Control and Shift keys while hitting Enter at the same time (Control + Shift + Enter) or Command + Shift + Enter in Excel for Mac 2011.
4. The formula will appear in the whole array block. Note that the curly brackets have appeared around the formula, so the formula will be `{=TRANSPOSE(A2:M6)}`.
5. Note that changes you make in the original block of data will be reflected in the second block.
GOAL SEEKING

Goal seek is a very handy and commonly used tool in financial modelling and analysis. Goal seek is used to adjust the value in a specified cell until a formula dependent on that cell reaches the result you specify. In other words, it will change the inputs such that the output is set to the exact amount you want it to be.

In order to run a goal seek, you must have:

- A formula.
- A hard-coded cell that drives that formula.

The formula and its input cell do not need to be on the same sheet or even in the same model. As long as there is a direct link between the two (no matter how many calculations are in-between) the goal seek will work. However, it’s important to remember that the input cell must be hard-coded. An input cell that contains a formula will not work.

A common use of goal seek is in break-even analysis. We normally want to know how many units we need to produce to break-even (i.e., how many units we need to produce in order to recover our costs). In this instance, we’d change the number of units in the model until the profit amount is set to zero. See “Break-Even Analysis” in Chapter 9 for an example of this.

Let’s say you borrow one million dollars at an interest rate of 6.5 percent.

1. Use the PMT function to calculate the monthly repayments over 15 years.
2. If you use the PMT formula wizard, your input should look as shown in Figure 8.13.

FIGURE 8.13 Loan-Repayment Calculation Using PMT Function

![Figure 8.13 Loan-Repayment Calculation Using PMT Function](image)
3. The result will be \(-8,711\). Put a minus sign in front of it to make it a positive number.

4. Your formula should be \(=\text{PMT}(B2/12,B3*12,B1)\).

See “Loan Calculations” in Chapter 6 for more detail on how to use PMT and other loan calculation functions.

Let’s say that we can afford for our repayments to go up to, say, $10,000 per month. How much of an increase in interest payments can we afford? Maybe we should fix our rate.

5. On the Data tab, in the Data Tools group, click on What-if Analysis and select Goal Seek from the drop-down list. In Excel for Mac 2011, go to the Data tab. Then, in the Analysis group, click on What-if Analysis and select Goal Seek from the drop-down list. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

6. In the Set Cell box, enter the reference for the cell containing the formula that produces the desired end result (B4, in this case).

7. In the To Value box, enter the result you would like to achieve in the Set Cell (type in 10000).

8. In the By Changing Cell, enter the reference for the cell that Excel is to change (B2, the interest rate).

9. This will bring up the Goal Seek Status dialog box containing the result of your seek. See Figure 8.14.

**FIGURE 8.14 Goal Seek Dialog Box**

10. Click OK to accept the new values, or Cancel to go back to the original values.

The answer to this problem is that we can afford for interest rates to increase to 8.75 percent. If the bank were to offer us a fixed interest rate of 8 percent, then we should take it!

While this calculation could have been done by trial and error, it’s much quicker to use a goal seek. Goal seek will work in huge models and run through a large number of calculations, giving the result you need to achieve your desired outcome.
PIVOT TABLES

Excel pivot tables are a very useful and powerful feature of Excel. They can be used to summarise, analyse, explore, and present your data. A pivot table is a great reporting tool that sorts and sums independent of the original data layout in the sheet.

For example, you can take the sales data with columns like salesperson, region, and product-wise revenues, and use pivot tables to quickly find out how products are performing in each region. Figure 8.15 is a snapshot of a pivot table that has been used to summarise the spend by each customer.

FIGURE 8.15 Source Data and Pivot Table

For how to create a pivot table from scratch, see “How to Create a Pivot Table” in this chapter.

The layout of pivot tables changed significantly in the upgrade from Excel 2003 to 2007. Although the basic functionality remains the same (with the usual improvements in 2007), the wizard layout has changed to a field list, so if you were an avid pivot-table user in Excel 2003, the new layout does take some getting used to.
Using Pivot Tables in Financial Modelling

Useful as they are, pivot tables are not used very widely in financial modelling. This is because they are static until refreshed, and this does not fit very well with the methodology of most financial models. As discussed in earlier sections, the whole point of financial modelling is that you are able to change the inputs, and the outputs change! It's far too easy for a user to change the inputs, and then forget to refresh the pivot table. This results in using incorrect outputs from the model.

It is for this reason that I recommend the use of an alternative live, dynamic formula, such as SUMIF or SUMIFS, in place of a pivot table when building a classic financial model that depends on inputs being changed. See “Aggregation Functions” in Chapter 6 for how to use the SUMIF and SUMIFS functions.

Whilst it is possible to change the settings so that the pivot table will automatically refresh whenever the file is opened, there is no guarantee that the user will open and close the file before using the data, and it cannot be relied upon.

It's not a bad idea to change the settings to automatically refresh in any case, however. You can do this by right-clicking on a pivot table, then go to Pivot Table Options. See Figure 8.16. On the Data Tab, select Refresh data when opening the file. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

**FIGURE 8.16 Pivot Table Options Dialog Box**
**Common Uses of Pivot Tables:** Pivot tables are more widely used in management reporting than in pure financial models.

Here are some commonly used examples of pivot tables:

- Summarising data, such as finding the average sales for each region and for each product, from a product sales data table.
- Listing unique values in any column of a table (this can also be done with the remove duplicates functionality of Excel 2007/10). Prior to the Excel 2007 release, pivot tables were a common way of obtaining a unique list.
- Filtering, sorting, and drilling down data in the reports without writing any formulas or macros.
- Transposing data (i.e., moving rows to columns or columns to rows).

**Other Things You Should Know about Pivot Tables**

- You can apply any formatting to the pivot tables. Excel has some very good pivot table formats (and they are better in the newer versions of Excel).
- You can easily change the pivot table summary formulas. Right-click on the pivot table and select the Summarise Data By option.
- You can also apply conditional formatting to pivot tables, although you may want to be a bit careful as pivot tables scale in size depending on the data.
- Whenever the original data from which pivot tables are constructed changes, just right-click on the pivot table and select Refresh Data.

**Tip:** If you want to drill down on a particular summary value, just double-click on it. Excel will create a new sheet with the data corresponding to that pivot report value. It’s very useful!

**How to Create a Pivot Table**

When you need to create a report forecasting your fees by department and area, you can follow these instructions:

1. Highlight the entire database, ensuring that the headings are at the top of the range.
2. Select Pivot Table from the Insert tab, in the Tables section (found in the Data tab, in the Analysis section in Excel for Mac 2011). See Figure 8.17.
3. The wizard will appear, and simply click OK.
4. By default, it will put your pivot table on a new page. If you prefer, you can change the options to locate it on the existing or a different page. The pivot table Field List will appear on the right-hand side.
5. If you drag Customers into the Row Labels field and Price into the Values field, it will summarise your data and create a pivot table report that looks like Figure 8.18.

FIGURE 8.18 Summarised Pivot Table

6. If you drag the Customers field to the Row Labels field below the Product field, it will split your report into subcategories. See Figure 8.19.
FIGURE 8.19 Completed Pivot Table with Field List in Excel 2010

The pivot table can now be quickly formatted using the drop-down styles on the Design tab. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

MACROS

Many aspiring modellers think that they need to be proficient in macro-building in order to become serious financial modellers. Whilst it’s not a bad idea to have a working knowledge of macros – and the language they are built in, Visual Basic for Applications (VBA) – it’s certainly not critical for a financial modeller to become a super VBA programmer. As discussed in previous sections, the best sort of financial model uses the simplest tools, and introducing macros to a financial model brings a whole new level of complexity.

Before launching further into the pros and cons of including macros in your financial model, let’s have a quick overview of what macros are and how to build them. VBA in Excel is a huge topic in itself and one I’m not planning on going into too deeply here. Once you start writing macros it’s quite easy to get hooked, as you can do some truly amazing things in Excel, which will bring the functionality of your work to a whole new level. If you develop an interest in the subject, there are lots of books and training courses specifically on macros and VBA. Make sure that you buy a book or attend a course that is specifically on VBA for Excel and its use in finance, as there is a lot of programming that is done in VBA that is not finance-related.

A macro is a collection of commands that are performed in a set order. A macro enables you to repeat operations that you would normally do by hand, but it is much faster and, when written correctly, much more reliable. Often, a macro will do in seconds what takes hours or days by hand. It can also perform tasks that are physically impossible manually. If you find you are performing the same commands or actions over and over again, in exactly the same sequence, you can create a macro to record all those actions for you. You can then assign the macro to a button and run it using a single click. You can even assign the macro to a keyboard command.
Macro Settings

Before we begin creating macros, there are a few settings in Excel you’ll need to change:

- Showing the Developer tab in the ribbon is not strictly required to record and run macros, but it contains tools that makes it easier to run and edit macros, as well as some handy control tools and buttons.
- Changing the security settings is required, and you must change this setting if you want to run macros.

The default installation version of Excel does not have these settings. You will need to change these settings only once, and you will not need to do it again unless you re-install Excel, or move to another machine.

**Showing the Developer Tab in the Ribbon:** This is only relevant for Excel 2007/10 and Excel for Mac 2011 users. While it is possible to record a macro by clicking on the launch button in the bottom left-hand corner of your screen, as shown in Figure 8.20, the Developer tab contains other functions that are useful when developing macros and other tools, so it’s best to install the Developer tab.

![FIGURE 8.20 Macro Launch Button]

If you do not see the Developer tab, click on File – Options – Customize Ribbon. Check the Developer box. Excel for Mac 2011 users go to Excel – Excel Preferences – Ribbon and check the Developer box. For more detailed instructions on how to do this, read “Showing the Developer Tab in the Ribbon,” under “Form Controls” in Chapter 7.
Setting Macro Security Levels: Macros perform various automated functions that run via executable code. While most macros are useful and harmless, some malicious macro viruses can destroy data or otherwise damage your machine. For this reason, many people decide to disable macros altogether or turn security up so that macros can only be run from documents written by trusted publishers. However, turning up the security may disable legitimate macros, so changing the security level is a personal decision. You may also want to change this setting before you open documents from different sources.

You will need to decide on the level of security appropriate for the way that you work. If you only ever run macros that you have written yourself, then Low may be suitable. High will be difficult to work with, as it won’t allow you to run macros at all. If you are often running macros from a trusted location, you may choose to select the Enable All Macros option.

To change your macro security settings:

1. Click on the File menu or the Microsoft Office Button in the top left-hand corner of your screen.
2. Scroll down to Options or Excel Options at the very bottom and select it.
3. Select Trust Center and click on Trust Center Settings.
4. Choose the desired level of security.
5. Close the model down, and then reopen it.

In Excel for Mac 2011:

1. Click on the Excel menu at top left-hand corner of your screen.
2. Click Preferences.
3. Click the Security button, and go to the Macro Security section.
4. Choose the desired level of security.
5. Close the model down, and then reopen it.

For Excel 2003, see the instructions available at www.wiley.com/go/steinfairhurst.

Recording and Running a Simple Macro

The best way to get started with macros is to record one.

TO RECORD A MACRO

These are the basic steps to create a simple macro by recording it. In the View tab in the Macros section, click on the arrow under the Macro button, then Record Macro. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

In Excel for Mac 2011, click the Record button in the Developer ribbon in the Visual Basic section.

See Figure 8.21.
Excel will come up with the suggested name Macro1. You can type over this. Macro names must be one word with no spaces. It is best to give the macro a name that relates to what it does (i.e., PrintCompanyData), rather than a nondescriptive name such as Macro1. Type a name for the macro into the Macro Name box. You can also allocate a shortcut key. You are now recording your macro. Every command or action you perform will be added to the macro.

1. Perform all the actions you wish to be included in the macro. For example, print, save, change colour, and insert or delete rows and columns, will all be included in the macro if you perform these actions while the macro is recording.

2. When you wish to stop recording the macro, click on the arrow under the Macro button, then Stop Recording. In Excel for Mac 2011, in the Developer ribbon in the Visual Basic section, click the Record button again, which will stop the recording.

This macro will save within the Excel you used when recording the macro. This macro is available whenever you have the file open.

TO RUN THE MACRO

1. In the View tab in the Macros section, click the Macro button. In Excel for Mac 2011, click the Macro in the Developer ribbon in the Visual Basic section.

   This will bring up the Macro dialog box, containing a list of all the available macros.

2. Click in the list to select the macro you wish to run.

3. Click on the Run button. All the actions you performed in the steps above will repeat themselves.
**Practical Exercise:** Let’s try recording a macro that will be useful. Say you want to change the formatting of a cell from 150000 to $150,000 – a very commonly performed task. (This macro will be useful, as it’s not possible change this formatting with a single mouse click or keystroke.) Follow these instructions:

1. Type 150000 into cell A1 on a blank worksheet.
2. Begin recording, as shown above. Call the macro **FormatCurrency**. Assign a shortcut key (e.g., Ctrl + m), and click OK. See Figure 8.22.

**FIGURE 8.22 Naming the Recorded Macro**

3. Select cell A1, and change the formatting to $150,000. This can be done through the menu bar, or right-click, Format cells, and change the currency to the desired format.
4. Stop recording.
5. Now we can test to see if the macro worked. Go back to cell A1 and change the formatting to a percentage, for example.
6. Then run the macro as shown above. The formatting of cell A1 will revert to the formatting we specified in the macro. Now we can edit the macro and make changes within the VBA code as follows:
   a. Select the Macros icon from the View or Developer tab on the ribbon (the Visual Basic tab in Excel for Mac 2011). The Macro dialog box contains a list of all the available macros.
   b. Select the macro that you want to edit, and press Edit. This will take you into the Visual Basic for Applications coding editor, where you can manually edit a macro.
   c. Change things such as sheet names or cell references, rather than re-recording the macro. You can even make the macro run more efficiently by removing the duplication of the .select command.
   d. Change the code, and close down the editor.
7. Now we can edit our macro. Go into the VBA editor, as shown above. If you haven’t been into the editor before, it can seem a bit scary, but don’t worry. You can always close down the editor to get back into your Excel model.
8. The screen should look something like Figure 8.23.
FIGURE 8.23 Viewing the Recorded Macro in the VBA Editor

The text in green font is purely descriptive text. Any text preceded by the apostrophe (’) will be ignored by the macro when running. You can delete or replace this with documentation of your own, describing what the macro does.

Take a look at the code. It contains two steps: It selects cell A1, and formats it as we have specified. This means that every time we run this macro, it will select cell A1 and format it. If we remove the reference to cell A1, it will change the formatting of whatever cell is selected. This is much more useful!

9. Remove the descriptive text and the first line of code. Your code should now say:

```
Sub FormatCurrency()
    Selection.NumberFormat = "$#,##0"
End Sub
```

10. Close down the VBA editor and return to your model.
11. Type some random numbers anywhere in your model – even on a different page.
12. Select the cells, and run the macro. These numbers should change to your desired format.

Creating Macro Buttons

You can assign a macro to almost any object or shape on your Excel worksheet, including shapes, buttons, and even combo-box drop-downs. The most commonly used object is a rectangular-shaped button. There are two ways of creating these buttons, either as shapes or traditional form buttons.

HOW TO CREATE A SHAPE

1. On the Insert tab, in the Illustrations group, a Drawing Shape can be used as a macro button. Use Autoshapes (Insert – Shape ... in Excel for Mac 2011). The style can be changed to look like a purple rectangular button. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)
2. Right-click to add text that says press me.
3. Right-click to assign the macro to the button. Whenever you press this button, the assigned macro will automatically run.

Alternatively, the more traditional macro button can be used.

If you wish to create a traditional form macro button in Excel 2007/10, it’s still possible, but it’s been hidden very well. You need to have the Developer tab showing before you can create these buttons. See the explanation from earlier in this chapter on how to make the Developer tab show in the ribbon.
Macros in Financial Modelling Case Studies

There are hundreds of situations where macros can save time and increase accuracy. They might not necessarily be built and saved within financial models, but they could be used in the collection of the data that goes into model. Here is a small sample of a few of the most common problems in financial modelling that are solved by macros.

**HOW TO CREATE A TRADITIONAL FORM BUTTON**

1. On the Developer tab, in the Controls group, select the Insert button and select the Form button, as shown in Figure 8.24.

**FIGURE 8.24 Inserting the Button in Excel 2007/10**

![Inserting the Button in Excel 2007/10](image)

On the Developer tab, in the Form Controls group, select the Button button. See Figures 8.25 and 8.26. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

**FIGURE 8.25 Form Controls Ribbon in Excel for Mac 2011**

![Form Controls Ribbon in Excel for Mac 2011](image)

**FIGURE 8.26 Forms Toolbar in Excel 2003**

![Forms Toolbar in Excel 2003](image)
2. Now click and drag over the spreadsheet to create the shape.
3. When you let go of the mouse button, the Assign Macro dialog box will appear. Select appropriate macro.
4. To change the assigned macro, right-click on the shape and click on Assign Macro.
5. You should add the appropriate text and format the shape with colour, shadow, and so on.

- A company is doing a salary comparison between different countries, and wants to know how much they would need to pay in Malaysian ringgit so that their salary is the same as someone working in Singapore. If a worker in Malaysia earns the equivalent of 100,000 MYR after tax, how much would the company need to pay the worker before tax? The problem is that tax is calculated on pre-tax salary, so our formula gives us a circular reference. We can use a macro with a goal seek to repeatedly set the pre-tax salary to the amount entered by the user.
- Fifty identical budget templates have been created, and you discover a formula needs to be changed. Instead of making the change 50 times, record a macro. It will be much quicker, and far less prone to error.
- A non-profit organisation sets its pricing so that all costs are fully recovered to break even. The costs keep changing, though, and the user is a senior account manager who doesn’t know how to do a goal seek in Excel. The modeller creates a simple macro using a goal seek so that all the user needs to do is change the costs and press the button to find out how much the pricing needs to change to under the new costing.
- A dump of information containing several thousand rows is exported from a database into Excel every day. The data needs to be formatted and manipulated manually to be used in a daily takings report. Automating this with a macro can literally save hours of manual data manipulation.
- A reporting model is built using a pivot table, but when new data is entered, the user sometimes forgets to refresh the pivot table. The modeller builds a button to refresh a pivot table every time it’s pressed.

Dangers and Pitfalls of Using Macros

Wonderful as they are, macros should always be used with caution. Quite often formulas or filtering will achieve the desired result, without the need for building a macro. Always try a formula or standard Excel solution before considering the inclusion of a macro in your model.

- Unless ranges are defined properly using relative cell references, macros don’t move their references the way that formulas do. If any data has moved since the macro was written, the macro will refer to the wrong cell. A badly written macro can copy and paste over data, and you won’t know what it has done!
- Visual Basic is a complex programming language, and a skill that many people don’t have. Therefore, many people are not able to edit or follow what a macro is doing – especially if it hasn’t been documented properly.
• Macros are time-consuming to write, and often a much quicker and more transparent solution can be built just as easily with a plain formula.
• Running macros requires security settings to be changed (as shown above), and if your model is used by other people, they may not realise they need to change their settings, causing the model to not work properly.
• In Excel 2007/10 and Excel for Mac 2011, macro-enabled files need to be saved in .xlsm file format. If they are accidentally saved as an .xlsx macro-free workbook, the macros will be removed from the file. If this happens, the macros have been deleted, and you’ll need to either rewrite the code, or copy it back in from a backup copy!
• Unless you will be maintaining the model yourself, most business Excel users have more than enough to do without also trying to learn how to program.
• If you’re the one running the macro each time the model needs to be updated, that’s fine, but what will happen after you’re gone? If the process stops working due to a macro problem, it can hold up monthly procedures significantly.

Basically, there are more things that can go wrong if a financial model contains macros. When it comes to building financial models, consider whether a VBA solution is absolutely necessary before including it in your model. Macros should not be used unless there is no other option!

USER-DEFINED FUNCTIONS (UDFs)

There may be times when expert modellers are restricted by the range of internal functions that Excel has to offer. To overcome these limitations, Excel offers what is known as user-defined functions (UDFs). These are VBA-based mini functions that can be created by users to suit their needs.

Note that user-defined functions are specialised uses for Visual Basic, and are not commonly known to many users – even advanced financial modellers. If you decide to create user-defined functions, don’t expect that users will be able to understand or edit them.

Benefits of UDFs

We don’t recommend the use of UDFs in financial models. However, if you do decide to use them, there are a number of benefits. Complex formulas can be reduced to a simple function, which makes it easier to build the financial model (but more difficult for someone unfamiliar with UDFs to follow your calculations). UDFs also support array functions to evaluate a series of cells and give the flexibility of custom-designed text manipulation.

Drawbacks of UDFs

As with array formulas, the main drawback is that very few modellers will be able to understand or edit them. UDFs are not macros; hence they cannot be recorded, so therefore you need good understanding of VBA to create them. Note also that, as formulas, UDFs cannot change the cell formats the way that macros can.

UDFs can also be included as add-ins, but having such add-ins makes it difficult to share the file with others. Add-ins mean one cannot decipher the function to troubleshoot any glitches in the model logic.
Reusability: UDFs as Add-Ins

UDFs created in a spreadsheet can be reused in other sheets as add-ins. To save a spreadsheet as an add-in, select File, then Save As. Select Save As Type Excel Add-In (*.xlam).

When you want to use the add-in in another spreadsheet, simply import the add-in.

HOW TO IMPORT A UDF AS AN ADD-IN

1. Click on the Add-Ins button in the Add-Ins ribbon under Developer tab. See Figure 8.27.

FIGURE 8.27 Accessing the Add-Ins from the Ribbon

2. In the Add-Ins dialog box, click Browse to look up the UDF. See Figure 8.28.

FIGURE 8.28 Add-Ins Dialog Box

3. If you have created a UDF add-in, you’ll see it listed here. Select the new addin from the location and click OK.
4. The new add-in gets added to the list of add-ins in the dialog box. Select the new add-in and click OK.
5. You can now use this function in the new spreadsheet just like the one in which it was created originally.

(See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)
SUMMARY

The tools for financial modelling covered in this chapter range from the basic, such as hiding and grouping, to the more complex tools such as UDFs and array formulas. As always, we try to make our models as simple as possible, and as complex as necessary. Therefore, if you can create a model using just basic functions and tools, by all means, do so.

If, however, you find that your simple solution does not provide your model with the desired functionality, then you may consider including a more complex nested formula, or even possibly a macro. The best sort of financial models are those that are clearly laid out and use very simple and clearly defined tools – not because we don’t know how to create complex models, but because they are easier to follow. So, in conclusion, it’s very difficult to be a top-notch financial modeller without knowing all the complex tools and functionality in Excel, but that does not mean that you should use these tools in every model. On the contrary, complex tools should only be used when absolutely necessary.
Chapter 8 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. By default, all sheets are set to:
   a) Protected
   b) Hidden
   c) Very Hidden
   d) Visible

2. Which of the following functions does the author suggest using in place of a pivot table when building a classical financial model that depends on inputs being changed:
   a) SUMIF
   b) SUMIFS
   c) LOOKUP
   d) either a or b

3. Why does the course recommend steering clear of pivot tables in pure financial models:
   a) they do not update automatically
   b) they cannot transpose data
   c) there is a limited amount of formatting that can be applied to a pivot table
   d) you cannot easily change the pivot table summary formulas
Chapter 8 – Solutions and Suggested Responses

1. A: Incorrect. If you want to protect a sheet, you need to do so yourself as all sheets are not protected by default.

   B: Incorrect. By default, all sheets are set to Visible. If you want to hide a sheet, you must do so manually.

   C: Incorrect. If you want a sheet to be Very Hidden, you must do this yourself as all sheets are set to Visible by default.

   D: Correct. All sheets are set to Visible by default. If you want to change this setting, it must be done manually.

   (See page 194 of the course material.)

2. A: Incorrect. SUMIF is just one of the two functions that the course recommends using in place of a pivot table.

   B: Incorrect. SUMIFS is just one of the two functions that the course recommends using in place of a pivot table when building a classical financial model with changing inputs.

   C: Incorrect. The course does not recommend using the LOOKUP function in place of a pivot table when building financial models. It recommends using a dynamic function such as SUMIF or SUMIFS.

   D: Correct. The course recommends using either the SUMIF or SUMIFS function in place of a pivot table for financial modeling.

   (See page 205 of the course material.)

3. A: Correct. Pivot tables are not recommended to be used in financial modeling because they remain static until refreshed.

   B: Incorrect. Pivot tables can transpose data, so this cannot be one of the reasons the course recommends steering clear from pivot tables.

   C: Incorrect. You can apply any formatting to pivot tables, so this cannot be one of the reasons the course recommends steering clear from pivot tables.

   D: Incorrect. You can easily change the pivot table summary formula, so this cannot be one of the reasons the course recommends steering clear from pivots tables when building financial models.

   (See pages 204 to 206 of the course material.)
Chapter 9: Common Uses of Tools in Financial Modelling

Now that we know how to use many of the useful tools, functions, and features of Excel, let’s take a look at actually using these tools to solve common problems, calculations, and situations encountered in financial models.

ESCALATION METHODS FOR MODELLING

There are several different ways of applying a growth, indexation, or escalation method over a period of time to a principal amount. We often need to be able to include escalation in our models for the purpose of forecasting sales growth year over year for example, or increasing costs by an inflation amount. Calculating a growth amount might seem straightforward initially, but there are several different methods that can be used, and when applying growth rates in a model and you need to be clear about which method you are using.

Whilst we can use functions to calculate future values based on set or varying growth rates, we’ll firstly calculate them manually so that we understand the mechanics of the calculations, and then use the functions.

Using Absolute (Fixed) Growth Rate

Here we have compound growth over five years at a fixed interest rate. The capital grows each year by 5 percent. At the simplest level, our formula is base amount*(1+growth). The reason we are adding 1 (effectively 100 percent) to the growth rate (5 percent) is because we want the capital sum returned along with the accrued interest. Multiplying an amount by (1+growth) is a very common calculation in financial modelling.

Exercise: Fixed and Compounding

1. Create the exercise, as shown in Figure 9.1. The rate is fixed in a single cell (B4). Therefore we need an absolute reference, namely $B$4. So, after the first year (in 2015) create the formula in cell C7: =B7*(1+$B$4).
2. Copy the formula in C7 to cells in D7 through G7. This method grows the amount at a fixed rate, which compounds each year. With most models we normally want to show the amount that is forecast in each year, but if you want a shortcut formula that will show, in a single cell, how much we’ll have at a fixed, 5-percent growth after five years, we can use the Future Value (FV) function. Let’s verify the amount you calculated for the year 2019 by using this function.

3. Somewhere in a cell to the right of this table, enter Excel’s FV function. Either type =FV( into the cell and follow the prompts, or select FV from the function wizard. Because there are no periodic payments being made, we need to include the yearly rate, the period in years, and the present value (PV).

4. Prefix the function with a minus symbol to get a positive result. Your formula should be =-FV($B$4,5,0,B7), and the totals using both methods should be the same. Your sheet should look something like Figure 9.2.

**FIGURE 9.2 Completed Fixed, Compounding Exercise**

![Comparison of Escalation Methods](image)

**Exercise: Fixed and Non-Compounding:** Another variation on this escalation method is to still use a fixed growth rate, but not compound it. To do this, we will use an escalation index across the top. This may be more practical in some model designs, but bear in mind that it yields different results. See Figure 9.3.

**FIGURE 9.3 Fixed, Non-Compounding Exercise**

1. In row 10, create your escalation index row using the formula =B10+$B$11 in cell C9, and copying across.

2. Escalate in cell C14 by using the formula =$B$14*C10, and copying across.

This formula gives you a lower result in Year 5 than the exercise examining fixed and compounding interest because it is not compounding on the previous year. It simply adds a flat $5,015 \times 5$ percent each year, instead of adding the growth rate to the increased total.
Using Relative (Varying) Growth Rates

The next example returns the future value of an initial principal after applying a series of interest rates. While the rate was fixed in the example above, here it fluctuates from year to year. This is considered to be a superior model design, as it allows for fluctuation of growth rates. Even if the growth rate does not change from year to year, by building the model in this way, we are allowing for changes in the future. By using the aforementioned design with a single growth rate, we are restricted to having only a rate that does not change. See Figure 9.4.

**FIGURE 9.4 Relative, Compounding Exercise**

We’ll no longer use absolute references for the interest rate, but will allow both it and the value to change from year to year as we copy the formula across D22 through to G22. Cell C22’s formula is base amount*(1+growth), as previously, but this time the growth does not have an absolute reference applied to it. =B22*(1+B19).

**Exercise: Relative and Compounding**

1. Complete cell C22 in the exercise workbook to achieve the result above, then copy the result to the right.

Let’s try a shortcut function to get directly to the results without going through the annual calculations.

To the right of the results, enter Excel’s FVSCHEDULE function to verify the figure for 2019.

Use the function FVSCHEDULE in your exercise spreadsheet. Note that the FVSCHEDULE function was new to Excel 2007 and therefore is not available in previous versions of Excel.

Your sheet should look something like Figure 9.5.
Exercise: Relative and Non-Compounding

In this next example, we are using another escalation index across the top. See Figure 9.6.

**FIGURE 9.6 Relative, Non-Compounding Exercise**

<table>
<thead>
<tr>
<th>PMT</th>
<th>=B25+B26</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Option 2b: Relative (varying) Growth rate, non-compounding</td>
</tr>
<tr>
<td>B</td>
<td>Growth:</td>
</tr>
<tr>
<td>C</td>
<td>Actual</td>
</tr>
<tr>
<td>E</td>
<td>Sales</td>
</tr>
<tr>
<td>F</td>
<td>$5,015</td>
</tr>
<tr>
<td>G</td>
<td>$5,767</td>
</tr>
<tr>
<td>H</td>
<td></td>
</tr>
</tbody>
</table>

1. In row 25, create your escalation index row using the formula =B25+B26 in cell C25, and copying across.
2. Escalate in cell C29 by using the formula =$B$29*C25, and copying across.

This formula gives you a lower result in Year 5 than of the fixed and compounding example because it is not compounding on the previous year.

Using Exponential Operations on an Absolute (Fixed) Growth Rate

This exercise is similar to the first one, except that we will include the use of the caret symbol (^) to perform exponential (to the power of) operations. For instance, 3 × 3 × 3 = 27. So does 3^3 and, in Excel’s equivalent, 3^3.

Exercise: Complex Escalation: Figure 9.7 shows compound growth over a period at a fixed 5-percent per annum interest rate.

**FIGURE 9.7 Complex Escalation**

<table>
<thead>
<tr>
<th>PMT</th>
<th>=B8*(1+6%4)^*(C36-B8$36)</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Option 3: Complex, uses absolute (fixed) Growth rate to the power of the period</td>
</tr>
<tr>
<td>B</td>
<td>Growth:</td>
</tr>
<tr>
<td>C</td>
<td>Actual</td>
</tr>
<tr>
<td>E</td>
<td>Sales</td>
</tr>
<tr>
<td>F</td>
<td>$5,015</td>
</tr>
<tr>
<td>G</td>
<td>$6,401</td>
</tr>
<tr>
<td>H</td>
<td></td>
</tr>
</tbody>
</table>

What’s the difference between Option 1 and Option 3?
The exercise on the next tab will demonstrate where it is necessary to use option 3 instead of 1.
Our formula will allow for start and end dates to the period, in the form of:

\[
\text{Base amount} \times \left(100\% \times \text{growth}\right)^{\text{End year} - \text{Start year}}
\]

Excel will perform the exponential operation before the multiplication, so the encompassing set of brackets (greyed) is not essential. The formula in C37 is therefore

\[=SB37 \times \left(1 + SB4\right)^{\left(C36 - SB36\right)}\]

Note that instead of using End year - Start year, you may also insert a helper row at the top to link to instead, which makes a slightly less complex formula. The next exercise shows how this can be used.

1. Complete the formula for cell C22 and copy it across D37 through G37 to achieve the results in the diagram above.
2. The function \(-FV(B34, G21-B36, 0, B37)\) will verify the answer for the year 2019.

**Practical Usage of Exponential Growth Rates**

You will notice that we achieve the same result ($6,401) under the fixed, compounding exercise as we did under the relative and compounding exercise, but with a far less complex formula. Using exponential growth rates is useful when you need to compound the growth rate, but want each cell to operate independently.

If, for example, you have start dates and end dates that need to be included in a formula as well as compounding escalation, you will need to use exponential growth rates. In Figure 9.8, we will create a formula to evaluate the start date and end date, only inserting the cost in the relevant years and then compounding the inflation.

**FIGURE 9.8 Staff Calculation Using Exponential Growth Rates**

This will require the IF and AND functions to be used in combination to establish whether the column heading year falls within an employee’s start and end dates.

For instance, in English terms we will be checking that \(\text{IF(AND(2013 >= Employee Startdate, 2013 <= Employee EndDate))}\) is true before writing inflation-escalated costs into the appropriate cell of column F. Otherwise we will write a zero.
Use the term in years (row 5) to exponentially escalate the costs (in column C). For instance, if the year 2013 (F6) meets the IF test, F7 will equate to Cost*(1+inflation)^0, which leaves it, in this case, unchanged.

Your formula should be: =IF(AND(F6<=E7,F6>=D7),SC7*(1+inflation)^F7,0)

And the sheet should look something like Figure 9.9.

FIGURE 9.9 Completed Staff Calculations

UNDERSTANDING NOMINAL AND EFFECTIVE (REAL) RATES

From a financial modelling perspective, there are two interesting aspects of nominal and effective rates that we should be aware of.

1. Escalation Calculations. We need to consider whether an escalation, growth rate, or indexation amount includes the effect of inflation (i.e., whether it is real or effective) and what this actually means in real terms.

2. Loan Calculations. When comparing and calculating interest rates, the frequency of compounding can make a difference to the amount of interest actually paid. This can be calculated in Excel using the EFFECT and NOMINAL functions.

When including escalation or growth rates into a financial model, we sometimes need to consider whether the growth percentage is expressed as a nominal or real rate. Normally we express the growth percentage as a nominal rate, meaning that we don’t take into consideration the effect of inflation or other factors that would impact the value of that rate. The real or effective rate will include the effect of other factors, such as inflation, to give you the real or adjusted value.

For example, if you earn a $100,000 salary, and after a year of working for the company, your boss unexpectedly gives you a raise of 10 percent, you think you’re going to have an extra $10,000 in your pocket, right? Well, not exactly. Theoretically, in the 12 months since you began working for the company, your cost of living has increased and eroded the purchasing power of your salary. Therefore, if we assume that the consumer price index (CPI), or rate of inflation, is 3 percent, then your $100,000 is not buying you as much now as it did when you first started the job. To calculate the effective salary increase that you received, you’d need to deduct the inflation from the raise. Your nominal increase was 10 percent, but the real or effective raise was only 7 percent.
Normally when modelling escalation amounts, we use the nominal rate, and we know, when considering the calculations, that it does not take into account the purchasing power in the future. For example, in the exercise described in the previous chapter, we indexed the sales revenue at 5 percent, as shown below. It goes without saying that the 5 percent is a nominal amount. We know that the $6,401 that is received in Year 5 is not really $6,401 in today’s terms because inflation will have eroded its purchasing power. See Figure 9.10.

FIGURE 9.10 Escalation Formula

If we wanted to compare an investment in today’s terms, we’d need to use the effective rate, and to calculate this, we would simply deduct the inflation amount – let’s say it’s 3 percent – from the growth rate, and hence our effective growth rate is 2 percent. As always, we need to be very explicit about the rates we have used. Note that expressing amounts in effective terms is not commonly used in financial models and unless otherwise stated the user would assume that a rate is nominal. Therefore, if you choose to use an effective rate, make sure that you state it clearly as an assumption, as shown in Figure 9.11.

FIGURE 9.11 Assumption Documentation in Growth Calculations
Adjusting Loan Rates with NOMINAL and EFFECT Functions

Calculating effective growth rates as outlined above is quite simple, and we certainly don’t need a dedicated Excel function to calculate them. There is another use for the nominal and effective concept in finance, and the calculation is far more complex. Nominal and real rates affect mortgage calculations, too. As discussed in “Loan Calculations” in Chapter 6, due to the effect of compounding, we actually pay a higher interest rate than is actually expressed in the nominal rate when quoted by the lender. Most loans are calculated and compounded daily, and therefore every single day we pay interest on the interest that was charged on the previous day.

The nominal rate is basically the simple interest rate for the complete period of the mortgage (i.e., the rate you are quoted when you take out the loan). The effective rate takes into account the compounding and will therefore be higher, depending on how frequently the loan is compounded.

The nominal and effective rates in Excel are related as follows:

\[
\text{Effective interest rate} = \left(1 + \frac{\text{Nominal interest rate}}{N}\right)^N - 1
\]

where N is equal to the number of compounding intervals in the year.

As usual, Excel has made these calculations simple for us by offering two important pre-defined functions to convert nominal to effective rates, and effective to nominal. These are NOMINAL and EFFECT. Note that the NOMINAL and EFFECT functions are new to Excel 2007 and therefore are not available in previous versions of Excel.

**NOMINAL( )**: This function returns the annual nominal interest based on the effective rate and compounding intervals in the year. The syntax for this command is:

- NOMINAL(Effective_Rate, Compounding_Period), where
- Effective_Rate: The effective interest rate for the year.
- Compounding_Period: The total number of compounding intervals in the year.

**EFFECT( )**: This function returns the effective interest based on the annual nominal rate and compounding intervals in the year. The syntax for this command is:

- EFFECT(Nominal_Rate, Compounding_Period), where
- Nominal_Rate: The annual nominal interest rate for the year.
- Compounding_Period: The total number of compounding intervals in the year.

The screenshot in Figure 9.12 shows how the effective rate can be calculated from nominal rate.

**FIGURE 9.12 Comparison of Interest Rates Exercise**
Exercise: Comparing Two Nominal and Effective Interest Rate Offers

Let’s say you need to borrow some money, and you’re offered two different interest rates from competing lenders

1. Lender A is offering a nominal rate of 7.9 percent, compounded daily.
2. Lender B is advertising an effective rate of 8.2 percent, compounded monthly.

Which is the best deal? Here is how to arrive at the answer:

1. Set up the inputs side by side, so that you can compare the effective rates. See Figure 9.12.
2. Calculate the effective rate of Offer A using the EFFECT function.
3. Your formula in cell B4 should be \( =\text{EFFECT(B2,B3)} \).

The effective rate of Offer A is 8.2219 percent, which means that Offer B is in fact a lower effective rate.

Let’s calculate the nominal rate of Offer B, for interest’s sake.

4. Your formula in cell C2 should be \( =\text{NOMINAL(C4,C3)} \).
5. The sheet should look something like Figure 9.13.

FIGURE 9.13 Completed Comparison of Interest Rates Exercise

Let’s see what effect the number of compounding periods has on the rate. If Lender A had compounded monthly instead of daily, would that have made a difference to the effective rate? It certainly would! Change the number of periods in cell B3 from 365 to 12, and we will see that this drops the effective rate to just slightly lower than that of Offer B. See Figure 9.14.

FIGURE 9.14 Comparison of Rates with Changed Compounding Periods

Although only a very simple calculation this is a good example of how, by following financial modelling best practice and linking the formulas to the hard-coded input variables, we can easily perform sensitivity analysis on our numbers by changing the calculation assumptions.
CALCULATING CUMULATIVE TOTALS

As always, we try to follow best practice when building financial models, and one of the important points of best practice is to ensure that formulas are as consistent as possible. Calculating cumulative totals is a common calculation in financial modelling, and this is one such situation where ensuring consistent formulas can be tricky.

We need to calculate the cumulative number of customers in order to calculate the revenue, and Figure 9.15 shows one solution to the problem. It will achieve a correct total, but it necessitates using different formulas in adjacent cells.

FIGURE 9.15 Cumulative Totals Using Inconsistent Formulas

Sometimes this is the only solution (without creating an overly complicated formula) and, if necessary, you may simply need to resign yourself to the fact that consistent formulas are not possible. There is, however, a simple solution: Using the formula =SUM($B$3:B3) will achieve the same result with consistent formulas, as shown in Figure 9.16.

FIGURE 9.16 Cumulative Totals Using Consistent Formula

HOW TO CALCULATE A PAYBACK PERIOD

There is no suitable formula in Excel for calculating a payback period. However, there are a couple of different ways of doing it. Demonstrated below are two methods, but this is by no means an exhaustive list. The first method is very simple, but not very accurate, and the second is quite long-winded, but more precise.

Simple Payback Calculation

In a business case summary as shown in Figures 9.17 and 9.18, we can see that the payback period (the point at which the sum of our cash flows becomes positive) is between three and four years – at 2016. We can easily estimate this by highlighting the cash totals for each year and looking at the sum amount at the bottom right-hand corner of the page. However, we would like to create a cell that automatically calculates the payback year so that as inputs change due to scenario and sensitivity analysis, the payback year will always be shown in the model, based on the cash flow amounts.
FIGURE 9.17 Manually Calculating the Payback Year

1. Above the years, in cell B2, create a formula that calculates the cumulative amount of cash. See “Calculating Cumulative Totals” later in this chapter for how to do this. Your formula should be =SUM($B$13:B13).

2. In cell B15, insert a formula that will return the year in which the cumulative cash amount becomes positive. Your formula should be something like this: =HLOOKUP(0,B2:K3,2,TRUE).

3. Note that this formula is looking for a close match because it has TRUE in the last field, not FALSE. This means that it will look along row 2 until it finds zero, and it will return the value before it passes zero. In this case, it will return the value under -1,677,907, as this is the last value before zero.

4. This will give you the value 2015, but we actually want 2016, so simply add a +1 to the end of the formula. Your formula should be: =HLOOKUP(0,B2:K3,2,TRUE)+1.

5. You may prefer to hide row 2 to avoid displaying the helper row, or change the font in row 2 to white if you do not wish to see it.

6. Alternatively, you may prefer to add the cumulative calculation in row 14, and then use a LOOKUP function to find the year at which the cumulative cashflow becomes positive. In this case, your formula in cell B15 would be =LOOKUP(0,B13:K13,B3:K3)+1.
Note that this method is only a sample of several different tools and functions that could be used to calculate the payback period. For example, you could use a nested IF function in row 2 instead, and an INDEX/MATCH combination. See Figure 9.19 for what your completed version could look like.

**FIGURE 9.19 Completed Simple Payback Calculation**

As the numbers for your business case change, so will your payback year. The result is only a rough estimate. For a more specific (albeit theoretical) payback date, we can use a more complex calculation, as shown by the following.

**More Complex Payback Calculation**

If you want to see exactly the year and month at which (theoretically) your project turns a profit, there is a more complex method. This way is also quite straightforward, but quite time-consuming!

1. On a new sheet, in column C, type in 1 Month, 2 Months... 1 Year and 1 Month, etc., up to 10 years or so.
2. In column A, insert the years that correspond with the months. In this case, the first year is 2013, so enter 2013 into cell A2. Copy this down, and change it to 2014 after 12 months. This can be most easily done by entering the formula =A2+1 into cell A14, and copying it right down to the bottom.
3. We are going to use column A as the criteria to pick up the cash in each year. In column B, enter a formula that will reference the profit and loss (P&L) page, and return the cash for that year, which should be divided by 12 to show the cash for each month. Your formula in cell B2 should be =HLOOKUP(A2,'P&L'!$B$3:$K$13,11,0)/12. This is (theoretically) how much cash the project has cost after one month of operation. We are assuming, in this formula, that the sheet that contains your cash flow is called P&L.
4. Then make this a cumulative amount in column B, by changing the formula in Month 2 so that it adds to the previous total. Your formula in cell B2 should be =HLOOKUP(A3,'P&L'!$B$3:$K$13,11,0)/12+B2. Copy this down the column.
5. Your sheet should look something like Figure 9.20.
Unfortunately the cumulative SUM calculation that was performed in the last exercise will not work in this instance, so we need to create an inconsistent formula. If this really bothers you, you could add a row and put a zero in cell B2 instead, so that the formulas are consistent.

6. Continue this calculation right down the page until you reach Year 7 or 8, or as far as you want your payback calculations to work. Remember that if you’re doing sensitivity and scenario on this later, you don’t want the formula to return an error if the calculations can’t handle a larger value, so go down a little bit further than you think you’ll need.

7. You can now perform a close match VLOOKUP or LOOKUP, which will return the year and month at which the return becomes positive. This is the payback period.

8. Enter the formula =VLOOKUP(0,Payback!B1:C200,2,TRUE) in the payback period cell on the P&L sheet. This will return the exact month and year that the project will (theoretically, of course) become profitable. See Figure 9.21.
Tip: There is some debate as to whether payback period should be discounted or not. I generally do not discount payback periods (as shown in this example), but whether or not it has been discounted needs to be stated clearly in your assumptions.

WEIGHTED AVERAGE COST OF CAPITAL (WACC)

Before investing in a project or new venture, we need to evaluate whether the expected returns justify the risks. Many financial models are built for the purpose of new project evaluation, and the most commonly used tools that we use for evaluating the expected returns are NPV (net present value), IRR (internal rate of return), and payback period. How to calculate these measures is discussed in detail in “Financial Project Evaluation Functions” in Chapter 6.

However, in order to calculate the NPV, we need to know our cost of capital or our required rate of return for the project. You may also hear the cost of capital referred to as the discount rate or hurdle rate. The cost of capital is basically the opportunity cost of the funds invested, or, in other words, the rate of return that investors would expect to receive if they invested the money somewhere else, rather than in this particular project. In effect, by investing in the business, the investor is willing to forego the returns from other avenues. Therefore, cost of capital is the minimum required return for a project — the returns need to be greater than the cost of capital for the project to be accepted.

The importance of WACC is that it becomes a baseline to determine suitable investments for success of the business. WACC is typically represented as a percent, so any investment decisions taken by the company must aim to deliver returns greater than the WACC to make them worthwhile. For example, if the WACC of a company is 15 percent, then most of the investments that the company makes must be with the goal of generating returns greater than 15 percent. WACC is not just calculated to the entire company or business. It can also be calculated for individual projects to determine if it is worthwhile for the company to pursue the project.
Company capital is sourced from many avenues and is targeted for various areas of business growth and sustenance. Typically, the two major sources of capital are debt and equity. Both these tools are distinctly different, have different costs, and hence need to be considered differently in our calculations. As a result, not all capital carries the same weight, which is why we sometimes need to calculate the weighted average cost of capital (WACC) in order to work out how much our capital is worth. Sometimes when calculating the NPV of a project, a modeller may simply use a nominated cost of cost capital (we used a rate of 12 percent in the section “NPV (Net Present Value)” in Chapter 6), but to evaluate a project more accurately, we can calculate which WACC will give us the exact cost of capital for that company. Note that the WACC will be completely different for each company, depending on their individual mix of equity and debt.

How to Calculate the WACC

The WACC is the average return on capital weighted proportionally based on category. Typically, a company sources its capital from stocks (common and preferred), bonds, and long-term debts. Each category of capital is invested in different avenues to help the business sustain and grow. WACC represents the average cost of capital with proportional contributions from the various sources.

WACC can be calculated using the given formula:

\[
\text{WACC} = \left( \frac{\text{Debt}}{\text{Debt} + \text{Equity}} \times \text{Cost of Debt} \right) \times (1 - \text{Tax Rate}) + \left( \frac{\text{Equity}}{\text{Debt} + \text{Equity}} \times \text{Cost of Equity} \right)
\]

where **Debt** equals total capital raised from debts.

**Equity** equals total capital raised from equity. Note that if the company has common and preferred shares, then the two need to be weighted and factored accordingly.

**Cost of Debt** equals the cost of raising the debt. If taken as bank loans, then it is the interest that needs to be paid to the banks.

**Cost of Equity** equals the return that the shareholders or investors expect from their holding in the company. Common ways of calculating this are the capital asset pricing model (CAPM) or Gordon’s growth model.

**Tax Rate** equals the prevalent corporate tax rates.

Exercise: Calculating the WACC in Excel

While the formula looks very complex, once the concepts are clear, WACC can be calculated relatively easily in Excel. Let’s do an exercise where we need to manually calculate the WACC.

Let’s say you have the following inputs:

- Debt is $6,023,000, for which you are paying 8.5 percent.
- Equity is $4,421,000, for which you expect a return of 15 percent.
- Tax is 30 percent.
1. Set up your sheet as shown in Figure 9.22.

**FIGURE 9.22 WACC Calculation Exercise**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Debt</td>
<td>Equity</td>
<td>Total</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Value</td>
<td>$6,023,000</td>
<td>$4,421,000</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Cost %</td>
<td>8.50%</td>
<td>15.0%</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Cost before tax</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Tax Rate</td>
<td>30.00%</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Cost after tax</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>WACC</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. In row 4, calculate the cost of debt and equity before tax.
4. In row 6, remove the tax from the debt amount.
5. Your formula in cell B6 should be =B4*(1-B5). Copy it across to cell C6. Although there is no tax applicable to the equity amount, we'll still copy the formula across to maintain consistency of formulas (hence following best practice).
6. Add together the value of debt and equity in cell D2, and cost after tax in cell D6.
7. Now calculate the WACC, which will be the cost after tax of debt and equity as a proportion of the total.
8. Your formula in cell D7 should be =D6/D2, and your worksheet should look something like Figure 9.23.

**FIGURE 9.23 WACC Completed Calculation Exercise**

Hence the weighted average cost of capital for this company is 9.78 percent. This means that when this company is evaluating new opportunities, the minimum required rate of return would be 9.78 percent, as this is what its capital is currently costing it. When calculating the NPV for a new project, this would be the input for the discount rate in the NPV function. Theoretically, the NPV at this discount rate must be greater than zero, and the IRR of a series of cash flows needs to be higher than this amount in order for a project to be accepted.
BUILDING A TIERING TABLE

Calculating an amount based on tiering tables is a pretty complex formula, and is commonly used in pricing models. There are two types of tiering tables (also called volume breaks, block, or stepped pricing). The simplest version calculates the entire amount at the tier. The more complex table, like the tax tiers, is progressive such that the first number of units at the first tier and the next amount at the next price.

For example, in a tax table where an income of $8,000 would be taxed at zero for the first $6,000 and then the next $2,000 is taxed at 15 percent, you would only pay $300 (15 percent of $2,000), not 15 percent on the whole amount.

Flat Tiering Structure

Let’s say for example, you have the pricing structure shown in Figure 9.24. If the customer purchases five items, each item costs $15, but if the order is for between six and 50 items, they are priced at $12 each, and so on.

FIGURE 9.24 Flat Tiered Pricing Calculation

<table>
<thead>
<tr>
<th>No Items</th>
<th>Price per Item</th>
<th>Total Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>63</td>
<td>$15.00</td>
</tr>
<tr>
<td>4</td>
<td>248</td>
<td>$12.00</td>
</tr>
<tr>
<td>5</td>
<td>12</td>
<td>$10.50</td>
</tr>
<tr>
<td>6</td>
<td>46</td>
<td>$8.00</td>
</tr>
<tr>
<td>7</td>
<td>563</td>
<td>$7.50</td>
</tr>
</tbody>
</table>

We’d like to populate Figure 9.24 to calculate how much a customer would be charged at different volumes.

A horribly long and complicated IF statement will do the trick:

\[=\text{IF}(A3<F3,G3,\text{IF}(A3<F4,G4,\text{IF}(A3<F5,G5,\text{IF}(A3<F6,G6,G7))))\]

But there is a much simpler way, using a VLOOKUP or LOOKUP.

1. In cell B3, calculate the per-unit price using a close-match VLOOKUP. Your formula should be \(=\text{VLOOKUP}(A3,$E$3:$G$7,3)\). Note that the last field is omitted, which means it will return a close match, not an exact match. You may also use the formula \(=\text{VLOOKUP}(A3,$E$3:$G$7,3,TRUE)\), which will give the same result.
2. Multiply the unit price by the number of units and add them up. Your total should be $7,564, and your sheet should look something like Figure 9.25.
FIGURE 9.25 Completed Flat Tiered Pricing Calculation

**Tip:** Because we need a close match, not an exact match, we could have used the LOOKUP function instead. This has the added advantage of not having to have the criteria to the left of the result because LOOKUPS are able to search backward. You also do not have to worry about someone inserting or deleting columns in the source data range and messing up the formula. For more detail on how to use LOOKUPS and VLOOKUPS, see “Lookup Formulas” in Chapter 6.

**Progressive Tiering Structure**

If the tiering calculation is not as straightforward as the one in Figure 9.26, we may need to calculate under a progressive tiered structure. A good example of this is the way that the tax calculations work, as shown in Table 9.1. This formula calculation is not for the faint-hearted, so unless you specifically need to calculate a progressive tiering table, feel free to skip this section.

**TABLE 9.1 Progressive Tiering Tables**

<table>
<thead>
<tr>
<th>Salary: $123,000</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010/2011 Withholding Tax Tiers</td>
</tr>
<tr>
<td>------------------</td>
</tr>
<tr>
<td>0–6,000</td>
</tr>
<tr>
<td>6,001–37,000</td>
</tr>
<tr>
<td>37,001–80,000</td>
</tr>
<tr>
<td>80,001–180,000</td>
</tr>
<tr>
<td>180,001+</td>
</tr>
</tbody>
</table>

Lowest Tier: $80,000

$43,120 \times 37\% = $15,954

Total Salary: $123,120

$33,504
The first person’s salary is $123,120, which means that this person is in the $80,000 to $180,000 tax bracket. However, we can’t do a flat tiering calculation on this because the first $6,000 is tax-free, the next $40,000 is only taxed at a rate of 15 percent, and so on.

The formula in column I takes care of the calculations below the threshold. Note that the tiers begin with one cent (e.g., $6,000.01).

You’ll need to split your calculation into several parts, as shown in the diagram above. Firstly work out the lowest tier, and then calculate the difference between the salary and the tier (in this case $80,000). Then the remainder should be calculated at the marginal tax rate.

Hint: This calculation will be easier if you calculate these in separate cells, and then combine them at the end – just like we have done with previous examples of nested functions, such as INDEX/MATCH or VLOOKUP/COLUMN.

1. Start by using a close match VLOOKUP to pick up column I (the amount payable up to the threshold). Your formula should be =VLOOKUP(C2,$F$2:$I$6,4).
2. Next, we need to work out the amount over the total salary that is above the lowest tier (in this example, $123,120 – $80,000 = $43,120). To do this we’ll do another close match VLOOKUP returning the first column and subtract this from the salary amount. In a separate cell, your formula should be =C2 - VLOOKUP(C2,$F$2:$F$6,1). Your answer should be $43,120.
3. Next, we need to find out how much to multiply the $43,120 by (i.e., the highest tax tier). To do this, create a VLOOKUP returning the third column. Your formula should be VLOOKUP(C2,$F$2:$H$6,3). Your answer should be 37 percent.
4. Now, put all three formulas together like this: =VLOOKUP(C2,$F$2:$I$6,4)+(C2 - VLOOKUP(C2,$F$2:$F$6,1))*VLOOKUP(C2,$F$2:$H$6,3).

The good news is that if you’ve used cell referencing correctly, you can simply copy the formula down. See Figure 9.27.
FIGURE 9.27 Completed Progressive Tiered Calculation

MODELLING DEPRECIATION METHODS

How we treat capital expenditure, its effect on cash flow, and the subsequent depreciation is an important part of financial modelling – especially if your model includes a P&L statement, cash flow, and balance sheet. Capital expenditure is recorded in several different places:

1. In the cash flow in the period in which it was purchased.
2. On the balance sheet as a fixed asset.
3. On the P&L statement as depreciation over the useful life of the asset.

In this section, we will focus on translating a purchase of a fixed asset into a depreciation charge to be shown on the P&L.

Why Depreciate?

The definition of a fixed asset is an asset that is used in production, or that supports business activities in some other way. Common examples are machinery, vehicles, and equipment such as computer hardware. Fixed assets, by definition, have an expected useful life of more than twelve months, and the cost of these assets must therefore be written off as an expense over the period in which they are used. Depreciation is the charge calculated to write off these assets over their expected useful lives.

In the examples that follow, in Year 1 we purchase a piece of machinery for $200,000 that has a useful life of five years (i.e., it will be generating income for the next five years), as shown in Table 9.2.
Instead of expensing the whole cost in Year 1, we should spread the cost of it over the
five years, as this is a much more accurate method of showing the profitability in each
year.

Adjusting depreciation is an attractive way for companies to increase expenses and
lower taxable earnings, and for this reason, the regulatory legislation around which
method of depreciation can be used is strictly monitored by the tax office. Bear in mind
that finance and accounting rules differ between countries. Financial modellers do not
need to be accountants, but they do need to ensure that accounting, tax, and finance
rules are applied correctly if the calculation method is material to the model.

**Depreciation Methods**

In the example above, we have used the most common form of depreciation, which is
the straight-line method. Under this method, the cost is equally spread over the number
of years it is in use. However, there are several more complex depreciation methods
also in use. It can be calculated either by using both a fixed rate and a fixed depreciable
base value, or by varying one or both of these variables. For this reason, the
depreciation charge each year as calculated by the different methods will not be the
same. Figure 9.28 illustrates the charges each year.

**FIGURE 9.28 Comparison of Different Depreciation Methods**
The exercise below will show step by step how to calculate depreciation using the different methods, and by doing this, we’ll see how very different each of the methods are. This is not an exhaustive list of depreciation methods; rather it’s an overview of the most common forms of depreciation calculations used in financial modelling.

**Straight-Line Method (=SLN Function):** Straight-line depreciation (also called prime cost method) is the simplest and most-used technique that calculates depreciation at a fixed rate over the expected useful life of an asset. We estimate the residual value (salvage or scrap value) of the asset at the end of its useful life and will expense a portion of original cost in equal increments over that period. The salvage value is an estimate of the value of the asset at the time it will be sold or disposed of, but often it is zero. If the asset is expected to have a salvage value at the end of its useful life, we need to take the salvage cost away from the base before depreciating it. The formula for calculating depreciation is therefore:

\[
\text{Straight Line Depreciation} = \frac{\text{Original Cost} - \text{Salvage Value}}{\text{Useful Life}}
\]

For example, we purchase an asset for $50,000, its useful life is 10 years, and we think we can sell it for $5,000 at the end of its useful life. We’d simply calculate the amount to be depreciated, which is the cost of the asset minus the residual value ($50,000 − $5,000 = $45,000) and divide it by 10, so the depreciation amount on the P&L would be $4,500 per year for 10 years.

It’s pretty easy to work this method of depreciation by using this sort of formula: 
\(=\frac{50000-5000}{10}\), or you could use the SLN formula: \(=\text{SLN}(50000,5000,10)\), which will deliver the same result.

Calculating depreciation using the straight-line method is by far the most common method of calculating depreciation in financial modelling.

In order to demonstrate the comparison of the different methods, let’s take a look at Figure 9.29, which shows an asset that has a purchase price of $50,000, a salvage value of $5,000, and a useful life of 10 years.

**FIGURE 9.29 Asset Depreciation Example**
To prepare a depreciation schedule for this asset in Excel using the straight-line method, the following steps are followed:

1. Using an SLN formula, calculate the depreciation per year in row 11 columns B to K.
2. Your formula in B11 should be =SLN($B$5,$B$6,$B$7). This formula requires cost value, salvage value, and life in years.
3. Once the absolute value signs have been added, the formula in B11 can be copied across into columns C to K. Using the straight-line method, the depreciation charge for each year is the same.
4. The amount in each year should be $4,500. After completing the table, check that the total is equal to cost less salvage value.

**Note:** Unlike the other depreciation methods functions, the SLN function does not stop when it has fully depreciated the asset. If you continue to copy row 11 across to cell K11, you will notice that it continues to apply depreciation, even though the asset has been fully depreciated. If you have assets being fully depreciated during the life of the model, this will need to be calculated manually if using the straight-line method. See “Calculating Depreciation at the End of Useful Life” later in this chapter for how to calculate depreciation on assets that have been fully depreciated.

**Declining Balance Value Methods**

These methods are also called the reducing balance, diminishing value, or accelerated methods. You could argue that assets are more useful when they are new, and therefore depreciate more quickly in the first few years of acquisition. Therefore, some companies use depreciation methods that provide for a higher depreciation charge in the first year of an asset's life and gradually decrease charges in subsequent years. These are called accelerated depreciation methods.

**Fixed Declining Balance Method (=DB Function):** The fixed declining balance method calculates depreciation at a fixed rate. This rate is calculated by the formula:

\[ \frac{1}{(\frac{\text{salvage value}}{\text{cost}})^{\frac{1}{\text{life}}}} \]

But it's much easier using the =DB Excel function! The depreciation charge for each period is not the same, as the depreciation rate for a period is applied to the net book value at the beginning of that period, and not to the original cost. With this method, the starting net book value is the cost price, so depreciation is applied to cost and not the value of cost less salvage. This is because using this method, the net book value can never reach zero.

Instead of treating each year the same, the fixed declining method depreciates more quickly in early years and more slowly in later years. The book value of the asset at the beginning of the period is multiplied by a fixed rate (e.g., in Year 1, 10 percent of $45,000 is $4,500 of depreciation). In Year 2, the same 10 percent is multiplied by the remaining $40,500 of book value, which then gives a depreciation value of $4,050.
The most difficult part in the fixed declining method is to figure out the correct percentage to use for each year, which is done with a rather complicated algebraic formula. If you use the pre-defined DB function in Excel, however, you don’t need to be concerned with the calculations. Bear in mind, however, that when Excel calculates the rate, it rounds to three decimal places, and this does cause the calculation to be off by a few dollars at the end of the useful life.

Therefore, unlike the straight-line method, you pretty much have to use the Excel formula. Using the example above, your fixed declining formula for Year 1 would look like this: \( DB(50000,5000,10,1) \).

Applied to the example above, to prepare a depreciation schedule for a particular asset on Excel using the fixed declining balance method, the following steps are followed:

1. Using a DB formula, calculate the depreciation per year in row 12, columns B to K.
2. Your formula in B12 should be \( DB($B$5,$B$6,$B$7,B10) \). This formula requires cost value, salvage value, life in years, and period for which depreciation is being calculated.
3. Note that the additional requirement of a specified period is a result of the depreciation calculated each year being unique to that particular year, or period. For this formula to return an accurate result, both life and period must be entered using the same unit (e.g., years).
4. Once the absolute value signs have been added, the formula in B12 can be copied into columns C to K.
5. If you create a total in L12, this will not be exactly equal to cost less salvage, as was the case for the straight-line method. This is a result of the fixed declining balance method producing a hyperbolic function and not a linear function and, therefore, never allowing the net book value to be zero.
6. Once the table has been completed, check that the total calculated in L13 is not more than cost less salvage. If this is the case, a manual adjustment to the last period’s depreciation charge will be required.
7. Your worksheet should look something like Figure 9.30.

**FIGURE 9.30 Calculating Fixed Declining Depreciation**

---

**Table:**

<table>
<thead>
<tr>
<th>B22</th>
<th>C22</th>
<th>D22</th>
<th>E22</th>
<th>F22</th>
<th>G22</th>
<th>H22</th>
<th>I22</th>
<th>J22</th>
<th>K22</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Depreciation Calculations</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Compare the depreciation charge using four different methods</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Purchase price</strong></td>
<td>$10,000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Salvage value</strong></td>
<td>$0</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Useful life</strong></td>
<td>10 years</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Straight-Line (SLN)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Fixed Declining (FD)</strong></td>
<td>$10,000</td>
<td>$9,178</td>
<td>$8,483</td>
<td>$7,786</td>
<td>$7,080</td>
<td>$6,374</td>
<td>$5,669</td>
<td>$4,963</td>
<td>$4,258</td>
</tr>
<tr>
<td><strong>Sumof-the-Years-Digits (SYD)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Double Declining Balance Method (=DDB function): The double declining balance method also calculates depreciation at a fixed rate. This rate per annum is calculated as:

\[
\left(2 \times \frac{100}{\text{expected useful life}}\right) \% 
\]

Again, the Excel function (=DDB) makes this calculation a lot easier!

As with the fixed declining balance method, the depreciation charge for each period is not the same. This is a result of the depreciation rate being applied to the net book value at the beginning of each period, and not to the original cost. Here, too, the starting net book value is the cost price and not cost less salvage. This method is quite similar to the fixed declining method shown above, except that the first year's depreciation uses double the percentage of the straight-line method. For each additional year of the asset's life, opening book value is multiplied by the same percentage. When the amount calculated by the double declining method is less than what it would have been using the straight-line method, then the straight-line method is used.

In the example above, using the double declining balance method, the depreciation rate would be 20 percent in the first year instead of 10 percent using the straight-line method. This amount then reduces until it is less than $5,000, and then it switches to the straight-line method.

Again, using the following Excel function is recommended: =DDB(50000,5000,10,1).

To prepare a depreciation schedule for a particular asset on Excel using the double declining balance method, the following steps are followed:

1. Using a DDB formula, calculate the depreciation per year in row 13, columns B to K.
2. Your formula in B13 should be =DDB($B$5,$B$6,$B$7,B10). This formula requires cost value, salvage value, life in years, and period for which depreciation is being calculated.
3. Once the absolute value signs have been added, the formula in B13 can be copied into columns C to K.
4. Once again, the total in L13 will not be exactly equal to cost less salvage, as was the case for the straight-line method. This is a result of the double declining balance method also producing a hyperbolic and not a linear function.
5. Once the table has been completed, check that the total calculated in L13 is not more than cost less salvage. If it is, a manual adjustment to the last period’s depreciation charge will be required.

Your worksheet should look something like Figure 9.31.
FIGURE 9.31 Calculating Double Declining Depreciation

Sum-Of-The-Years’-Digits Method (=SYD Function): Unlike the previous three methods of calculating depreciation, the sum-of-the-years’-digits (SYD) method calculates depreciation at varying rates for each period. As with the straight-line method, however, it uses a constant depreciable base, being cost less salvage value. The sum-of-the-years’-digits is calculated as:

\[
\frac{n(n+1)}{2}
\]

where \(n\) is equal to the useful life in years.

Depreciation for each period is then calculated as:

\[
\frac{(\text{cost} - \text{salvage}) \times (\text{useful life} - \text{number of previous periods}) \times \text{sum-of-the-years’-digits}}{\text{sum-of-the-years’-digits}}
\]

Sum-of-the-years’-digits is a depreciation method that results in a more accelerated write-off than straight line, but less than the declining balance method. Under this method, annual depreciation is determined by multiplying the depreciable cost by a schedule of fractions.

Use the Excel formula =SYD(50000,5000,10,1).

To prepare a depreciation schedule for a particular asset on Excel using the sum-of-the-years’-digits method, the following steps are followed:

1. Using an SYD formula, calculate the depreciation per year in row 14, columns B to K.
2. Your formula in B14 should be =SYD($B$5,$B$6,$B$7,B10). As with the previous two methods, this formula requires cost value, salvage value, life in years, and period for which depreciation is being calculated.
3. Once again, the additional requirement of a specified period is a result of the depreciation calculated each year being unique to that particular year, or period. Unlike with the two previous methods however, the difference in yearly depreciation charges is a result of a change in rate, and not a change in the depreciable base.
4. Once the absolute value signs have been added, the formula in B14 can be copied into row 14, columns C to K.

5. Check that the total in L14 is, as with the straight-line method, exactly equal to cost less salvage value. Despite using varying rates, this method also produces a linear function.

Your worksheet should look something like Figure 9.32.

**FIGURE 9.32 Calculating Sum-Of-The-Years’-Digits Depreciation**

Of course, there are many other methods of depreciation, most of which also have an Excel function, to make what would otherwise be an extremely complicated calculation much easier. Don’t completely rely on the function, however! As always, sense-check the results and double-check the timing of the purchase date and the period at which the asset is deemed to be fully depreciated.

**Calculating Depreciation at the End of Useful Life**

When building a model to depreciate assets using the straight-line method, whether calculating it longhand, or using the SLN function, it is possible to continue to calculate depreciation on an asset that has already been fully depreciated past its useful life. This results in an ever-increasing negative net book value, which is impossible, and can be the cause of an error in the model.

In order to prevent depreciation from being calculated once the asset has reached the end of its useful life, the Excel depreciation formula needs to be amended.

Let’s say you have a list of capital items in a database, as shown in Figure 9.33. The first item on the capital expenditure register is for some IT equipment that was purchased in July 2011. The useful life is three years, which means that it will be fully depreciated in July 2014, and therefore if we create a forecast model for 2014, we need to ensure that the depreciation does not continue past the end of its useful life, and we need to create a formula to do this. See Figure 9.33.
This will be a rather long formula, but we’ll use a simple building block methodology where we create a simple formula, test it, and check it before adding to it. We then test and check it again, before adding to it. In this way, we minimise errors by making sure the formula syntax is correct.

1. Begin by calculating the depreciation for January 2014 for the asset in cell G4, using the straight-line depreciation method. Remember it’s for a month, not a year. Your formula should look like this: \( =\text{SLN}(\$D4,\$E4,\$C4)/12 \).

Test this by copying across and down the page to make sure that the cell referencing is correct.

2. Once we’ve got this right, we need to consider the spend date. In some instances, the spend date for the item has not yet elapsed, so we need to evaluate whether this date has passed or not, and only allow the depreciation to show if the date has passed. We can achieve this by inserting an IF statement around the SLN function like this: \( =\text{IF}(G2>=$B4, \text{SLN}($D4,$E4,$C4)/12,0) \). Test this by copying across and down the page to make sure that the cell referencing is correct.

3. Now we need to consider the end-of-useful-life date. We could do this all in one formula, but it will make our calculations easier to follow if we insert this as a date within the model. In cell F4, calculate the date at which the item will be fully depreciated. We can do this using the formula \( =B4+(C4*365) \). However, note that it gives you a value of June 30, 2014, because 2012 is a leap year. You can get around this by using the EOMONTH or DATE functions or by using 365.25 instead of 365 – or you can simply leave it as it is. Copy the formula down column F.

4. Next, we need to add in the end-of-useful-life date to our formula in cell G4. The best way to do this is by adding the AND function using the syntax. Your formula should look like this: \( =\text{IF}(\text{AND}(G2<=$F4, G2>=$B4), \text{SLN}($D4,$E4,$C4)/12,0) \).

5. Copy the formula across and down, and test to see if it is working correctly. The depreciation for the IT equipment should stop in July 2014.

6. Your worksheet should look something like Figure 9.34.
BREAK-EVEN ANALYSIS

Including break-even analysis in a financial model is very useful for budgeting purposes and especially for any business that is starting or expanding its operations. Break-even analysis is a very effective tool to determine profitability and give you a snapshot of the sales volume target that is required to start making profit. For a new start up venture, this analysis is very effective in projecting sales targets. For established companies that are looking to launch new products and services, this analysis is invaluable in developing the pricing strategy.

There are several different ways to carry out the break-even analysis, depending on the perspective you want to look at. If you keep your pricing fixed, you can determine the units you need to produce and sell to break even (zero profit and zero loss). On the other hand, if your market position allows you to change the pricing, then you can determine the optimal pricing strategy to make your department or business break even within the stipulated target sales.

Let’s take an in-depth look at some of the different methods of calculations for break-even analysis. It is also very helpful to show break-even points graphically so we will also include some line charts when calculating the break-even points in our model in this section.

Calculating Break-Even Point

The break-even point is dependent on the total cost of production, the price of units, and the number of units. In its most simplified form, the break-even point is achieved when:

\[ \text{Total cost of production} = \text{price} \times \text{number of units} \]

However, in real businesses the equation is not this simple because the cost of production is never completely fixed. There is a variable component to it, which is related to the total units produced. This component includes everything from the price of raw materials, labor costs, and additional overheads. Thus total cost of production is the sum of the fixed costs and the variable costs.

\[ \text{Total cost of production} = \text{fixed costs} + \text{variable costs} \]
By varying the total number of units and/or the selling price of each unit, you can calculate the break-even point for your business. Figure 9.35 shows an example the various break-even points at three different price points: $100, $150, and $200. We can see that the lower the selling price per unit, the more units we need to sell in order to break even.

**FIGURE 9.35 Break-Even Chart**

![Break-Even Chart](image)

**Example Using Excel**

Let’s look at an example of how to calculate the break-even point for a new product. Let’s say you want to start producing custom-made birdcages. You have determined your fixed and variable costs for the first year are as follows:

- Fixed costs $250,275 (this includes rent, machinery, electricity, etc.).
- Raw materials of $5 per cage.
- Labour of $25 per cage.
- Overheads of $10 per cage.

Using the layout in Figure 9.36, calculate the net profit at each level of production. Ensure you use consistent formulas! At what level of production does the business begin to make a profit? The answer follows in the numbered list.

**FIGURE 9.36 Break-Even Example Layout**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
<th>J</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Bob's Bird Cages Break-Even Analysis</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Fixed Costs</td>
<td>$250,275</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Variable Costs per Unit (Unit)</td>
<td>$5</td>
<td>$25</td>
<td>$10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Raw Material</td>
<td>$5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Labour</td>
<td>$25</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Unit Overheads</td>
<td>$10</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Total Variable Cost per Unit</td>
<td>$40</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
1. Fixed costs will remain $250,275 regardless of the production level. The formula in cell F5 should be =$C$3. Copy it across.
2. Variable costs will fluctuate depending on the volume produced. The formula in cell F6 should be =F4*$C$8. Copy it across.
3. Add together the fixed and variable costs in row 7.
4. Calculate the total revenue in row 8. The formula in cell F8 should be =F4*$F$3. Copy it across.
5. Now calculate the net profit at the various production volumes in row 9.
6. The formula in cell F9 should be =F8-F7. Copy it across.

Your worksheet should look something like Figure 9.37.

**FIGURE 9.37 Break-Even Calculations**

![Table of Break-Even Calculations](image)

We can see that somewhere between 2,000 and 3,000 cages is when the revenue begins to cover our costs.

**Charting the Break-Even Point**

It is also interesting to look at the numbers graphically, and we can create a line chart that shows the point at which the revenue from the business becomes greater than the cost. See Figure 9.38.

**FIGURE 9.38 Completed Break-Even Chart**

![Completed Break-Even Chart](image)

For detailed instructions on how to create this chart, see the supplementary material available on www.wiley.com/go/steinfairhurst.
We can see what the break-even point is by looking at the chart, but it can be a pretty laborious task when done manually, and it is also not very accurate. We can calculate this exactly, however, using two methods:

1. A formula calculation.
2. A goal seek.

Calculating Break-Even Using a Formula

Using a formula is the fastest way of calculating the break-even point. It can be calculated using the following formula:

\[
\frac{\text{fixed cost}}{\text{price} - \text{variable cost}}
\]

Price minus variable costs gives you the gross profit, or contribution of each unit. We can then divide the fixed costs by the contribution to see how many units need to be sold to cover the fixed costs. See Figure 9.39.

**FIGURE 9.39 Break-Even Number of Units Using a Formula**

In our model, we can calculate the break-even point by using this formula:

\[
\frac{\$250,275}{\$125 - \$40} = 2,944.41
\]

The Excel formula in our model to calculate this is:

\[
C5/(C11 - C10)
\]
Break-Even Analysis Using Goal Seek

Another way to perform a break-even analysis is to use the goal seek tool. For a refresher on how to use this tool refer to the “Goal Seeking” section in Chapter 8. While this method takes a little longer to set up and run than using a formula as described above, it is more flexible and allows more options for changing inputs.

Using our Bob’s Birdcage example, we need to set up the sheet as a simple P&L calculation, as shown in Figure 9.40.

**FIGURE 9.40 Setting up a Break-Even Calculation for Goal Seek**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Bob’s Bird Cages</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Break Even Analysis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Fixed Costs</td>
<td></td>
<td>total</td>
</tr>
<tr>
<td>4</td>
<td>Variable Costs/Unit</td>
<td>$250,275</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Produced:</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Raw Material</td>
<td>$5</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Labour</td>
<td>$25</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Unit Overheads</td>
<td>$10</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Total Variable Cost</td>
<td>$40</td>
<td></td>
</tr>
<tr>
<td></td>
<td>per Unit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Selling Price</td>
<td>$125</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Cages produced</td>
<td>2,500</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Total Revenue</td>
<td>$312,500</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Total Variable Costs</td>
<td>$100,000</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Total Cost</td>
<td>$350,275</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Total Profit/Loss</td>
<td>-$37,775</td>
<td></td>
</tr>
</tbody>
</table>

The number of cages produced is the unknown variable, and we have entered a value of 2,500 into cell C11 as a placeholder in the meantime (which we can see generates a loss). This is the variable that will change when we perform the goal seek. Remember that to perform a goal seek we need a formula, and a hard-coded number that drives that formula. The formula will be the profit/loss amount in cell C16, and the hard-coded number is the number of cages in cell C11. Make sure that all of the formulas in cells C13 to C16 contain formulas; otherwise the goal seek won’t work.

So to perform the break-even analysis, we need to set the net profit/loss value to zero by changing the number of cages produced. See Figure 9.41.
Chapter 9: Common Uses of Tools in Financial Modelling

FIGURE 9.41 Using Goal Seek to Calculate Break-Even Point

When you click OK, Excel calculated the exact breakeven point and edits the cell value accordingly, as shown in Figure 9.42.

FIGURE 9.42 Completed Break-Even Goal Seek

We can see that we end up with a value of 2944.41176470588. You might like to round it to the nearest unit, which will show a small profit or loss, which might be confusing. Alternatively, change the formatting so that the decimal places don’t show.

If you have the power to manipulate the unit pricing, then you can change the price points to reach breakeven at the sale of fixed number of units, and even set profit targets using the goal-seek function. Let’s say you don’t think you can sell more than 2,500. What would you need to set your price at in order to make a profit of $50,000 if the maximum you will sell is 2,500? Because of the way we have set up this model, this is relatively easy to calculate. See Figure 9.43.
If we want to make a profit of $50,000, we’d need to sell 2,500 cages at $160 each.

Whilst the goal-seek method takes a little longer to run and set up, it’s a great way to run different scenarios and test changes in inputs when performing breakeven analysis.

**SUMMARY**

In the first part of this course, we covered the tools, functions, and techniques that financial modellers need to know. In this chapter, we focussed on the use of these tools in a financial modelling context. If you are pursuing a career as a financial modeller, you will almost certainly have to calculate escalation at some point, and it is quite likely that you will find yourself needing to use tiering tables, calculate depreciation, or perform a break-even analysis.
Chapter 9 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Unless noted, the user should assume that escalation amounts are expressed using:
   a) the effective rate
   b) the nominal rate
   c) the real rate
   d) either a or b

2. The rate of return that investors would expect to receive if they invested the money somewhere else is known as:
   a) the cost of capital
   b) the discount rate
   c) the hurdle rate
   d) all of the above

3. Each of the following is an example of a fixed asset except:
   a) cash
   b) machinery
   c) vehicles
   d) computer hardware

4. The most common technique to calculate depreciation is the:
   a) straight-line method
   b) double declining balance method
   c) sum-of-the-years’-digits method
   d) fixed declining balance method
Chapter 9 – Solutions and Suggested Responses

1. A: Incorrect. The effective rate is not commonly used in financial models. If a model does express amounts in terms of the effective rate, it should be clearly stated as an assumption in the model.

   B: Correct. The nominal rate is typically used when modeling escalation amounts. If this is not the case, the modeler should have stated clearly that the effective rate (or real rate) is used and not the nominal rate.

   C: Incorrect. The real rate, also known as the effective rate, is not typically used in financial modeling, so a user should not assume that escalation amounts are expressed using the real rate.

   D: Incorrect. A user should only assume that escalation amounts are expressed using the nominal rate, as most financial models do not use the effective rate.

   (See page 227 of the course material.)

2. A: Incorrect. The cost of capital, also known as the discount rate or the hurdle rate, refers to the rate of return that investors would expect to receive if they invested the money elsewhere, so all of the above is the correct answer.

   B: Incorrect. The discount rate, the cost of capital, and the hurdle rate all refer to the opportunity costs of funds invested, so all of the above is the correct answer.

   C: Incorrect. The hurdle rate is just one of three names often used to describe the opportunity costs of funds invested, so all of the above is the correct answer.

   D: Correct. The cost of capital, the discount rate, and the hurdle rate are all used to describe the opportunity costs of the funds invested.

   (See page 234 of the course material.)

3. A: Correct. Cash is not a fixed asset. Cash is a current or liquid asset. Unlike machinery, vehicles, and computer hardware, cash is not used in production.

   B: Incorrect. Machinery is one example of a fixed asset. A fixed asset is an asset used in production or one that supports business in some other way.

   C: Incorrect. Vehicles are one example of a fixed asset. The costs of fixed assets must be written off as an expense over the period in which they are used.

   D: Incorrect. Computer hardware is an example of a fixed asset. Like machinery and vehicles, computer hardware can be used in production or to support business activities in some other way.

   (See page 240 of the course material.)
4. **A: Correct.** The straight-line depreciation method, also known as the prime cost method, is the simplest and most common method for calculating depreciation.

   B: Incorrect. The double-declining method is not the most commonly used method. In this method, the first year’s depreciation uses double the percentage of the straight-line method. When the amount calculated using this method is less than what it would have been using the straight-line method, then the straight-line method is used instead.

   C: Incorrect. The sum-of-the-years’-digits method is not the most commonly used method. This method results in a more accelerated write-off than the straight-line method, but less than the declining balance method.

   D: Incorrect. The straight-line method, not the fixed declining balance method, is the most popular method for calculating depreciation.

   (See page 242 of the course material.)
Chapter 10: Model Review

If you are lucky, you will get to build your own model from scratch, but most often you will be handed someone else’s model to validate, modify, and make your own. One of the toughest tasks for any financial modeller is trying to use, understand, audit, or validate an existing model. While it may seem like a simple enough task where the hard work is already done, the real challenge will be to understand how the model was designed.

Excel is such a flexible tool, and there are so many different ways to achieve the same end, that trying to understand the way a model has been built is like trying to get inside another modeller’s mind! Give three different modellers a problem, and you’ll undoubtedly have three different model designs, as each modeller will approach the model design in a different way and almost certainly using different formulas.

REBUILDING AN INHERITED MODEL

Obviously the best place to start when trying to understand a model is to talk to the original designer, if that is at all possible. There is no one who understands the model better than the modeller who designed it in the first place. However, the original modeller is often unavailable, and we therefore need to allow the model to speak for itself.

If financial modelling best practice has been used, understanding a financial model in Excel should be a fairly straightforward task. However, many inherited models have not been built by professional modellers, but rather cobbled together by different areas of a business to achieve a (usually short-term) outcome. These kinds of inherited models can be a real nightmare to unravel, and often it’s simply easier to start from scratch. If this is not practical, there are some tricks and techniques in Excel that can help you to take apart someone else’s model. Using these techniques you can make the task of rebuilding an inherited model more achievable. We will explore some of these techniques in this section.

Removing Redundant Assumptions and Source Data in a Model

Common problems modellers encounter when rebuilding an inherited model are redundant assumptions and sources in the data model. This can happen when modellers need to use source information that is already in the spreadsheet, and re-create without realising that they are entering a duplicate set of assumptions or data. Often as a model evolves, parts of the model calculations are deleted, but the assumptions that fed into those calculations remain, despite no longer being needed.

The easiest way to see if any formulas are linking to an input cell is to use the trace dependents formula-auditing tool. This tool will allow you to trace forward and backward throughout the model. One technique you can use to remove redundant cells is to colour code all of the input assumption and calculation cells. Then go to the model outputs, and trace back the formulas. As each input assumption is validated, change the colour of the input cells back to their original colour. At the end of the process, if any cells are still coloured, you will know that they are redundant and can be deleted.
If you think a section of the model is not being used, check it using the trace dependents formula-auditing tool as described in this chapter before deleting it. Be aware that there are a few tools and formulas such as INDIRECT and OFFSET that sometimes can rely on a cell but that do not show up in the formula auditing tool. For this reason, make sure you save before deleting, and check the output of the model for #REF! or other errors before continuing. If the deletion has caused a problem, you can simply undo or close without saving to revert to the version of the file prior to deletion. It's also best to delete entire rows or columns instead of just clearing cells when removing sections of a model in this way. Deleting the cell will show an error and flag the issue if it had been linking to a formula, whereas clearing cells will simply change the value to zero, which will not necessarily return an error. This can cause undetected errors to remain in the model.

**Formula Auditing**

One of the most effective ways to start understanding a financial model (especially one that you did not build yourself!) is to look at the formulas and identify the precedents and dependents. This will give you an idea of the logic used by the previous builder of the model. Usually the best place to start in this technique is the final output. Take a look at each output and trace back the predecessors until you eventually find out what calculations, source data, and assumptions have been used by the original designer.

If you have a formula and you want to know which cells it uses, the easiest way is to use formula auditing. You can access these features in Excel from the Formula Auditing ribbon under the Formulas tab, as shown in Figure 10.1.

**FIGURE 10.1 Formula Auditing Icons in the Ribbon**

![Formula Auditing Icons in the Ribbon](image)

**Tracing Precedents:** To trace the precedents, select the cell you want to audit and click on Trace Precedents in the Formula Auditing ribbon. See Figure 10.2. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

**FIGURE 10.2 Trace Precedents in Excel 2007/10**

![Trace Precedents in Excel 2007/10](image)
The trace precedents feature allows you to see all the other cells whose values are used in the formula in the present cell. It is possible to understand the calculation just by observing the cell formula too, but the arrows make it easier to locate the cells, which reduces the chances of errors in auditing the model. See Figure 10.3.

**FIGURE 10.3 Using Trace Precedents on a Formula**

![Excel formula and trace precedents](image)

*Note:* Double-clicking on the blue arrows will take you to the preceding cells. If you double-click again, it will bring you back to the original cell. Also note that if the preceding cells are on another page, the blue arrow will show a dotted line. To go to the precedent cell, simply double-click on the dotted line, and it will bring up a list of all the off-sheet references of that cell. Double-click on the reference to go to that cell.

**Tracing Dependents:** Just like precedents, you can also trace the dependents to a particular cell. These are all the cells that use the value in the current cell for the calculations.

Select the Trace Dependents button in the Formula Auditing ribbon under the Formulas tab. See Figure 10.4.

**FIGURE 10.4 Trace Dependents in Excel 2007/10**

![Trace Dependents in Excel](image)
This is particularly useful if you are considering deleting a cell and don’t want to mess up the model. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

**Tip:** Click on the Trace Precedents button again to trace the precedents of the precedent cells. This is invaluable in auditing complex formulas.

While arrows are great visual aids to understand the formula, sometimes they can become a distraction, especially if there are too many of them. You can clear all the arrows by clicking on the Remove Arrows button. See Figure 10.5. This is also important if you plan to print the spreadsheet. If you don’t remove the arrows before printing, they will show up on the printed document.

**FIGURE 10.5 Removing All Arrows**

Note: There are some formulas upon which the Formula Auditor will not work very well, such as array formulas, data tables, and the INDIRECT formula. These are visible using the Dependency Auditor tool, which can be purchased separately from Microsoft.

**Tip:** You can also jump to precedent cells by using these shortcuts:

- Control + [ (open square bracket) to jump to and highlight precedent cells.
- Control + ] (close square bracket) to jump to and highlight dependent cells.

These shortcuts can be performed in Excel for Mac 2011 by using the Command instead of Control key.

**Error-Checking Tools:** There are times when we unintentionally introduce errors in the financial model. This could be because we did not comprehend the logic completely or because we mistyped the formula. Excel provides an error-checking function that helps identify the problem. This is extremely useful when your incorrect formula is syntactically correct. Excel indicates the anomalies in the model with a green triangle in the top-left corner of the cell.
To understand the nature of the error, select the cell and click on the drop-down menu. There are many categories of such errors, but inconsistent formula is one of the most common errors, as is omitting adjacent cells, as shown in Figure 10.6.

**FIGURE 10.6 Error-Checking Tools Showing Error in Sum Formula**

You can change the kind of error checking you want to perform on your model by selecting the Error Checking Options, as shown in Figure 10.7. This will display the screen where you can control the kind of checks you want performed.

**FIGURE 10.7 Editing Error-Checking Options**
You can also access the Excel Options dialog box from selecting the File tab or Microsoft Office button, then Options or Excel Options. In Excel for Mac 2011, access Excel Options by clicking Excel, then Preferences, then Error Checking.

You can review all the errors in the financial model using the error checking feature in Excel. See Figure 10.8.

**FIGURE 10.8 Error-Checking Feature**

Error checking offers two options:

1. **Error Checking**: Used to check formulas in error.
2. **Trace Error**: This is used to trace the source of the error in the final result. To use this feature, select the cell with the error (usually shown as #ERR?, #NAME?, etc.) and click on Error Checking – Trace Error. See Figure 10.9.

**FIGURE 10.9 Error-Checking Options**

Excel will trace back the source of the error with a red arrow as shown in Figure 10.10.

**FIGURE 10.10 Tracing the Error Source**
Evaluating Formula Tool: Sometimes it is difficult to decipher a complex nested formula just by looking at precedents and dependent relations. It is easier to actually evaluate it step-by-step to understand how it works. Excel facilitates this by the use of the Evaluate Formula feature.

To evaluate a formula in any cell, select the cell and click on Evaluate Formula in the Formula Auditing ribbon under the Formula tab. See Figure 10.11.

**FIGURE 10.11 Evaluate Formula in the Ribbon**

This will display an Evaluate Formula dialog that will show you the complete formula in the cell. Keep clicking on the Evaluate button to see how Excel calculates the value step-by-step. See Figure 10.12.

**FIGURE 10.12 Evaluate Formula Dialog Box**

Once you have looked up the source of the parameter, you can click Step Out to continue the evaluation.

**Tip:** You can also evaluate a partial formula manually by selecting each expression and pressing F9. You must select an entire section of the formula that makes sense in its own right; for example, in the horribly long and complex formula shown in Figure 10.13, we can select this portion of the formula: SUM(B$2:B2).
FIGURE 10.13 Selecting Part of the Formula

By then pressing F9, the formula will display the result of that expression, which in this case is 250. See Figure 10.14.

FIGURE 10.14 Viewing the Value of Part of the Formula

If you then hit the Enter key, it will paste that value into the formula (usually not what we want to do) but if you hit Escape, it will return to normal. This is a handy little trick that is sometimes easier and less complicated than using the Evaluate Formula tool.

For more detail on why you would want to break up a formula in this way, see “How Long Should a Formula Be?” in Chapter 4.

Note: The Evaluate Formula auditing option is currently unavailable for Excel for Mac 2011.

Viewing All the Formulas: If you want to look at all the formulas and not the evaluated value, you can use the Show Formulas option in Excel. This is also a very effective tool to understand the general logic in the model and can sometimes make anomalies more evident.

This can also be done using the CTRL +shortcut key. Note that ` is usually located below the ~ key at the top left of the keyboard, and should not be confused with the CTRL + ` shortcut used to edit cells. See Figure 10.15. No keyboard shortcut exists at this time for Excel for Mac 2011. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)
Direct Editing: By default, Excel allows users to edit the formulas directly in the cell, when they double-click the cell. However, while auditing any inherited spreadsheet, this may not be a good idea, as we could inadvertently mess up the formulas that are already in the cell. Excel allows users to disable direct editing, which protects the cells to a degree, but it still allows users to view the formula. It is quite different from protection, which does not let you do anything at all on the cell, and it’s much easier to turn off and on than protection.

Using this tool you can double-click on the cell to trace back, and ensure that you understand the assumptions made by the original modeller and take care that you are not making any inadvertent changes to the formulas in the cell. You can still make any changes necessary directly in the formula bar.

You can disable Direct Editing from the File menu. Click Options, then Advanced, and select Allow Editing Directly in Cells. Note in Excel for Mac 2011 this option is found in Excel > Preferences > Edit. Select Double-Click Allows Editing Directly in Cells. See Figure 10.16.

FIGURE 10.16 Disabling Direct Editing in Cells

Now when you double-click on the cell, it will highlight all the cells used as parameters in the formula, but not let you edit the cell directly. See Figure 10.17.
AUDITING A FINANCIAL MODEL

Any model used to support output required for decision making purposes should be checked and tested at some level by an independent party (whether internal or external to the organisation) for both logic and accuracy before it is handed over to the end user. Reviewing, checking, and auditing a model are important parts of the model-building process. As discussed in the section on financial modelling best practice, checking should be done by the modeller during the model build process. However, once the model is complete, or near completion, it should be reviewed by another party not involved in the model build.

How detailed the audit needs to be will depend on the importance of the financial model to the organisation using it. Whether it’s a simple pricing model or a multi-million-dollar merger, at least some level of checking and testing appropriate to the model need to take place in order to identify and eliminate spreadsheet error and to ensure that calculations, assumptions, and logic within the model are correct. Below are listed a few different levels of testing and audit that may be appropriate for a model.

1. **Informal check:** In many models this process could be an informal check by a colleague before passing it on to senior staff.
2. **Quality assurance (QA) procedure:** For larger projects, such as the one outlined in “Steps to Building a Model” in Chapter 2, particularly if a team is involved, it is an important final step in the build process prior to handing over the model. This would be a more formal (QA) procedure carried out and documented by the modelling team, and is also usually conducted internally.
3. **Formal model audit:** When a high-profile transaction, such as an acquisition or high-stakes project finance, an external auditing specialist will be engaged to conduct an independent audit of the financial model. These audit procedures are often a requirement of banks, lenders, and investors as part of the due diligence process to satisfy themselves that the projections and results of the financial model are reliable and accurate.

The type of audit that needs to take place will depend on the size, scope, and importance of the financial model you have been working on. Unless you work for a model audit firm, you are unlikely to be involved in an external model audit, so let’s take a look at how to go about the internal checks, which you are most likely to be involved with.
Informal Check

Let’s face it; the majority of financial models built will only get an informal check by colleagues. Depending on how much time they have available, they could spend anything from an hour to several weeks testing your model. Below are some techniques that can be used to test the integrity of the model on an informal basis.

- The traditional method of auditing is commonly known as the tick-and-bash method, whereby the model checker goes through the model cell-by-cell to check for consistency and logic. This is not a particularly effective method of checking, as it is highly likely that the tester will very quickly become bored with this tedious task and miss anomalies. It is also a task commonly given to junior staff who often do not have the practical modelling experience to know common errors.

- A more effective, but more costly, method is to commission the development of a parallel model to support the primary model. This can be done by providing an independent modeller with the input page to a model and the output layout required – without the numbers. The modeller is then required to build a high-level parallel model (minus the bells and whistles, of course). This can then be compared to the results produced by the primary model and confirm that the primary model is working correctly. This is a rather time-consuming exercise, but one of the most effective ways of checking model accuracy.

- Ditch the spreadsheet and use a calculator! Print out the results of the model and see if you can roughly achieve the same results offline.

- Another effective method of testing a model is to use scenarios, sensitivity analysis, and stress-testing. Change the inputs to something unexpected and see what happens. If you change the price of all your products to zero, does your revenue become zero also? It should, and if it does not the tester needs to understand why. See “Scenarios and Sensitivity Analysis in a Business Case” in Chapter 11 for more detail on how to perform sensitivity and stress-tests.

- Create lots and lots of charts. Create metrics, and plot as many inputs and outputs on the same charts as you have time for. Calculate the revenue per customer and chart it against market share on a line/column combination chart on two separate axes. (See “Charting on Two Different Axes and Chart Types” in Chapter 12 for how to do this.) Make sure that you understand every single trend and movement in the charts as these can flush out anomalies in the model that may not have been visible previously.

QA Procedure

Working on a QA procedure is the most labour-intensive type of audit most modellers are likely to be involved in. Below are some detailed instructions of how to go about a financial model QA procedure. The QA of a model involves two main tasks:

1. **Logic checking**, which aims to test whether the logic underpinning the model is reflected accurately in the model. These tests check that the model does what it is supposed to do. This form of QA should be carried out once the model is completed and before it is used to generate outputs. It should be repeated again later if significant changes have been made to the model structure.

2. **Data checking** to ensure that the correct input data is used and has been entered into the model accurately. This type of QA may be more appropriately undertaken closer to finalisation of the report, when final decisions have been made on parameters that should be used in the model.
QA Logic Testing:

Step 1: Scope of the QA Work.

Before you begin, the scope of the QA needs to be established. The person undertaking the QA should clarify what parts of the model need a QA and, in particular, whether there are any parts that need special attention. For example, certain calculations may be crucial to the model and the model developer may want assurance that the logic of the formulas used is appropriate. In some cases the model developer may seek feedback on possible improvements to the model, so as to enhance transparency, clarity, or some other aspect.

It is important to ensure that all supporting documentation is available to undertake the QA process. The model developer and/or the project team should provide all the documentation and source data in either hard or soft copy.

Step 2: QA Checks of Calculations and Logic.

Logic checks are carried out in order to:

- Check that cell referencing in a formula is consistent and correct.
- Ensure that formulas are mathematically correct.
- Confirm that the formulas used are suitable.
- Ensure consistency within the model in relation to the use of inputs such as:
  - Nominal or real values.
  - Units (for example, $'000,000 or $'000; kL or ML).
  - Timing assumptions, where applicable.
  - Labelling, which should be clear.

To check the logic of a model, quality assurers must first understand the output the model is required to produce and determine if the calculations correctly produce that output. Some of the tasks required in undertaking a logic check are therefore the same as those that would be done in the model building process.

To check the calculations and logic, the following steps should be followed:

1. Understand the purpose and limits of the model. This includes ascertaining what the model is supposed to do, what questions the model is supposed to answer, how the model tries to answer the questions, what the limitations of the model are, and what the model cannot do. This will most certainly require discussions with the project team and model developer.

2. Stress-test the model as a whole by entering a wide range of inputs and checking that the outputs are logical. This includes testing values at the extremes to ensure the model processes the input as expected, especially where validation and protection are used. While testing a wide range of combination of input variables may identify some hidden bugs in the calculations, using 0 or 1 is a good way to highlight obvious errors, as the outputs should be simple. For example a unit price of zero should generate a revenue of zero, and if it does not, you’ll need to investigate why not!

3. Another way of testing this is to use historical figures as input and test whether the model can replicate actual results. For example, key outputs such as profit, growth rate, and other financial ratios that are calculated by the model can be compared to the known historical results.
Yet another way is to check the sensitivity of outputs (dependent variables) to changes in the inputs (independent variables). This involves checking that the direction and magnitude of the change are in accordance with how you logically expect the outputs to behave.

4. Establish which cells contain formulas. This can be done using audit software such as Spreadsheet Detective (an add-in available for purchase from Microsoft), which allows easy identification of which cells are fully hard-coded, which contain formulas, and whether formulas are consistent across rows and columns.

5. Check both the logic and the reference accuracy of each identified formula. This is usually done by tracing the outputs back to the inputs to ensure that calculations produce accurate and logical output. See the “Formula Auditing” section earlier in this chapter for detail on how to use the Trace Precedents tool.

To assist with the logic and calculation checks, you may choose to write down the formulas in Excel notation using cell names and also in plain English by substituting the cell names in the formula with the actual variable names. For example:

Excel notation: \( J25 = J6 \times J9 \)

Plain English: total variable cost = variable cost per unit \( \times \) number of units

Logic: number of units drives total variable cost

This is a simple and effective method to check and document the logic of the formula used by the model developer, and pick up any cell referencing errors. Sometimes a formula can be quite long, especially if Excel nested functions are used. Writing it out and breaking it down into its components makes it easier to thoroughly check each component (e.g., ensuring that they are referenced correctly, consistent in years, units, etc.). The tool Dependency Auditor can help with this auditing by providing the Excel notation.

6. Check that the calculations have been suitably applied. For example, an indexation formula may be correct, but may not be suitable where it is applied, if, for example, the underlying data is already inflated.

Step 3: QA Checks of the Model’s Structural Layout and Documentation

Apart from its underlying calculations and logic, each model’s structural layout, appearance, and documentation should be checked.

Checking the structural layout of each sheet and workbook involves reviewing these to make sure that they are simple, transparent, and easily navigable. Elements to look out for are:

- Logical sequencing of the components in the model.
- Whether calculations are spread out all over the model or if they follow neatly down and across in a logical fashion. (Note that in larger models not everything will follow neatly!)
- Whether hard coding is only on the input sheet.

Checking the model’s appearance and documentation involves checking the spelling and formatting, as well as that the documentation and notations in the model are clear, are easily understood, and accurately reflect what is in the model.
Step 4: Document Your QA Work

The QA procedure needs to be documented. The quality assurer should note all issues (minor and major), bring these to the attention of the model developer, and record the actions taken to remedy any problems.

At the start of the process, quality assurers should make a copy of the model to be audited and insert a new worksheet called QA Log (see the template in Appendix 10.1 at the end of this chapter).

All issues should be documented in the QA Log sheet. The quality assurer may also wish to insert comments near the actual cells in the model where issues have been found, as this can be useful for the model developer when locating and fixing the problems identified.

Step 5: Report Your Findings

Once the QA work has been completed, any issues should be discussed with the model developer. Alternatively, issues can be progressively discussed and addressed as they arise.

Normally, the model developer will be able to advise whether an identified issue must be corrected, or whether it is intentional and should be left as is. All decisions and reasons should be recorded in the QA Log. Agreed changes should be checked again to ensure that they have been made correctly. This should also be recorded in the log.

Some changes may be very minor. Common sense should be exercised as to which changes can be left to the model developer to change without further final checking.

Input Testing

While logic checks focus on the calculations, structure, and layout of the model, input checks focus on the data entered into a model that is already built. Checks of input will usually involve:

- Matching input values to source documents to ensure that data has been entered accurately.
- Checking that inputs, especially assumptions, are consistent with the original output specifications.
- Checking that units are consistently applied, spelling and naming are consistent throughout the model, and the documentation of inputs and assumptions is clear.

As with a logic check, documenting the QA work and reporting the findings is required when conducting a QA of data inputs.

**QA of Model Inputs:** The aim of checking input data in a model that will be used to produce a report is to ensure that the model and its output are accurate. The following are things to look out for:
• Check the inputs back to the source data for accuracy of data entry. This includes checking the actual numbers and also the units. For example, a common error is that the source data may be in $’000,000, while the model is set up in $’000.

• Check that the inputs used are consistent with those approved by the users of the report to be produced. Where possible, cross-reference the input data back to the minutes of meetings held to determine the required output.

• Check that the naming and explanations for the inputs are clear and easily understood.

• Check that the units are applied correctly and consistently throughout the model.

• Check for spelling and grammatical errors.

APPENDIX 10.1: QA LOG

The following is a sample QA Log template.

<table>
<thead>
<tr>
<th>NAME OF MODEL</th>
<th>FILE NAMES &amp; FILE PATH LOCATION</th>
</tr>
</thead>
<tbody>
<tr>
<td>NAME OF MODELLER</td>
<td></td>
</tr>
<tr>
<td>NAME(S) OF QA STAFF</td>
<td></td>
</tr>
</tbody>
</table>

Purpose of model

1.
2.
3.

Have the following items been checked in the QA?

  Yes/No/NA Are timing assumptions consistent throughout the model?
  Yes/No/NA Are calculations consistent and clearly marked?
  Yes/No/NA Have units been provided for all values and clearly marked?
  Yes/No/NA Have adequate error checks been built into the model?
  Yes/No/NA Other . . .

Specific areas of the model that the model developer/project team want assurance on:

QA staff notes:

Details of issues found in the QA that need to be discussed with the model developer/project team:
**SUMMARY**

Whilst reviewing, auditing, or taking apart other people’s models is certainly not the most fun part of financial models, chances are you’ll need to be involved in the process at some stage. Even if you are fortunate enough to only be charged with the model build, it’s important to understand the model review and audit process, and build the model in such a way as to make the audit process easier for the reviewer.
Chapter 10 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Which of the following allows you to see all the other cells whose values are used in the formula in the present cell:
   a) the Show Formulas option
   b) the Trace Error feature
   c) the Trace Precedents feature
   d) the Trace Dependents feature

2. The traditional method of auditing whereby the model checker goes through the model cell-by-cell to check for consistency and logic is commonly known as the:
   a) tick-and-bash method
   b) QA procedure
   c) stress-testing method
   d) formal model audit

3. Which of the following is the first step of QA logic testing task:
   a) scope the QA work
   b) check calculations and logic
   c) check the model’s structural layout and documentation
   d) document your QA work
1. **A:** Incorrect. The Show Formulas option is used to show all the formulas and not the evaluated value.

   **B:** Incorrect. The Trace Error feature is used to trace the source of the error in the final result, but not to show all other cells whose values are used in the formula.

   **C:** **Correct.** The trace precedents feature allows you to see all the other cells whose values are used in the formula in the present cell.

   **D:** Incorrect. The trace dependents feature allows you to trace all the cells that use the value in the current cell for calculations, not trace all the cells whose values are used in the formula in the present cell.

   (See page 261 of the course material.)

2. **A:** **Correct.** The tick-and-bash method is a type of informal audit whereby the model checker goes through each cell to check for consistency and logic. This task is often handed off to junior level staff who do not have practical modeling experience and who may get bored with the tedious task; therefore, this is not typically an effective method of auditing.

   **B:** Incorrect. The QA procedure is the most labor-intensive type of audit that involves both logic and data checking. This method aims to ascertain whether the logic underpinning the model is reflected accurately in the model, and to determine whether the input data has been entered into the model accurately.

   **C:** Incorrect. Stress testing in either the form of scenario or sensitivity analysis, involves changing the input or inputs to something unexpected and seeing what happens.

   **D:** Incorrect. The formal model audit occurs when an external auditing specialist is used to conduct an independent study of the financial model.

   (See page 269 of the course material.)

3. **A:** **Correct.** Before you can begin logic testing, you must first establish the scope of the quality assurance work.

   **B:** Incorrect. Checking calculations and logic of a model is the second step of the QA logic testing task.

   **C:** Incorrect. Checking the structural layout and documentation of a model is the third step of the QA logic testing task.

   **D:** Incorrect. Documenting your work is the fourth step of the QA logic testing task.

   (See pages 270 to 272 of the course material.)
Any good financial model will usually contain scenario and sensitivity analysis functionality, at least to some degree. Scenarios are an important part of financial modelling, and the reason we have left this to near the end of the course is because it is usually a task performed at the end of the model-building process. If the model has been properly designed using best practice, it is not difficult to add, edit, and change scenarios in the model.

Scenarios and sensitivity analysis are great ways to insulate your model from risk. What would be the absolute worst that could happen? If everything that can go wrong does go wrong, will my business/project/venture still be okay? There are usually effects and interactions between multiple variables that may change in the model.

Scenarios can assist with decision analysis. They are laid out in advance so that the decision makers can see the expected impact of each course of action. How close to reality these scenarios are really depends on the accuracy of the assumptions implicit in the model – but that’s another story! (See “Document Your Assumptions" in Chapter 3.)

Scenario analysis is a very important part of financial modelling – in fact, in some cases, being able to perform a scenario analysis is almost the whole point of building a financial model in the first place! Many of the principles of best practice in financial modelling discussed in earlier sections were to ensure that the model is set up in such a way that scenarios can be easily included in our model.

There are several different technical methods of creating scenarios and sensitivities in financial models, which we will discuss, but all scenarios involve changing input variables to see the impact of the change on the model outputs. By following good practice when building the model in the first place – particularly when it comes to linking to the source, and only entering data once – creating scenarios and sensitivities in the model is quite simple. (See Chapter 3, “Best Practice Principles of Modelling.”) With a well-built model that has all inputs linked to outputs, it is relatively easy to change inputs and watch the outputs change.

Building scenarios is a task normally best left to the end of the model build process. We need to get the model design and layout finalised, and make sure the model is working correctly, before we can change the input assumptions by adding scenarios. As with many complex model functions, perform a simple task first, then test it, check it, and make sure it is correct, before adding more complexity, such as scenarios.

WHAT’S THE DIFFERENCE BETWEEN SCENARIO, SENSITIVITY, AND WHAT-IF ANALYSIS?

Scenario analysis, sensitivity analysis, and what-if analysis are really only slight variations of the same thing.

A sensitivity analysis, otherwise known as a what-if analysis, in financial modelling refers to the process of tweaking one key input or driver in a financial model, and seeing how sensitive the model is to the change in that variable. Scenarios, on the other hand, involve listing a whole series of inputs and changing the value of each input for each scenario. For example, a worst-case scenario could include interest rates increasing, number of new customers being less than expected, and unfavourable exchange rates.
Scenarios should really focus around the area or assumption around which we have the least certainty. For example, let’s say we are analysing the costs of reducing carbon emissions:

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Fossil Fuel Prices</th>
<th>Non-Fossil Fuel Technology Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>Best Case</td>
<td>−10%</td>
<td>+10%</td>
</tr>
<tr>
<td>Likely Case</td>
<td>−</td>
<td>−</td>
</tr>
<tr>
<td>Worst Case</td>
<td>+10%</td>
<td>−10%</td>
</tr>
</tbody>
</table>

In this very simple example, you could model the prices that you think are most likely and then tweak each of these up or down. It is possible to create many more than three scenarios in a financial model.

I’m often asked how many scenarios should be in a model, and it really depends on the amount of time and the degree of detail and certainty that are required for the model. Three scenarios, as shown in this example, should be a minimum. It’s possible to have 20, 30, or even 50 scenarios modelled, but it does become rather unwieldy and confusing so unless you really need them, I’d probably recommend sticking to around a dozen scenarios.

**Scenarios and Sensitivity Analysis in a Business Case**

In a volatile economic environment, creating a business case for a new project or product that contains financial projections is an extremely difficult task. Looking at historical data and extrapolating the numbers to create future projections simply doesn’t cut it anymore. Creating a business case is imperative for companies to plan for the future, attract investor funding, and gain approval for projects, although most of the time, there is so much uncertainty involved that financial projections are way off the mark. How do we create a financial model for a business case that is not complete guesswork?

Thorough stress-testing, along with scenario and sensitivity analysis, will provide a business case the rigour and robustness to cope with various fluctuations in economic inputs. At an absolute minimum, any business case financial model should have a best-, base-, and worst-case scenario. The scenario analysis may include answers to the following questions, as well as others specific to the industry. Obviously, particular attention should be paid to the downside!

- What is our break-even number of customers?
- What happens if we lose our biggest expected customer? What if we gain another customer?
- What if we lose a supplier? Will this impact costs?
- What if interest rates increase or decrease?
- What if we lost a key staff member?
- It’s unlikely, but what if all of the above negative outcomes eventuate?

Of course, if you count on the worst-case scenario, you’ll probably end up doing nothing, and you definitely won’t get any funding or approval! However, by creating a well-built, robust financial model, we can know exactly what the possible outcomes are so that we can show that we are prepared for the best or worst eventualities.
Stress-Testing a Financial Model versus a Business

Following the global financial crisis, there was quite a lot of discussion on the importance of stress-testing businesses, and I need to point out that this is quite different from stress-testing a financial model. Stress-testing a business involves putting the business’s financial forecasts through scenario modelling. Stress-testing a financial model is more about testing the technical inner workings of the model (i.e., varying the inputs to see how much the outputs change).

Strategies to stress-test a model include:

- Set inputs to zero and check that the outputs respond as you would expect. For example, by setting price to zero, you would expect revenue to also be zero.
- Double your units sold. Does your revenue double?
- If you are indexing costs, try setting the indexation percentage to zero and see if the costs remain flat.

Stress-testing your financial model by way of scenario and sensitivity analysis will help you to be prepared for varying outcomes as a result of fluctuating external factors. Once you have completed your financial model you should stress-test the workings of model to ensure that it is robust and accurate.

OVERVIEW OF SCENARIO ANALYSIS TOOLS AND METHODS

Many people will create a financial model, and save it as a base case. They then change all the numbers, and save it as a worst case. Then they change all the numbers again and save it as a best case. Whilst this method will work, it’s not a very efficient way of performing scenario analysis. If a subsequent change needs to be made to the model, it will need to be made several times, and there is a high possibility that an error will be made between the different versions.

Let’s take a look at the technical methods available in Excel for creating scenarios and sensitivities, which will provide a much better way of building models. Essentially, there are three ways:

1. Manual drop-downs
   a. In-cell drop-downs (using data validation)
   b. Object drop-downs (using combo boxes)
2. Scenario Manager
3. Data Tables

Manual Drop-Downs

Creating scenario analysis using manual drop-down boxes means that you can only view one scenario at a time.

In-Cell Drop-Downs (Using Data Validation): In an in-cell drop down, the value sits within the cell of data validation drop-down box. See Figure 11.1.
Chapter 11: Stress-Testing, Scenarios, and Sensitivity Analysis in Financial Modelling

FIGURE 11.1 Data Validation Drop-Down Box

In this case, the modeller has limited the valid entries to this cell to one of three options: either Best Case, Base Case, or Worst Case. This is the easiest and most commonly used type of drop-down box.

See “Bulletproofing your Model” in Chapter 7 for how to create a data validation drop-down box, and “Comparing Scenario Methods” later in this chapter for a practical exercise on how to use them in scenario analysis.

Object Drop-Down Boxes (Using Combo Boxes): There is very little difference from the user perspective with a combo box drop-down, but it’s built very differently. See Figure 11.2.

FIGURE 11.2 Combo Box Drop-Down

This type of box is an object that sits on top of the sheet, rather than within the cell itself. If you look very closely, you can see that the box is sitting across several cells instead of within a single cell. This type of box is a little more difficult to build, but is easier for the user, as the drop-down arrow appears all the time, rather than only when the cell is selected.

See “Form Controls” in Chapter 7 for how to create a combo box drop-down, and “Comparing Scenario Methods” later in this chapter for a practical exercise on how to use them in scenario analysis.

Scenario Manager

Scenario Manager is an Excel tool in which you can create multiple scenarios. Once it is set up, the user can select a scenario, and input cells will change automatically. Scenario Manager is fairly limited and is not particularly helpful in large and complex models. It is therefore not a very widely used tool for scenarios in financial modelling. See Figure 11.3.
Scenario Manager is a tool that, in later versions of Excel, is grouped together with Goal Seek and Data Tables in the What-if Analysis section of the Data tab. Being grouped with other tools that are so useful would lead the aspiring modeller to believe that Scenario Manager is also a critical tool to know. However, despite its useful-sounding name and the good company it keeps, Scenario Manager is quite limited in its functionality and is not particularly helpful in large and complex financial models. It is therefore not commonly used by expert financial modellers; however, for completeness, we will cover it very briefly!

Let’s take a very simple example of a couple creating their personal budget for next year. Let’s assume they do not know what their mortgage payments will be, due to the changing rate of interest, or how much their rail card will cost.

You can define different scenarios and then switch between them to do what-if analysis to see if they will end up in debt or be able to afford a holiday. Scenarios work best on complex spreadsheets where there is a large knock-on effect from changes in the variable data.

Scenarios are created and managed using the Scenario Manager in the following manner:

1. Create and format the spreadsheet as shown in Figure 11.4. You can leave the blue variable cells empty.
2. On the Data tab, in the Data Tools section, click on the What-if Analysis icon, and select Scenario Manager from the drop-down list. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)
3. This will bring up the Scenario Manager dialog box.
4. Click on the Add button to create a new scenario.
5. This will bring up the Add Scenario dialog box.
6. Enter a name for the first scenario into the Scenario Name box (i.e., Best Case).
7. Enter the cell references for the variable cells into the Changing Cells box. Use absolute references, and separate each reference with a comma (if there is more than one), but don’t use spaces. You can actually hold down the Control key and click on each cell in the spreadsheet to insert the references into the box. Click OK.
8. This will bring up the Scenario Values dialog box.
9. Enter the variables’ values for this scenario (i.e., Base Case). For example, $15,000 for mortgage and $2,000 for travel. Click OK.
10. This will take you back to the Scenario Manager dialog box.
11. Follow the previous steps again to create each scenario (i.e., Worst Case: $20,000 for mortgage and $3,000 for travel, and Best Case: $10,000 for mortgage and $1,500 for travel).
12. When you have created all the scenarios you can use the Scenario Manager to view each scenario.
13. Scenarios are sheet-specific, meaning they only exist in the sheet where you created them.

As we can see, Scenario Manager is quite a rudimentary tool, which simply changes hard-coded numbers. It’s not very easy to see, display, or print the different options unless we go into the Scenario Manager tool. Using the summary tool creates a summary report of the scenarios created, but they are not dynamic or interactive, and are therefore of little use as a modelling tool. The biggest downfall of Scenario Manager is that the user cannot see the results on the sheet unless they actually go in to view the scenarios.
Using Data Tables for Sensitivity Analysis

Data tables are one of the more advanced and complex financial modelling tools. They can be used for scenarios and sensitivity analysis, but they are not as commonly used as drop-down scenarios, mostly because users don’t know much about them. Because data tables use array formulas, they are unlike most other formulas in that you cannot trace dependents, and they are very difficult to follow unless you are familiar with them.

Note that a modeller who does not know data tables will be unable to edit the table, or make any changes.

Let’s create an interest rate calculator upon which we can test the sensitivity of monthly repayments to changes in interest rates and loan terms.

1. Firstly, set up the model with the hard-coded input assumptions, as shown in Figure 11.5.

**FIGURE 11.5 Loan Calculation Inputs**

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>INTEREST RATE CALCULATOR</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Enter data here</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Loan Amount</td>
<td>$300,000</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Interest Rate</td>
<td>7.50%</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Term of Loan (Years)</td>
<td>25</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Monthly Repayment</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

2. In cell B12, use a PMT formula to calculate the monthly repayments. See “Loan Calculations” in Chapter 6 for more information on how to use this function.

3. Using the wizard, it should look like Figure 11.6.

**FIGURE 11.6 PMT Function Wizard**

![PMT Function Wizard](image)

4. Your formula should be =PMT(B8/12,12*B10,B6). The function returns a negative value because this is an expense. For our purposes, change it to a positive by preceding the function with the minus symbol.
**One-Variable Data Table:** The data table presents a body of data derived from a function. The rows and columns of the table are drawn from one or two of the arguments or variables fed to the function. In this case, the data comes from the results of the PMT function, using the interest rate variable (cell B8).

5. We will decide what the column elements will be by entering them in cells E7 to E12. For this exercise, use 6.00 to 8.50 percent in increments of half a percent, as shown in Figure 11.7.

**FIGURE 11.7 One-Variable Data Table Inputs**

![Interest Rate Calculator](image)

Merge cells D7 to D12, and change the orientation under the Alignment tab under Format Cells if you wish to have the interest rate title oriented vertically, as shown above.

6. Enter in cell F6 the formula =B12, which is the cell containing the PMT function. The table, when created, will use the PMT function to populate the table according to the values in the input column (this will become clearer once the table is populated).

7. Highlight cells E6:F12. You must highlight all the cells for it to work. Select the What-if Analysis from the Data tab. Choose Data Table from the options that appear. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

8. The Data Table dialog box will appear. Because we are only doing a one-variable data table, we only need to enter data for one of the interest-rate or term variables, but which one depends on whether our input variable is arranged in a row or a column. Because it is in a column, we should use the Column input cell field. Link this field to the input field for the interest rate (cell B8).

9. Your dialog box should look like Figure 11.8.

**FIGURE 11.8 One-Variable Data Table Dialog Box**

![Data Table Dialog Box](image)

10. Click OK, and your data table will populate. Note that the formula in the cells will have curly brackets around them, denoting that it is an array formula: 

\[{\text{=TABLE}(B8)}\]. You will not be able to edit the cells.

11. Your sheet should look something like Figure 11.9.
FIGURE 11.9 Completed One-Variable Data Table

Two-Variable Data Table

12. Now, let’s change this to a two-variable data table. Clear cells F7:F12. You will need to highlight and clear them all at once, as you cannot change or delete part of a data table.

13. With a two-variable table, the output cell needs to be at the top-left of the table, at the intersection of the row and column variables. Therefore, cut and paste cell F6 to cell E6.

14. In cells F6:I6, enter the number of years you wish to test in your data table. For this exercise enter the values 20, 25, 30, and 35 across the table. Change the formatting as necessary. We now have the makings of a table with the term across the top row and the interest rate down the left-hand column, as shown in Figure 11.10.

FIGURE 11.10 Two-Variable Data Table Inputs

15. Now highlight the table area cells E6:I12. You must highlight all the cells for it to work.

Select Data Table from the drop-down list under the What-if Analysis icon in the Data Tools section on the Data tab.

16. Your row input cell will be the entry field for the values shown in the row (the term in years), and the column input cell will be the entry field for the values shown in the column (the interest rate). Your dialog box should look like Figure 11.11.
17. Your table should now look like Figure 11.12.

**Tip:** Data tables look great when you apply colour scales as shown in Figure 11.13, as you can visually see the incremental change to the data. For more information on how to use colour scales see “Conditional Formatting” in Chapter 7.

18. You might wish to change the font in cell E6 to white; while it is required for the data table to work, it does not add any value visually (and is simply confusing).

**FIGURE 11.11 Two-Variable Data Table Dialog Box**

![Two-Variable Data Table Dialog Box](image1)

**FIGURE 11.12 Completed Two-Variable Data Table**

![Completed Two-Variable Data Table](image2)

**FIGURE 11.13 Data Table with Colour Scales**

![Data Table with Colour Scales](image3)
Limitations of Data Tables: We can see from the example above that data tables are a great way to look at multiple scenarios or sensitivity analysis at a time. Instead of manually changing the interest rate, or the term of the loan, we can display at a glance the impact of these changes.

However, data tables have a couple of limitations that make them inappropriate for some scenarios or sensitivity analysis situations. These limitations are here:

1. The inputs and outputs need to be on the same page.
2. You have a limitation of showing only two inputs and one output at a time. This is not a restriction with other forms of scenario analysis.
3. Formula auditing (trace precedents and trace dependents) doesn’t work very well in data tables.

Data tables are extremely useful when, as in the example shown above, you want to see the incremental change of one or two inputs on a single output. For example, how much does my profit margin change by if I change my price from $450 to $460, $470, $480, $490, and $500? A data table would not be an appropriate solution if the output of your financial model were a full set of financial statements, for example! In this situation, a drop-down scenario would be most appropriate.

ADVANCED CONDITIONAL FORMATTING

A data table is a good opportunity to use conditional formatting with a formula. We can use advanced conditional formatting to enhance a two-variable data table, making it more visually interesting and interactive for the user.

Our final result will look similar to Figure 11.14, using the term of the loan and the interest rate as the two variables to drive the conditional formatting. If you changed the interest rate in cell B8 from 7.5 to 7 percent, the row currently being highlighted will change from row 10 to row 9. Similarly, if the term of the loan was changed in cell B10 from 25 to 30, the column currently being highlighted will change from column G to column H. In this way, we can see at a glance which inputs have been selected currently in the model.

FIGURE 11.14 Completed Data Table Using Advanced Conditional Formatting
For a review of the basics, see “Conditional Formatting” in Chapter 7. As you know, conditional formatting allows you to apply formats to a cell or range of cells, and have that formatting change depending on the value of the cell (or the value of a formula).

In this particular example we want the interest rate and term to intersect at the appropriate repayment installment. As the variables to the PMT function are changed, the intersection point will move to spotlight the repayment amount.

One way we can accomplish this is to apply conditional formatting by means of a formula to each row within the table and, likewise, to each column. For instance, in Figure 11.15, we can stipulate that if cell E10 is equal to the interest rate (B8), then Excel must colour the row 10 within the table.

FIGURE 11.15 Highlighting Selected Interest Scenario Using Conditional Formatting

This would require 10 formulas if we were to cover each of the six interest rates and each of the four terms. However, we can accomplish the exercise with two formulas only: The first locks either the rows or columns with absolute references; the second allows other elements of the cell address to float across the row or up and down the column by using relative references. This exercise illustrates how this is done.

1. Select the entire table (cells E6 to I12). Choose Conditional Formatting on the Styles section (Format for Excel for Mac 2011) of the Home tab. Select New Rule from the drop-down list, and then Use a Formula to Determine Which Cells to Format. In Excel for Mac 2011, select the entire table (cells E6 to I12). Choose Conditional Formatting on the Format section of the Home tab. Select New Rule from the drop-down list, set Style to Classic and then Use a Formula to Determine Which Cells to Format. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

2. Choose to use a formula to determine which cells to format. Note that E in Figure 11.16 is an absolute reference to hold us in column E, but that the row number (presently 6) is free to roam down within the column.
3. Format the cell as required using the Format button.
4. Repeat the exercise to format the terms. In this case the formula will reverse the relative and absolute references like this: E$6, locking in row 6. The rules should look like Figure 11.17.

5. To modify the conditional formatting, highlight the relevant rules (in this case the entire data table). Choose Manage Rules . . . from the Conditional Formatting menu.
COMPARING SCENARIO METHODS

Let’s create a very simple property development feasibility model to demonstrate the difference between the methods of scenario analysis. You are considering purchasing an empty block upon which you are considering developing a residential villa complex on the property.

The assumptions are:

- The land will cost $4.3 million to purchase.
- Council contribution fees will be $750,000.
- The properties that we develop will be 5,000 square metres in total.
- Building costs will be $1,500 per square metre.
- We will sell the properties for $3,000 per square metre.
- Sales commission to the estate agent will be 2.5 percent of the sale price.

To create the working model, do the following:

1. Lay out the model, and enter the assumptions as shown in Figure 11.18.

**FIGURE 11.18 Model Layout for Drop-Down Scenario Method**

These assumptions are all input variables, so format them as inputs with blue font and beige background.

2. Calculate the income from selling the properties in cell C11 by multiplying the sale price per square metre by the total number of square metres. Your formula should be =D8*C8.
3. Similarly, calculate the building costs in cell C14 by multiplying the building cost per square metre by the total number of square metres. Your formula should be =B8*D8.

4. Calculate the sales commission by multiplying the income by the sales commission. Your formula should be =C11*E8.

5. Add the expenses in cell C17.

6. Calculate the net profit in cell C19 by deducting the expenses from the profit.

7. Calculate the profit margin in cell C20 by showing the profit as a percentage of the revenue. Your formula in cell C20 should be =C19/C11.

8. Your model should look something like Figure 11.19 so far.

**FIGURE 11.19 Model with Calculations**

We have now completed the workings of the model and are ready to add some scenarios. Note that this is a very simple one-page model, which we will use to demonstrate how to build scenarios. Your model can be a lot more complex than this, containing many more pages and calculations, but the methodology for creating a scenario will be exactly the same.

**Manual Sensitivity Analysis**

The two input variables that we think are the most likely to change are the building cost and the sale price per square metre. Note that because of the way we have built this model, with these assumptions hard-coded and all the calculation linking to these inputs, we can quite easily change these inputs manually and this will affect the output of the model. We can see that if the building costs were to decrease from $1,500 to $1,200 per square metre, this would increase the profit margin to 24 percent. Additionally, if the sale price were to increase from $3,000 to $3,300 per square metre, this would increase the profit margin further to 31 percent.

You can see that we can also manually change the sales commission and the total number of square metres in the development, although we have determined that these are unlikely to change.
Creating Built-In Scenarios Using a Data Validation Drop-Down: Tweaking these input variables manually is a form of sensitivity or what-if analysis, but it's difficult to control and not very auditable. It's much better practice to build some pre-defined scenarios into the model, and allow the user to switch between the scenarios using a drop-down box.

Let's build some scenarios using this method.

1. In cells A4 to A6, enter **Best Case**, **Base Case**, and **Worst Case**.
2. Enter in hard-coded assumptions, as shown in Figure 11.20.

**FIGURE 11.20 Model Scenario Inputs**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Building cost per sq mtr</td>
<td>Sale Price per sq mtr</td>
<td>Total no sq mtrs</td>
<td>Sales commission</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Best Case</td>
<td>$1,250</td>
<td>$3,300</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Base Case</td>
<td>$1,500</td>
<td>$1,000</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Worst Case</td>
<td>$1,750</td>
<td>$2,700</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. At the very top of the model in cell B1, create a data-validation drop-down box that the user can select from to choose the scenario they'd like to see. For instructions on how to do this, see “Using Validations to Create a Drop-Down List” in Chapter 7.
4. The data validation should be linked to the source cells, as shown in Figure 11.21.

**FIGURE 11.21 Data Validation Drop-Down List Dialog Box**

5. Your sheet should look like Figure 11.22.
6. Now we need to change the input assumptions in cells B8 and C8 from hard-coded inputs to formulas that will change depending on the scenario that has been selected from the drop-down box.

7. There are several different functions that we can use to achieve this; an IF statement, a VLOOKUP, or a SUMIF, will all return a similar result. If you choose a SUMIF, the formula in cell B8 should look like this: 
   \[ \text{=SUMIF($A$4:$A$6,$B$1,B4:B6)} \].

8. If you've got the cell referencing correct, you can simply copy the formula across to cell C8 without changing the formula.

9. Change the cell and font colour of cells B8 and C8 to denote that they now contain formulas instead of hard-coded values.

10. Your completed sheet should now look something like Figure 11.23.
11. Practice changing the scenario drop-down in cell B1, and watch the numbers change! Under the best case, you’ll be making a 29 percent profit, and worst case, you’ll have a loss of 5 percent.

Creating Scenarios Using a Combo Box Drop-Down: Now that we’ve got our scenarios working, let’s take a look at what we could achieve using a combo box drop-down instead. Note that combo boxes require VBA code, as previously discussed in “Form Controls” in Chapter 7.

Leaving the scenario model we’ve just created intact, make a copy of the sheet by right-clicking on the sheet tab at the bottom. Select Move or Copy and then select Create a Copy, as shown in Figure 11.24, and click OK.

FIGURE 11.24 Sheet Copy Dialog Box
1. Remove the data validation drop-down we created in cell B1. The easiest way to do this is to copy a blank cell and paste it over cell B1. This will mess up your calculations, but don’t worry; we’ll fix them later.

2. Now create a combo box drop-down in the same area. For instructions on how to do this, see the “Combo Boxes” section in Chapter 7.

3. Right-click on the combo box, and select Format Control. On the Control tab, under Input Range, select the words Best Case, Base Case, and Worst Case in cells A4 to A6.

4. Also choose a cell link, which is where you want the output cell from the drop-down box to be. We often choose the cell behind the combo box, in this case cell B1, as this will be hidden behind the drop-down, and unlikely to be accidentally deleted. You may need to move the combo box out of the way temporarily (select it the combo box whilst holding down the control key to do this).

5. Your format control dialog box should look like Figure 11.25.

**FIGURE 11.25 Combo Box Format Control Dialog Box**

6. Click OK. Click away from the combo box, and then select it again. Practice changing the options from the drop-down, and you’ll notice the number in cell B1 changing. See Figure 11.26.

**FIGURE 11.26 Model with Combo Box Drop-Down**
7. What we need to do now is to change the formula in cells B8 and C8, which are driving the calculations in the model. The SUMIF (or IF, VLOOKUP, or whatever you used) function we created earlier is not working because cell B1 no longer contains name of the scenario. This now needs a formula that will select the first option if it contains a 1, the second option if it contains a 2, and so on.

8. Again, there are several functions we can use to achieve this, a CHOOSE or an INDEX to name two. If you use a CHOOSE function, your formula in cell B8 will be =CHOOSE($B$1,B4,B5,B6). If you use absolute referencing, you can copy this across to cell C8.

9. Practice changing the drop-down box and make sure it works properly. Your model should now work in exactly the same way as it did earlier, except that we are now using a combo box instead of a data validation drop-down.

10. Hold down the Control key, and move the combo box so that it covers the cell link output number in cell B1.

11. Your sheet should now look something like Figure 11.27.

**FIGURE 11.27 Completed Combo Box Model**

What’s the Difference between a Data Validation and Combo Box Drop-Down?: From the user perspective, the data validation and the combo box drop-down should be almost indistinguishable from each other. They both work in the same way – that the user selects from a drop-down list, and the model will change. However, there are a couple of key differences from the model developer’s perspective:

- The combo box takes longer to build, as it requires inputs and outputs.
- As we can see in the previous example, the formulas we use to link to it are quite different.
- The combo box can easily be embedded in a chart.
We can assign macros to a combo box so that unbeknownst to the user a macro is launched as soon as an option is selected from the drop-down.

The source data that appears in the combo box must be oriented vertically, not horizontally. This is an important point when designing the model. If you plan to use a combo box for scenario analysis, make sure that the input assumptions are listed vertically. Sources for data-validation drop-down boxes can be oriented either horizontally or vertically.

As shown in Figure 11.28, combo boxes will not work if the source data is oriented horizontally instead of vertically.

**FIGURE 11.28 Combo Box Drop-Down with Horizontally Oriented Source Data**

Creating Scenarios Using a Two-Variable Data Table: Let's take a look to see if we could achieve the same result on our property development feasibility model using a data table method of scenario analysis instead of a drop-down box.

Leaving the scenario model we've just created intact, make another copy of the sheet by right-clicking on the sheet tab at the bottom. Select Move or Copy, and then select Create a Copy and click OK.

Instead of creating base-, best-, and worst-case scenario from which users need to select the scenario that they want to display, we are instead going to create a single matrix, where users can see simultaneously the results of different inputs. We need to change the design of the model just a little bit in order to create this scenario analysis using a data table instead.

1. Change the assumptions in row 8 from formulas back into hard-coded input numbers.
2. Change the formatting of the cell so that we can see they are hard-coded, not formulas. The quickest way to do this is to copy the formatting from another cell by using the format painter.
3. Move the assumption titles to row 7, remove the best-, base-, and worst-case inputs and the scenario drop-downs in rows 1 to 6, and replace with a data table layout as shown in Figure 11.29.
4. To create the titles for the data table inputs, use Merge Cells, and then for the vertically oriented title, wrap text, and right-hand click. Select Format Cells and on the Alignment tab change the orientation. To show the title on the right-hand side of the cell instead of the centre, choose Right text alignment instead of Centred under the Text Alignment area.

5. Now create a two-data table by selecting the input assumption for sale price for row, and building cost for column. For detail on how to create a data table, see “Using Data Tables for Sensitivity Analysis,” earlier in this chapter.

6. Link cell B2 to profit margin in cell C20, as this is the output we want to show on the data table.

7. Highlight the entire data table, and go to the data table tool under the Data tab, in the What-if Analysis section. In Excel 2003, go to Data – Table.

8. The Data Table dialog box will look like Figure 11.30.
9. When completed, the data table will look like Figure 11.31.

FIGURE 11.31 Completed Data Table

This gives us exactly the same results as the drop-down box options, but instead of having to flick through the drop-downs, the user can see at a glance all the results of the different scenarios simultaneously.

In this situation, the data table is an appropriate option for displaying the sensitivity of our profit margin to changes in inputs because the inputs and outputs are all on one page, and we are only interested in a single output. We do lose some detail by using the data table method, as we cannot see, for example, the building cost amount under each different scenario, only the final outcome.

This feasibility model shows clearly the difference between three of the scenario methods. We have chosen not to use Scenario Manager, because even though it is perfectly possible on this model, it is not a particularly useful tool. In this example, the data validation drop-down, combo box drop-down, and the data table scenario analysis methods are all suitable. However it really depends on the size, layout, and required output of the model as to which method is best to use.
SUMMARY

In this chapter, we have covered the different tools that are available in Excel for scenarios and sensitivity analysis. Depending on the inputs and outputs for the scenarios, different tools are most appropriate.

As discussed, the drop-down method is the most popular, as that allows for many different scenario inputs as well as outputs. Scenario Manager is not a particularly useful tool, and data tables are most useful for sensitivity analysis where there are a maximum of two input variables, and only one output that needs to be shown. Whilst there are several different scenario tools available, the methodology and logic behind creating the scenarios remains the same.
Chapter 11 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Tweaking one key input or driver in a financial model in order to see how sensitive the model is to the change in that variable is known as:
   
   a) what-if analysis 
   b) sensitivity analysis 
   c) scenario analysis 
   d) both a and b

2. The course recommends having a minimum of ____ scenario(s) in a model.
   
   a) 1 
   b) 3 
   c) 8 
   d) 12

3. Which of the following is true regarding combo boxes:
   
   a) the source data must be listed horizontally 
   b) they can be embedded in a chart 
   c) they take less time to build than data validation drop-down 
   d) they only require inputs
Chapter 11 – Solutions and Suggested Responses

1. A: Incorrect. What-if analysis, also known as sensitivity analysis, involves tweaking one key input or driver and seeing what happens if you do so.

B: Incorrect. Sensitivity analysis is the same thing as what-if analysis. Both of these refer to the process of tweaking one key input or driver in a financial model in order to see how sensitive the model is to the change in that variable.

C: Incorrect. Scenario analysis involves listing a whole series of inputs, not just one input, and changing the value of each input for each scenario.

D: Correct. Both sensitivity analysis and what-if analysis, as they are the same thing, entail tweaking one key input or driver in a financial model in order to see how sensitive the model is to the change in that variable.

(See page 277 of the course material.)

2. A: Incorrect. Your model must have a minimum of three scenarios, so one is too low of a number.

B: Correct. At a minimum, your model should have three scenarios. An example of three scenarios that could be used are best case, likely case, and worst case scenario.

C: Incorrect. It is possible to have eight scenarios, but the recommended minimum is only three scenarios per model.

D: Incorrect. The author recommends having a minimum of three, not eight, scenarios per model.

(See page 278 of the course material.)

3. A: Incorrect. The source data that appears in a combo box must be oriented vertically, not horizontally.

B: Correct. Combo boxes can be easily embedded in a chart.

C: Incorrect. Combo boxes take more time to build because they require both inputs and outputs, whereas a data validation drop-down does not require both inputs and outputs.

D: Incorrect. Combo boxes require both inputs and outputs.

(See pages 296 to 297 of the course material.)
Once a model has been built, it’s important to display results clearly and concisely to get your message across, whether via a written report or oral presentation.

**PREPARING AN ORAL PRESENTATION FOR MODEL RESULTS**

As the person who knows the model best, financial modellers are often requested to communicate the results of the financial model as a formal presentation to the board or senior management. Understandably, many detail-orientated analysts often find that it is quite a challenge to distill their 20-megabyte financial model that has taken weeks to build into a 10-minute presentation.

Although most senior management may not be interested in seeing the model itself, they might like to see live and changing scenarios. If the model is built correctly, you’ll be able make a single change to the input assumptions and the audience will be able to see the effects of these changing scenarios in real time. Make sure that you test all possible inputs in advance – nothing looks less professional than a #REF! error during a live sensitivity analysis.

Not all presentations require you to use PowerPoint, but in this kind of environment, where it is necessary to convey lots of information, having the summary tables or charts on a slide behind you while you are speaking will be helpful. It can also help to take the focus off you if you are a little nervous.

Follow these basic rules of presentations:

- Only display one key message per slide. Don’t crowd it or try to convey too much at once.
- Give them a more detailed report to look through, but the slides should be a very concise summary of this report.
- Make sure the font is big enough and clear on a data projector. Test it in advanced if you can – sometimes colours look great on a monitor, but look washed out when projected on the wall.
- If you are showing the model itself on the screen, increase the zoom in Excel so that your audience can see the numbers. Test this in advance, and remember you’ll only be able to show a small portion of the screen in this way.
- Use charts and graphics to display your message. Generally the output from a model will be numerical, and charts are a great way of showing this. Research also shows that audience attention and retention of information increases significantly when graphics are used instead of pure text in presentations.

Most importantly, be prepared for questions regarding the output, inputs, assumptions, or workings of the model. Make sure that you can defend the assumptions that have been used, or the way something has been calculated. If you are not comfortable with some of the assumptions, say so up front. The model output is only as good as the assumptions that have gone into it, so you need to make sure that the audience accepts the key assumptions before they will accept the model results.
If you have the opportunity, spend some time with the key audience members in advance and walk them through the assumptions and methodology of the model. They might have some questions or comments that you have not anticipated, and it will give you a chance to make changes or prepare your answers to likely questions in advance.

Summarising and Displaying Model Results

If you have a 10-minute slot during which you need to convey the high-level output of the model, you probably need about four slides. If we have put together a business case for a new product, for example, outputs for a typical financial model, may include:

1. **A summary of projected cash flows or profitability.** You won’t be able to fit more than about five years onto a PowerPoint slide, so if you need to show 20 years, just show Years 1, 5, 10, 15, and 20, for example.
2. **Key assumptions.** Use your judgement here to choose which assumptions are important. Select the ones that either impact the model the most, or you are most certain of.
3. **Scenarios analysis.** On a slide you’ll probably comfortably be able to fit 4–5 scenarios so choose wisely. At minimum, display a best-case, base-case, and worst-case scenario. See “Scenarios and Sensitivity Analysis in a Business Case” in Chapter 11 for more detail on how to create these.
4. **Results of sensitivity testing.** Show the results of tweaking a single assumption. For example, if we were to get our customer take-up amount wrong by 1 percent, this will cause a $500,000 change to the NPV — and this is something the audience needs to be aware of!

If you have longer than 10 minutes, you might be able to show the model itself if the presentation is more of a workshop than a formal presentation. In either case, you should be able to give each person a hard-copy summary report of the first few pages of the model with more detailed numbers than you have been able to include in the PowerPoint presentation. If the model has been well written, each page will form the back up data and source information for the model, and can be printed or distributed if the recipient of the summary results requests further information.

PREPARING A GRAPHIC OR WRITTEN PRESENTATION FOR MODEL RESULTS

Charts are a way to present a series of data in a visual presentation so that patterns of information can be identified. Charts can be a powerful tool for the end user if they are built correctly and help simplify and summarise data.

A common mistake many analysts make is to try to put as much information as possible into one chart in an attempt to make it look impressive. In reality, the chart just looks cluttered and fails to get the message across. Remember that charts are for the purpose of visually presenting information that is easier to digest than the raw data. When creating a chart, balance the amount of information presented along with the formatting. It may be more useful to create two charts, dividing up information, rather than putting it all on one chart. Consider Figure 12.1.
FIGURE 12.1 Line Chart with Multiple Series

Is this chart useful? There is so much data presented that the chart has no real value. As well, the type of chart isn’t necessarily the best choice. Consider instead Figures 12.2 and 12.3.

FIGURE 12.2 Column Chart with Two Series

FIGURE 12.3 Stacked Column Chart with Two Series
With the same set of data, we have created two charts that give us much more intelligence, using less of the data. In Figure 12.2, a viewer can see at a glance the trend in revenues and the corresponding gross margin. Is the cost of goods sold really necessary? Well, depending on the specific needs of the user, maybe, but most likely the viewer of this chart just wants a snapshot of how the company is performing at the top level.

Figure 12.3 shows the composition of marketing and G&A (general and administrative) expenses month to month. Note that using a stacked bar chart allows the user to see the total expenses. Compare this to the original line chart, and you can see it is almost impossible to compare the expenses in the line chart, as there is so much interference. By breaking up the data into two charts, picking the correct chart type, and limiting the information presented, we have gone from useless to informative.

**Additional Tips for Charting**

Use the following tips to really make your charts have an impact:

- Reduce clutter by representing less data, using fewer words in the legend, and avoiding unnecessary labels.
- Don’t use gridlines. Let the relative ups and downs of the chart speak for themselves.
- Limit the number of bars to seven in a bar chart; limit the number of lines to three in a line chart.
- Use standard imagery instead of special artwork; it’s too distracting (i.e., a stack of coins to represent an expense rather than a standard bar).
- Choose your x- and y-axis ranges so that the space is utilised effectively.
- If you have fewer than 12 periods for a time-series chart, use a bar chart instead of a line chart.
- Avoid the use of 3-D charts. Remember: Keep things simple!
- Be cautious of the colours and shading you use.
- If the data has no natural order, sort the data from largest to smallest.

**CHART TYPES**

Before looking at how to build charts from a technical perspective, let’s first look at which chart to use. The most common types of charts are line and bar charts, but there are many other charting options Excel has to offer, and which chart types will display the data in the best, most visual way really depends on the available data and the message you are trying to convey.

**Choosing a Chart Type**

The first step in creating a useful chart is to choose the correct type of chart. Bar charts, pie charts, line charts, areas, scatter plots, donuts, radars, and bubbles are all options. Which one makes the most sense? Note that when displaying information outputs of a typical financial model, line and bar charts are the predominate types of charts used, but this is not always the case. It’s quite a skill to choose the most appropriate chart to display the output information in the best possible way.
Sometimes it’s a matter of trial and error. The best way to choose a chart is try several different charts to get a sense of which one is the best. Fortunately, it’s very easy to flick between different chart types in Excel.

Summary of Common Charts and Applications

Table 12.1 is a brief summary of different chart types and their uses for displaying data graphically. The next section describes in detail what each of these charts does and what sort of data it best displays.

**TABLE 12.1 What Type of Chart Best Fits Your Data?**

<table>
<thead>
<tr>
<th>Chart Type</th>
<th>Suitable for ...</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column</td>
<td>Data point (Y) variation over a short range of values (X). Suitable for comparison of data points.</td>
<td>See Figure 12.4.</td>
</tr>
<tr>
<td>Bar</td>
<td>Same as column charts.</td>
<td>See Figure 12.5.</td>
</tr>
<tr>
<td>Line</td>
<td>Trend and functional relations; useful for spotting trends.</td>
<td>See Figure 12.6.</td>
</tr>
<tr>
<td>Area</td>
<td>Similar to line chart; represents variation of data points relative to each other.</td>
<td>See Figure 12.7.</td>
</tr>
<tr>
<td>Pie</td>
<td>Single series of positive percentages or ratios.</td>
<td>See Figure 12.8.</td>
</tr>
<tr>
<td>Donut</td>
<td>Stacking multiple pie charts.</td>
<td>See Figure 12.9.</td>
</tr>
<tr>
<td>Bubble</td>
<td>Enhancing scatter plots with additional variable.</td>
<td>See Figure 12.10.</td>
</tr>
<tr>
<td>Radar</td>
<td>Displaying multivariate information for statistical analysis.</td>
<td>See Figure 12.11.</td>
</tr>
<tr>
<td>3-D</td>
<td>Showing data three-dimensionally instead of two-dimensionally.</td>
<td>See Figure 12.12.</td>
</tr>
</tbody>
</table>

**FIGURE 12.4 Column Chart**
FIGURE 12.5 Bar Chart

FIGURE 12.6 Line Chart

FIGURE 12.7 Area Chart
FIGURE 12.8 Pie Chart

Expenses

- Hammerhead
- Mako
- Goblin
- Thresher

FIGURE 12.9 Donut Chart

Land Area versus Population of Australia by State/Territory

- Australian Capital Territory
- New South Wales
- Victoria
- Queensland
- South Australia
- Western Australia
- Tasmania
- Northern Territory

FIGURE 12.10 Bubble Chart

Profit and Number of Staff

2006 2007 2008 2009 2010 2011 2012 2013

$70,000 $60,000 $50,000 $40,000 $30,000 $20,000 $10,000 $0

23 17 20 30 22 9
Let's go into each of these chart types in a little more detail.

**Column Charts:** Column charts one of the most commonly used charts available in Excel, and they are a staple of presenting unrelated data points graphically. The height of the columns indicates the value or the parameter on y-axis while the width indicates value along the x-axis. Column charts are a very effective method of displaying a message instantly, due to the simple format they represent the information. See Figure 12.13.
Excel offers multiple variations in column charts. Some of them are very effective in conveying the message, while others may look good but distract from your main point.

- **Stacked Column Charts:** These are a variation on a basic column chart, with multiple variables stacked on top of each other. They are particularly good for showing proportionate totals. For example, in Figure 12.14, not only can we see how each region compares to each other, but how much each department contributes to costs.

**FIGURE 12.14 Stacked Column Chart**

Note that including a data table will add more detail to the stacked column chart. See “Handy Charting Hints” later in this chapter for instructions on how to add a data table. See Figure 12.15.
• **100-Percent Stacked Column Charts**: As the name suggests, these are column charts that stack on a percentage basis. They are most appropriate for use in comparing data where we are comparing percentages and ratios rather than an absolute number. When using 100-percent stacked column charts, make sure that the labels clearly show that it is displaying percentages rather than absolute numbers. See Figure 12.16.

**FIGURE 12.16 100-Percent Stacked Column Chart**

• **Clustered Column Charts**: These are multiple series of basic column charts arranged next to each other. Instead of creating multiple charts for similar information, it may sometimes be better to use the clustered charts instead. However, you must ensure that columns are not too congested, as that would defeat the purpose. See Figure 12.17.
3-D Charts: Excel also offers three-dimensional (3-D) versions of these column charts as bar, cylinder, and cone charts. While 3-D bar and cylinder charts are easy to comprehend, understanding the cone charts can get complicated, so they are not very commonly used to display data. In general, 3-D charts do not convey any more information than 2-D charts, so usually a 2-D chart is a simpler and clearer way of displaying information. See Figure 12.18.
**Bar Charts:** Bar charts are transposed column charts. They represent the same information as column charts from a different perspective. Most times the choice between column and bar charts will depend on how you want to represent the information depending on the space constraints of the display area. Most commonly, bar charts are used to represent time or future projections along the x-axis. See Figure 12.19.

**FIGURE 12.19 Bar Chart**

![Bar Chart](image)

**Line Charts:** These are lines joining data points to display the information. Line charts are most appropriate for indicating trends. Like column charts, the simplicity of these charts makes them one of the favourites in displaying data. Whilst column and line charts can be used interchangeably, line charts are best used for trending information and columns are better to study absolute data metrics.

We can see in Figure 12.20 that a line chart is not the most appropriate method of displaying these different costs, as it insinuates that there is some connection between the data points.

**FIGURE 12.20 Line Chart**

![Line Chart](image)

Like column charts, there are also stacked line and 100-percent stacked line chart options in Excel. Sometimes line charts convey information in a more meaningful manner when the data points are marked. Excel offers the line chart with marker options for this purpose.
Area Charts: Area charts are similar to line charts but have a shaded area below. Like line charts, they are good for displaying data that is connected. These can be stacked or not stacked, similar to column charts. Figure 12.21 is a stacked chart – not a particularly effective way of displaying four different regions with no connection between them.

FIGURE 12.21 Area Chart

![Costs by Region](image)

Pie Charts: Pie charts have variable size sectors indicating the percentage of each variable in the overall picture. Again, like the stacked 100-percent charts, pie charts are great for displaying ratios or percentage information. They are very popular, but are notoriously poor for displaying information. In Figure 12.22, the pie chart is useful for comparing which department has the highest expenses, but it portrays very little information compared to a column chart, for example.

FIGURE 12.22 Pie Chart

![Expenses](image)
**Donut Charts**: Visually donut charts are pie charts with a hole in the center. While it may not seem like a big difference at first, this gap in the donut hole allows several series to be stacked in the same chart. Pie charts can be used to represent a single series of values; multiple series require a separate chart for each series. This can be overcome with donut charts, where multiple series can be stacked centrally.

However, since donut charts are not commonly used, interpreting them can become cumbersome. If you want to use this chart, you need to plan it properly and make it as intuitive as possible. See Figure 12.23.

**FIGURE 12.23 Donut Chart**

**Combination Charts**: Sometimes using the same chart type to represent different data metrics is not very effective. In such cases, using a combination of chart types can be a very powerful solution. One of the most popular representations is the combination of column and line charts. Such combinations can convey a lot of information without cluttering the chart. These are particularly useful in dashboard reporting and other instances where you want to display as much information as possible in a small amount of space. See Figure 12.24.

**FIGURE 12.24 Combination Chart**

Quite often we might want to show two different measures, such as number of units and profits on the same charts. For instructions on how to do this, see “Charting with Two Different Axes and Chart Types” later in this chapter.
**Bubble Chart:** Bubble charts are an enhancement to scatter charts. The bubble chart can compare three characteristics: It can plot not only the x- and y-axis, but also reflect bubble size for each category. See detailed instructions later in this chapter for how to build a bubble chart. See Figure 12.25.

**FIGURE 12.25 Bubble Chart**

![Bubble Chart](image)

**Radar Charts:** Radar charts plot the points on a circular axis rather than an x- and y-axis. Hence, the data points are indicated by their relative distances from the centre. They are easy enough to build, but can be confusing and are not particularly good at displaying quantitative information and, therefore, are not commonly used. See Figure 12.26.

**FIGURE 12.26 Radar Chart**

![Radar Chart](image)

Note: If you are not keen on creating a full-fledged chart to represent data, you can use the sparkline feature, which is new to Excel 2010. To learn more, refer to “Sparklines” in Chapter 7.
**Exercise:** Looking at the following list of data, which chart type would best represent the sales data to show a regional comparison?

<table>
<thead>
<tr>
<th>Department</th>
<th>Sales</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hammerhead</td>
<td>$8,500</td>
</tr>
<tr>
<td>Mako</td>
<td>$5,200</td>
</tr>
<tr>
<td>Goblin</td>
<td>$7,600</td>
</tr>
<tr>
<td>Thresher</td>
<td>$9,600</td>
</tr>
</tbody>
</table>

Take a look at the options in Figure 12.27. Which would be the best fit to get our message across?

**FIGURE 12.27 Comparison of Chart Types**
Line charts and area charts insinuate that there is some kind of connection between the data points, which is not the case, so they are not particularly useful in this situation.

The column or bar chart is the best for comparing this kind of information, as we can easily see which area is the highest and lowest. The pie chart shows the proportion, and looks visually pleasing, but it is not as good for showing comparisons between the data points.

For detailed instructions on how to build a basic line chart, see the supplementary materials available at www.wiley.com/go/steinfairhurst.

**WORKING WITH CHARTS**

The following outlines some of the most commonly used features of charting.

**Changing the Type of Chart**

Displaying data graphically is usually an iterative process, and if you create a chart based on your model data and it doesn’t look quite right, it is relatively quick and easy to change the chart type displayed.

To change the chart type, display the Change Chart Type dialog box by right-clicking on the chart area and selecting Change Chart Type from the drop-down menu that appears. See Figure 12.28.

**FIGURE 12.28 Change Chart Type Dialog Box**

Choose the chart you’d like to display, and click OK. Note that you can also change the chart type through the Design tab on the ribbon.
Changing the Source Data

You can also quite easily change the source data for your chart while retaining the original chart type.

In Figure 12.29, the pie chart is based on sales data per region (B2 through to B5). To depict expenses per region (E2 through to E5), you would need to change the source data.

**FIGURE 12.29 Pie Chart Depicting Units Sold Data**

To change the source data:

1. Right-click on the chart area and click Select Data from the menu that appears. See Figure 12.30.

**FIGURE 12.30 Select Data Option from Right-Clicking Menu**

2. The Select Data Source dialog box will be displayed. See Figure 12.31.
3. The field called Chart Data Range at the top of the dialog box shows the range of cells used in the data source for the chart.
4. Click on the series name (Units sold, in this case), and click Edit.
5. Select the new data range from the sheet with your mouse.

**Tip:** Make sure that you delete all of the original data from the series or it will mess up your graph. See Figure 12.32. This is a rather annoying habit of Excel charting; unless you highlight the existing range and then reselect the new data, it will automatically add it to the range with a plus (+) sign.

**FIGURE 12.32 Edit Series Dialog Box with Incorrect Series Values Data**

6. When you have completed your data selection, the new data range reference will appear in the Edit Data Source dialog box. Click OK.
7. The size of the pie slices (in the example above) has changed to reflect the new data. See Figure 12.33.
FIGURE 12.33 Pie Chart Depicting Expenses Data

If you want to change the title of the chart to something more interesting than Expenses:

1. Right-click on the title and select the Edit Text option from the drop-down menu. Or, in Excel for Mac 2011, simply double-click on the title.
2. Edit the text to change the title. Remember that if you change the underlying data in the model, the chart will change as well.

To add or remove data series:

1. From the Select Data or Source Data dialog box, as shown above, click the Add, Edit, or Remove button.
2. Enter a range of data for the series by selecting a range in the model.

Saving a Chart as a Template

If you’ve spent a lot of time getting the axes, colours, and formats the way that you want them, you can save this chart as a template to use again and again.

To save a chart as a template:

1. Click on the chart area to display the Design ribbon.
2. Click the Save as Template button on the Design ribbon to display a Save Chart Template dialog box. See Figure 12.34.

FIGURE 12.34 Save as Template Option in the Chart Tools Ribbon

3. Enter a name for the chart template and choose the location where you’d like the template to be saved.
4. Click the Save button.
In Excel for Mac 2011:

1. Click on the chart area to display the Charts ribbon.
2. Click the Other button on the Charts ribbon to display a Save As Template dialog box. See Figure 12.35.

**FIGURE 12.35 Save as Template Option in the Chart Tools Ribbon**

3. Enter a name for the chart template and choose the location you’d like the template to be saved under.
4. Click the Save button. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

To use the chart template:

1. Select a data range for the new chart.
2. Click the dialog launcher, which is located at the lower-right of the Charts button group. (Found in the Other menu in Excel for Mac 2011.)
3. Select the template you’d like to use. See Figure 12.36.

**FIGURE 12.36 Using a Chart Template**

Click on Set as Default Chart so that each time you create a chart, it will default to your template. (Note that this function is unavailable in Excel for Mac 2011.) This is particularly useful when using the F11 shortcut to create a chart.
HANDY CHARTING HINTS

Here are some handy charting hints:

- The formatting on most of the areas of the chart can be changed by double-clicking on the area you wish to change. You can play with this to make your graph look more attractive.
- The legend on the right-hand side can be resized, moved, or deleted by selecting it.
- If the chart has been inserted in the worksheet, rather than on its own page, it can be easily dragged around the worksheet or resized.
- If you hide data in your source sheet, this will not show on the chart. Test this by hiding one of the columns on the Financials sheet and check that the month has disappeared on the chart. You can change the options under Select Data Source so that it displays hidden cells. This is a new feature that was introduced in Excel 2007, and it is unavailable in previous versions. See Figure 12.37.

FIGURE 12.37 Select Data Source Dialog Box

- The chart can be changed to a different type of chart (e.g., a bar chart or a pie chart) by right-clicking and selecting Change Chart Type.
- Including a data table (not to be confused with a sensitivity analysis data table) that shows actual values below the chart is a great way to display the information visually while still providing detailed data. See Figure 12.38.
Select Show Data Table from the drop-down menu under the Data Table icon on the Layout tab (Format tab in Excel for Mac 2011) as shown in Figure 12.39.

### Charts can be pasted directly into Microsoft Word or PowerPoint.

Note that if you simply copy and paste, the links to the underlying data in Excel will be maintained. This is fine, if you want to be able to edit the Excel data and have the chart update. Normally when you've copied and pasted a chart into Word or PowerPoint, you have finished it and don't want the chart to change at all. Therefore, it needs to be pasted as a picture. Copy the chart and then Paste Special, pasting the chart into the destination document as a picture to make sure that the chart does not change.

**Tip:** To create a chart very quickly on a new sheet, highlight the data and use the F11 shortcut. This automatically creates a column chart in all versions of Excel. In Windows versions you can change the default settings under Change Chart Type.
DYNAMIC RANGE NAMES

When creating a chart for which you are not sure of the size of the data, using dynamic named ranges can be particularly helpful.

The problem with specifying a range is that if someone adds data to right or below the table, it will not be included in the range. This can potentially cause error.

Let’s say that you have the data shown in Figure 12.40. You have defined a named range called Expense_data, which has a formula linking to it. Now, if a user wants to add data to this table (e.g., another expense item in row 9, or another city in column J), this new data will not be included in the range.

**FIGURE 12.40 Source Data for Dynamic Named Range**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Expenses</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Staff Costs</td>
<td>$568,492</td>
<td>$592,118</td>
<td>$511,589</td>
<td>$563,907</td>
<td>$460,450</td>
<td>$552,516</td>
<td>$414,387</td>
</tr>
<tr>
<td>3</td>
<td>Superannuation</td>
<td>$51,159</td>
<td>$61,391</td>
<td>$48,043</td>
<td>$55,252</td>
<td>$41,439</td>
<td>$49,726</td>
<td>$57,923</td>
</tr>
<tr>
<td>4</td>
<td>Workers Comp</td>
<td>$5,684</td>
<td>$6,821</td>
<td>$5,136</td>
<td>$6,133</td>
<td>$4,604</td>
<td>$5,525</td>
<td>$4,144</td>
</tr>
<tr>
<td>5</td>
<td>Staff Amenities</td>
<td>$28,422</td>
<td>$34,106</td>
<td>$25,579</td>
<td>$30,695</td>
<td>$23,021</td>
<td>$27,826</td>
<td>$20,719</td>
</tr>
<tr>
<td>6</td>
<td>Consumables</td>
<td>$84,106</td>
<td>$40,927</td>
<td>$30,655</td>
<td>$36,834</td>
<td>$27,266</td>
<td>$33,151</td>
<td>$24,893</td>
</tr>
<tr>
<td>7</td>
<td>Recruitment</td>
<td>$17,553</td>
<td>$20,464</td>
<td>$15,348</td>
<td>$18,417</td>
<td>$13,833</td>
<td>$16,575</td>
<td>$12,432</td>
</tr>
<tr>
<td>8</td>
<td>Travel</td>
<td>$13,369</td>
<td>$13,642</td>
<td>$20,232</td>
<td>$12,278</td>
<td>$9,209</td>
<td>$13,066</td>
<td>$8,288</td>
</tr>
</tbody>
</table>

Let’s make this named range dynamic, so that if data is added to the table, it will be included in the range. Firstly, we need to work out how big the range is. We’ll do this using a COUNTA formula in row 1 and column A. This counts the number of cells that are not blank.

Note that the data needs to be a block, with no blank rows or columns, as this could throw the formula off by a row or column.

Go to the Name Manager or and create a named range as shown in Figure 12.41. See “Named Ranges” in Chapter 5 for instructions on how to create a named range.

**FIGURE 12.41 Creating a Dynamic Named Range**
Instead of putting the absolute range of A1:I8 in the Refers To box, put the formula 

=OFFSET(A1,0,0,COUNTA(A:A),COUNTA(1:1)).

This is telling the named range to start at A1 and to go for as far up and down as there is data. We are using the height and width sections of the OFFSET function in this case. For more detail on this function, see “OFFSET Function” in Chapter 6.

You can now refer to this named range in formulas, knowing that additional data will always be captured within the range.

**Note:** It is not normally a good idea to use entire column or row references in formulas because they use a lot more memory; however, using them in this case, there is no limitation on how large the range can grow. If memory is an issue, you may prefer to limit the range to 1,000 rows and columns, or as many as you think your users may need. In this case you could add some colour markings so that user know when they have exceeded the range limits.

**Using a Dynamic Range Name in a Chart**

Dynamic named ranges are helpful when you are creating a chart with a variable number of values. For example, let’s say you are creating a chart based on financial mode that contains a variable number of tenants. We know that users are unlikely to need to model more than five or 10 tenants in the model, but we’ve made the model flexible so that users can enter up to 25 tenants, just in case they need that many. If we set up the chart allowing for 25 tenants it would look perfectly ridiculous. See Figure 12.42.

**FIGURE 12.42 Chart with Variable Number of Tenants**

The chart looks much better if we only include the tenants that actually have data in the chart. See Figure 12.43.
**FIGURE 12.43 Chart with Five Tenants**

![Chart with Five Tenants](image)

However, using an ordinary chart, we’d need users to go into the source data and change the chart range manually, which would be time-consuming and error-prone. The alternative is to create dynamic named ranges in the source data, and then refer to the named ranges when creating the chart. This way the range (and therefore the labels picked up in the chart) will automatically expand and contract, depending on whether the cells contain data or not. Unused tenancy cells will remain blank and will not be included in the chart.

*Note: When using dynamic named ranges in a chart, each range must be one-dimensional (i.e., only contain data in a single row or column). You therefore need to create a range for the labels and then a separate range for each series that appears on the chart.*

**CHARTING WITH TWO DIFFERENT AXES AND CHART TYPES**

One of the best ways of analysing the output of your model is to plot two different variables on the same chart, so that we can understand trends and look for correlations in the data. Sometimes the only way to spot a trend or an anomaly in the model is to look at it graphically. For example, how does our overall revenue compare to head count? Surely as revenue increases so should head count, and if it doesn’t we need to understand why. What if we compare regions and their number of units sold and profit? Surely the regions with the highest number of units sold should be the most profitable? This may not necessarily be the case. Let’s take a look at some data, and plot the number of units sold and the profits using two different chart types on two axes.

If we have the data as shown in Figure 12.44, we can create a simple line chart. The easiest way to do this is to highlight the data in columns A, B, and D by holding down the Control key.
FIGURE 12.44 Inserting a Line Chart

Select the 2-D line from the Insert tab on the ribbon. In Excel for Mac 2011, select the 2-D line from the Chart tab on the ribbon. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

Note that you’ll need to hold down the Control key while selecting nonconsecutive ranges.

The chart will look something like Figure 12.45.

FIGURE 12.45 Preliminary Line Chart

The problem is that the chart looks quite nonsensical because we are plotting two different types of units: number of units sold and profit (in dollars).

The first thing we need to do is move the units sold to a new y-axis on the right-hand side.

1. Select one of the series by clicking on it. Make sure the entire series has been selected.
2. Right-click and go to Format Data Series.
3. On the Series Options tab, click on Secondary Axis instead of Primary Axis. See Figure 12.46.
4. This will create a new axis on the right-hand side. This can also be done on the Layout tab (or the Format tab in Excel for Mac 2011); simply click on Format Selection, as shown in Figure 12.47.

**FIGURE 12.46 Format Data Series, Secondary Axis**

Insert the axis labels to make your chart clearer.

Choose Primary Vertical Axis Title and Secondary Vertical Axis Title from the Axis Titles on the Layout tab in the ribbon, as shown in Figure 12.48.

**FIGURE 12.47 Format Selection (on the Layout Tab)**

**FIGURE 12.48 Adding the Axes Titles in Excel 2007/10**
This will look better as a combination of a column and line graph, so let’s change the Profit series to a column graph.

1. Select the Profit series.
2. Right-click and select Change Series Type.
3. Choose a column chart.

Your chart should look like Figure 12.49.

**FIGURE 12.49 Completed Chart on Two Axes and Chart Types**

Insert a title by selecting Chart Title from the Layout tab. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

*Tip:* These charts can be a little confusing if you try to put too much in, so keep it simple by sticking to only two series. Make sure that the axes are formatted correctly if currency symbols are appropriate. Leave the legend, which will make it clearer which section of the chart refers to which series.

**BUBBLE CHARTS**

Bubble charts are a variation of other types of graphs, combining elements from column and scatter charts. They give the user a way to compare values based on the relative size of the bubble, as well as the location within the chart. They are most useful when there are three data points to display.
Let’s say you have collected the following historical information about your company’s profits and profit margins by year:

<table>
<thead>
<tr>
<th>Year</th>
<th>Profit</th>
<th>Number of Staff</th>
</tr>
</thead>
<tbody>
<tr>
<td>2008</td>
<td>$50,000</td>
<td>23</td>
</tr>
<tr>
<td>2009</td>
<td>$35,000</td>
<td>17</td>
</tr>
<tr>
<td>2010</td>
<td>$40,000</td>
<td>20</td>
</tr>
<tr>
<td>2011</td>
<td>$18,000</td>
<td>9</td>
</tr>
<tr>
<td>2012</td>
<td>$60,000</td>
<td>30</td>
</tr>
<tr>
<td>2013</td>
<td>$45,000</td>
<td>22</td>
</tr>
</tbody>
</table>

Since you have three data points, it is difficult to represent this as a 2-D graph. Consider the following example of how the data could be charted. See Figure 12.50. It can be difficult to compare the relativity of the gross margin dollars and the gross margin percentage. Essentially, having all of the information in this format loses the intended purpose.

**FIGURE 12.50 Data Shown in a Two-Dimensional Chart**

In this situation, we can consider using a bubble chart. The same data presented in a bubble chart tells a different story. You are able to compare the profits and margins by using the vertical rise of each bubble (profit) and its corresponding y-axis value, along with comparing the margins by looking at the size of the bubbles.

Creating a bubble chart is a bit more involved than a standard bar chart, but the few extra steps are worthwhile.

1. Open up a blank worksheet and start by entering the data as shown in Figure 12.51.
2. The columns are reflected on the bubble chart, as shown:
   a. The first column contains the values for the horizontal x-axis and it must contain numerical data – text such as Area A, Area B, and so on will not show up on the x-axis.
   b. The second column contains the values for the vertical y-axis.
   c. The third column will be shown as the size of the bubble.
3. The first trick with a bubble chart is that all data needs to be formatted as Number; otherwise it will not be properly displayed. Change the formatting to ensure the data has been formatted as a number.
4. We can now create a bubble chart from this data. The easiest way to do this is to highlight the whole range A2:C7, and create the chart. It is important to remember not to include the headers – another trick with bubble charts. Doing so will cause errors.
5. Select the bubble chart under Other Charts from the column section on the Insert tab (or Charts tab in Excel for Mac 2011), and the basic bubble chart will appear automatically. See Figure 12.52. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

FIGURE 12.52 Inserting the Bubble Chart

6. The chart should now look something like Figure 12.53 (although the colours and background might look a little different, depending on which version of Excel you are using).
7. Click on the series legend and delete it.
8. Add the title Profit & Staff. Click on the graph and select Chart Title from the Layout tab. Right-click and go to Chart Options.
9. Right-click on the bubbles to select them all, and choose Add Data Labels. The default will be the sales amounts. To change this, right-click again on the bubbles, and choose Format Data Labels.

Under Label Options, unselect y-axis, select Bubble Size, and also select Center. Your chart should be informed by the samples in Figures 12.54, 12.55, and 12.56.

FIGURE 12.54 Changing the Labels
Then, right-click on the actual labels, choose Format Data Labels, go to Alignment, and select Center under Label Position, and click OK.
10. To bold the data labels, you can highlight them first, then press Control + B (this trick works anywhere in Excel, Word, and most programs). This is Command + B in Excel for Mac 2011.

11. Your bubble chart should look something like Figure 12.57.

**FIGURE 12.57 Completed Bubble Chart**

![Completed Bubble Chart](image)

**WATERFALL CHARTS**

Waterfall charts, also called bridge or stepped charts, have become popular in recent years, particularly when displaying the output of a financial model. A waterfall chart displays very effectively the incremental impact of each period of time, or unit. It is a type of bar chart where the value of the second bar generally begins where the first one finished. To illustrate, a waterfall chart might look something like Figure 12.58.

**FIGURE 12.58 Completed Basic Waterfall Chart**

![Completed Basic Waterfall Chart](image)

This kind of waterfall chart is very simple, and will only take a few minutes to build, as the incremental cash amounts for each month are always positive, and there are no values below the x-axis. First, we'll take a look at creating this kind of very simple waterfall chart, then we'll tackle the more complex charts.
Creating a Basic Waterfall Chart (with Only Positive Values)

Let’s say you have a forecast for incoming cash for the next six months (see the data list that follows).

<table>
<thead>
<tr>
<th>Month</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan</td>
<td>$250</td>
</tr>
<tr>
<td>Feb</td>
<td>$200</td>
</tr>
<tr>
<td>Mar</td>
<td>$1,000</td>
</tr>
<tr>
<td>Apr</td>
<td>$120</td>
</tr>
<tr>
<td>May</td>
<td>$650</td>
</tr>
<tr>
<td>Jun</td>
<td>$800</td>
</tr>
</tbody>
</table>

You could forecast it as a cumulative bar chart. See Figure 12.59.

**FIGURE 12.59 Cumulative Cash Forecast Chart**

But we’d like to see the incremental contribution of each month individually, which will add a new dimension to the analysis.

Contrary to popular belief, you don’t need fancy software to build a basic waterfall chart. They are really not that difficult to build in Excel and are achieved by a little trick whereby we create a floating or dummy series in a stacked column chart.

1. Open a blank worksheet and start by entering the dates and your cash amount in columns A and C as shown, leaving column B blank. See Figure 12.60.

**FIGURE 12.60 Basic Waterfall Chart Workings Layout**
2. In column B, we need to create a dummy series, which will be used to push each cash series bar up to where the last one ended. So column B will contain the cumulative balance from the previous period. You’ll see what I mean in a minute.

3. We need to make cell B3 a cumulative balance, so the formula in cell B3 should be \(=B2+C2\). Copy B3 down to B7. Let’s label it the Base column because it’s effectively where the bottom of each column starts. It should now look something like Figure 12.61.

**FIGURE 12.61 Basic Waterfall Chart Formulas**

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Month</td>
<td>Base</td>
<td>Cash</td>
</tr>
<tr>
<td>2</td>
<td>Jan</td>
<td></td>
<td>$250</td>
</tr>
<tr>
<td>3</td>
<td>Feb</td>
<td>$250</td>
<td>$200</td>
</tr>
<tr>
<td>4</td>
<td>Mar</td>
<td>$450</td>
<td>$1,000</td>
</tr>
<tr>
<td>5</td>
<td>Apr</td>
<td>$1,450</td>
<td>$120</td>
</tr>
<tr>
<td>6</td>
<td>May</td>
<td>$1,570</td>
<td>$650</td>
</tr>
<tr>
<td>7</td>
<td>Jun</td>
<td>$2,220</td>
<td>$800</td>
</tr>
</tbody>
</table>

4. We can now create a stacked bar chart from this data. The easiest way to do this is to highlight the whole range A2:C7, and create the chart.

5. Select the stacked column from the column section on the Insert tab (or the Charts tab in Excel for Mac 2011) and the chart will appear automatically. (See the Excel 2003 instructions available at www.wiley.com/go/steinfairhurst.)

The chart should now look something like this (although the colours and background might look a little different if you are using Excel 2003 or Excel for Mac). See Figure 12.62.

**FIGURE 12.62 Draft Basic Waterfall Chart**
6. Click on the series legend and delete it.
7. Add the title Cash Forecast Waterfall by clicking on the graph, and selecting Chart Title from the Layout tab.
8. Click on the bottom series and change the series fill colour of the bars to white or no fill by right-clicking and selecting Format Data Series. You may also like to edit the colour of the chart series that is showing on the chart.
9. You can remove the background gridlines by clicking on them and deleting.
10. If there is a border around the white series, you can remove this by going into Format Data Series again and selecting the No Border option.
11. Your waterfall chart should look something like Figure 12.63.

![Completed Basic Waterfall Chart](image)

**FIGURE 12.63 Completed Basic Waterfall Chart**

Creating a Waterfall Chart (with Positive and Negative Values)

What if your cash forecast changed, however, and in April you are expecting a poor month, with a loss amount of $500? See the following list of data:

<table>
<thead>
<tr>
<th>Month</th>
<th>Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jan</td>
<td>$250</td>
</tr>
<tr>
<td>Feb</td>
<td>$200</td>
</tr>
<tr>
<td>Mar</td>
<td>$1,000</td>
</tr>
<tr>
<td>Apr</td>
<td>($500)</td>
</tr>
<tr>
<td>May</td>
<td>$650</td>
</tr>
<tr>
<td>Jun</td>
<td>$800</td>
</tr>
</tbody>
</table>

Simply changing the data on your existing waterfall chart model will not display the chart correctly. Entering a negative value will cause the series to display below the x-axis, which is not correct. See Figure 12.64.
We’ll need to create separate columns for additional series in order to allow for negative values in our waterfall chart.

1. Change the layout of your sheet so that it shows the negative and positive amounts in separate columns as shown below. Remove the dummy figures from column B. Even though the value in cell D5 is a negative amount, we will enter it as positive for the chart. See Figure 12.65.

2. Maintain a balance in row E. Cell E2 would be \( =E1+C2-D2 \). Copy this formula down to E7 to achieve the following results. See Figure 12.66.
3. Now we’ll use the dummy column B as we did before, to control the stepping stones of our chart. The formula in cell B2 should be $E1-D2$. Copy it down the range. See Figure 12.67.

**FIGURE 12.67 Waterfall Chart Formulas (with Positive and Negative Values)**

```
<table>
<thead>
<tr>
<th></th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>Base</td>
<td>Pos Cash</td>
<td>Neg Cash</td>
</tr>
<tr>
<td>2</td>
<td>Jan</td>
<td>$0</td>
<td>$250</td>
<td>$250</td>
</tr>
<tr>
<td>3</td>
<td>Feb</td>
<td>$250</td>
<td>$200</td>
<td>$450</td>
</tr>
<tr>
<td>4</td>
<td>Mar</td>
<td>$450</td>
<td>$1,000</td>
<td>$1,450</td>
</tr>
<tr>
<td>5</td>
<td>Apr</td>
<td>$550</td>
<td>$500</td>
<td>$950</td>
</tr>
<tr>
<td>6</td>
<td>May</td>
<td>$550</td>
<td>$400</td>
<td>$1,600</td>
</tr>
<tr>
<td>7</td>
<td>Jun</td>
<td>$1,600</td>
<td>$800</td>
<td>$2,400</td>
</tr>
</tbody>
</table>
```

4. Generate a chart, as you did in the exercise above, for this data, excluding column E. See Figure 12.68.

**FIGURE 12.68 Draft Waterfall Chart (with Positive and Negative Values)**

5. Again, change the base series to white font or no fill.
6. You may wish to show the negative cash amount in a different colour. If you’d like to see all series the same colour, simply make them both the same.
7. Practice changing the input numbers from positive to negative, and check that the chart is working correctly.
8. The final chart should look something like Figure 12.69.
Figure 12.69 is also useful for displaying the profitability of the company by category, instead of by time series.

In Figure 12.70, we have simply replaced the months with the revenue and expense categories and changed the numbers. Using exactly the same simple template, we can display how much of the revenue is being spent in each expense category and how much residual profit is left.

Creating a Complex Waterfall Chart (with Positive and Negative Values Crossing the x-Axis)

You may have noticed that the charts we created above all remain as positive total values. They will not work if the columns are below the x-axis. For example, if the cash loss amount (as shown in one of the last examples) was $2,000 instead of $500, this template would not work correctly. See Figure 12.71.
In order to create a waterfall chart that will handle both positive and negative values, as well as a balance that crosses the x-axis, we'll need to create much more complex calculations. If you are sure that you don't need this additional complexity, then one of the previous examples will suffice. However, if you spend the extra time setting up the template as we will now discuss, the chart will work no matter what the parameters of the inputs are. Be warned: These formulas are not for the faint-hearted. You might prefer to simply type in the formulas as described above instead of trying to follow the logic of what each formula is doing, as detailed in the following instructions.

1. To start, we need to treat the series separately depending on whether they are positive or negative, and above or below the x-axis (or zero), so we need to plot five series:
   a. Positive values above zero.
   b. Positive values below zero.
   c. Negative values below zero.
   d. Negative values above zero.
   e. The floating or dummy series (labelled blank in Figure 12.72).

2. Therefore you need to set up the sheet to look like Figure 12.72.
3. **Positive values above zero**: To calculate this, we need to show the minimum of the cumulative amount and the current month’s amount – but only if this value is greater than zero. The formula in cell D2 should be \( \text{MAX(0,MIN(SUM(B$2:B2),B2))} \). Copy it down the range.
4. **Positive values below zero:** If the series goes below zero, we’ll need to know the difference between the value entered, and the positive amount above zero (calculated in the last step), displayed as a negative amount. The formula in cell E2 should be =-MAX(0,B2-D2). Copy it down the range.

5. **Negative values below zero:** To calculate this, we need to show the maximum of the cumulative amount and the current month’s amount – but only if this value is less than zero. The formula in cell F2 should be =MIN(0,MAX(SUM(B$2:B2),B2)).

6. **Negative values above zero:** If the negative values go above zero, we want to calculate the difference between the value entered, and the negative amount above zero (calculated in the last step). The formula in cell G2 should be =MAX(0,F2-B2). Copy it down the range.

7. **The floating or dummy series:** This calculation adds together both the highest and lowest of the cumulative values so that it can be a starting point for the other series. The formula in cell C3 should be =MAX(0,MIN(SUM(B$2:B2),SUM(B$2:B3)))\(\pm\)MIN(0,MAX(SUM(B$2:B2),SUM(B$2:B3))). Copy it down the range. Note that cell C2 should be left blank.

8. Now that all five series have been completed, create the stacked chart by highlighting the whole block except for the cash amounts in column B. Your sheet should look something like Figure 12.73.

**FIGURE 12.73 Draft Complex Waterfall Chart**

9. Change the colour of the blank series to white font or no fill.

10. Now you have four different series in different colours. We want the positive and negative amounts to be the same colour, so change them so that they are the same. (You might prefer to have all four series the same colour.)

11. Delete the legend and add a title.

12. Your waterfall chart should look something like Figure 12.74.
SUMMARY

Presenting the completed model is a part of the model-building process that is typically not done well by most financial modellers. The majority of the focus has been on the building, structure, design, and layout, and on getting accurate calculations and results.

When senior managers or clients commission a financial model to be built, they are less interested in the structure or calculations of the model than they are with the output and the results of scenario analysis and sensitivity testing. Quite often the modeller does not consider how to best present and communicate these results to senior managers’ clients.

It’s important that at the end of the model-building process that the modeller spends some time thinking about what the viewer of the model needs to see, whether it is a report, chart, or table, and how best to communicate both verbally and visually the methodology, assumptions, and results of the model in the clearest and most informative way.
Chapter 12 – Review Questions

The following questions are designed to ensure that you have a complete understanding of the information presented in the chapter. They do not need to be submitted in order to receive CPE credit. They are included as an additional tool to enhance your learning experience.

We recommend that you answer each review question and then compare your response to the suggested solution before answering the final exam questions related to this chapter.

1. Each of the following is a recommended tip to follow when charting except:
   a) do not use gridlines
   b) limit the number of bars to seven in a bar chart
   c) limit the number of lines to five in a line chart
   d) avoid using 3-D charts

2. A donut chart is typically best suited for:
   a) stacking multiple pie charts
   b) showing data three-dimensionally
   c) displaying single series of positive percentages or ratios
   d) enhancing scatter plots with an additional variable

3. Which type of charts plot the points on a circular axis:
   a) bubble charts
   b) radar charts
   c) area charts
   d) bar charts
1. A: Incorrect. You do not need to use gridlines. The relative ups and downs of the charts will speak for themselves without the help of gridlines.
   
   B: Incorrect. It is recommended that you limit the number of bars in a bar chart to seven.
   
   C: Correct. Five lines are too many. You should limit the number of lines to three in a line chart.
   
   D: Incorrect. Presentations should be kept simple, and 3-D charts are often too complex. It is recommended that you avoid using 3-D charts.
   
   (See page 306 of the course material.)

2. A: Correct. Donut charts are pie charts with a hole in the middle. This allows donut charts to stack several series in the same chart.
   
   B: Incorrect. 3-D charts are best suited for showing data three-dimensionally.
   
   C: Incorrect. In order to show single series of positive percentages or ratios, you would want to use a pie chart, not a donut chart.
   
   D: Incorrect. Bubble charts, not donut charts, are best suited for enhancing scatter plots with an additional variable. Bubble charts are able to reflect bubble size for each category in the chart, but not stack multiple pie charts.
   
   (See page 307 of the course material.)

3. A: Incorrect. Bubble charts plot points on the x- and y- axis. They are unique because they reflect bubble size for each category in the chart.
   
   B: Correct. Radar charts plot points on a circular axis. Data points are indicated by their relative distances from the center.
   
   C: Incorrect. Area charts plot points on an x- and y- axis.
   
   D: Incorrect. Bar charts plot points representing time or future projections along the x- axis and a different category along the y- axis.
   
   (See page 317 of the course material.)
Notes

Chapter 1


Chapter 3

1. FAST Modelling Standard: www.fast-standard.org/

Chapter 4


2. Spreadsheet Errors: What We Know. What We Think We Can Do: arxiv.org/abs/0802.3457

Chapter 7

1. By design, all the Option buttons will always refer to a single cell, unlike check boxes. If you change the cell link for one option button, it will automatically update the rest.
Glossary

Aggregation functions: functions used when there is a lot of data arranged either vertically or horizontally that must be added together.

Array formula: a collection of data of the same type that can be treated as a single entity. It treats the entire array as a single input to the formula. Array formulas follow different rules than ordinary formulas, making them difficult to understand.

Cell and file hyperlinks: links to other files or locations within the model. They aid in navigation of a model and are especially useful for new users to find their way around the model.

Data checking: one of the two main tasks of the quality assurance (QA) procedure for auditing a financial model. It aims to ensure that the correct input data is used and has been entered into the model accurately.

Declining balance value methods: provide for a higher depreciation charge in the first year of an asset's life and gradually decreases charges in subsequent years.

Financial functions: functions used to calculate commonly used financial calculations such as net present value, interest payments, and depreciation amounts.

Financial model: a model containing a set of variable assumptions, inputs, outputs, calculations, scenarios, and often includes a set of standard financial forecasts such as profit and loss, balance sheet, and cash flow which are based on the variable assumptions.

Formula: a built in application in Excel such as SUM, COUNT, and AVERAGE.

Function: instructions defined by users on how to perform calculations.

Goal seek: adjusts the value in a specified cell until a formula dependent on that cell reaches the result you specify. It changes the inputs such that the output is set to the exact amount you want it to be.

Internal rate of return (IRR): equates the present value of cash inflows and the present value of the cash outflows.

Logical functions: functions used when one needs to evaluate a condition.

Logic testing: one of the two main tasks of the quality assurance (QA) procedure for auditing a financial model. It aims to test whether the logic underpinning the model is reflected accurately in the model.

Lookup functions: functions used when one needs to look up a value to return a single amount.

Net present value (NPV): the value of the expected future cash flows from an investment, expressed in today's dollars.
**Payback period**: the point at which the sum of cash flows becomes positive.

**Scenario analysis**: involves listing a whole series of inputs and changing the value of each input for each scenario.

**Sensitivity/what-if analysis**: the process of tweaking one key input or driver in a financial model in order to see how sensitive the model is to the change in that variable.

**Sparklines**: a small line chart used to display the trends in data.

**Spreadsheet**: a catchall term for any type of information stored in Excel.

**Straight-line method**: calculates depreciation at a fixed rate over the expected useful life of an asset. The formula for this calculation is:

\[
\frac{\text{cost} - \text{salvage}}{\text{expected useful life}}
\]

**Sum-of-the-years'-digits method**: calculates depreciation at varying costs for each period. The formula for this calculation is:

\[
\frac{(n(n + 1))}{2} \quad \text{where } n \text{ is equal to the useful life in years}
\]
About the Website

Please visit the companion website (referred to throughout the course) at www.wiley.com/go/steinfairhurst for more information on the tools discussed. The website includes additional instructions, materials, downloads, and handy tips including:

Instructions:
- A detailed document containing instructions for how to use tools for which instructions differ between versions – for those still using Excel 2003.

Materials:
- Excel Versions (Chapter 5).
- Additional Material:
  - Basic Formatting (Chapter 7).
  - Break-Even Analysis (Chapter 9).
  - How to Create a Basic Line Chart (Chapter 12).

Downloadable Resources:
- Online resources including a list of websites, blogs, and tutorials for Excel and financial modelling (Chapter 1).
- Shortcuts (Windows Version) (Chapter 5).
- Shortcuts (Mac Version) (Chapter 5).
- QA Log template (Chapter 10, Appendix 10.1).

Models:
- Model Assessment Checklist (Chapter 3).
- Salary Sacrifice Calculator (Chapter 7).
- Scenario Comparison (including both Exercise and Completed Versions) (Chapter 11).
- Waterfall Chart (including both Exercise and Completed Versions) (Chapter 12).

. . . and much more.
absolute cell referencing, 100
access, 7
accounting knowledge, 12
ActiveX Controls, 188
advanced conditional formatting, 287
advanced Excel course, 10, 17, 18
aggregation functions, 85, 109, 349
amortisation schedule, 144
AND Statement, 96
area chart, 308, 315
array formula, 197, 198, 200
assumptions, 44, 65
assumptions documentation, 47, 53
assumptions layout, 23
assumptions validation, 14
audit add-ins, 9
auditing, 268
AVERAGE( ), 94
AVERAGEIF, 115
AVERAGEIFS, 116
AVERAGEIFS, 116

bad habits, 45
balanced scorecard, 4
bar chart, 308
basic Excel functions, 91
basic formatting, 151
benchmarking, 4
best practices, 100
break link dialog box, 71
break-even analysis, 249, 253
break-even point, 249, 251
bubble chart, 309, 317, 331
budgeting, 6
building a model, 29, 31
business knowledge, 12

calculator organisation, 28
calculation sheet, 27
calculations, 35
chart types, 306, 328
charting, 306
choose function, 129
circular references, 76
circular references, 75, 76, 77
client review, 36
client skills, 14
clustered column charts, 312
colour coding, 28
colour scales, 158, 159, 160, 286
column chart, 307, 310
columns, 191
combination charts, 316
combo boxes, 184, 280, 294, 295, 296
cost of capital, 139
COUNT( ), 93
COUNTIF, 109
COUNTIFS, 113
cover sheet, 27, 28
cumulative totals, 230
custom currency symbols, 154
custom formatting, 151
customer relationship management, 6

dashboard report, 2
dashboards, 4
data bars, 157, 158
data collection, 26
data collection plan, 34, 41, 43
data gathering, 14
data validations, 49, 171, 279, 292, 296
date formatting, 136, 137
day function, 136
declining balance value methods, 243
dependents, 261
depreciation methods, iii, 240, 241
design issues, 26
design skills, 13
display settings, 168
donut chart, 309, 316
double declining balance method, 245
draft model, 36
dynamic range names, 326
end of useful life, 247
EOMONTH Function, 133, 134
error avoidance strategies, 62
error check sheet, 28
error checks, 72
error displays, 75
error-check alerts, 74
error-checking tools, 262, 263
errors, 195
escalation calculations, 226
escalation methods, 221
excel add-ins, 8
excel shortcuts, 86
exponential growth rates, 225
external files, 69
external links, 70

file structure, 39, 40
financial functions, 85, 138, 349
financial model, 3, 4, 29, 268
financial modeller, 15, 16
financial modelling, 57, 83, 109, 191, 205, 221, 277
financial modelling techniques, i, 61
financial project evaluation functions, 138
fixed declining balance method, 243
flat tiering structure, 237
footnoting, 50, 51
forecast function, 130
forecast function wizard, 132
forecasting, 1, 6, 69
form controls, 175, 188
formatting options, 155
formulas, 46, 67
formula auditing, 77, 260, 261, 265, 271
formula bar, 98, 170
function wizard, 83, 84, 98, 110, 111, 116, 121, 125, 127, 130, 132, 283

goal seek, 202, 253
grouping, 196
growth rate, 221, 223, 224

hard coding, 44, 57, 69, 70, 271
hard-coded text, 53
hidden sheets, 166, 192
HLOOKUP, 121
horizontal lookup, 121
hyperlinks, 47, 51, 52

icon sets, 158, 159, 162
IF Functions, 97
IF Statement, 95
in-cell comments, 47, 48, 190
index, 124
industry knowledge, 11
information requests, 38
inherited model, 259
input sheet, 27
integration add-ins, 9
interest calculations, 77
interest rates, 144, 147
internal rate of return, 139
IPMT function, 146
iterative calculations, 78, 79

language skills, 14
line chart, 308, 314
Linked Dynamic Assumptions Documentation, 54
linking, 44
loan calculations, 143, 226
loan-interest calculation method, 144
locking cells, 168
logic errors, 64
logical functions, 85, 95, 349
lookup formulas, 116
lookup function, 85, 121, 349

Mac shortcuts, 89
macro settings, 209
macros, 208, 215
MATCH, 124
MAX( ), 92
methodology, 65
Microsoft Office Tools, 7
MIN( ), 93
mixed referencing, 101
model audience, 26
model design, 23, 25
model layout flow charting, 30
model purpose, 26
model results, 303, 304
model structure, 27, 41, 42, 269
modelling tools, 6
MONTH Function, 135, 136
MS Project, 8

N
named ranges, 102
net present value, 139
NOMINAL( ), 228
number formats, 154
numeracy skills, 15

O
offset function, 126
one-variable data table, 284
option button, 180
OR Statement, 97
oral presentation, 303
outputs, 36

P
password-protect, 166
payback calculation, 230, 232, 234
payback period, 230
peer review, 36
pie chart, 309, 315
pivot tables, 204, 205, 206
PPMT Function, 147
presentation skills, 14
progressive tiering, 238
project planning, i, 4, 29, 40
protection, 165, 195

Q
QA Procedure, 269
quality assurance, 37

R
radar chart, 310, 317
read-only, 166
red triangle comments, 48, 50, 58, 59
regression analysis, 130
relative cell referencing, 100
ribbon, 170
risk assessment, 2
risk management, 4
rows, 191

S
scenario analysis, 279
scenario manager, 279, 280, 281, 282, 289, 300
scenario methods, 290
scenario sheets, 27
sense-checking methodology, 66, 67
sensitivity analysis, 277, 278, 283, 291
sheet tabs, 169
sheets, 192
simple formula errors, 45, 62
sparklines, 162
spin buttons, 183
spreadsheet, 3, 10
stacked column charts, 311
straight-line method, 242
stress-testing, iii, 64, 277, 279
SUM( ), 91
SUMIF, 111
SUMIFS, 115
summary categorisation, 24

T
template, 322
the streamlined version, 31
the team version, 32
tiering table, 237
time series, 26
training course, 16, 17
TREND function, 130
Two-Variable Data Table, 285, 297
user-defined functions, 216
user-friendly features, 56
users, 33

variance analysis, 2
version-control documentation, 39
vertical lookup, 116
VLOOKUP, 116

waterfall chart, 336
web URL hyperlinks, 52
WEEKDAY Function, 134
weighted average cost of capital, 234
Windows shortcuts, 87
work area, 171
workbook anatomy issues, 28
workings, 35
workings sheet, 27
worksheet, 167
written presentation, 304

YEAR Function, 135